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Chapter 1. C Language

This chapter describes the target specific features of the C language, including language extensions that
are not standard in ISO-C. For example, pragmas are a way to control the compiler from within the C
source.

The TASKING VX-toolset for MCS C compiler fully supports the ISO C99 standard and supports all
mandatory language features of the C11 standard, and adds extra possibilities to program the special
functions of the target. C11 is the default of the C compiler.

C11 language features

All mandatory ISO C11 language features are supported (ISO/IEC 9899:2011 section 6.10.8.1 Mandatory
macros). Furthermore the C compiler supports the following conditional features (ISO/IEC 9899:2011
section 6.10.8.3 Conditional feature macros):

« variable length arrays and variably modified types

Other conditional language features such as threads, as mentioned in section 6.10.8.3 Conditional feature
macros and section 6.10.8.2 Environment macros of the ISO/IEC 9899:2011 standard, are not supported.
__STDC NO ATOM CS__and __ STDC NO THREADS _ are defined as 1.

Additional language features

In addition to the standard C language, the compiler supports the following:
» extra datatypes, like __int72_t, uint72_t and__aei _t
 address space qualifiers

« intrinsic (built-in) functions that result in target specific assembly instructions
» pragmas to control the compiler from within the C source

 predefined macros

« the possibility to use assembly instructions in the C source

» keywords for inlining functions and channel functions

* libraries

All non-standard keywords have two leading underscores (__).

In this chapter the target specific characteristics of the C language are described, including the above
mentioned extensions.
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1.1. Data Types

The C compiler supports the ISO C11 defined data types, and additionally the types __i nt 72_t,
__uint72_t and __aei _t.The characteristics of these types are shown in the following table.

The precision describes the number of bits that are used to express a value.

The size is the storage size in bits that a variable of a given C type consumes when it is stored in memory.

The alignment specifies how variables of the given C type are aligned in memory. A memory address is
said to be n-bits aligned when the address is a multiple of n bits (where n is a power of 2). The values
depend on the data transfer operations as defined by the MCS instruction set architecture.

CType Precision |Size |Alignment [Limits

_Bool 1 24 32 Oor1l

char 24 24 (32 [-2%, 2%-1)

unsigned char 24 24 32 [0, 224-1]

short 24 24 (32 [-2%3, 2731

unsigned short 24 24 (32 [0, 2%%-1]

int 24 24 (32 [-2%, 2%-1)

unsigned int 24 24 32 [0, 224-1]

enum 24 24 (32 [-2%, 2731

long 48 48 (32 [-2*7, 2%7-1]

unsigned long 48 48 32 [0, 248-1]

long long 72 72 (32 -2, 2%

unsigned long long 72 72 32 [0, 272-1]

_int72_t 72 72 |32 2%, 2™

__uint72_t 72 72 [32 [0, 27%-1]

float (23-bit mantissa) 32 48 32 [-3.402E+38, —1.175E-38]
[+1.175E-38, +3.402E+38]

double 64 72 32 [-1.797E+308, -2.225E-308]

long double (52-bit mantissa) [+2.225E-308, +1.797E+308]

pointer to data or function 24 24 32 [0, 224-1]

pointer to ARU, AEI, OREG,

XOREG or WXREG

__aeit 32 32 (32 [0, 2%-1]

__mcs_aei_t

A byte is defined as the size of a char, so a byte contains 24 bits.

Data type __aei _t is a storage type to interface on the AEI Bus Master Interface. Arithmetic operations
applied on this data type result in either 32-bit unsigned behavior or undefined behavior. __nts_aei _t
is an alias of __aei _t for use with the __mcs__ intrinsics.
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Data types that consist of multiple words are allocated with the least significant word at the lowest memory
address (little-endian). The contents of the upper RDW-W bits of a memory location are undefined, except
for objects of type __aei _t.

Arrays

Arrays are aligned according to the alignment of its element type.

Structures and unions
The alignment of structures and unions is equivalent with the most restrictive alignment of their members.

A structure or union is padded to the alignment of its most restrictive member.
Bit-fields

Individual bit-fields cannot exceed 24 bits in width. The allowed bit-field fundamental data types are _Bool ,
(un)si gned char, (un)si gned short, (un)si gned i nt and enum The maximum bit-field size is
equal to that of the type’s size. For the bit-field types the same rules regarding to alignment and signed-ness
apply as specified for the fundamental data types. Plain i nt bit-fields (without the si gned or unsi gned
type modifier) are unsi gned. In addition, the following rules apply:

» The first bit-field is stored at the least significant bits. Subsequent bit-fields will fill the higher significant
bits.

A bit-field of a particular type cannot cross a boundary as is specified by its maximum width. For example,
a bit-field of type short cannot cross a 24-bit boundary.

« Bit-fields share a storage unit with other bit-field members if and only if there is sufficient space in the
storage unit. Adjacent bit-fields are packed together with no padding in between, except as required
for the special case of a zero-width bit-field.

« An unnamed bit-field creates a gap that has the size of the specified width.

» As a special case, an unnamed bit-field having width 0 (zero) prevents any further bit-fields from residing
in the storage unit corresponding to the type of the zero-width bit-field (a zero-width bit-field, as specified
by ISO C, forces alignment to a storage unit boundary, which for MCS is 32 bits).

Bit-fields are always allocated beginning with the next available bit in the structure or union. No alignment
padding is inserted, except for the cases noted. In the following example therefore, padding will be inserted
in bits [31:9] of the first 32 bits to complete a full 32-bit word in memory. The 17-bit bit-field f 17 will occupy
positions [16:0] of the second word in memory. Padding will be inserted in bits [31:17] to complete a full
word, and the structure will be 32-bit aligned.

struct {
int f1: 5;
int f2: 4;
/1 padding ...
int f17: 17;
/1 padding ...
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1.1.1. Floating-point Types

The IEEE Std 754-2008 binary 32 format is used for C type f | oat and the binary 64 format is used for
C types doubl e and | ong doubl e.

The first word in the tables below is the most significant word. The last word in the tables is the least
significant word.

float

Bit number 31 0 31 0
Binary ----.---.0000.0000.0000. 0000. eeee. eeee ===, === -, SOTM MMM MM MM mmrm mm
encoding
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double /long double

Bit 31 0|31 0 |31 0
number
Binary <---.----.0000. 0000. Seee. ecee. eeee. MMM - - - - . - - - - MM MM MM MM Am mmm - | - - - - - - - - . [m Amm Ammm rmmm mmmm mmmm
encoding

S = sign bit, m = mantissa bit, e = exponent bit, - = undefined

1.2. Special Function Registers

You can access the MCS special function registers (SFRs) directly from your C source by using names
for registers instead of addresses.

The special function register set (SFR_REG) consists of the following OREG and XOREG registers:

STA (status register)

CTRG (clear trigger bits register)
STRG (set trigger bits register)
TBU_TSO (TBU tinestanp TSO register)
TBU_TS1 (TBU tinestanp TS1 register)
TBU_TS2 (TBU tinestanp TS2 register)

DSTA (DPLL status register)

DSTAX (DPLL extended status register)
GM 0 (GTM Modul e Interrupt O register)
GM 1 (GTM Modul e Interrupt 1 register)

Furthermore SFRs are present for several sub-modules.

The general purpose registers RO .. R7 and RSO .. RS7, as well as registers MHB and ACB are not
accessible.

The STAflags N, V, Z and CY are compiler resources, you cannot use them. The CAT, CWI and SAT flags
are used by intrinsic functions.

The SFRs are defined in . sf r files. The files are located in the sf r subdirectory of the standard i ncl ude
directory. The files are named r egcpu. sf r, where cpu is the CPU specified with the control program
option --cpu.

For example from r eggt n81_01. sfr:

#define STA (*(__oreg volatile unsigned int *)0x08)

The compiler includes this register file if you specify option --include-file=sfr/reggtm31_01.sfr
Example of accessing an SFR from C:

if ( (CTRG & 0x8) !=0)
{
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TBU TS1 = Ox7;

Note that indirect access to SFRs might not work if your hardware is configured by a memory
protection unit in such a way that self-modifying code is not allowed. So, try to avoid working with
pointers to SFRs. The compiler issues a warning (W798) and an informational message (1852).

#include __ SFRFILE__(gtnB1_01)

int read_sfr( __oreg volatile unsigned int * p)

{
*p = 10; /1 W89 and | 852
return *p; /1 W89 and | 852

}

int main( void )

{
read_sfr( & STA );
read_sfr( & TBU TSO );
_wurmx( & TBU TS0, 2, 2 );
return O;

}

Sub-module channel/instance independent SFRs

For some sub-modules of the GTM, many functional units are available in multiple entities. Therefore,
apart from the channel/instance specific SFR names, channel/instance independent SFR names are also
available by means of a base address plus offset.

For example, see the Timer Input Module (TIM). The absolute address based GPRO and GPR1 SFR
names for channel 0 and 1 are:

#define TIMCHO_GPRO (*(__aei volatile __aei_t *)0) /* TIM channel 0 GPRO
#define TIMCHO_GPRL (*(__aei volatile __aei_t *)0x4) [/* TIMchannel 0 GPRL
#define TIMCHL _GPRO (*(__aei volatile __aei_t *)0x80) /* TIMchannel 1 GPRO
#define TIMCHL_GPRL (*(__aei volatile __aei_t *)0x84) /* TIMchannel 1 GPRL

Apart from that, channel independent SFR names are also available:

#define TI M CHx_GPRO(BASE) (*(__aei
#define TIM CHx_GPRL(BASE) (*(__aei

#define TI M CHO_BASE 0
#define TI M_CH1_BASE 0x80

/*
/*

TI M channel
TI M channel

volatile __
volatile __

aei _t *)(BASE + 0))
aei _t *)(BASE + 0x4))

0 base address */
1 base address */

To access for example TI M_CH1_GPRL1 in a base+offset way, you can use:

TI M_CHx_GPRL( TI M_CHL_BASE)

*/
*/

*/



C Language

1.3. Address Space Qualifiers

The C compiler supports several address space qualifiers for the definition of SFRs and intrinsic functions.

Address Applicable to Remarks
Space Registers
Qualifier
__oreg STA, CTRG STRG The OREG register set consists of RO. . R7, STA, ACB, CTRG,
TBU_TS0, TBU _TS1, |STRG TBU TS0, TBU TS1, TBU_TS2 and MHB.The Rx registers,
TBU _TS2 ACB and MHB are omitted from __or eg since these registers are
used by the compiler.
__Xoreg STA, CTRG STRG, The XOREG register set consists of the OREG register set plus
TBU TS0, TBU TS1, |RSO..RS7,GM 0, GM 1, DSTA and DSTAX. Address space
TBU TS2,GM 0, GM 1,|__oreg is nested into __xor eg. The RSx registers are omitted
DSTA, DSTAX from __xor eg.
__Wxreg STA, CTRG STRG The WXREG register set consists of the OREG register set plus
TBU_ TS0, TBU TS1, |GM 0, GM 1, DSTA and DSTAX.
TBU_TS2, GM 0, GM 1,
DSTA, DSTAX
__aei To facilitate checking of addresses passed to the bus master
interface intrinsics.
__aru To facilitate checking of addresses passed to the blocking and
non-blocking ARU read intrinsics.

You can combine multiple address space qualifiers to specify that a register is located in multiple address
spaces. For example:

#define DSTA (*(volatile __xoreg __wxreg *)Oxla) /* DSTA belongs to XOREG as wel | as

to WKREG */

#defi ne SOME_XOREG (*(volatile __xoreg )O0x..) /* SOME_XOREG only bel ongs to XOREG */
#defi ne SOME_WKREG (*(volatile __wxreg *)O0x..) /* SOME_WKREG only bel ongs to WKREG */

Because of the __aei qualifier, you can access an SFR on the AEI bus master interface also without

using intrinsics.

For example, CMJ_CLK_EN is defined in r eggt nB1_01. sfr as:

#define CMJ_CLK _EN (*(__aei

You can access it in your C source:

CMJ_CLK_EN = 8;

vol atile

__aei_t *)0x7000)

The compiler generates the following assembly:

nmov|
nmov|
bwr

r5, #8
mhb, #0
r5, 28672
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__aru qualified SFRs are only accessible through intrinsics.

See Section 1.2, Special Function Registers and Section 1.9.7, Intrinsic Functions for more information.

Pointer conversions
The compiler supports the following pointer conversions (casts):

__oreg --> _ Xxoreg
__oreg -->  wxreg
__Xxoreg _ wxreg --> _ wxreg
__Xxoreg _ wxreg --> _ xoreg

1.4. Shift JIS Kanji Support

In order to allow for Japanese character support on non-Japanese systems (like PCs), you can use the
Shift JIS Kanji Code standard. This standard combines two successive ASCII characters to represent
one Kaniji character. A valid Kanji combination is only possible within the following ranges:

* First (high) byte is in the range 0x81-0x9f or Oxe0-0xef.
» Second (low) byte is in the range 0x40-0x7e or 0x80-0xfc

Compiler option -Ak enables support for Shift JIS encoded Kanji multi-byte characters in strings and
(wide) character constants. Without this option, encodings with 0x5c as the second byte conflict with the
use of the backslash (\ ') as an escape character. Shift JIS in comments is supported regardless of this
option.

Note that Shift JIS also includes Katakana and Hiragana.
Example:

/1l Exanpl e usage of Shift JIS Kanji

/1 Do not switch off option -Ak

/!l At the position of the italic text you can

/1 put your Shift JIS Kanji code

int i; // put Shift JIS Kanji here

char c1;

char c2;

unsi gned int ui;

const char rres[]- put Shift JIS Kanjl here";

const unsigned int ar[5]={"K, ,'n',
i
/1 5 Japanese array

voi d mai n(voi d)

{

=(int)cil;

++; /* put Shift JIS Kanji here\
conti nuous conment */

c2=mes[ 9] ;
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ui =ar[0];

1.5. Using Assembly in the C Source: __asm()

With the keyword __asn{() you can use assembly instructions in the C source and pass C variables as
operands to the assembly code.

It is recommended to use constructs in C or use intrinsic functions instead of __asmn() . Be aware
that C modules that contain assembly are not portable and harder to compile in other environments.

The compiler does not interpret assembly blocks but passes the assembly code to the assembly source
file; they are regarded as a black box. So, it is your responsibility to make sure that the assembly block
is syntactically correct. Possible errors can only be detected by the assembler.

You need to tell the compiler exactly what happens in the inline assembly code because it uses that for
code generation and optimization. The compiler needs to know exactly which registers are written and
which registers are only read. For example, if the inline assembly writes to a register from which the
compiler assumes that it is only read, the generated code after the inline assembly is based on the fact
that the register still contains the same value as before the inline assembly. If that is not the case the
results may be unexpected. Also, an inline assembly statement using multiple input parameters may be
assigned the same register if the compiler finds that the input parameters contain the same value. As
long as this register is only read this is not a problem.

General syntax of the __asm keyword

_asn( "instruction_tenpl ate”
[ : output_paramli st
[ @ input_paramli st
[ @ register_reserve_list]]] );

instruction_template Assembly instructions that may contain parameters from the input
list or output list in the form: %parm_nr[.regnum]
Y%parm_nr Parameter number in the range 0 .. 9.
output_param_list [[ "=[&]constraint_char" (C_expression)],...]
input_param_list [[ "constraint_char" (C_expression)],...]
& Says that an output operand is written to before the inputs are read,
so this output must not be the same register as any input.
constraint _char Constraint character: the type of register to be used for the
C_expression. See the table below.
C_expression Any C expression. For output parameters it must be an Ivalue, that
is, something that is legal to have on the left side of an assignment.
register_reserve_list [["register_name"],...]
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register_name Name of the register you want to reserve. For example because this
register gets clobbered by the assembly code. The compiler will not
use this register for inputs or outputs. Note that reserving too many
registers can make register allocation impossible.

Specifying registers for C variables
With a constraint character you specify the register type for a parameter.

You can reserve the registers that are used in the assembly instructions, either in the parameter lists or
in the reserved register list (register_reserve_list). The compiler takes account of these lists, so no
unnecessary register saves and restores are placed around the inline assembly instructions.

Constraint |Type Operand Remark
character
r general purpose register [r0 .. 16 Input and output constraint.
s general purpose register |rO .. r6, and rsO .. rs7 Input and output constraint.
and mirror when option
--extended-registers is
used
number type of operand it is same as %number Input constraint only. The number
associated with must refer to an output parameter.
Indicates that %enumber and number
are the same register.

If an input parameter is modified by the inline assembly then this input parameter must also be
added to the list of output parameters (see Example 6). If this is not the case, the resulting code
may behave differently than expected since the compiler assumes that an input parameter is not
being changed by the inline assembly.

Loops and conditional jumps

The compiler does not detect loops with multiple __asn{) statements or (conditional) jumps across
__asn() statements and will generate incorrect code for the registers involved.

If you want to create a loop with __asmn{( ) , the whole loop must be contained in a single __asm()
statement. The same counts for (conditional) jumps. As a rule of thumb, all references to a label in an
__asn{) statement must be in that same statement. You can use numeric labels for these purposes.

Example 1: no input or output

A simple example without input or output parameters. You can use any instruction or label. When it is
required that a sequence of __asn{) statements generates a contiguous sequence of instructions, then
they can be best combined to a single __asn() statement. Compiler optimizations can insert instruction(s)
in between __asn() statements. Use newline characters ‘\n’ to continue on a new line ina __asn{()
statement. For multi-line output, use tab characters '\t' to indent instructions.

10
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__asn( "nop\n"
"\'tnop" );

Example 2: using output parameters

Assign the result of inline assembly to a variable. A register is chosen for the parameter because of the
constraint s; the compiler decides which register is best to use. The %9 in the instruction template is
replaced with the name of the variable.

int read_acb( void )

{
int out;
__asn( "MV 9%, acbh"
. "= (out) ):
return out;
}

Generated assembly code:

MV r2,acb ; r2 is chosen as output register

Example 3: using input parameters

The preferred use is to use intrinsics, but for illustrating purposes the following example performs a write
access on the bus master interface. A register is chosen for the parameter because of the constraint r ;
the compiler decides which register is best to use. The %9 in the instruction template is replaced with the
name of this register. The compiler generates code to move the input variable to the input register. Because
there are no output parameters, the output parameter list is empty. Only the colon has to be present.

void witebn( int in)

{
__asm "BWR 9%, #256"
re(in) )
}
int main(void)
{
writebm(1234);
return 1;
}
Generated assembly code:
.sdecl '.ntstext.exanple3.witebmn
. sect '. ncstext. exanpl e3. writebm
.global witebm
.align 4

witebm .type func
BVWR r2, #256

11
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ret

.sdecl '.ntstext.exanple3. min
. sect '. ntstext.exanpl e3. mai n
.global main
.align 4
nmai n: .type func
novl r2,#1234
call witebm
nmovl  r2#1

ret

Example 4: using input and output parameters

Assign one C variable to another variable. Registers are necessary for the input and output parameters
(constraint s, %® for out , %4 for i n in the instruction template). The compiler generates code to move
the input expression into the input register.

int in=5;

int movvar( void )

{ .
int out;
_asn( "MV %, d"
"=s" (out)
"st (in) );
return out;
}

Generated assembly code:

novvar: .type func
nr d r5,in
MOV r2,r5
ret

Example 5: reserving registers

Sometimes an instruction knocks out certain specific registers. The most common example of this is a
function call, where the called function is allowed to do whatever it likes with some registers. If this is the
case, you can list specific registers that get clobbered by an operation after the inputs.

Same as Example 4, but now register r 5 is a reserved register. You can do this by adding a reserved
registerlist (: " r5"). As you can see in the generated assembly code, register r 5 is not used (the register
usedisr4).

int in=5;

int movvar( void )

{

12



int out;

_asm "MV %), A"
: "=s" (out)
"s" (in)
©otrst ),
return out;

}
Generated assembly code:

novvar: .type func
nr d r4,in
MoV r2,r4
ret

C Language

Example 6: use the same register for input and output

As input constraint you can use a number to refer to an output parameter. This tells the compiler that the
same register can be used for the input and output parameter. When the input and output parameter are
the same C expression, these will effectively be treated as if the input parameter is also used as output.
In that case it is allowed to write to this register. For example:

inline int foo(int parl, int par2)
{

int retval ue;

__asn(
" SHL %, #2\ n\ t "
" ADD %R, %d\ n\t"
" MOV %0, 92"
"=&s" (retvalue), "=s" (parl),
"1" (parl), "2" (par2)
)
return retval ue;

}

int result;

voi d func(void)

{
}

result = foo(1000, 1000);

(par2)

In this example the "1" constraint for the input parameter par 1 refers to the output parameter par 1, and
similar for the "2" constraint and par 2. In the inline assembly %4 (par 1) and %2 (par 2) are written. This

is allowed because the compiler is aware of this.

This results in the following generated assembly code:

13
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nmovl r5, #1000
nov r4,r5

SHL r5, #2
ADD ra,r5
MOV r3,rd

mw r3,result

However, when the inline assembly would have been as given below, the compiler would have assumed
that %4 (par 1) and 92 (par 2) were read-only. Because of the i nl i ne keyword the compiler knows that
par 1 and par 2 both contain 1000. Therefore the compiler can optimize and assign the same register to
% and 92. This would have given an unexpected result.

__asm(
" SHL %, #2\n\t"
" ADD %2, %\ n\t"
" MOV %, "
"=&s" (retval ue)
"s" (parl), "s" (par2)
)

Generated assembly code:

movl r5, #1000

SHL r5, #2

ADD r5r5 ; sane register, but is expected read-only
MoV r4,r5

mw r4,result ; contains unexpected result

1.6. Attributes

You can use the keyword __attri bute__ to specify special attributes on declarations of variables,
functions, types, and fields.

Syntax:

__attribute_ ((nane,...))
or:

__hane__

The second syntax allows you to use attributes in header files without being concerned about a possible
macro of the same name. This second syntax is only possible on attributes that do not already start with
an underscore. For example, you may use __noreturn__insteadof __attri bute__((noreturn)).

14
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alias("symbol")

Youcanuse __attribute_ ((alias("synbol"))) to specify that the function declaration appears
in the object file as an alias for another symbol. For example:

void __f() { /* function body */; }
void f() __attribute_ ((weak, alias("__f")));

declares 'f ' to be a weak alias for'__f".

const

Youcanuse __attribute__ ((const)) to specify that a function has no side effects and will not
access global data. This can help the compiler to optimize code. See also attribute pur e.

The following kinds of functions should not be declared __const __:
A function with pointer arguments which examines the data pointed to.

» A function that calls a non-const function.

export

Youcanuse __attribute__((export)) to specify that a variable/function has external linkage and
should not be removed. During MIL linking, the compiler treats external definitions at file scope as if they
were declared st at i c. As a result, unused variables/functions will be eliminated, and the alias checking
algorithm assumes that objects with static storage cannot be referenced from functions outside the current
module. During MIL linking not all uses of a variable/function can be known to the compiler. For example
when a variable is referenced in an assembly file or a (third-party) library. With the export attribute the
compiler will not perform optimizations that affect the unknown code.

int i __attribute__((export)); /* 'i' has external |inkage */

flatten

Youcanuse __attribute__ ((flatten)) toforce inlining of all function calls in a function, including
nested function calls.

Unless inlining is impossible or disabled by __attri bute__((noinline)) for one of the calls, the
generated code for the function will not contain any function calls.

format(type,arg_string_index,arg_check_start)

Youcanuse _attribute_ ((format(type,arg_string_index,arg check_start))) to
specify that functions take pri nt f, scanf,strfti ne or strf nmon style arguments and that calls to
these functions must be type-checked against the corresponding format string specification.

type determines how the format string is interpreted, and should be pri ntf, scanf,strftime or
strfron.

15
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arg_string_index is a constant integral expression that specifies which argument in the declaration of the
user function is the format string argument.

arg_check_start is a constant integral expression that specifies the first argument to check against the
format string. If there are no arguments to check against the format string (that is, diagnostics should only
be performed on the format string syntax and semantics), arg_check_start should have a value of 0. For
strfti me-style formats, arg_check_start must be 0.

Example:
int foo(int i, const char * ny_format, ...) _ attribute__((format(printf, 2,

The format string is the second argument of the function f oo and the arguments to check start with the
third argument.

leaf

Youcanuse __attribute__((Ieaf)) tospecify that a function is a leaf function. A leaf function is
an external function that does not call a function in the current compilation unit, directly or indirectly. The
attribute is intended for library functions to improve dataflow analysis. The attribute has no effect on
functions defined within the current compilation unit.

malloc

Youcanuse __attribute__ ((malloc)) toimprove optimization and error checking by telling the
compiler that:

» The return value of a call to such a function points to a memory location or can be a null pointer.

» On return of such a call (before the return value is assigned to another variable in the caller), the memory
location mentioned above can be referenced only through the function return value; e.g., if the pointer
value is saved into another global variable in the call, the function is not qualified for the malloc attribute.

» The lifetime of the memory location returned by such a function is defined as the period of program
execution between a) the point at which the call returns and b) the point at which the memory pointer
is passed to the corresponding deallocation function. Within the lifetime of the memory object, no other
calls to malloc routines should return the address of the same object or any address pointing into that
object.

noinline

Youcanuse __attribute__((noinline)) topreventa function from being considered for inlining.
Same as keyword __noi nl i ne or #pragnma noi nl i ne.

always_inline
With __attribute__((al ways_inline)) you force the compiler to inline the specified function,

regardless of the optimization strategy of the compiler itself. Same as keyword i nl i ne or #pr agnma
inline.

16
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noreturn

Some standard C function, such as abort and exit cannot return. The C compiler knows this automatically.
Youcanuse __attribute__((noreturn)) to tell the compiler that a function never returns. For
example:

void fatal () __attribute__((noreturn));
void fatal ( /* ... */ )

[* Print error nessage */
exit(1);
}

The function f at al cannot return. The compiler can optimize without regard to what would happen if
fat al everdid return. This can produce slightly better code and it helps to avoid warnings of uninitialized
variables.

protect

Youcanuse _attribute__ ((protect)) toexclude avariable/function from the duplicate/unreferenced
section removal optimization in the linker. When you use this attribute, the compiler will add the "protect"”
section attribute to the symbol's section. Example:

int i __attribute__((protect));

Note that the protect attribute will not prevent the compiler from removing an unused variable/function
(see the used symbol attribute).

pure
Youcanuse __attribute__ ((pure)) tospecify that a function has no side effects, although it may

read global data. Such pure functions can be subject to common subexpression elimination and loop
optimization. See also attribute const .

section("section_name")

Youcanuse __attribute__((section("name"))) to specify that a function must appear in the
object file in a particular section. For example:

extern void foobar(void) __attribute__((section("bar")));
puts the function f oobar in the section named bar .

See also #pragna secti on.

used

Youcanuse __attribute__ ((used)) toprevent an unused symbol from being removed, by both the
compiler and the linker. Example:

17



TASKING VX-toolset for MCS User Guide
static const char copyright[] __attribute__((used)) = "Copyright 2019 TASKI NG BV";

When there is no C code referring to the copyr i ght variable, the compiler will normally remove it. The
__attribute__((used)) symbol attribute prevents this. Because the linker should also not remove
this symbol, __attribute__ ((used)) implies__attribute__((protect)).

unused

Youcanuse __attribute__((unused)) to specify that a variable or function is possibly unused. The
compiler will not issue warning messages about unused variables or functions.

weak

Youcanuse__attribute_ ((weak)) to specify that the symbol resulting from the function declaration
or variable must appear in the object file as a weak symbol, rather than a global one. This is primarily
useful when you are writing library functions which can be overwritten in user code without causing
duplicate name errors.

See also #pragma weak.

18
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1.7. Pragmas to Control the Compiler

Pragmas are keywords in the C source that control the behavior of the compiler. Pragmas overrule
compiler options. Put pragmas in your C source where you want them to take effect. Unless stated
otherwise, a pragma is in effect from the point where it is included to the end of the compilation unit or
until another pragma changes its status.

The syntax is:
#pragma [ | abel : ] pragma-spec pragnma-argunents [on | off | default | restore]

or:

_Pragma( "[I| abel :] pragma-spec pragma-argunments [on | off | default | restore]"” )

Some pragmas can accept the following special arguments:

on switch the flag on (same as without argument)
of f switch the flag off

def aul t set the pragma to the initial value

restore restore the previous value of the pragma
Examples:

/1l by default all warnings are shown

#pragnma war ni ng 535 /1 disable W35

#pragnma war ni ng 530 /1 also disable W30

const char var_1 = 0x5678; // W30 is not shown

var_2; /1 W35 is not shown

#pragnma warni ng restore /Il restore one level, only W35 is disabl ed
const char var_3 = 0x56789; // W30 is shown

#pragma war ni ng def aul t /'l back to default, all warnings are shown
var _4; /1 W35 is shown

Label pragmas

Some pragmas support a label prefix of the form "label:" between #pr agma and the pragma name. Such
a label prefix limits the effect of the pragma to the statement following a label with the specified name.
The r est or e argument on a pragma with a label prefix has a special meaning: it removes the most
recent definition of the pragma for that label.

You can see a label pragma as a kind of macro mechanism that inserts a pragma in front of the statement
after the label, and that adds a corresponding #pragma ... rest ore after the statement.

Compared to regular pragmas, label pragmas offer the following advantages:

» The pragma text does not clutter the code, it can be defined anywhere before a function, or even in a
header file. So, the pragma setting and the source code are uncoupled. When you use different header
files, you can experiment with a different set of pragmas without altering the source code.
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» The pragma has an implicit end: the end of the statement (can be a loop) or block. So, no need for
pragma restore / endoptimize etc.

Example:

#pragma | abl:optimze P

volatile int v;

void f( void)

{
int i, a
a = 42;
labl: for( i=1; i<10; i++)
{
/* the entire for loop is part of the pragma optim ze */
a+=i;
}
vV = a;

}
Supported pragmas

The compiler recognizes the following pragmas, other pragmas are ignored. On the command line you

can use cmcs --help=pragmas to get a list of all supported pragmas. Pragmas marked with (*) support
a label prefix.

STDC FP_CONTRACT [on | off | default | restore] (*)

This pragma is defined in ISO C99/C11. With this pragma you can control the +contract flag of C compiler
option --fp-model.

alias symbol=defined_symbol
Define symbol as an alias for defined_symbol. It corresponds to a . ALI AS directive at assembly level.

The symbol should not be defined elsewhere, and defined_symbol should be defined with static storage
duration (not extern or automatic).

boolean [on | off | default | restore] (*)

This pragma is used to mark the macros "false" and "true" from the library header file st dbool . h as
"essentially BOOLEAN", which is a concept from the MISRA C:2012 standard.

extension isuffix [on | off | default | restore] (*)

Enables a language extension to specify imaginary floating-point constants. With this extension, you can
use an "i" suffix on a floating-point constant, to make the type _I nagi nary.

20
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float 0.5i

extern symbol
Normally, when you use the C keyword ext er n, the compiler generates an . EXTERN directive in the

generated assembly source. However, if the compiler does not find any references to the ext er n symbol
in the C module, it optimizes the assembly source by leaving the . EXTERN directive out.

With this pragma you can force an external reference (. EXTERN assembler directive), even when the
symbol is not used in the module.

fp_negzero [on | off | default | restore] (*)

With this pragma you can control the +negzero flag of C compiler option --fp-model.
fp_nonan [on | off | default | restore] (*)

With this pragma you can control the +nonan flag of C compiler option --fp-model.

fp_rewrite [on | off | default | restore] (*¥)

With this pragma you can control the +rewrite flag of C compiler option --fp-model.

inline / noinline / smartinline [default | restore] (*)

See Section 1.9.5, Inlining Functions: inline.

inline_max_incr {value | default | restore} (*)
inline_max_size {value | default | restore} (*)

With these pragmas you can control the automatic function inlining optimization process of the compiler.
It has effect only when you have enable the inlining optimization (C compiler option --optimize=+inline).

See C compiler options --inline-max-incr / --inline-max-size.
macro / nomacro [on | off | default | restore] (*)
Turns macro expansion on or off. By default, macro expansion is enabled.

message "message" ...
Print the message string(s) on standard output.

nomisrac [nr,...] [default | restore] (*)

Without arguments, this pragma disables MISRA C checking. Alternatively, you can specify a
comma-separated list of MISRA C rules to disable.

See C compiler option --misrac and Section 3.6.2, C Code Checking: MISRA C.
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optimize [flags] / endoptimize [default | restore] (*)

You can overrule the C compiler option --optimize for the code between the pragmas opt i mi ze and
endopt i m ze. The pragma works the same as C compiler option --optimize.

See Section 3.5, Compiler Optimizations.

section [type=][format_string][,...] / endsection [default | restore] (*)
Rename sections by adding a format_string to all section nhames specified with .type, or restore default
section naming. If you specify only a format_string (without a type), the suffix is added to all section names.

See Section 1.10, Section Naming, C compiler option --rename-sections and assembler directive . SDECL
for more information.

source / nosource [on | off | default | restore] (*)

With these pragmas you can choose which C source lines must be listed as comments in assembly output.
See C compiler option --source.

stdinc [on | off | default | restore] (*)

This pragma changes the behavior of the #i ncl ude directive. When set, the C compiler options
--include-directory and --no-stdinc are ignored.

tradeoff level [default | restore] (*)

Specify tradeoff between speed (0) and size (4). See C compiler option --tradeoff

unroll_factor value / endunroll_factor [default | restore] (*)

Specify how many times the following loop should be unrolled, if possible. At the end of the loop use
endunrol | _factor.

See C compiler option --unroll-factor.

warning [number,...] [default | restore] (*)

With this pragma you can disable warning messages. If you do not specify a warning number, all warnings
will be suppressed.

weak symbol

Mark a symbol as "weak" (. WEAK assembler directive). The symbol must have external linkage, which
means a global or external object or function. A static symbol cannot be declared weak.

A weak external reference is resolved by the linker when a global (or weak) definition is found in one of
the object files. However, a weak reference will not cause the extraction of a module from a library to
resolve the reference. When a weak external reference cannot be resolved, the null pointer is substituted.
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A weak definition can be overruled by a normal global definition. The linker will not complain about the
duplicate definition, and ignore the weak definition.

1.8. Predefined Preprocessor Macros

The TASKING C compiler supports the predefined macros as defined in the table below. The macros are
useful to create conditional C code.

Macro Description

__BUILD__ Identifies the build number of the compiler in the format yymmddqq (year,
month, day and quarter in UTC).

__CMCs__ Identifies the compiler. You can use this symbol to flag parts of the source
which must be recognized by the TASKING cmcs compiler only. It expands
to 1.

__CORE_ Expands to a string with the core name depending on the option --core=core.
The dots "." are removed from the core name. For example, if --core=mcs3.0
is specified, the symbol __ CORE___ expands to ntcs30.

_ CORE_core___ A symbol is defined depending on the option --core=core. The core is
converted to uppercase and the dots '." are removed. For example, if
--core=mcs3.0is specified, the symbol __ CORE_MCS30__is defined. When
no --core is supplied, the compiler defines __ CORE_MCS31__.

__ DATE___ Expands to the compilation date: “mmm dd yyyy”.

__DOUBLE_FP__ Expands to 1 if you used option --fp-model=-float, otherwise unrecognized
as macro.

__FILE__ Expands to the current source file name.

_ HAS_FLOAT_BUILTINS__

Expands to 1.

__LINE__

Expands to the line number of the line where this macro is called.

__LITTLE_ENDIAN__

Expands to 1. The processor accesses data in little-endian.

__ MISRAC_VERSION__

Expands to the MISRA C version used 1998, 2004 or 2012 (option
--misrac-version). The default is 2004.

_ PROF_ENABLE__

Expands to 1 if profiling is enabled, otherwise expands to 0.

__REVISION__

Expands to the revision number of the compiler. Digits are represented as
they are; characters (for prototypes, alphas, betas) are represented by -1.
Examples: v1.0r1 -> 1, v1.0rb -> -1

__ SFRFILE__(cpu)

If control program option --cpu=cpu is specified, this macro expands to the
filename of the used SFR file, including the pathname and the < >. The cpu
is the argument of the macro. For example, if --cpu=gtm31_01 is specified,
the macro __ SFRFILE__(__CPU__) expands to

_ SFRFILE__(gtnB1_01),whichexpandsto<sfr/reggtnBl_01.sfr>.

__SINGLE_FP__

Expands to 1 if you used option --fp-model=+float (Treat ‘double’ as ‘float’),
otherwise unrecognized as macro.
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Macro

Description

__STDC__

Identifies the level of ANSI standard. The macro expands to 1 if you set
option --language (Control language extensions), otherwise expands to 0.

_ STDC_HOSTED__

Always expands to 0, indicating the implementation is not a hosted
implementation.

__STDC_NO_ATOMICS__

(C11 only) Expands to 1 to indicate that this implementation does not support
atomic types and the st dat omi c. h header file.

__STDC_NO_THREADS__

(C11 only) Expands to 1 to indicate that this implementation does not support
the t hr eads. h header file.

__STDC_VERSION__

Identifies the 1SO-C version number. Expands to 201112L for ISO C11,
199901L for ISO C99 or 199409L for ISO C90.

_ TASKING__ Identifies the compiler as a TASKING compiler. Expands to 1 if a TASKING
compiler is used.

__TIME__ Expands to the compilation time: “hh:mm:ss”

__VERSION__ Identifies the version number of the compiler. For example, if you use version
2.1r1 of the compiler, _ VERSION__ expands to 2001 (dot and revision
number are omitted, minor version number in 3 digits).

_ VX Identifies the VX-toolset C compiler. Expands to 1.

Example

#ifdef _ CORE_MCS31__

/* this part is only

#endi f

24

conpiled for core ncs3.1 */




C Language

1.9. Functions

1.9.1. Calling Convention

Parameter passing

A lot of execution time of an application is spent transferring parameters between functions. The fastest
parameter transport is via registers. Therefore, function parameters are first passed via registers. If no
more registers are available for a parameter, the compiler pushes parameters on the stack.

Registers available for parameter passing are r2, r3, r4 and r5. The parameters are loaded sequentially
into the parameter registers. For each parameter the next unused register (pair) is selected. If fewer (or
no) registers are needed, the unneeded registers are not loaded and will contain undefined values on
entry to the called function. Up to four arithmetic types or four pointers can be passed this way.

The following table specifies which registers are used to pass an object of a specific type to a function.

Type Registers used for parameters
_Bool 12, r3, r4 or r5

(unsigned) char

r2,r3,r4 orr5

(unsigned) short

r2,r3,r4orr5

(unsigned) int

r2,r3, r4 orrs

(unsigned) long

r2r3, r3r4 or r4r5

(unsigned) long long

r2r3r4 or r3r4r5

__int72_t r2r3r4 or r3r4r5
__uint72_t r2r3r4 or r3r4r5
float r2r3, r3r4 or r4r5

(long) double

r2r3r4 or r3r4r5

pointer to function / data / ARU / AEI
/ OREG / XOREG / WXREG

r2,r3, r4 orr5

struct / union’ (size 24-hits)

r2,r3,r4orr5

struct / union’ (size 48-bits)

r2r3, r3r4 or r4r5

struct / union’ (size 72-hits)

r2r3r4 or r3r4r5

" Small struct/union types are passed in registers, except when any of the members has the __aei _t

type.

Only when the parameters do not fit in the four registers provided for parameter passing, or when the
object is an aggregate type that cannot be passed in registers, or has the __aei _t type, the caller
allocates stack space for the parameters in its stack frame. It allocates only enough space to hold the
parameters that do not fit into registers. The space that holds the parameters is called the argument
passing area (APA).
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Examples:
void funcl( int i, char * p, char c ); /[* r2r3r4 */
void func2( int i1, double d, int i2); /* r2 r3r4r5 stack */

void func3( char cl1, char c2, char c3[] ); /* r2 r3 r4 */
void func4( double di, int i1, double d2, int i2);
/* r2r3r4 r5 stack stack */

Variable argument lists

Parameters that are passed to a function in the variable argument list are always passed in the argument
passing area (APA), directly after the fixed parameters on the stack, if any.

Function return values

The C compiler uses registers to store C function return values, depending on the function return types.

Return type Return register
_Bool r2
(unsigned) char r2
(unsigned) short r2
(unsigned) int r2
(unsigned) long r2r3
(unsigned) long long r2r3r4
__int72_t r2r3r4
__uint72_t r2r3r4
float r2r3
(long) double r2r3r4
pointer to function / data / ARU / AEI |r2

/ OREG / XOREG / WXREG

struct / union’ (size 24-hits) r2
struct / union’ (size 48-bits) r2r3
struct / union’ (size 72-bits) r2r3r4

" Small struct/union types are returned through registers, except when any of the members has the
__aei _t type.

Return values of an aggregate type that cannot be returned in registers or return values of the __aei _t
type are returned in memory. When stack space is required, the caller allocates enough stack space to
hold the return value and passes a pointer to the return value memory area to the called function in its
first parameter register (r2). The called function stores the value to be returned at the memory location
designated by the pointer in r2, and returns r2 again to the caller. The parameter allocation then continues
as usual, with r2 being occupied. After the called function returns, the caller releases the stack space for
the return value when necessary.
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The C compiler uses the registers according to the convention given in the following table.

Register |Class Purpose

ro callee saves local variables

rl callee saves local variables

r2..r3 caller saves parameter passing and return values

rd4 caller saves parameter passing and return values and used for mul u/mul s instructions
and for the remainder result of di vu and di vs instructions

r5 caller saves parameter passing and used for nt di o/mar i 0 instructions

ré callee saves used for j mpi /j bsi /j bei /cal | i /ar di fawr i /nar di AMur nx/wur cx
instructions and local variables

r7 dedicated stack pointer

rsO ..rs3 caller saves [optional, not EABI compliant] local variables

rs4 ..rs7 callee saves [optional, not EABI compliant] local variables

mhb scratch intrinsic functions and the __aei _t type.

ach scratch intrinsic functions.

The registers are classified as follows:

caller saves

callee saves

dedicated

scratch

1.9.3. Stack Usage

These registers are allowed to be changed by a function without saving the contents.
Therefore, the calling function must save these registers when necessary prior to a

function call.

These registers belong to the calling function. These registers must be saved and
restored by the called function, i.e. the caller expects them not to be changed after the

function call.

The dedicated registers have a specific purpose throughout the entire application and
are always valid.

The scratch registers are never preserved.

The stack is used for parameter passing and return values and for the allocation of automatic and temporary
storage. The stack grows from lower addresses to higher addresses. The stack pointer (r7) points to the
highest occupied word of the most recently allocated stack frame. The stack pointer alignment is 32-bit.
The following figure outlines a stack frame.
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The return address area is used to store the return address of a function call. The register save area is
used to store the callee-saves registers when necessary. The local variables area is used to store local
variables, function return values and spilled registers. The argument passing area is only used to pass
stack parameters to the called functions. After control has been passed to the called function, this area
is called the parameter area.

1.9.4. Variable Length Arrays

Variable length arrays (VLAS) are allocated on the heap using the mal | oc() and f r ee() function calls
from the C library.

1.9.5. Inlining Functions: inline

With the C compiler option --optimize=+inline, the C compiler automatically inlines small functions in
order to reduce execution time (smart inlining). The compiler inserts the function body at the place the
function is called. The C compiler decides which functions will be inlined. You can overrule this behavior
with the two keywords i nl i ne (ISO-C) and __noi nl i ne.

With the i nl i ne keyword you force the compiler to inline the specified function, regardless of the
optimization strategy of the compiler itself:

inline unsigned int abs(int val)

{

val ;
-val ;

unsi gned int abs_val
if (val < 0) abs_val
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return abs_val;
}

If a function with the keyword i nl i ne is not called at all, the compiler does not generate code for it.

You must define inline functions in the same source module as in which you call the function, because
the compiler only inlines a function in the module that contains the function definition. When you need to
call the inline function from several source modules, you must include the definition of the inline function
in each module (for example using a header file).

With the __noi nl i ne keyword, you prevent a function from being inlined:

__noinline unsigned int abs(int val)

{
unsi gned int abs_val = val;
if (val < 0) abs_val = -val;
return abs_val;

}

Using pragmas: inline, noinline, smartinline

Instead of the i nl i ne qualifier, you can also use #pr agma i nl i ne and #pr agnma noi nl i ne to inline
a function body:

#pragma inline
unsi gned int abs(int val)

{
unsi gned int abs_val = val;
if (val < 0) abs_val = -val;
return abs_val;

}

#pragma noi nline
void main( void )
{ . .

int i;

i = abs(-1);
}

If a function has ani nl i ne/__noi nl i ne function qualifier, then this qualifier will overrule the current
pragma setting.

With the #pr agma noi nl i ne /#pragma smarti nl i ne you can temporarily disable the default behavior
that the C compiler automatically inlines small functions when you turn on the C compiler option
--optimize=+inline.

With the C compiler options --inline-max-incr and --inline-max-size you have more control over the
automatic function inlining process of the compiler.
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1.9.6. Channel Functions

To support the channels of an MCS, the TASKING C compiler for MCS supports an attribute and a function
qualifier.

Defining a channel function: channel() attribute

With the function attribute __attri bute__((channel (channel ))) or with the function type qualifier
__channel (channel ) you can declare a function as a channel function.

voi d channel _x( void ) __attribute__((channel ([channel])))

{

or:

void _ _channel ([ channel]) channel _x( void )
{
}

A function qualified with this attribute is called at program startup and serves as the entry point of the
code executed by the specified channel. The argument channel is an integral number in the range 0..7
and is bound to the corresponding MCS channel. A channel can have only one entry point. For each
channel function an unconditional jump to the function is inserted at the corresponding entry in the channel
vector table (register MCSJi]_CHI[x]_PC). Furthermore the stack pointer is initialized, unless the function
does not use a stack. For example,

voi d channel _1( void ) __attribute__((channel (1)));

void channel _1( void ) /* inherit channel () attribute from prototype */

{
}

When the channel function returns the channel is disabled by clearing the EN flag in the STA register. A
channel function does not save, nor restore any registers in its function prologue/epilogue.

return;

The following rules apply:

» Only one channel function can be bound to a specific channel.

» Channel functions cannot return anything and must have a void argument type list.
* Itis not possible to call a channel function directly from an application.

The C compiler will bind the channel function to the appropriate vector. For example:

.gl obal _vector_1
_vector_1 .equ channel _1
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Function mai n() is called from the startup code and is executed by channel 0 by default. However, you
can execute mai n() from an arbitrary channel by specifying the macro GTM_MCScor e_MAI N_CHANNEL
to the linker for the specified MCS core. See Section 5.7.3, Preprocessor Macros in the Linker Script Files
for more information. Function mai n() should not be qualified with the channel () attribute. If function
mai n() returns then function exi t () is called. The exi t () function does not disable the channel but
will loop forever.

Each function qualified with the channel () attribute initializes a private stack. The heap is shared
between channels.

The __csr pointer qualifier

When you need to create a pointer to a channel function, it is advised to qualify the pointer with the __csr
pointer qualifier. This prevents that a channel function is accidentally called directly from an application
through a function pointer. When you omit the __csr pointer qualifier, the C compiler issues a warning.
You can avoid this warning with an explicit type cast. The function attribute
__attribute__((channel (channel))) automatically assigns the __csr pointer qualifier. When
you use the __csr pointer qualifier without the channel () function attribute, the MCS C compiler binds
the function to channel O by adding __attri bute__((channel (0))).Examples:

extern void chn( void ) __attribute__((channel (1)));
extern void f( void );

voi d (*fp_a)( void);
voi d (*fp_b)( void);
voi d (*fp_c)( void);

void __csr (*fp_chn_a)( void );
void __csr (*fp_chn_b)( void );

int main( void)

{
fp_a = f; /* ok, non-channel function, non-channel pointer */
fp_chn_a = chn; /* ok, channel function, channel pointer */
fp_b = chn; /* warni ng, channel function, non-channel pointer */
fp_chn_b = f; /* ok, non-channel function, channel pointer */
fp_c = fp_chn_a; /* warning, channel pointer assigned to

non- channel pointer */

chn(); /* error, cannot call a channel function */
(*fp_chn_a)(); /* error, cannot call a channel function */
return O

}

1.9.7. Intrinsic Functions
Some specific assembly instructions have no equivalence in C. Intrinsic functions give the possibility to

use these instructions. Intrinsic functions are predefined functions that are recognized by the compiler.
The compiler generates the most efficient assembly code for these functions.
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The compiler always inlines the corresponding assembly instructions in the assembly source (rather than
calling it as a function). This avoids parameter passing and register saving instructions which are normally
necessary during function calls.

Intrinsic functions produce very efficient assembly code. Though it is possible to inline assembly code by
hand, intrinsic functions use registers even more efficiently. At the same time your C source remains very
readable.

You can use intrinsic functions in C as if they were ordinary C (library) functions. All intrinsics begin with
a double underscore character (__).

Some intrinsic functions are available in two variants, with or without __nts_, with similar semantics but
different prototypes. You can choose which one fits best for your implementation.

1.9.7.1. Intrinsic Functions Used Internally by the C Compiler

Allocate a Variable Length Array
void * volatile __alloc( __size_t size);

Allocate memory. Returns a pointer to space of si ze bytes on the heap. Memory allocated through this
function is freed when the calling function returns. This function is used internally for variable length arrays,
it is not to be used by end users.

Free a Variable Length Array
void volatile _ free( void * ptr );

Deallocate the memory pointed to by pt r. pt r must point to memory earlier allocated by a call to
__alloc().

Variable argument lists
char * _ dotdotdot__( void );

Variable argument '..." operator. Used in library function va_st art () . Returns a pointer to the start of
the variable argument list on the stack.

1.9.7.2. ARU Transfer
Built-in type __aru_t

typedef struct {
unsi gned int ach;
unsigned int data_l;
unsigned int data_h;
} _aru_t;

__aru_t is used by the intrinsic functions that provide access to the following MCS operations: ARD,
AWR, ARDI, AWRI, NARD, NARDI, that update the registers: ACB, STA.CAT and STA.SAT.
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Blocking ARU read access

_aru_t _ _ard( const __aru __aru_t * address, unsigned int * sta );
_aru_t __ard_I( const __aru __aru_t * address, unsigned int * sta );
_aru_t __ard_h( const __aru __aru_t * address, unsigned int * sta );

This function returns the two 24-bit values from the ARDJI] instruction in the dat a_h and dat a_| fields
of the return value, and the ARU control bits in the acb field of the return value. If the execution was not
successful the return value is undefined.

The behaviorof __ard_| () and __ard_h() is analogous to the behavior of __ar d() , with the exception
that the high 24-bit value is not transferred by __ar d_I (), therefore the value in the dat a_h field of the
return value is undefined. Similarly, for __ar d_h() the value of dat a_| is undefined.

For example:

#include _ SFRFILE_ (gtnB81_01)

void test_ard( void )

{

unsi gned int sta;

__aru_t ar u;

aru = __ard( & TIMD_WRADDR(0), & sta );
}

This results in the following assembly:

addl r7,#4
ard r5,réd, #1
mwi sta,r7
subl r7,#4

Blocking ARU read access (__mcs_ variant)

void __nts_ard( unsigned int address, unsigned int * plword,
unsigned int * phword);

Perform a blocking read access to the ARU, write the 24-bit high word received at the ARU port to the
address specified by phwor d and write the 24-bit low word received at the ARU port to the address
specified by pl wor d. If one of these values is not required, the corresponding pointer may be NULL and
the value is not written.

You can access the resulting ARU control bits afterwards with __nts_get _ACB(), and you can access
the resulting CAT and SAT flags of the register STA afterwards with __nts_get _STA() . The transfer
was successful if SAT=1. If the transfer failed, the data specified by pl wor d/phwor d is undefined.

This function returns nothing.

Blocking ARU write access

unsigned int __aw ( unsigned int index, __aru_t value );
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Perform a blocking write access to the ARU and transfer two 24-bit values and the ARU control bits stored
in val ue to the ARU port. The value of i ndex mustbe 0 <= i ndex <= 23.Ifi ndex is outside this
range, the behavior is undefined.

This function generates the AWR instruction and returns the contents of the status register STA.

Blocking ARU write access (__mcs_ variant)

void __ncs_aw ( unsigned int index , unsigned int |word,
unsigned int hword );

Perform a blocking write access to the ARU and transfer the | wor d/hwor d values to the ARU port. The
value of i ndex mustbe 0 <= i ndex <= 23.Ifi ndex is outside this range, the behavior is undefined.

You can write to the ARU control bits with __nts_set _ACB() . The CAT and SAT flags of the STA
register are updated and you can access them afterwards with __ncs_get _STA() . The transfer was
successful if SAT=1.

This function returns nothing.

Non-blocking ARU read access

_aru_t __nard( <const __aru __aru_t * address, unsigned int * sta );
_aru_t __nard_I( const __aru __aru_t * address, unsigned int * sta );
_aru_t __nard_h( const __aru __aru_t * address, unsigned int * sta );

This function returns the two 24-bit values from the NARD]JI] instruction in the dat a_h and dat a_| fields
of the return value, and the ARU control bits in the acb field of the return value. If the execution was not
successful the return value is undefined.

The behavior of __nard_I () and __nard_h() is analogous to the behavior of __nar d() , with the
exception that the high 24-bit value is not transferred by __nard_| (), therefore the value in the dat a_h
field of the return value is undefined. Similarly, for __nard_h() the value of dat a_| is undefined.

For example:

#include __SFRFILE_ (gtn81_01)

void test_nard( void )

{

unsi gned int sta;

_aru_t aru;

aru = _ nard( & TIM_WRADDR(0), & sta );
}

This results in the following assembly:

addl r7,#4
nard r5,r4, #1
mwi sta,r7
subl r7,#4
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Non-blocking ARU read access (__mcs_ variant)

void __nts_nard( unsigned int address, unsigned int * plword,
unsi gned int * phword);

Perform a non-blocking read access to the ARU, write the 24-bit high word received at the ARU port to
the address specified by phwor d and write the 24-bit low word received at the ARU port to the address
specified by pl wor d. If one of these values is not required, the corresponding pointer may be NULL and
the value is not written.

You can access the resulting ARU control bits afterwards with __nts_get _ACB(), and you can access
the resulting CAT and SAT flags of the register STA afterwards with __nts_get _STA() . The transfer
was successful if SAT=L1. If the transfer failed, the data specified by pl wor d/phwor d is undefined.

This function returns nothing.
1.9.7.3. Bus Master Addressing

Read access at bus master interface
_aei_t _ _brd( const volatile __aei __aei_t * address );
Initiate a read access at the bus master interface using the specified addr ess.

This function generates the BRD instruction and returns the 32-bit value that is read from the bus master
interface.

For example:

#include __ SFRFILE_(gtnB1_01)

unsigned int return_brd( void )

{
}

This results in the following assembly:

return (unsigned int)__brd( & TIMCH2_GPRO );

return_brd: .type func
brd r2,256
ret

Read access at bus master interface (__mcs_ variant)
__nts_aei _t __nts_brd( unsigned int address );
Initiate a read access at the bus master interface using the specified addr ess.

This function generates the BRD instruction and returns the 32-bit value that is read from the bus master
interface.
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Write access at bus master interface
void __bw( volatile __aei __aei_t * address, __aei_t value );

Initiate a write access at the bus master interface using the specified addr ess and transfer a 32-bit
val ue to the bus.

This function generates the BWR instruction and returns nothing.
For example:

#include __SFRFILE_(gtnB81_01)

void test_bw ( void)

{
__bw( & TIMCH2_CGPRO, 5 );
}
This results in the following assembly:
movl r5,#5
nmovl  mhb, #0
bwr r5, 256

Write access at bus master interface (__mcs_ variant)
void _ _ncs_bw( unsigned int address, __nts_aei_t value );

Initiate a write access at the bus master interface using the specified addr ess and transfer a 32-bit
val ue to the bus.

This function generates the BWR instruction and returns nothing.
1.9.7.4. Suspending Wait Instructions

Wait until extended register match

unsigned int _ wurnx( volatile __wxreg unsigned int * sfr,
unsi gned int val ue, unsigned int mask);

Suspend the current MCS channel until the value of the expression sfr_val ue & mask == val ue
evaluates to t r ue, where sfr _val ue is the current value of the SFR register identified by sf r . If mask
is a compile-time constant that fits into 16 bits, only the lower 16 bits are used.

This function generates the WURMX or WURM instruction and returns the value of the status register
STA.

For example:

__wurnx( & STRG 0x8, 0x8 );
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Wait until extended register match (__mcs_ variant)
void __nmcs_wurmx(unsigned int sfr, unsigned int value, unsigned int mask);

Suspend the current MCS channel until the value of the expression sfr_val ue & mask == val ue
evaluates to t r ue, where sfr _val ue is the current value of the SFR register identified by sfr .

sf r must be a compile-time constant, equal to the address offset of the corresponding SFR. val ue and
mask can be constant or variables. If mask is a compile-time constant that fits into 16 bits, only the lower
16 bits are used.

This function changes the value of register STA, which you can read afterwards with __nts_get _STA() .
If the execution was successful CWT=0, otherwise the operation was canceled by the CPU.

This function returns nothing.

For example:

#define MCS_STRG (0x0b)

_ ncs_wurnk( MCS_STRG 0x8, 0x8 );

If you want to use the predefined SFR names, you need to cast the SFR to an unsi gned i nt and use
a pointer dereference:

#include _ SFRFILE_(gtnB1_01) // include sfr/reggtnBl_01.sfr

__mcs_wurnmx( (unsigned int) & STRG 0x8, 0x8 );
Wait until extended register change

unsigned int _ wurcx( volatile __wxreg unsigned int * sfr,
unsi gned int value, unsigned int mask);

Suspend the current MCS channel until the value of the expression sfr_val ue & mask != val ue
evaluates to t r ue, where sfr _val ue is the current value of the SFR register identified by sfr.The
lower 16 bits of mask are used.

This function generates the WURCX instruction and returns the value of the status register STA.
For example:

unsi gned int a;

/1 wait until DPLL trigger status STA T (bits 0 to 7 of DSTA) changes
a = DSTA & OxF; // get actual state
_wurcx( & DSTA, a, OxF ); // wait until state changes

Wait until extended register change (__mcs_ variant)

void _ ncs_wurcx( unsigned int sfr, unsigned int value, unsigned int nask);
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Suspend the current MCS channel until the value of the expression sfr_val ue & mask != val ue
evaluates to t r ue, where sfr_val ue is the current value of the SFR register identified by sfr.

sf r must be a compile-time constant, equal to the address offset of the corresponding SFR. val ue and
mask can be constant or variables.

This function changes the value of register STA, which you can read afterwards with __nts_get _STA() .
If the execution was successful CWT=0, otherwise the operation was canceled by the CPU.

This function returns nothing.
For example:

#define MCS_DSTA (0x1a)
unsi gned int a;

/1 wait until DPLL trigger status STA T (bits 0 to 7 of DSTA) changes
a = _ ncs_get DSTA() & OxF; /1 get actual state
__ncs_wurcx( MCS_DSTA, a, OxF ); // wait until state changes

Built-in type __wuce_dir_t

t ypedef enum

{
__WUCE_FWD,
__WJCE_BWD
} __wuce_dir_t;
The __wuce_dir _t typeis used by the __wuce() intrinsic and specifies the counting direction.
Wait until cyclic event

unsigned int _ wuce( volatile __oreg unsigned int * sfr,
unsigned int value, _ wice_dir_t direction);

Suspend the current MCS channel until a cyclic event compare matches.
The sf r argument must be one of the time base registers TBU_TS0, TBU_TS1, or TBU_TS2.

The val ue is the compare value and must not be larger than (forward) or smaller than (backward) half
of the range of the total time base value (0x7FFFFF).

The di r ect i on specifies the counting direction of the time base register specified by TBU_TSx.

You can use the __wuce() intrinsic to synchronize an MCS program to a cyclic event generated by a
TBU channel. If the event is in the future, the MCS channel suspends until the event occurs. If the event
is in the past, the WUCE instruction is finished immediately.

This function generates the WUCE instruction and returns the value of the status register STA.
For example:

__wuce( & TBU TSO, 0x187, _ WUCE FWD ); // wait until state changes
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Wait until cyclic event (__mcs_ variant)
void __ncs_wuce( unsigned int sfr, unsigned int value, _Bool direction );
Suspend the current MCS channel until a cyclic event compare matches.

The sf r argument must be one of the time base registers TBU_TS0, TBU_TS1, or TBU_TS2 (equal to
the address offset of the corresponding SFR).

The val ue is the compare value and must not be larger than (forward) or smaller than (backward) half
of the range of the total time base value (0x7FFFFF), otherwise the behavior is undefined.

The di r ect i on specifies the counting direction of the time base register specified by TBU_TSx:
di recti on=0 (false) assumes forward counting, di r ect i on=1 (true) assumes backward counting.

You can use the __nts_wuce() intrinsic to synchronize an MCS program to a cyclic event generated
by a TBU channel. If the event is in the future, the MCS channel suspends until the event occurs. If the
event is in the past, __nts_wuce() execution finishes immediately.

This function changes the value of register STA, which you can read afterwards with __nts_get _STA() .
If the execution was successful CWT=0, otherwise the operation was canceled by the CPU.

This function returns nothing.
For example:

#define MCS TBU TSO (0x0c) // read-only
#define MCS TBU TS1 (0x0d) // read-only
#define MCS TBU TS2 (0x0e) // read-only

/1l wait for TBU TSO val ue 0x187 (forward direction)
__ncs_wuce( MCS TBU TS0, 0x187, 0 ); // wait until state changes

/1l wait for TBU TS1 val ue 0x17 (backward direction)
__ncs_wuce( MCS TBU TS1, 0x17, 1 ); // wait until state changes

1.9.7.5. SFR Direct Access

Several __nts_ variant intrinsics are available to access SFR registers. Note that you can also access
SFR registers directly by means of defines, see Section 1.2, Special Function Registers for more
information.

SFR get functions

unsigned int _ _nts_get_ STA(void);
unsigned int __nts_get ACB(void);
unsigned int _ ncs_get _CTRE voi d);
unsigned int _ ncs_get_STRE voi d);
unsigned int _ _ncs_get_MHB(void);
unsigned int _ nts_get _TBU TSO0(void);
unsigned int _ ncs_get _TBU TS1(void);
i

unsigned int _ _nts_get _TBU TS2(void);
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unsigned int _ ncs_get _GM 0(void);

unsigned int _ ncs_get _GM 1(void);

unsigned int _ ncs_get DSTA(void);

unsigned int _ ncs_get DSTAX(void);

These functions return the current value of the corresponding SFR.
SFR set functions

void _ nts_set_STA(unsigned int data);
void _ nts_set_ ACB(unsigned int data);
void _ nts_set CTRG unsigned int data);
void _ nts_set_ STRG unsigned int data);
void _ nts_set_MB(unsigned int data);
void _ nts_set_GM O(unsigned int data);
void _ nts_set_GM 1(unsigned int data);
void _ nts_set DSTA(unsigned int data);
void _ nts_set_ DSTAX(unsigned int data);

These functions write dat a into the corresponding SFR. TBU_TS0, TBU_TS1 and TBU_TS2 do not have
set functions because those are read-only registers.

These functions return nothing.
1.9.7.6. Floating-Point

Extract sign bit from floating-point value

_Bool __signbit( double d );
_Bool __signbitf( float f );

Generate code to extract the sign bit from a floating-point value.
This function returns the sign bit of the floating-point argument.
Extract exponent from floating-point value

unsigned int __exp( double d );
unsigned int __expf( float f );

Generate code to extract the exponent from a floating-point value.
This function returns the exponent of the floating-point argument.
Extract mantissa from floating-point value

_uint72_t _ mant( double d );
unsigned int _ mantf( float f );

Generate code to extract the mantissa from a floating-point value.

This function returns the mantissa of the floating-point argument.
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Extract exponent and mantissa from floating-point value

_uint72_t _ _expmant( double d );
unsigned long __expmantf( float f );

Generate code to extract the exponent and mantissa from a floating-point value. The exponent is the
most significant part of the returned value. Due to the special layout of float values on the MCS, the
__expmant f () function leaves a gap of 1 bit between the exponent and the mantissa. In this bit the sign
bit of the single precision floating-point value is stored. For double values the normal layout is used. The
sign bit, either in the special or normal place, is always cleared.

This function returns the exponent and mantissa of the floating-point argument.
Construct floating-point value from sign, exponent and mantissa

doubl e __pack( _Bool sign, unsigned int exp, __uint72_t mant );
float __packf( _Bool sign, unsigned int exp, unsigned int nant );

Construct a floating-point value from the components sign, exponent and mantissa.

This function returns the constructed floating-point value.

Set exponent of floating-point value

doubl e __set_exp( double d, unsigned int exp );
float _ set_expf( float f, unsigned int exp );

Set the exponent of a floating-point value. The biased representation is used, where the value 1 represents
the minimum possible exponent value.

This function returns the updated floating-point value.
Set sign of floating-point value

doubl e __set_sign( double d, _Bool sign );
float __set_signf( float f, _Bool sign);

Set the sign of floating-point value.

This function returns the updated floating-point value.

Copy sign of floating-point value

doubl e _ copysi gn( doubl e dst, double src );

float _ copysignf( float dst, float src );
Copy the sign of a source floating-point value to a destination floating-point value.

This function returns the updated floating-point value.
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Create infinity value

double __inf( void );
float __inff( void );

Create a floating-point infinity value.
This function returns the floating-point infinity value.
Create NaN value

double _nan( void );
float _ nanf( void );

Create a floating-point NaN value.

This function returns the floating-point NaN value.
1.9.7.7. Miscellaneous

Execute the NOP Instruction
void __nop( void );

or

void _ ncs_nop( void );
Execute the NOP instruction.
This function returns nothing.
Disable current channel
void __halt( void);
Disable the current channel.

This function returns nothing.

1.10. Section Naming

By default the compiler generates section names that start with a dot ('.") and a section name prefix,
extended with the module name and the name of the symbol that is allocated in the section. Each
component is separated by a dot ('."):

. prefix. nodul e- nane. synbol - name

You can rename sections with a pragma or with a command line option. The syntax is the same:
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--renanme-sections=[[prefix=|all=][format_string]],...

#pragma section [[prefix=|all=][format_string]],...

With the prefix argument you select which sections are renamed. When the prefix of a section matches,
the section name will get the specified format_string as suffix.

You can specify the following section name prefixes:

Section prefix Description Implicit section type
mcstext program code CODE

mcsdata initialized data DATA

mcsbss uninitialized data (cleared) DATA

When you omit the section prefix or use "all", all sections will be renamed.

With the format_string you specify the string that extends the ELF section name. The format string can
contain characters and may contain the following format specifiers:

{attrib} Expands to the section attributes, separated by underscores. The cluster attribute,
used when debug information is enabled, is not included.

{ nodul e} Expands to the basename of the module name.

{nane} Expands to the object name, name of variable or function.

In format specifier expansions (for example, a module name with an extra dot), dots ('.") are replaced by
dollars ('$").

When you omit the format string, a section will have a name that consist of a dot ('.") and the section prefix
only.

Note that #pr agna secti on ntstext =code, , ntsdat a=speci al will give all sections a name
consisting of just the section prefix, except for mcsdata sections, which will be named

". mcsdat a. speci al ".The reason for this is that the double comma is interpreted as: --rename-sections
or #pragma sect i on, without arguments:

#pragma section ntstext=code, , ncsdat a=speci al
is the same as:

#pragma section ntstext=code
#pragma section
#pragma secti on ntsdat a=speci al

With #pr agma endsect i on the naming convention of the previous level is restored, while with #pr agnma

section defaul t the default section naming convention is restored. Nesting of pragma
section/endsection pairs will save the status of the previous level.
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Example

The following example (file t est . c¢) sets a default naming scheme for all sections, and then specializes
the names for some sections.

#pragma section all=other.{nane}, ntsbss=regi onl. { nane}
#pragma section ntstext=taskl.{nane}

int varl; /* .ntsbss.regionl.varl */

#pragma section ntsbss={nodul e}
/* assign nodul e nane to .ntsbss sections */

int var2; /* .ncsbss. test */
void f1( void ) /* .nmcstext.taskl.f1 */
{

return;
}
void f2( void ) /* .mcstext.taskl.f2 */
{

return;
}

#pragma endsection /* pop |ast #pragma section fromstack */

int var3; /* .ntsbss.regionl.var3 */
const int ¢ = 3; /* .ntsdata.other.c */
int s1 = 5; /* .ntsdata. other.sl */

This example generates the following code:

. sdecl ".ncstext.taskl. f1'
. sect ".ncstext.taskl. f1'
.global f1
; Function f1
.align 4
f1: .type func
ret
; End of function
. Si ze f1,*-f1
;. End of section

. sdecl ".ncstext.taskl. f2'
. sect ".ncstext.taskl. f2'
.global f2

; Function f2
.align 4

f2: .type func
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var 1:

var 2:

var 3

sl:

ret

; End of
. Size

; End of

. sdecl

. sect

. gl oba
.align

. Size
.type

. Space
End of

. sdecl

. sect

. gl oba
.align

. Size
.type

. Space
End of

. sdecl

. sect

. gl oba
.align

. Size
.type

. Space
End of

. sdecl

. sect

. gl oba
.align

. Size
.type
.wor d
End of

. sdecl

. sect

. gl oba
.align

. Size
.type
.wor d

; End of

function
f2,*-f2
section

' . nctsbss.
' . nctsbss.

varl

4

varl, 4
obj ect
1
section

' . nctsbss.
' . nctsbhss.

var 2

4

var2, 4
obj ect
1
section

' . nctsbss.
' . nctsbhss.

var 3

4

var3, 4
obj ect
1
section

regionl.varl'
regionl.varl'

test’
test’

regi onl. var3'
regionl.var3'

' . nctsdat a. ot her.c'
' . nctsdat a. ot her.c'

Wo o hM~O

section

' . nctsdat a. ot her.s1'
' . nctsdat a. ot her.s1'

sl

4

sl, 4
obj ect
5
section

C Language
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Chapter 2. Assembly Language

This chapter describes the most important aspects of the TASKING assembly language for the Multi
Channel Sequencer (MCS).

For a complete overview of the MCS v3.0/v3.1 core, refer to the Multi Channel Sequencer (MCS) chapter
in the GTM-IP Generic Timer Module GTM-IP Specification [Robert Bosch GmbH Automotive Electronics
(AB)].

2.1. Assembly Syntax

An assembly program consists of statements. A statement may optionally be followed by a comment.
Any source statement can be extended to more lines by including the line continuation character (\) as
the last character on the line. The length of a source statement (first line and continuation lines) is only
limited by the amount of available memory.

Mnemonics, directives and other keywords are case insensitive. Labels, symbols, directive arguments,
and literal strings are case sensitive.

The syntax of an assembly statement is:

[label[:]] [instruction | directive | macro_call] [;comrent]

label A label is a special symbol which is assigned the value and type of the current
program location counter. A label can consist of letters, digits and underscore
characters (). The first character cannot be a digit. The label can also be a
number. A label which is prefixed by whitespace (spaces or tabs) has to be
followed by a colon (:). The size of an identifier is only limited by the amount of
available memory.

number is a number ranging from 1 to 255. This type of label is called a numeric
label or local label. To refer to a numeric label, you must put an n (next) or p
(previous) immediately after the label. This is required because the same label
number may be used repeatedly.

Examples:
LABL: ; This label is followed by a colon and
; can be prefixed by whitespace
LAB1 ; This label has to start at the beginning
; of aline

1. jnmp 1p ; This is an endless |oop
; using nuneric |abels
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instruction An instruction consists of a mnemonic and zero, one or more operands. It must
not start in the first column.

Operands are described in Section 2.3, Operands of an Assembly Instruction.
The instructions are described in the Target Specification Manual.

The instruction can also be a so-called 'generic instruction’. Generic instructions
are pseudo instructions (no instructions from the instruction set). Depending on
the situation in which a generic instruction is used, the assembler replaces the
generic instruction with appropriate real assembly instruction(s). For a complete
list, see Section 2.11, Generic Instructions.

directive With directives you can control the assembler from within the assembly source.
Except for preprocessing directives, these must not start in the first column.
Directives are described in Section 2.9, Assembler Directives and Controls.

macro_call A call to a previously defined macro. It must not start in the first column. See
Section 2.10, Macro Operations.

comment Comment, preceded by a ; (semicolon).

You can use empty lines or lines with only comments.

Apart from the assembly statements as described above, you can put a so-called ‘control line' in your
assembly source file. These lines start with a $ in the first column and alter the default behavior of the
assembler.

$cont rol

For more information on controls see Section 2.9, Assembler Directives and Controls.

2.2. Assembler Significant Characters

You can use all ASCII characters in the assembly source both in strings and in comments. Also the
extended characters from the 1ISO 8859-1 (Latin-1) set are allowed.

Some characters have a special meaning to the assembler. Special characters associated with expression
evaluation are described in Section 2.6.3, Expression Operators. Other special assembler characters
are:

Character [Description

; Start of a comment

\ Line continuation character or macro operator: argument concatenation
? Macro operator: return decimal value of a symbol

% Macro operator: return hex value of a symbol

N Macro operator: override local label

Macro string delimiter or quoted string . DEFI NE expansion character

String constants delimiter
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Character |Description

@ Start of a built-in assembly function
* Location counter substitution

# Constant number

++ String concatenation operator

[1 Substring delimiter

2.3. Operands of an Assembly Instruction

In an instruction, the mnemonic is followed by zero, one or more operands. An operand has one of the
following types:

Operand Description

symbol A symbolic name as described in Section 2.4, Symbol Names. Symbols can also occur
in expressions.

register Any valid register name or register address as listed in Section 2.5, Registers.

expression Any valid expression as described in Section 2.6, Assembly Expressions.

address A combination of expression, register and symbol.

Addressing modes
The MCS assembly language has several addressing modes. These addressing modes are used for
indirect memory addressing or indirect ARU addressing. For details see the Multi Channel Sequencer

(MCS) chapter in the GTM-IP Generic Timer Module GTM-IP Specification [Robert Bosch GmbH
Automotive Electronics (AE)].

2.4. Symbol Names

User-defined symbols
A user-defined symbol can consist of letters, digits, dots (.) and underscore characters (_). The first
character cannot be a digit. The size of an identifier is only limited by the amount of available memory.

The case of these characters is significant. You can define a symbol by means of a label declaration or
an equate or set directive.

Predefined preprocessor symbols

These symbols start and end with two underscore characters, __symbol__, and you can use them in your
assembly source to create conditional assembly. See Section 2.4.1, Predefined Preprocessor Symbols.
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Labels

Symbols used for memory locations are referred to as labels. It is allowed to use reserved symbols as
labels as long as the label is followed by a colon.

Reserved symbols

Symbol names and other identifiers starting with a period (.) are reserved for the system (for example for
directives or section names). ldentifiers starting with an at sign ('@") are reserved for built-in assembler
functions. Instructions are also reserved. The case of these built-in symbols is insignificant.

Examples
Valid symbol names:

| oop_1
ENTRY
aBc
_aBC

Invalid symbol names:

1 | oop ; starts with a nunber
ri ; reserved register nanme
. DEFI NE ; reserved directive nane

2.4.1. Predefined Preprocessor Symbols

The TASKING assembler knows the predefined symbols as defined in the table below. The symbols are
useful to create conditional assembly.

Symbol Description

__ASMCS__ Identifies the assembler. You can use this symbol to flag parts of the source
which must be recognized by the asmcs assembler only. It expands to 1.

__BUILD__ Identifies the build number of the assembler in the format yymmddqq (year,
month, day and quarter in UTC).

__REVISION__ Expands to the revision number of the assembler. Digits are represented
as they are; characters (for prototypes, alphas, betas) are represented by
-1. Examples: v1.0rl1 -> 1, v1.0rb -> -1

_ _TASKING__ Identifies the assembler as a TASKING assembler. Expands to 1 if a
TASKING assembler is used.
_ _VERSION__ Identifies the version number of the assembler. For example, if you use

version 2.1r1 of the assembler, _ VERSION___ expands to 2001 (dot and
revision number are omitted, minor version number in 3 digits).
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Example

.if @efined(' __ASMCS__')
; this part is only for the asncs assenbl er

endi f
2.5. Registers

Register names

The following register names, either uppercase or lowercase, should not be used for user-defined symbol
names in an assembly language source file:

RO .. R7 (general purpose registers)
STA (status register)

ACB (ARU control bit register)
CTRG (clear trigger bits register)
STRG (set trigger bits register)
TBU_TSO (TBU tinestanp TSO register)
TBU_TS1 (TBU tinestanp TS1 register)
TBU_TS2 (TBU tinestanp TS2 register)
MHB (menmory high byte register)

The extended register set is the same set of registers as above, plus:

RSO .. RS7 (mirror of general purpose registers RO .. R7)

DSTA (DPLL status register)

DSTAX (DPLL extended status register)
GM 0 (GTM Modul e Interrupt O register)
GM 1 (GTM Modul e Interrupt 1 register)

The extended register set is disabled by default. Note that the extended registers use the next MCS
channel. You can enable the extended register set with assembler option --extended-registers.

Register addresses

Instead of register names, the assembler also accepts register addresses in instructions. This is mainly
for internal use by the compiler. It is not recommended to use this syntax in handwritten assembly, because
it has a negative effect on the readability of the source.

For example, the following instruction:
mov sta, rl

Can also be written as:

mov 8, r1l
nmov sta, 1
mov 8, 1
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All these instructions are identical. You can find the register addresses as "Address Offset" in the register
descriptions in the GTM-IP Generic Timer Module GTM-IP Specification [Robert Bosch GmbH Automotive
Electronics (AE)].

2.6. Assembly Expressions

An expression is a combination of symbols, constants, operators, and parentheses which represent a
value that is used as an operand of an assembler instruction (or directive).

Expressions can contain user-defined labels (and their associated integer or floating-point values), and
any combination of integers, floating-point numbers, or ASCII literal strings.

Expressions follow the conventional rules of algebra and boolean arithmetic.

Expressions that can be evaluated at assembly time are called absolute expressions. Expressions where
the result is unknown until all sections have been combined and located, are called relocatable or relative
expressions.

When any operand of an expression is relocatable, the entire expression is relocatable. Relocatable
expressions are emitted in the object file and evaluated by the linker. Relocatable expressions can only
contain integral functions; floating-point functions and numbers are not supported by the ELF/DWARF
object format.

The assembler evaluates expressions with 64-bit precision in two's complement.
The syntax of an expression can be any of the following:

* numeric constant

* string

* symbol

» expression binary_operator expression

* unary_operator expression

 (expression)

« function call

All types of expressions are explained in separate sections.

2.6.1. Numeric Constants

Numeric constants can be used in expressions. If there is no prefix, by default the assembler assumes
the number is a decimal number. Prefixes can be used in either lowercase or uppercase.
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Base Description Example
Binary A Ob or OB prefix followed by binary digits (0,1). 0B1101
0b11001010
Hexadecimal A Ox or 0X prefix followed by hexadecimal digits (0-9, A-F, a-f). |OX12FF
0x45
Oxf al0
Decimal integer Decimal digits (0-9). 12
1245
2.6.2. Strings

ASCII characters, enclosed in single (') or double (") quotes constitute an ASCII string. Strings between
double quotes allow symbol substitution by a . DEFI NE directive, whereas strings between single quotes
are always literal strings. Both types of strings can contain escape characters.

Strings constants in expressions are evaluated to a number (each character is replaced by its ASCII
value). Strings in expressions can have a size of up to 4 characters or less depending on the operand of
an instruction or directive; any subsequent characters in the string are ignored. In this case the assembler
issues a warning. Null strings have a value of 0.

Square brackets ([ ]) delimit a substring operation in the form:
[string, of fset, | ength]

offset is the start position within string. length is the length of the desired substring. Both values may not
exceed the size of string.

Examples
" ABCD . (0x41424344)
79 ; to enclose a quote double it
"Al"BC ; or to enclose a quote escape it
"AB' +1 ; (0x4143) string used in expression
v ; null string
.word ' abcdef’ ; (0x64636261) 'ef' are ignored
; warning: string value truncated
"abc' ++' de' ; you can concatenate
; two strings with the '++ operator.
; This results in 'abcde'
[" TASKI NG , 0, 4] ; results in the substring ' TASK

2.6.3. Expression Operators
The next table shows the assembler operators. They are ordered according to their precedence. Operators

of the same precedence are evaluated left to right. Parenthetical expressions have the highest priority
(innermost first).
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Valid operands include numeric constants, literal ASCII strings and symbols.

Most assembler operators can be used with both integer and floating-point values. If one operand has
an integer value and the other operand has a floating-point value, the integer is converted to a floating-point
value before the operator is applied. The result is a floating-point value.
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Type Operator Name Description

O parenthesis Expressions enclosed by parenthesis are evaluated
first.

Unary + plus Returns the value of its operand.

- minus Returns the negative of its operand.

~ one's complement Integer only. Returns the one’s complement of its
operand. It cannot be used with a floating-point
operand.

! logical negate Returns 1 if the operands' value is O; otherwise 0.
For example, if buf is 0 then ! buf is 1. If buf has
a value of 1000 then ! buf is 0.

Arithmetic * multiplication Yields the product of its operands.

/ division Yields the quotient of the division of the first operand
by the second. For integer operands, the divide
operation produces a truncated integer result.

% modulo Integer only. This operator yields the remainder from
the division of the first operand by the second.

+ addition Yields the sum of its operands.

- subtraction Yields the difference of its operands.

Shift << shift left Integer only. Causes the left operand to be shifted
to the left (and zero-filled) by the number of bits
specified by the right operand.

>> shift right Integer only. Causes the left operand to be shifted
to the right by the number of bits specified by the
right operand. The sign bit will be extended.

Relational < less than Returns an integer 1 if the indicated condition is

-— less than or equal TRUE or an integer 0 if the indicated condition is
FALSE.

> greater than

— greater than or equal For example, if D has a value of 3 qnd E ha§ avalue
of 5, then the result of the expression D<E is 1, and

== equal the result of the expression D>E is 0.

I= not equal o ) ) )

Use tests for equality involving floating-point values
with caution, since rounding errors could cause
unexpected results.

Bit and & AND Integer only. Yields the bitwise AND function of its

Bitwise operand.
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Type Operator Name Description
[ OR Integer only. Yields the bitwise OR function of its
operand.
A exclusive OR Integer only. Yields the bitwise exclusive OR function

of its operands.

Logical && logical AND Returns an integer 1 if both operands are non-zero;
otherwise, it returns an integer 0.

[l logical OR Returns an integer 1 if either of the operands is
non-zero; otherwise, it returns an integer 1

The relational operators and logical operators are intended primarily for use with the conditional assembly
. i f directive, but can be used in any expression.

2.7.Working with Sections

Sections are absolute or relocatable blocks of contiguous memory that can contain code or data. Some
sections contain code or data that your program declared and uses directly, while other sections are
created by the linker and contain debug information or code or data to initialize your application. These
sections can be named in such a way that different modules can implement different parts of these
sections. These sections are located in memory by the linker (using the linker script language, LSL) so
that concerns about memory placement are postponed until after the assembly process.

All instructions and directives which generate data or code must be within an active section. The assembler
emits a warning if code or data starts without a section definition and activation. If you program in assembly
you have to define sections yourself.

For more information about locating sections see Section 5.7.9, The Section Layout Definition: Locating
Sections.

Section definition

Sections are defined with the . SDECL directive and have a name. A section may have attributes to instruct
the linker to place it on a predefined starting address.

. SDECL "nane"[, type][, attribute ]... [AT address]

The name specifies the name of the section. Section names that start with a dot "." and a predefined
section name prefix have a special meaning to the locating process. Optionally, you can extend the section
names with a dot ".' and a user defined name. You can specify the following section name prefixes:

Section prefix Description Implicit section type
mcstext program code CODE

mcsdata initialized data DATA

mcsbss uninitialized data (cleared) DATA

See the description of the . SDECL directive for a complete description of all possible attributes.
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Section activation
Sections are defined once and are activated with the . SECT directive.
. SECT "namne"

The linker will check between different modules and emits an error message if the section attributes do
not match. The linker will also concatenate all matching section definitions into one section. So, all "code"
sections will be linked into one big "code" chunk which will be located in one piece. A . SECT directive
referring to an earlier defined section is called a continuation. Only the name can be specified.

Examples

.SDECL ".ntstext.code"
. SECT ". ntstext.code"

Defines and activates a relocatable section in CODE memory. Other parts of this section, with the same

name, may be defined in the same module or any other module. Other modules should use the same
. SDECL statement. When necessary, it is possible to give the section an absolute starting address.

.SDECL ".ntsdata.abs", data at 0x100
. SECT ". ncsdat a. abs"

Defines and activates an absolute section named . ntsdat a. abs starting at address 0x100.

2.8. Built-in Assembly Functions

The TASKING assembler has several built-in functions to support string comparison and macro testing.
You can use functions as terms in any expression.

Syntax of an assembly function
@ unction_nane([argunent[,argunment]...])
Functions start with the '@’ character and have zero or more arguments, and are always followed by

opening and closing parentheses. White space (a blank or tab) is not allowed between the function name
and the opening parenthesis and between the (comma-separated) arguments.

The names of assembly functions are case insensitive.

Overview of mathematical functions

Function Description
@POW exprl, expr2) Raise to a power
@GN( expr) Returns the sign of an expression as -1, 0 or 1
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Overview of conversion functions

Function

Description

@cVi (expr)
@RVB( expr[ , exprN] )

Convert floating-point to integer
Reverse order of bits in field

Overview of string functions

Function Description
@CAT( strl, str2) Concatenate strl and str2
@ EN( string) Length of string

@0OS( strl, str2[ , start] )
@BCP( strl, str2)
@UB( str, exprl, expr2)

Position of str2 in strl
Compare strl with str2
Return substring

Overview of macro functions

Function Description

@A\RGE "' symbol' | expr) Test if macro argument is present
@CNT() Return number of macro arguments
@/AC( symbol) Test if macro is defined

@MXP() Test if macro expansion is active

Overview of address calculation functions

Function Description
@-SB( expr) Least significant 8 bits of the expression
@vBB( expr) Most significant 8 bits of the expression

Overview of assembler mode functions

Function Description

@3l GENDI AN() Test if assembler generates code for big-endian mode
@EF("' symbol' | symbol) Returns 1 if symbol has been defined

@EXP( expr) Expression check

@ NT( expr) Integer check

@.ST() LIST control flag value
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Detailed Description of Built-in Assembly Functions

@ARG('symbol’ | expression)
Returns integer 1 if the macro argument represented by symbol or expression is present, 0 otherwise.

You can specify the argument with a symbol name (the name of a macro argument enclosed in single
quotes) or with expression (the ordinal number of the argument in the macro formal argument list). If you
use this function when macro expansion is not active, the assembler issues a warning.

Example:

JF @RE ' TWDDLE' ) ;is argunment tw ddl e present?
I F GARGQ(1) ;is first argunent present?

@BIGENDIAN()

Returns 1 if the assembler generates code for big-endian mode, returns 0 if the assembler generates
code for little-endian mode (this is the default).

@CAT(stringl,string2)
Concatenates the two strings into one string. The two strings must be enclosed in single or double quotes.

Example:

.DEFINE ID "@AT(' TASK ,"ING)" ;1D = " TASKI NG

@CNT()

Returns the number of macro arguments of the current macro expansion as an integer. If you use this
function when macro expansion is not active, the assembler issues a warning.

Example:

ARGCOUNT . SET @NT() ; reserve argunent count

@CVl(expression)

Converts the result of expression to an integer value. This function should be used with caution since the
conversions can be inexact (e.g., floating-point values are truncated).

Example:

INT .SET @V (-1.05) JINT = -1
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@DEF('symbol' | symbol)

Returns 1 if symbol has been defined, 0 otherwise. symbol can be any symbol or label not associated
with a . MACROor . SDECL directive. If symbol is quoted, it is looked up as a . DEFI NE symbol; if it is not
quoted, it is looked up as an ordinary symbol or label.

Example:
. | F @EFI NED(' ANGLE' ) ;is synmbol ANGLE defined?
. | F @EFI NED( ANGLE) ; does | abel ANGLE exist?

@EXP(expression)

Returns 0 if the evaluation of expression would normally result in an error. Returns 1 if the expression
can be evaluated correctly. With the @XP function, you prevent the assembler from generating an error
if the expression contains an error. No test is made by the assembler for warnings. The expression may
be relative or absolute.

Example:
I F 1T @XP(3/0) ;Do the |F on error

; assenbl er generates no error
JAF 1(3/0) ;assenbl er generates an error

@INT(expression)

Returns integer 1 if expression has an integer result; otherwise, it returns a 0. The expression may be
relative or absolute.

Example:

.IF @NT(TERM ; Test if result is an integer

@LEN(string)

Returns the length of string as an integer.

Example:

SLEN .SET @EN('string') ;SLEN =6
@LSB(expression)

Returns the least significant 8 bits of the result of the expression. The result of the expression is calculated
as 16 bit.
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Example:
VARL . SET @ SB(0x34) ; VARL = 0x34
VAR2 . SET @ SB(0x1234) ; VAR2 = 0x34
VAR3 . SET @ SB(0x654321) ; VAR3 = 0x21
@LST()

Returns the value of the $LI ST O\ OFF control flag as an integer. Whenever a $LI ST ON control is
encountered in the assembler source, the flag is incremented; when a $L1 ST OFF control is encountered,
the flag is decremented.

Example:

.DUP  @BS(@ST()) ;1ist unconditionally
@MAC(symbol)

Returns integer 1 if symbol has been defined as a macro name, 0 otherwise.
Example:

JF @/AC( DOMUL) ; does macro DOMUL exist?
@MSB (expression)

Returns the most significant 8 bits of the result of the expression. The result of the expression is calculated
as 16 bit.

Example:

VARL . SET @/BB(0x34) ; VARL = 0x00

VAR2 . SET @/BB(0x1234) ; VAR2 = 0x12

VAR3 . SET @/BB(0x654321) i VAR3 = 0x43

@MXP()

Returns integer 1 if the assembler is expanding a macro, 0 otherwise.
Example:

A F @XP() ; Macro expansi on active?

@POS(stringl,string2[,start])

Returns the position of string2 in stringl as an integer. If string2 does not occur in stringl, the last string
position + 1 is returned.

With start you can specify the starting position of the search. If you do not specify start, the search is
started from the beginning of stringl. Note that the first position in a string is position 0.
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Example:

IDL .EQU @OS('TASKING ,"ASK') ; ID1 =1
ID2 .EQU @OS('ABCDABCD ,'B',2) ; ID2 =5
ID3 .EQU @OS('TASKING ,'BUG) ; ID3 =7

@POW(expressionl,expression2)

Returns expressionl raised to the power expression2 as a floating-point value. expressionl and
expression2 must be separated by a comma.

Example:

BUF .EQU @Vl (@OW2.0,3.0)) ;BUF = 8

@RVB(expressionl,expression?2)

Reverse the order of bits in expressionl delimited by the number of bits in expression2. If expression2
is omitted the field is bounded by the target word size. Both expressions must be 16-bit integer values.

Example:

VARL . SET @RVB(0x200) :reverse all bits, VARL=0x40
VAR2 . SET @RVB(0xB02) :reverse all bits, VAR2=0x40D0
VAR3 . SET @VB(0xB02, 2) ;reverse bits 0 and 1,

; VAR3=0xB01

@SCP(stringl,string?2)
Returns integer 1 if the two strings compare, 0 otherwise. The two strings must be separated by a comma.
Example:

.IF @CP(STR,' MAIN ) ; does STR equal 'MAIN ?

@SGN(expression)

Returns the sign of expression as an integer: -1 if the argument is negative, O if zero, 1 if positive. The
expression may be relative or absolute.

Example:

VARL . SET @G\(-1.2e-92) ;VARL = -1
VAR2 . SET @G\(0) VAR = 0
VAR3 . SET @G\(28.382) VAR = 1

@SUB(string,expressionl,expression?2)
Returns the substring from string as a string. expressionl is the starting position within string, and

expression?2 is the length of the desired string. The assembler issues an error if either expressionl or
expression2 exceeds the length of string. Note that the first position in a string is position 0.
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Example:

.DEFINE ID "@UB(' TASKING ,3,4)" ;ID="KING

2.9. Assembler Directives and Controls

An assembler directive is simply a message to the assembler. Assembler directives are not translated
into machine instructions. There are three main groups of assembler directives.

» Assembler directives that tell the assembler how to go about translating instructions into machine code.
This is the most typical form of assembly directives. Typically they tell the assembler where to put a
program in memory, what space to allocate for variables, and allow you to initialize memory with data.
When the assembly source is assembled, a location counter in the assembler keeps track of where
the code and data is to go in memory.

The following directives fall under this group:

* Assembly control directives

« Symbol definition and section directives

« Data definition / Storage allocation directives
» High Level Language (HLL) directives

« Directives that are interpreted by the macro preprocessor. These directives tell the macro preprocessor
how to manipulate your assembly code before it is actually being assembled. You can use these
directives to write macros and to write conditional source code. Parts of the code that do not match the
condition, will not be assembled at all.

» Some directives act as assembler options and most of them indeed do have an equivalent assembler
(command line) option. The advantage of using a directive is that with such a directive you can overrule
the assembler option for a particular part of the code. Directives of this kind are called controls. A typical
example is to tell the assembler with an option to generate a list file while with the controls $LI ST ON
and $LI ST OFF you overrule this option for a part of the code that you do not want to appear in the
list file. Controls always appear on a separate line and start with a '$' sign in the first column.

The following controls are available:
* Assembly listing controls
* Miscellaneous controls

Each assembler directive or control has its own syntax. You can use assembler directives and controls
in the assembly code as pseudo instructions.

Some assembler directives can be preceded with a label. If you do not precede an assembler directive

with a label, you must use white space instead (spaces or tabs). The assembler recognizes both uppercase
and lowercase for directives.
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2.9.1. Assembler Directives

Overview of assembly control directives

Directive Description

. COMVENT Start comment lines. You cannot use this directive in .IF/.ELSE/.ENDIF
constructs and .MACRO/.DUP definitions.

. END Indicates the end of an assembly module

.FAI L Programmer generated error message

. | NCLUDE Include file

. MESSAGE Programmer generated message

. WARNI NG Programmer generated warning message

Overview of symbol definition and section directives

Directive Description

. ALI AS Create an alias for a symbol

. EQU Set permanent value to a symbol

. EXTERN Import global section symbol

. GLOBAL Declare global section symbol

. LOCAL Declare local section symbol

. ORG Initialize memory space and location counters to create a nameless section
. SDECL Declare a section with name, type and attributes
. SECT Activate a declared section

. SET Set temporary value to a symbol

. Sl ZE Set size of symbol in the ELF symbol table

. TYPE Set symbol type in the ELF symbol table

. VIEAK Mark a symbol as 'weak’

Overview of data definition / storage allocation directives

Directive Description

.ALI GN Align location counter

. SPACE Define storage (32 bits)
. WVORD Define word (32 bits)

Overview of macro preprocessor directives

Directive

Description

. DEFI NE

Define substitution string
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Directive Description

. DUP, . ENDM Duplicate sequence of source lines

. DUPA, . ENDM Duplicate sequence with arguments

. DUPC, . ENDM Duplicate sequence with characters

. DUPF, . ENDM Duplicate sequence in loop
.IF,.ELIF,.ELSE Conditional assembly directive

. ENDI F End of conditional assembly directive
. EXIT™M Exit macro

. MACRO, . ENDM Define macro

. PMACRO Undefine (purge) macro

. UNDEF Undefine . DEFI NE symbol
Overview of HLL directives

Directive Description

. CALLS Pass call tree information and/or stack usage information

. COVPI LER | NVOCATI ON
. COVPI LER_NANME
. COWP| LER_VERSI ON

. M SRAC

Pass C compiler invocation
Pass C compiler name

Pass C compiler version header
Pass MISRA C information

64




Assembly Language

ALIAS

Syntax

al i as-name . ALI AS synbol - nane

Description

With the . ALI AS directive you can create an alias of a symbol. The C compiler generates this directive
when you use the #pragma al i as.

Example

_exit .ALIAS Exit
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ALIGN

Syntax

. ALI GN expression

Description

With the . ALI GNdirective you instruct the assembler to align the location counter. By default the assembler
aligns on four bytes.

When the assembler encounters the . ALI GN directive, it advances the location counter to an address
that is aligned as specified by expression and places the next instruction or directive on that address.
The alignment is in minimal addressable units (MAUs). The assembler fills the ‘gap’ with NOP instructions
for code sections or with zeros for data sections. If the location counter is already aligned on the specified
alignment, it remains unchanged. The location of absolute sections will not be changed.

The expression must be a power of two: 4, 8, 16, ... If you specify another value, the assembler changes
the alignment to the next higher power of two and issues a warning.

The assembler aligns sections automatically to the largest alignment value occurring in that section.

A label is not allowed before this directive.

Example
.sdecl '.ntstext.code', code
.sect '.nctstext.code'
.ALI GN 16 ; the assenbler aligns
instruction ; this instruction at 16 MAUs and
; fills the "gap' with NOP instructions.
.sdecl '.ntstext.code', code
.sect '.nctstext.code'
.ALIGN 12 ; WRONG not a power of two, the
instruction ; assenbler aligns this instruction at

; 16 MAUs and i ssues a warning.
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.CALLS

Syntax

.CALLS "caller’,’ callee’

or
. CALLS 'caller’,’’, stack_usage
Description

The first syntax creates a call graph reference between caller and callee. The linker needs this information
to build a call graph. caller and callee are names of functions.

The second syntax specifies stack information. When callee is an empty name, this means we define the
stack usage of the function itself. The value specified is the stack usage in bytes at the time of the call
including the return address.

This information is used by the linker to compute the used stack within the application. The information
is found in the generated linker map file within the Memory Usage.

This directive is generated by the C compiler. Normally you will not use it in hand-coded assembly.
A label is not allowed before this directive.
Example
. CALLS 'mmin', "' nfunc'
Indicates that the function mai n calls the function nf unc.
. CALLS 'main',"",8

The function mai n uses 8 bytes on the stack.
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.COMMENT

Syntax

.COWENT delimter

delinmter
Description

With the . COMMVENT directive you can define one or more lines as comments. The first non-blank character
after the . COMMENT directive is the comment delimiter. The two delimiters are used to define the comment
text. The line containing the second comment delimiter will be considered the last line of the comment.
The comment text can include any printable characters and the comment text will be produced in the
source listing as it appears in the source file.

A label is not allowed before this directive.

Example

.COMWENT + This is a one |line conment +

.COMENT * This is a nultiple line
conment . Any nunber of |ines
can be pl aced between the two
delinmiters.
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.COMPILER_INVOCATION, .COMPILER_NAME, .COMPILER_VERSION

Syntax

. COWPI LER _VERSI ON "versi on_header"
. COVPI LER_I NVOCATI ON "i nvocati on"
. COWPI LER_NAME " nane"

Description

The C compiler generates information about itself and the invocation at the start of the assembly source.
This way you can always see how the assembly source file was generated. When you assemble the
source file, this information will appear in . not e sections in the object file.

A label is not allowed before these directives.
Example

. COWPI LER_VERSI ON "TASKI NG VX-tool set for MCS: C conpiler vx.yrz Build yymmddqgq"
. COWPI LER_| NVOCATION "cnts test.c"”
. COWPI LER_NAME "cnts”
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.DEFINE

Syntax

. DEFI NE synbol string

Description

With the . DEFI NE directive you define a substitution string that you can use on all following source lines.
The assembler searches all succeeding lines for an occurrence of symbol, and replaces it with string. If
the symbol occurs in a double quoted string it is also replaced. Strings between single quotes are not
expanded.

This directive is useful for providing better documentation in the source program. A symbol can consist
of letters, digits and underscore characters (_), and the first character cannot be a digit.

Macros represent a special case. . DEFI NE directive translations will be applied to the macro definition
as it is encountered. When the macro is expanded, any active . DEFI NE directive translations will again
be applied.

The assembler issues a warning if you redefine an existing symbol.

A label is not allowed before this directive.

Example

Suppose you defined the symbol LEN with the substitution string "32":
. DEFI NE LEN " 32"

Then you can use the symbol LEN for example as follows:

. SPACE LEN
. MESSACE "The length is: LEN'

The assembler preprocessor replaces LEN with "32" and assembles the following lines:

. SPACE 32
. MESSACGE "The length is: 32"

Related Information
. UNDEF (Undefine a .DEFINE symbol)

. MACRO, . ENDM(Define a macro)
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.DUP, .ENDM

Syntax

[l abel :] .DUP expression
- ENDM

Description

With the . DUP/. ENDMdirective you can duplicate a sequence of assembly source lines. With expression
you specify the number of duplications. If the expression evaluates to a number less than or equal to O,
the sequence of lines will not be included in the assembler output. The expression result must be an
absolute integer and cannot contain any forward references (symbols that have not already been defined).
The . DUP directive may be nested to any level.

If you specify label, it gets the value of the location counter at the start of the directive processing.
Example

In this example the loop is repeated three times. Effectively, the preprocessor repeats the source lines
(. WORD 10) three times, then the assembler assembles the result:

.DUP 3

.WORD 10 ; assenbly source lines
. ENDM

Related Information

. DUPA, . ENDM(Duplicate sequence with arguments)
. DUPC, . ENDM(Duplicate sequence with characters)
. DUPF, . ENDM(Duplicate sequence in loop)

. MACRO, . ENDM(Define a macro)
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.DUPA, .ENDM

Syntax

[label:] .DUPA formal _arg, argunment[, argunent]. ..
. ENDM

Description

With the . DUPA/. ENDMdirective you can repeat a block of source statements for each argument. For
each repetition, every occurrence of the formal_arg parameter within the block is replaced with each
succeeding argument string. If an argument includes an embedded blank or other assembler-significant
character, it must be enclosed with single quotes.

If you specify label, it gets the value of the location counter at the start of the directive processing.
Example
Consider the following source input statements,

.DUPA VALUE, 12,, 32, 34

.WORD VALUE

. ENDM

This is expanded as follows:

.MORD 12
.\WORD VALUE ; results in a warning
.WORD 32
.WORD 34

The second statement results in a warning of the assembler that the local symbol VALUE is not defined
in this module and is made external.

Related Information

. DUP, . ENDM(Duplicate sequence of source lines)

. DUPC, . ENDM(Duplicate sequence with characters)
. DUPF, . ENDM(Duplicate sequence in loop)

. MACRO, . ENDM(Define a macro)
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.DUPC, .ENDM

Syntax

[label:] .DUPC formal _arg, string
- ENDM

Description

With the . DUPC/. ENDMdirective you can repeat a block of source statements for each character within
string. For each character in the string, the formal_arg parameter within the block is replaced with that
character. If the string is empty, then the block is skipped.

If you specify label, it gets the value of the location counter at the start of the directive processing.
Example
Consider the following source input statements,

.DUPC VALLUE, ' 123’
.WORD VALUE
. ENDM

This is expanded as follows:

. WORD
. WORD
. WORD

WN -

Related Information

. DUP, . ENDM(Duplicate sequence of source lines)

. DUPA, . ENDM(Duplicate sequence with arguments)
. DUPF, . ENDM(Duplicate sequence in loop)

. MACRO, . ENDM(Define a macro)
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.DUPF, .ENDM

Syntax

[label:] .DUPF formal _arg,[start], end[,increnent]
. ENDM

Description

With the . DUPF/. ENDMdirective you can repeat a block of source statements (end - start) + 1/ increment
times. start is the starting value for the loop index; end represents the final value. increment is the increment
for the loop index; it defaults to 1 if omitted (as does the start value). The formal_arg parameter holds the
loop index value and may be used within the body of instructions.

If you specify label, it gets the value of the location counter at the start of the directive processing.
Example
Consider the following source input statements,

.DUPF NUM O, 7

. VWORD NUM

. ENDM

This is expanded as follows:

~N~No b~ wNEFE O
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Related Information

. DUP, . ENDM(Duplicate sequence of source lines)

. DUPA, . ENDM(Duplicate sequence with arguments)
. DUPC, . ENDM(Duplicate sequence with characters)

. MACRO, . ENDM(Define a macro)
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.END

Syntax

. END

Description

With the optional . END directive you tell the assembler that the end of the module is reached. If the
assembler finds assembly source lines beyond the . END directive, it ignores those lines and issues a
warning.

You cannot use the . END directive in a macro expansion.
The assembler does not allow a label with this directive.
Example

; source lines
. END ; End of assenbly nodul e

Related Information
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.EQU

Syntax

synbol . EQU expression

Description

With the . EQU directive you assign the value of expression to symbol permanently. The expression can
be relocatable or absolute and forward references are allowed. Once defined, you cannot redefine the
symbol. With the . GLOBAL directive you can declare the symbol global.

Example

To assign the value 0x400 permanently to the symbol MYSYMBOL:

MYSYMBOL . EQU 0x4000

You cannot redefine the symbol MYSYMBOL after this.

Related Information

. SET (Set temporary value to a symbol)
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EXITM

Syntax

.EXIT™

Description

With the . EXI TMdirective the assembler will immediately terminate a macro expansion. It is useful when
you use it with the conditional assembly directive . | F to terminate macro expansion when, for example,
error conditions are detected.

A label is not allowed before this directive.
Example

CALC .MNMACRO XVAL, YVAL

AF XVAL<0

.FAIL " Macro paraneter value out of range'
.EXITM ;Exit macro

. ENDI F

. ENDM

Related Information

. DUP, . ENDM(Duplicate sequence of source lines)

. DUPA, . ENDM(Duplicate sequence with arguments)
. DUPC, . ENDM(Duplicate sequence with characters)
. DUPF, . ENDM(Duplicate sequence in loop)

. MACRO, . ENDM(Define a macro)
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.EXTERN

Syntax

. EXTERN synbol [, synbol ]. ..

Description

With the . EXTERNdirective you define an external symbol. It means that the specified symbol is referenced
in the current module, but is not defined within the current module. This symbol must either have been
defined outside of any module or declared as globally accessible within another module with the . GLOBAL
directive.

If you do not use the . EXTERN directive and the symbol is not defined within the current module, the
assembler issues a warning and inserts the . EXTERN directive.

A label is not allowed with this directive.

Example
. EXTERN AA, CC, DD ;defined el sewhere
.sdecl ".ntstext"
.sect ".ncstext"
movl R3, AA ; AA is used here

Related Information
. GLOBAL (Declare global section symbol)

. LOCAL (Declare local section symbol)
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.FAIL

Syntax

.FAIL {str|exp}[,{str|exp}]...

Description

With the . FAI L directive you tell the assembler to print an error message to st der r during the assembling
process.

An arbitrary number of strings and expressions, in any order but separated by commas with no intervening
white space, can be specified to describe the nature of the generated error. If you use expressions, the
assembler outputs the result. The assembler outputs a space between each argument.

The total error count will be incremented as with any other error. The . FAI L directive is for example
useful in combination with conditional assembly for exceptional condition checking. The assembly process
proceeds normally after the error has been printed.

With this directive the assembler exits with exit code 1 (an error).
A label is not allowed with this directive.
Example
.FAIL 'Paraneter out of range'
This results in the error:
E143: ["filenane" |ine] Paraneter out of range
Related Information
. MESSACE (Programmer generated message)

. WARNI NG (Programmer generated warning)
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.GLOBAL

Syntax

. GLOBAL synbol [, synbol ]. ..

Description

All symbols or labels defined in the current section or module are local to the module by default. You can
change this default behavior with assembler option --symbol-scope=global.

With the . GLOBAL directive you declare one of more symbols as global. It means that the specified
symbols are defined within the current section or module, and that those definitions should be accessible
by all modules.

To access a symbol, defined with . GLOBAL, from another module, use the . EXTERN directive.
Only program labels and symbols defined with . EQU can be made global.
If the symbols that appear in the operand field are not used in the module, the assembler gives a warning.

The assembler does not allow a label with this directive.

Example

.sdecl '.ntsdata.data'
. sect ' . ntsdat a. dat a’'
.GLOBAL LOCOPA ; LOCOPA will be globally
; accessi bl e by other nodul es
LOOPA .EQU 1 ; definition of synmbol LOOPA

Related Information
. EXTERN (Import global section symbol)

. LOCAL (Declare local section symbol)
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IF, .ELIF, .ELSE, .ENDIF

Syntax

.1 F expression

[.ELIF expression] ; the .ELIF directive is optional
[ . ELSE] ; the .ELSE directive is optional
. ENDI F

Description

With the . | F/. ENDI F directives you can create a part of conditional assembly code. The assembler
assembles only the code that matches a specified condition.

The expression must evaluate to an absolute integer and cannot contain forward references. If expression
evaluates to zero, the IF-condition is considered FALSE, any non-zero result of expression is considered
as TRUE.

If the optional . ELSE and/or . ELI F directives are not present, then the source statements following the
. | Fdirective and up to the next . ENDI F directive will be included as part of the source file being assembled
only if the expression had a non-zero result.

If the expression has a value of zero, the source file will be assembled as if those statements between
the . | F and the . ENDI F directives were never encountered.

If the . ELSE directive is present and expression has a nonzero result, then the statements between the
. | Fand . ELSE directives will be assembled, and the statement between the . ELSE and . ENDI F directives
will be skipped. Alternatively, if expression has a value of zero, then the statements between the . | F and
. ELSE directives will be skipped, and the statements between the . ELSE and . ENDI F directives will be
assembled.

You can nest . | F directives to any level. The . ELSE and . ELI F directive always refer to the nearest
previous . | F directive.

A label is not allowed with this directive.
Example

Suppose you have an assemble source file with specific code for a test version, for a demo version and
for the final version. Within the assembly source you define this code conditionally as follows:

I F TEST
. ; code for the test version
. ELI F DEMO

. ; code for the denp version
. ELSE
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; code for the final version
. ENDI F

Before assembling the file you can set the values of the symbols TEST and DEMOin the assembly source
before the . | F directive is reached. For example, to assemble the demo version:

TEST .SET 0O
DEMO . SET 1

You can also define the symbols on the command line with the assembler option --define (-D):

asnts --define=DEMO - -defi ne=TEST=0 test.asm
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INCLUDE

Syntax

. I NCLUDE "fil ename" | <fil enane>

Description

With the . | NCLUDE directive you include another file at the exact location where the . | NCLUDE occurs.
This happens before the resulting file is assembled. The . | NCLUDE directive works similarly to the

#i ncl ude statement in C. The source from the include file is assembled as if it followed the point of the
. | NCLUDE directive. When the end of the included file is reached, assembly of the original file continues.

The string specifies the filename of the file to be included. The filename must be compatible with the
operating system (forward/backward slashes) and can contain a directory specification.

If an absolute pathname is specified, the assembler searches for that file. If a relative path is specified
or just a filename, the order in which the assembler searches for include files is:

1. The current directory if you use the "filename" construction.
The current directory is not searched if you use the <filename> syntax.
2. The path that is specified with the assembler option --include-directory.
3. The path that is specified in the environment variable ASMCSI NC when the product was installed.
4. The default i ncl ude directory in the installation directory.

The assembler does not allow a label with this directive.

Example
. I NCLUDE ' st orage\ nem asmi ; include file
. I NCLUDE <dat a. asn® ; Do not look in

; current directory
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.LOCAL

Syntax

. LOCAL synmbol [, synmbol ] . ..

Description

All symbols or labels defined in the current section or module are local to the module by default. You can
change this default behavior with assembler option --symbol-scope=global.

With the . LOCAL directive you declare one of more symbols as local. It means that the specified symbols
are explicitly local to the module in which you define them.

If the symbols that appear in the operand field are not used in the module, the assembler gives a warning.
The assembler does not allow a label with this directive.
Example

. SDECL ".ntsdata. data", DATA

. SECT ".ntsdat a. data"
.LOCAL LOCPA ; LOOPA is local to this section
LOOPA . WORD  0x100 ; assigns the val ue 0x100 to LOOPA

Related Information
. EXTERN (Import global section symbol)

. GLOBAL (Declare global section symbol)
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.MACRO, .ENDM

Syntax

macr o_nanme . MACRO [argunent [, argument]...]
rracr o_definition_statenents
. ENDM

Description

With the . MACROdirective you define a macro. Macros provide a shorthand method for handling a repeated
pattern of code or group of instructions. You can define the pattern as a macro, and then call the macro
at the points in the program where the pattern would repeat.

The definition of a macro consists of three parts:

» Header, which assigns a name to the macro and defines the arguments (. MACRO directive).
» Body, which contains the code or instructions to be inserted when the macro is called.

» Terminator, which indicates the end of the macro definition (. ENDMdirective).

The arguments are symbolic names that the macro processor replaces with the literal arguments when
the macro is expanded (called). Each formal argument must follow the same rules as symbol names: the
name can consist of letters, digits and underscore characters (_). The first character cannot be a digit.
Argument names cannot start with a percent sign (%).

Macro definitions can be nested but the nested macro will not be defined until the primary macro is
expanded.

You can use the following operators in macro definition statements:

Operator [Name Description

\ Macro argument concatenation | Concatenates a macro argument with adjacent
alphanumeric characters.

? Return decimal value of symbol | Substitutes the ?symbol sequence with a character string
that represents the decimal value of the symbol.

% Return hex value of symbol Substitutes the %symbol sequence with a character string
that represents the hexadecimal value of the symbol.

“ Macro string delimiter Allows the use of macro arguments as literal strings.

A Macro local label override Prevents name mangling on labels in macros.

Example

The macro definition:
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CONST24 . MACRO reg, val ue ; header
nov| reg, val ue ; body
. ENDM ; term nator

The macro call:

. SDECL ". ncstext.code", code
. SECT " . ncst ext.code"
CONST24 5, 0x123456

The macro expands as follows:
nmov| r5, 0x123456
Related Information
Section 2.10, Macro Operations
. DUP, . ENDM(Duplicate sequence of source lines)
. DUPA, . ENDM(Duplicate sequence with arguments)
. DUPC, . ENDM(Duplicate sequence with characters)
. DUPF, . ENDM(Duplicate sequence in loop)
. PMACRO (Undefine macro)

. DEFI NE (Define a substitution string)

Assembly Language
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.MESSAGE

Syntax

. MESSAGE {str|exp}[,{str]|exp}]...

Description

With the . MESSAGE directive you tell the assembiler to print a message to st der r during the assembling
process.

An arbitrary number of strings and expressions, in any order but separated by commas with no intervening
white space, can be specified to describe the nature of the generated message. If you use expressions,
the assembler outputs the result. The assembler outputs a space between each argument.

The error and warning counts will not be affected. The . MESSAGE directive is for example useful in
combination with conditional assembly to indicate which part is assembled. The assembling process
proceeds normally after the message has been printed.

This directive has no effect on the exit code of the assembler.

A label is not allowed with this directive.

Example

. DEFI NE LONG " SHORT"
.MESSACE 'This is a LONG string'
.MESSACE "This is a LONG string"

Within single quotes, the defined symbol LONGis not expanded. Within double quotes the symbol LONG
is expanded so the actual message is printed as:

This is a LONG string
This is a SHORT string

Related Information
. FAI L (Programmer generated error)

. WARNI NG (Programmer generated warning)
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.MISRAC

Syntax

. M SRAC string

Description

The C compiler can generate the . M SRAC directive to pass the compiler's MISRA C settings to the object
file. The linker performs checks on these settings and can generate a report. It is not recommended to
use this directive in hand-coded assembly.

Example

.M SRAC ' M SRA- C: 2004, 64, e2, Ob, e, el1, 27, 6, ef 83, el,
ef, 66, cb75, af 1, ef f, e7, e7f, 8d, 63, 87ff 7, 6ff 3, 4'

Related Information
Section 3.6.2, C Code Checking: MISRA C

C compiler option --misrac
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.ORG

Syntax

.ORG [abs-loc][,sect_type][,attribute]...

Description

With the . ORGdirective you can specify an absolute location (abs_loc) in memory of a section. This is
the same as a . SDECL/ . SECT without a section name.

This directive uses the following arguments:

abs-loc Initial value to assign to the run-time location counter. abs-loc must be an absolute
expression. If abs_loc is not specified, then the value is zero.

sect_type |An optional section type: code or data

attribute An optional section attribute: init, noread, noclear, max, rom, group(string), cluster(string),
protect

For more information about the section types and attributes see the assembler directive . SDECL.
The section type and attributes are case insensitive. A label is not allowed with this directive.

Example

; define a section at |ocation 100 deci mal
.org 100

; define a relocatable nanel ess section
.org

; define a relocatable data section
.org , data

; define a data section at 0x8000
.org 0x8000, dat a

Related Information
. SDECL (Declare section name and attributes)

. SECT (Activate a declared section)
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.PMACRO
Syntax

. PMACRO synbol [, synbol ]. ..
Description

With the . PMACROdirective you tell the assembler to undefine the specified macro, so that later uses of
the symbol will not be expanded.

The assembler does not allow a label with this directive.

Example
. PMACRO MAC1, MAC2

This statement causes the macros named MACL and MAC2 to be undefined.

Related Information

. MACRO, . ENDM(Define a macro)

91



TASKING VX-toolset for MCS User Guide

.SDECL
Syntax
. SDECL "name"[,type][,attribute]... [AT address]
Description
With the . SDECL directive you can define a section with a name (between single or double quotes), type
and optional attributes. Before any code or data can be placed in a section, you must use the . SECT

directive to activate the section.

The name specifies the name of the section. Section names that start with a dot "." and a predefined
section hame prefix have a special meaning to the locating process. Optionally, you can extend the section
names with a dot '.' and a user defined name. You can specify the following section name prefixes:

Section prefix Description Implicit section type
mcstext program code CODE

mcsdata initialized data DATA

mcsbss uninitialized data (cleared) DATA

The type operand specifies the section’s type and must be one of:

Type Description
CODE |Code section.
DATA  |Data section.
DEBUG | Debug section.

When you use a section prefix, the section type is optional.
The section type and attributes are case insensitive.

The defined attributes are:

Attribute Description Allowed on type
AT address Locate the section at the given address. CODE, DATA
CLEAR Sections are zeroed at startup. DATA

CLUSTER( ‘name* | Cluster code sections with companion debug sections. Used |CODE, DATA,
) by the linker during removal of unreferenced sections. The DEBUG
name must be unique for this module (not for the application).
To prevent naming conflicts with other symbols, the prefix
".cl uster."is added to the cluster name during object file
generation.

CONCAT Concatenate sections. Used by the linker to merge sections |DATA
with the same name.
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Attribute Description Allowed on type
INIT Defines that the section contains initialization data, which is |CODE, DATA
copied from ROM to RAM at program startup.
NOCLEAR Sections are not zeroed at startup. This is a default attribute |DATA
for data sections. This attribute is only useful with BSS
sections, which are cleared at startup by default.
NOREAD Defines that the section can be executed from but not read. |CODE
PROTECT Tells the linker to exclude a section from unreferenced section | CODE, DATA
removal and duplicate section removal.
ROM Section contains data to be placed in ROM. This ROM area |CODE, DATA

is not executable.

Section names

The name of a section can have a special meaning for locating sections. The name of code sections
should always start with ". ntst ext ". The name of data sections should always start with ". ncsdat a".

Example

. sdecl
. sect

. sdecl
. sect

. sdecl

. sect

decl are ntscode secti

on

. ncsdat a. nydat a"
. ncsdat a. nydat a"

. ntsdat a. abssec”

. ncsdat a. abssec”

Related Information

. SECT (Activate a declared section)

. ncst ext . mycode" ;
. ncst ext . mycode"

data at

; activate section

; declare ntsdata section
; activate section

0x100

; absolute section
; activate section
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SECT

Syntax

. SECT "nane"

Description

With the . SECT directive you activate a previously declared section with the name name. Before you can
activate a section, you must define the section with the . SDECL directive. You can activate a section as
many times as you need.

Example
.sdecl ".ntsdata.nydata" ; declare ntsdata section
. sect ".ntsdat a. nydat a" ; activate section

Related Information

. SDECL (Declare section name and attributes)
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SET

Syntax

synbol .SET expression
. SET synbol expression

Description

With the . SET directive you assign the value of expression to symbol temporarily. If a symbol was defined
with the . SET directive, you can redefine that symbol in another part of the assembly source, using the
. SET directive again. Symbols that you define with the . SET directive are always local: you cannot define
the symbol global with the . GLOBAL directive.

The . SET directive is useful in establishing temporary or reusable counters within macros. expression
must be absolute and forward references are allowed.

Example

COUNT .SET O ; Initialize count. Later on you can
; assign other values to the synbol

Related Information

. EQU (Set permanent value to a symbol)
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SIZE

Syntax
.Sl ZE synbol , expression
Description
With the . SI ZE directive you set the size of the specified symbol to the value represented by expression.

The . SI ZE directive may occur anywhere in the source file unless the specified symbol is a function. In
this case, the . Sl ZE directive must occur after the function has been defined.

Example

_MCS str:  .type obj ect ; object _MCS str
.size _MCS str,16 ; size of object
.word 80
.word 67
.word 80
.word 0

Related Information

. TYPE (Set symbol type)
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.SPACE

Syntax

[l abel :] .SPACE expression
Description

The . SPACE directive reserves a block in memory. The reserved block of memory is not initialized to any
value.

If you specify the optional label, it gets the value of the location counter at the start of the directive
processing.

The expression specifies the number of words to be reserved, and how much the location counter will
advance. The expression must evaluate to an integer greater than zero and cannot contain any forward
references (symbols that have not yet been defined).

If you specify label, it gets the value of the location counter at the start of the directive processing.
Example

To reserve 12 words (not initialized) of memory in a RAM data section:

.sdecl ".ntsdata.data"
. sect ".nctsdat a. dat a"
uninit .SPACE 12 ; Sanpl e buffer

Related Information

. WORD (Define a constant word)
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.TYPE
Syntax
synmbol . TYPE typeid

Description

With the . TYPE directive you set a symbol's type to the specified value in the ELF symbol table. Valid
symbol types are:

FUNC The symbol is associated with a function or other executable code.
OBJECT The symbol is associated with an object such as a variable, an array, or a structure.
FILE The symbol name represents the filename of the compilation unit.

Labels in code sections have the default type FUNC. Labels in data sections have the default type OBJECT.

Example

_MCS_Afunc: .type func

Related Information

. Sl ZE (Set symbol size)
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.UNDEF
Syntax

. UNDEF synmbol
Description

With the . UNDEF directive you can undefine a substitution string that was previously defined with the
. DEFI NE directive. The substitution string associated with symbol is released, and symbol will no longer
represent a valid . DEFI NE substitution or macro.

The assembler issues a warning if you undefine a non-existing symbol.
The assembler does not allow a label with this directive.
Example

The following example undefines the LEN substitution string that was previously defined with the . DEFI NE
directive:

. UNDEF LEN

Related Information

. DEFI NE (Define a substitution string)
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WARNING

Syntax

. WARNI NG {str|exp}[,{str]|exp}]...

Description

With the . WARNI NG directive you tell the assembler to print a warning message to st der r during the
assembling process.

An arbitrary number of strings and expressions, in any order but separated by commas with no intervening
white space, can be specified to describe the nature of the generated warning. If you use expressions,
the assembler outputs the result. The assembler outputs a space between each argument.

The total warning count will be incremented as with any other warning. The . WARNI NG directive is for
example useful in combination with conditional assembly to indicate which part is assembled. The
assembling process proceeds normally after the message has been printed.

This directive has no effect on the exit code of the assembler, unless you use the assembler option
--warnings-as-errors. In that case the assembler exits with exit code 1 (an error).

A label is not allowed with this directive.
Example
.WARNI NG ' Paranmeter out of range'
This results in the warning:
WL44: ["filename" |ine] Paraneter out of range
Related Information
. FAI L (Programmer generated error)

. MESSACGE (Programmer generated message)
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WEAK
Syntax

. EEAK synbol [, synbol J. ..
Description

With the . VEAK directive you mark one or more symbols as 'weak'. The symbol can be defined in the
same module with the . GLOBAL directive or the . EXTERN directive. If the symbol does not already exist,
it will be created.

A 'weak' external reference is resolved by the linker when a global (or weak) definition is found in one of
the object files. However, a weak reference will not cause the extraction of a module from a library to
resolve the reference.

You can overrule a weak definition with a . GLOBAL definition in another module. The linker will not
complain about the duplicate definition, and ignore the weak definition.

Only program labels and symbols defined with . EQU can be made weak.

Example

LOOPA . EQU 1 ; definition of synbol LOOPA
.GLOBAL LOOPA ; LOOPA will be globally
; accessi bl e by other nodul es
. VEAK LOGPA ; mark synbol LOOPA as weak

Related Information
. EXTERN (Import global section symbol)

. GLOBAL (Declare global section symbol)

101



TASKING VX-toolset for MCS User Guide

.WORD

Syntax

[label:] .WORD argument[, argunent]...

Description

With the . WORD directive the assembler allocates and initializes one word (32 bits) of memory for each
argument.

If you specify the optional label, it gets the value of the location counter at the start of the directive
processing.

An argument can be a single- or multiple-character string constant, an expression or empty.

Multiple arguments are stored in sets of four bytes. One or more arguments can be null (indicated by two
adjacent commas), in which case the corresponding byte location will be filled with zeros.

The value of the arguments must be in range with the size of the directive; floating-point numbers are not
allowed. If the evaluated argument is too large to be represented in a word, the assembler issues a
warning and truncates the value.

String constants

Single-character strings are stored in the most significant byte of a word, where the lower seven bits in
that byte represent the ASCII value of the character, for example:

.WORD 'R ;= 0x52000000

Multiple-character strings are stored in consecutive byte addresses, as shown below. The standard C
language escape characters like ‘\n’ are permitted.

.WORD ' ABCD ;= 0x44434241

Related Information

. SPACE (Define Storage)
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2.9.2. Assembler Controls

Controls start with a $ as the first character on the line. Unknown controls are ignored after a warning is
issued.

Overview of assembler listing controls

Control Description

$LI ST OV OFF Print / do not print source lines to list file

$PAGE Generate form feed in list file

$PACE settings Define page layout for assembly list file

$PRCTL Send control string to printer

$STI TLE Set program subtitle in header of assembly list file
$TI TLE Set program title in header of assembly list file

Overview of miscellaneous assembler controls

Control Description

$CASE QV OFF Case sensitive user names ON/OFF

$DEBUG ON/ OFF Generation of symbolic debug ON/OFF

$I DENT LOCAL/ GLOBAL |Assembler treats labels by default as local or global
$OBJECT Alternative name for the generated object file
$WARNI NG OFF [num] Suppress all or some warnings
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$CASE

Syntax

$CASE ON
$CASE OFF

Default
$CASE ON
Description

With the $CASE ONand $CASE OFF controls you specify wether the assembler operates in case sensitive
mode or not. By default the assembler operates in case sensitive mode. This means that all user-defined
symbols and labels are treated case sensitive, so LAB and Lab are distinct.

Note that the instruction mnemonics, register names, directives and controls are always treated case
insensitive.

Example

; begin of source
$CASE OFF ; assenbler in case insensitive node

Related Information

Assembler option --case-insensitive
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$DEBUG
Syntax
$DEBUG ON
$DEBUG COFF
Default
$DEBUG OFF
Description

With the $DEBUG ON and $DEBUG OFF controls you turn the generation of debug information on or off.
($DEBUG ONis similar to the assembler option --debug-info=+asm,+local (-gal).

Example

; begin of source
$DEBUG ON ; generate |local synbols debug information

Related Information

Assembler option --debug-info
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$IDENT

Syntax

$1 DENT LOCAL
$1 DENT GLOBAL

Default

$! DENT LOCAL

Description

With the controls $I DENT LOCAL and $1 DENT GLOBAL you tell the assembler how to treat symbols that
you have not specified explicitly as local or global with the assembler directives . LOCAL or . GLOBAL.

By default the assembler treats all symbols as local symbols unless you have defined them to be global
explicitly.

Example

; begin of source
$I DENT GLOBAL ; assenbly |abels are gl obal by default

Related Information
Assembler directive .GLOBAL
Assembler directive .LOCAL

Assembler option --symbol-scope

106



Assembly Language

$LIST ON/OFF

Syntax

$LI ST ON
$LI ST OFF

Default

$LI ST ON

Description

If you generate a list file with the assembler option --list-file, you can use the $LI ST ONand $LI ST
OFF controls to specify which source lines the assembler must write to the list file. Without the assembler
option --list-file these controls have no effect. The controls take effect starting at the next line.

The $LI ST ONcontrol actually increments a counter that is checked for a positive value and is symmetrical
with respect to the $L1 ST OFF control. Note the following sequence:

; Counter value currently 1

$LI ST ON ;. Counter value = 2
$LI ST ON ;. Counter value = 3
$LI ST OFF ;. Counter value = 2
$LI ST OFF ;. Counter value =1

The listing still would not be disabled until another $L1 ST OFF control was issued.

Example

. SDECL ". ntstext.code", code

.SECT ".ntstext.code"

...  source lineinlist file
$LI ST OFF

...  source line not inlist file
$LI ST ON

...  source line alsoinlist file

Related Information
Assembler option --list-file

Assembler function @LST()
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$OBJIECT

Syntax

$OBIECT "file"
$OBJECT OFF

Default
$OBJECT
Description

With the $OBJECT control you can specify an alternative name for the generated object file. With the
$OBJECT OFF control, the assembler does not generate an object file at all.

Example

; Begin of source
$obj ect "x1.0" ; generate object file x1.0

Related Information

Assembler option --output
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$PAGE

Syntax

$PAGE [ pagew dt h[, pagel engt h[, bl ankl ef t[, bl ankt op[, bl ankbtnj]]]
Default

$PAGE 132,72,0,0,0

Description

If you generate a list file with the assembler option --list-file, you can use the $PAGE control to format
the generated list file.

The arguments may be any positive absolute integer expression, and must be separated by commas.

pagewidth Number of columns per line. The default is 132, the minimum is 40.

pagelength Total number of lines per page. The default is 72, the minimum is 10.
As a special case, a page length of 0 turns off page breaks.

blankleft Number of blank columns at the left of the page. The default is 0, the
minimum is 0, and the maximum must maintain the relationship: blankleft
< pagewidth.

blanktop Number of blank lines at the top of the page. The default is 0, the

minimum is 0 and the maximum must be a value so that (blanktop +
blankbtm) < (pagelength - 10).

blankbtm Number of blank lines at the bottom of the page. The default is 0, the
minimum is 0 and the maximum must be a value so that (blanktop +
blankbtm) < (pagelength - 10).

If you use the $PAGE control without arguments, it causes a 'formfeed': the next source line is printed on
the next page in the list file. The $PACE control itself is not printed.

Example

$PAGE ; fornfeed, the next source line is printed
; on the next page in the list file.

$PAGE 96 ; set page width to 96. Note that you can

; omit the last four argunents.
$PAGE ,,,3,3 ; use 3 line top/bottom nmargins.

Related Information

Assembler option --list-file
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$PRCTL

Syntax

$PRCTL exp|string[,exp|string]...
Description

If you generate a list file with the assembler option --list-file, you can use the $PRCTL control to send
control strings to the printer.

The $PRCTL control simply concatenates its arguments and sends them to the listing file (the control line
itself is not printed unless there is an error).

You can specify the following arguments:

expr A byte expression which may be used to encode non-printing control characters, such as ESC.

string  An assembler string, which may be of arbitrary length, up to the maximum assembler-defined
limits.

The $PRCTL control can appear anywhere in the source file; the assembler sends out the control string
at the corresponding place in the listing file.

If a $PRCTL control is the last line in the last input file to be processed, the assembler insures that all
error summaries, symbol tables, and cross-references have been printed before sending out the control
string. In this manner, you can use a $PRCTL control to restore a printer to a previous mode after printing
is done.

Similarly, if the $PRCTL control appears as the first line in the first input file, the assembler sends out the
control string before page headings or titles.

Example

$PRCTL $1B,'FE ; Reset HP LaserJet printer

Related Information

Assembler option --list-file
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$STITLE

Syntax

$STI TLE "string"
Default
$STITLE ""

Description

If you generate a list file with the assembler option --list-file, you can use the $STI TLE control to specify
the program subtitle which is printed at the top of all succeeding pages in the assembiler list file below
the title.

The specified subtitle is valid until the assembler encounters a new $STI TLE control. By default, the
subtitle is empty.

The $STI TLE control itself will not be printed in the source listing.
If the page width is too small for the title to fit in the header, it will be truncated.
Example

$TI TLE "This is the title'
$STITLE 'This is the subtitle'

Related Information
Assembler option --list-file

Assembler control $TITLE

111



TASKING VX-toolset for MCS User Guide

$TITLE
Syntax
$TI TLE "string"
Default

$TITLE "

Description

If you generate a list file with the assembler option --list-file, you can use the $TI TLE control to specify
the program title which is printed at the top of each page in the assembler list file.

The specified title is valid until the assembler encounters a new $TI TLE control. By default, the title is
empty.

The $TI TLE control itself will not be printed in the source listing.

If the page width is too small for the title to fit in the header, it will be truncated.
Example

$TITLE 'This is the title'

Related Information

Assembler option --list-file

Assembler control $STITLE
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$WARNING OFF

Syntax

$WARNI NG OFF [ nunber]
Default

All warnings are reported.
Description

This control allows you to disable all or individual warnings. The number argument must be a valid warning
message number.

Example

$WARNI NG OFF ; all warning messages are suppressed
$WARNI NG OFF 135 ; suppress warni ng nessage 135

Related Information

Assembler option --no-warnings

113



TASKING VX-toolset for MCS User Guide

2.10. Macro Operations

Macros provide a shorthand method for inserting a repeated pattern of code or group of instructions. You
can define the pattern as a macro, and then call the macro at the points in the program where the pattern
would repeat.

Some patterns contain variable entries which change for each repetition of the pattern. Others are subject
to conditional assembly.

When a macro is called, the assembler executes the macro and replaces the call by the resulting in-line
source statements. 'In-line' means that all replacements act as if they are on the same line as the macro
call. The generated statements may contain substitutable arguments. The statements produced by a
macro can be any processor instruction, almost any assembler directive, or any previously-defined macro.
Source statements resulting from a macro call are subject to the same conditions and restrictions as any
other statements.

Macros can be nested. The assembler processes nested macros when the outer macro is expanded.

2.10.1. Defining a Macro
The first step in using a macro is to define it.
The definition of a macro consists of three parts:
» Header, which assigns a name to the macro and defines the arguments (. MACROdirective).
» Body, which contains the code or instructions to be inserted when the macro is called.
» Terminator, which indicates the end of the macro definition (. ENDMdirective).
A macro definition takes the following form:
nmacro_nanme . MACRO [argunent[, argunent]...]
lm-a;:ro_defi nition_statenents
- ENDM
For more information on the definition see the description of the . MACRO directive.

The . DUP, . DUPA, . DUPC, and . DUPF directives are specialized macro forms to repeat a block of source
statements. You can think of them as a simultaneous definition and call of an unnamed macro. The source
statements between the . DUP, . DUPA, . DUPC, and . DUPF directives and the . ENDMdirective follow the
same rules as macro definitions.

2.10.2. Calling a Macro

To invoke a macro, construct a source statement with the following format:
[l abel] macro_nanme [argunent[,argunment]...] [; comment]

where,

114



Assembly Language

label An optional label that corresponds to the value of the location counter
at the start of the macro expansion.

macro_name The name of the macro. This may not start in the first column.

argument One or more optional, substitutable arguments. Multiple arguments

must be separated by commas.

comment An optional comment.

The following applies to macro arguments:

Each argument must correspond one-to-one with the formal arguments of the macro definition. If the
macro call does not contain the same number of arguments as the macro definition, the assembler
issues a warning.

If an argument has an embedded comma or space, you must surround the argument by single quotes
0-

You can declare a macro call argument as null in three ways:

enter delimiting commas in succession with no intervening spaces

macr onane ARGL, , ARG ; the second argument is a null argunent

terminate the argument list with a comma, the arguments that normally would follow, are now
considered null

macr onane ARGL, ; the second and all follow ng argunents are null

declare the argument as a null string

No character is substituted in the generated statements that reference a null argument.

2.10.3. Using Operators for Macro Arguments

The assembler recognizes certain text operators within macro definitions which allow text substitution of
arguments during macro expansion. You can use these operators for text concatenation, numeric
conversion, and string handling.

Operator |[Name Description

\

Macro argument concatenation | Concatenates a macro argument with adjacent
alphanumeric characters.

Return decimal value of symbol | Substitutes the ?symbol sequence with a character string
that represents the decimal value of the symbol.

Return hex value of symbol Substitutes the %symbol sequence with a character string
that represents the hexadecimal value of the symbol.

Macro string delimiter Allows the use of macro arguments as literal strings.

Macro local label override Prevents name mangling on labels in macros.
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Example: Argument Concatenation Operator -\
Consider the following macro definition:

MAC_A . MACRO reg, val
movl r\reg, val
. ENDM

The macro is called as follows:

MAC A 0, 1

The macro expands as follows:
nmovl roO,1

The macro preprocessor substitutes the character '0' for the argument r eg, and the character '1' for the
argument val . The concatenation operator (\) indicates to the macro preprocessor that the substitution
characters for the arguments are to be concatenated with the character 'r'.

Without the '\' operator the macro would expand as:
movl rreg, 1

which results in an assembler error (invalid operand).

Example: Decimal Value Operator - ?

Instead of substituting the formal arguments with the actual macro call arguments, you can also use the
value of the macro call arguments.

Consider the following source code that calls the macro MAC_A after the argument AVAL has been set to
1.

AVAL . SET 1
MAC_A 0, AVAL

If you want to replace the argument val with the value of AVAL rather than with the literal string ' AVAL' ,
you can use the ? operator and modify the macro as follows:

MAC_A . MACRO r eg, val
movl r\reg, ?val
. ENDM

Example: Hex Value Operator - %

The percent sign (%) is similar to the standard decimal value operator (?) except that it returns the
hexadecimal value of a symbol.

Consider the following macro definition:
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GEN_LAB . MACRO LAB, VAL, STMI
LAB\ W/AL STMT
. ENDM

The macro is called after NUMhas been set to 10:

NUM . SET 10
GEN_LAB  HEX, NUM NOP

The macro expands as follows:
HEXA NOP

The %W/AL argument is replaced by the character 'A’ which represents the hexadecimal value 10 of the
argument VAL.

Example: Argument String Operator - "

To generate a literal string, enclosed by single quotes ('), you must use the argument string operator (*)
in the macro definition.

Consider the following macro definition:

STR_MAC . MACRO STRI NG
.WORD " STRI NG’
. ENDM

The macro is called as follows:
STR_MAC ABCD

The macro expands as follows:
.WORD ' ABCD

Within double quotes . DEFI NE directive definitions can be expanded. Take care when using constructions
with single quotes and double quotes to avoid inappropriate expansions. Since . DEFI NE expansion
occurs before macro substitution, any . DEFI NE symbols are replaced first within a macro argument string:

. DEFI NE LONG 'short'

STR_MAC . MACRO STRI NG
.MESSAGE 'This is a LONG STRI NG
.MESSAGE "This is a LONG STRI NG'
. ENDM

If the macro is called as follows:
STR_MAC sentence

it expands as:
. MESSACE 'This is a LONG STRI NG
.MESSACE 'This is a short sentence'
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Macro Local Label Override Operator - *

If you use labels in macros, the assembler normally generates another unique name for the labels (such
as LAB__M_L000001).

The macro ~-operator prevents name mangling on macro local labels.
Consider the following macro definition:
STA Z . EQU 5

INIT . MACRO ARG CNT
MoV R5, Ox1
NLAB:
.WORD ARG
ADD R5, Ox1
ATUL R5, CNT
JBC STA, STA Z, "LAB
. ENDM

The macro is called as follows:
INNT 2,4
The macro expands as:

MoV R5, Ox1

LAB:
.WORD 2
ADD R5, Ox1
ATUL R5, 4

JBC STA, STA Z, LAB

If you would have omitted the * operator, the macro preprocessor would choose another name for LAB
because the label already exists. The macro would expand like:

MOV RS, 0x1
LAB__M L000001:

.WORD 2
ADD R5, Ox1
ATUL R5, 4

JBC STA, STA Z, LAB__M L000001

2.11. Generic Instructions

The assembler supports so-called 'generic instructions'. Generic instructions are pseudo instructions (ho
instructions from the instruction set). Depending on the situation in which a generic instruction is used,
the assembler replaces the generic instruction with appropriate real assembly instruction(s).

If you select the MCS v1.0 core, the assembler supports the generic instructions MWRL and MWRIL that
are replaced by MWR24 and MWRI24, so that code for newer cores can be built for the MCS v1.0 core.
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If you select any other core than MCS v1.0, the assembler supports the generic instructions MWR24 and
MWRI24 that are replaced by MWRL and MWRIL, so that code for the MCS v1.0 core can be built for
newer cores.

MWRL generic

Convert MWRL to MWR24 on MCS v1.0.

Instruction |Replacement
MWRL A,C MAR24 A, C

MWRIL generic

Convert MWRIL to MWRI24 on MCS v1.0.

Instruction |[Replacement
MWRIL A,B MARI 24 A, B

MWR24 generic

Convert MWR24 to MWRL on MCS v2.0 and later.

Instruction |Replacement
MWR24 A,C MARL A, C

MWRI24 generic

Convert MWRI24 to MWRIL on MCS v2.0 and later.

Instruction [Replacement
MWRI24 A,B MARIL A B
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Chapter 3. Using the C Compiler

This chapter describes the compilation process and explains how to call the C compiler.

The TASKING VX-toolset for MCS under Eclipse uses the TASKING makefile generator and make utility
to build your entire embedded project, from C source till the final ELF/DWARF object file which serves
as input for the debugger.

Although in Eclipse you cannot run the C compiler separately from the other tools, this section discusses
the options that you can specify for the C compiler.

On the command line it is possible to call the C compiler separately from the other tools. However, it is
recommended to use the control program for command line invocations of the toolset (see Section 6.1,
Control Program). With the control program it is possible to call the entire toolset with only one command
line.

The C compiler takes the following files for input and output:
Csource file

~

| » compiler intermediate file

C compiler .
- .mil

assembly file
.src

This chapter first describes the compilation process which consists of a frontend and a backend part.
Next it is described how to call the C compiler and how to use its options. An extensive list of all options
and their descriptions is included in Section 8.1, C Compiler Options. Finally, a few important basic tasks
are described, such as including the C startup code and performing various optimizations.

3.1. Compilation Process

During the compilation of a C program, the C compiler runs through a number of phases that are divided
into two parts: frontend and backend.

The backend part is not called for each C statement, but starts after a complete C module or set of modules
has been processed by the frontend (in memory). This allows better optimization.

The C compiler requires only one pass over the input file which results in relative fast compilation.
Frontend phases

1. The preprocessor phase:

The preprocessor includes files and substitutes macros by C source. It uses only string manipulations
on the C source. The syntax for the preprocessor is independent of the C syntax but is also described
in the ISO/IEC 9899:1999(E) standard.
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. The scanner phase:

The scanner converts the preprocessor output to a stream of tokens.

. The parser phase:

The tokens are fed to a parser for the C grammar. The parser performs a syntactic and semantic
analysis of the program, and generates an intermediate representation of the program. This code is
called MIL (Medium level Intermediate Language).

. The frontend optimization phase:

Target processor independent optimizations are performed by transforming the intermediate code.

Backend phases

1.

Instruction selector phase:

This phase reads the MIL input and translates it into Low level Intermediate Language (LIL). The LIL
objects correspond to a processor instruction, with an opcode, operands and information used within
the C compiler.

. Peephole optimizer/instruction scheduler/software pipelining phase:

This phase replaces instruction sequences by equivalent but faster and/or shorter sequences, rearranges
instructions and deletes unnecessary instructions.

. Register allocator phase:

This phase chooses a physical register to use for each virtual register. When there are not enough
physical registers, virtual registers are spilled to the stack. Intermediate results of any optimization can
live, for some time, on the stack or in physical registers.

. The backend optimization phase:

Performs target processor independent and dependent optimizations which operate on the Low level
Intermediate Language.

. The code generation/formatter phase:

This phase reads through the LIL operations to generate assembly language output.

3.2. Calling the C Compiler

The TASKING VX-toolset for MCS under Eclipse uses the TASKING makefile generator and make utility
to build your entire project. After you have built your project, the output files are available in a subdirectory
of your project directory, depending on the active configuration you have set in the C/C++ Build » Settings
page of the Project » Properties for dialog.
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Building a project under Eclipse

You have several ways of building your project:

Build Selected File(s) (). This compiles and assembles the selected file(s) without calling the linker.
1. In the C/C++ Projects view, select the files you want to compile.

2. Right-click in the C/C++ Projects view and select Build Selected File(s).

* Build Individual Project (1),

To build individual projects incrementally, select Project » Build project.

Rebuild Project (3. This builds every file in the project whether or not a file has been modified since
the last build. A rebuild is a clean followed by a build.

1. Select Project » Clean...
2. Enable the option Start a build immediately and click OK.

 Build Automatically. This performs a build of all projects whenever any project file is saved, such as
your makefile.

This way of building is not recommended for C/C++ development, but to enable this feature select
Project » Build Automatically and ensure there is a check mark beside the Build Automatically
menu item. In order for this option to work, you must also enable option Build on resource save (Auto
build) on the Behavior tab of the C/C++ Build page of the Project » Properties for dialog.

See also Chapter 9, Influencing the Build Time.

Select a target processor (core)

Processor options affect the invocation of all tools in the toolset. In Eclipse you need to set them for each
configuration. Based on the target processor, the compiler includes a special function register file. This
is a regular include file which enables you to use virtual registers that are located in memory.

You can specify the target processor when you create a new project with the New C Project wizard (File
» New » TASKING MCS C Project), but you can always change the processor in the project properties
dialog.

1. From the Project menu, select Properties for
The Properties dialog appears.
2. Inthe left pane, expand C/C++ Build and select Processor.
In the right pane the Processor page appears.
3. From the Configuration list, select a configuration or select[ Al l configurations ].

4. From the Processor selection list, select a processor.
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To access the C compiler options

1.

From the Project menu, select Properties for
The Properties dialog appears.
In the left pane, expand C/C++ Build and select Settings.
In the right pane the Settings appear.
From the Configuration list, select a configuration or select[ All configurations ].
On the Tool Settings tab, select C Compiler.
Select the sub-entries and set the options in the various pages.
Note that the C compiler options are used to create an object file from a C file. The options you

enter in the Assembler page are not only used for hand-coded assembly files, but also for
intermediate assembly files.

Note that when you click Restore Defaults to restore the default tool options, as a side effect the
processor is also reset to its default value on the Processor page (C/C++ Build » Processor).

You can find a detailed description of all C compiler options in Section 8.1, C Compiler Options.

Invocation syntax on the command line:

Cc

ncs [ [option]... [file]... ]...

3.3. How the Compiler Searches Include Files

When you use include files (with the #i ncl ude statement), you can specify their location in several ways.
The compiler searches the specified locations in the following order:

1.

If the #i ncl ude statement contains an absolute pathname, the compiler looks for this file. If no path
or a relative path is specified, the compiler looks in the same directory as the source file. This is only

possible for include files that are enclosed in ™.

This first step is not done for include files enclosed in <>.

. When the compiler did not find the include file, it looks in the directories that are specified in the C

Compiler » Include Paths page in the C/C++ Build » Settings » Tool Settings tab of the Project
Properties dialog (equivalent to option --include-directory (-)).

. When the compiler did not find the include file (because it is not in the specified include directory or
because no directory is specified), it looks in the path(s) specified in the environment variable CMCSI NC.
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4. When the compiler still did not find the include file, it finally tries the default include directory relative
to the installation directory (unless you specified option --no-stdinc).

Example
Suppose that the C source file t est . ¢ contains the following lines:

#i ncl ude <stdio. h>
#i ncl ude "nmnyinc. h"

You can call the compiler as follows:
cnts -lnyinclude test.c

First the compiler looks for the file st di 0. h in the directory nyi ncl ude relative to the current directory.
If it was not found, the compiler searches in the environment variable CMCSI NC and then in the default
i ncl ude directory.

The compiler now looks for the file nyi nc. h, in the directory where t est . ¢ is located. If the file is not
there the compiler searches in the directory myi ncl ude. If it was still not found, the compiler searches
in the environment variable CMCSI NC and then in the default i ncl ude directory.

3.4. Compiling for Debugging

Compiling your files is the first step to get your application ready to run on a target. However, during
development of your application you first may want to debug your application.

To create an object file that can be used for debugging, you must instruct the compiler to include symbolic
debug information in the source file.

To include symbolic debug information

1. From the Project menu, select Properties for
The Properties dialog appears.

2. Inthe left pane, expand C/C++ Build and select Settings.
In the right pane the Settings appear.

3. On the Tool Settings tab, select C Compiler » Debugging.

4. Select Default in the Generate symbolic debug information box.

Debug and optimizations

Due to different compiler optimizations, it might be possible that certain debug information is optimized
away. Therefore, if you encounter strange behavior during debugging it might be necessary to reduce

the optimization level, so that the source code is still suitable for debugging. For more information on
optimization see Section 3.5, Compiler Optimizations.
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Invocation syntax on the command line

The invocation syntax on the command line is:

cncs -g fileoc

3.5. Compiler Optimizations

The compiler has a number of optimizations which you can enable or disable.

1.

From the Project menu, select Properties for

The Properties dialog appears.

In the left pane, expand C/C++ Build and select Settings.

In the right pane the Settings appear.

From the Configuration list, select a configuration or select[ All configurations ].
On the Tool Settings tab, select C Compiler » Optimization.

Select an optimization level in the Optimization level box.

or:

In the Optimization level box select Custom optimization and enable the optimizations you want
on the Custom optimization page.

Optimization levels

The TASKING C compiler offers four optimization levels and a custom level, at each level a specific set
of optimizations is enabled.

Level 0 - No optimization: No optimizations are performed. The compiler tries to achieve a 1-to-1
resemblance between source code and produced code. Expressions are evaluated in the order written
in the source code, associative and commutative properties are not used.

Level 1 - Optimize: Enables optimizations that do not affect the debug-ability of the source code. Use
this level when you encounter problems during debugging your source code with optimization level 2.

Level 2 - Optimize more (default): Enables more optimizations to reduce the memory footprint and/or
execution time. This is the default optimization level.

Level 3 - Optimize most: This is the highest optimization level. Use this level when your
program/hardware has become too slow to meet your real-time requirements.

Custom optimization: you can enable/disable specific optimizations on the Custom optimization page.
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Optimization pragmas

If you specify a certain optimization, all code in the module is subject to that optimization. Within the C
source file you can overrule the C compiler options for optimizations with #pr agna opti m ze fl ag
and #pragma endopti m ze. Nesting is allowed:

#pragma optim ze e /* Enabl e expression
sinplification */
C source ...
#pragma optim ze c /* Enabl e common expression
C. elimnation. Expression
C source ... sinplification still enabled */

#pragma endoptinize /* Disable comopn expression

elimnation */
#pragma endoptinize /* Disable expression
. sinplification */

The compiler optimizes the code between the pragma pair as specified.

You can enable or disable the optimizations described in the following subsection. The command line
option for each optimization is given in brackets.

3.5.1. Generic Optimizations (frontend)

Common subexpression elimination (CSE) (option -Oc/-OC)

The compiler detects repeated use of the same (sub-)expression. Such a "common" expression is replaced
by a variable that is initialized with the value of the expression to avoid recomputation. This method is
called common subexpression elimination (CSE).

A CSE can live in a register, on stack or can be recomputed when required.

Expression simplification (option -Oe/-OE)

Multiplication by 0 or 1 and additions or subtractions of 0 are removed. Such useless expressions may
be introduced by macros or by the compiler itself (for example, array subscripting).

Constant propagation (option -Op/-OP)
A variable with a known value is replaced by that value.
Automatic function inlining (option -Oi/-Ol)

Small functions that are not too often called, are inlined. This reduces execution time at the cost of code
size.
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Control flow simplification (option -Of/-OF)

A number of techniques to simplify the flow of the program by removing unnecessary code and reducing
the number of jumps. For example:

» Switch optimization: A number of optimizations of a switch statement are performed, such as removing
redundant case labels or even removing an entire switch.

» Jump chaining: A (conditional) jump to a label which is immediately followed by an unconditional jump
may be replaced by a jump to the destination label of the second jump. This optimization speeds up
execution.

» Conditional jump reversal: A conditional jump over an unconditional jump is transformed into one
conditional jump with the jump condition reversed. This reduces both the code size and the execution
time.

» Dead code elimination: Code that is never reached, is removed. The compiler generates a warning
messages because this may indicate a coding error.

Subscript strength reduction (option -Os/-0OS)

An array or pointer subscripted with a loop iterator variable (or a simple linear function of the iterator
variable), is replaced by the dereference of a pointer that is updated whenever the iterator is updated.

Loop transformations (option -OI/-OL)

Transform a loop with the entry point at the bottom, to a loop with the entry point at the top. This enables
constant propagation in the initial loop test and code motion of loop invariant code by the CSE optimization.

Forward store (option -Oo/-O0)
A temporary variable is used to cache multiple assignments (stores) to the same non-automatic variable.
3.5.2. Core Specific Optimizations (backend)

Coalescer (option -Oa/-OA)

The coalescer seeks for possibilities to reduce the number of moves (MOV instruction) by smart use of
registers. This optimizes both speed and code size.

Interprocedural register optimization (option -Ob/-OB)
Register allocation is improved by taking note of register usage in functions called by a given function.
Peephole optimizations (option -Oy/-QY)

The generated assembly code is improved by replacing instruction sequences by equivalent but faster
and/or shorter sequences, or by deleting unnecessary instructions.
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Unroll small loops (option -Ou/-OU)

To reduce the number of branches, short loops are eliminated by replacing them with a number of copies.
Generic assembly optimizations (option -Og/-OG)

A set of optimizations on the generated assembly code that increase speed and decrease code size,
similar to peephole optimizations applied within and across basic blocks. The set includes but is not limited
to:

» removal of unused code

» removal of superfluous code

* loop optimizations

* flow optimizations

Shrink wrapping (option -Oh/-OH)

The shrink wrapper tries to move code from the function's prologue/epilogue to a conditional path. The
prologue/epilogue code is then only executed when necessary. For example:

externint e( int * p);

int g;
int h;
int f(int p)
{
int r;
int a;
int b;
r =0;
if (p!'=0)
{
a=g;
b = h;
e( & );
r=a+b
}
return r;
}
When compiled with the shrink wrapper disabled (-OH) this results in:
f: .type func
addl r7,#8 ; function prologue al ways execut ed
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mar i ré, r7,#-4
nov| r5, #0
atul r2, #0
j bs sta, #5,.L2 ; conditional branch
nr d r5,g
mar i r5r7
nr d ré,h
nov r2,r7
call e
nT di r5r7
add r5ré6
L2:
nov r2,r5
nT di ré,r7,#-4 ; function epilogue al ways execut ed
subl r7,#8

When the shrink wrapper is enabled the function's prologue/epilogue code is moved under the i f ()
statement. By doing so, the stack pointer r 7 will only be updated and register r 6 will only be saved/restored
when the assignments and the call to function e() are really executed, and the function will execute

faster when parameter p == 0. With the shrink wrapper enabled (-Oh) this results in:

f: .type func
novl r5, #0
at ul r2, #0
j bs sta, #5,.L2 ; conditional branch
addl r7,#8 ; function prologue conditionally executed
e i ré,r7,#-4
nrd r5,g
e i r5r7
nrd ré,h
nov r2,r7
cal | e
nr di r5r7
add r5r6
nT di ré, r7,#-4 ; function epilogue conditionally executed
subl r7,#8

L2:

nov r2,r5

3.5.3. Optimize for Code Size or Execution Speed
You can tell the compiler to focus on execution speed or code size during optimizations. You can do this

by specifying a size/speed trade-off level from O (speed) to 4 (size). This trade-off does not turn optimization
phases on or off. Instead, its level is a weight factor that is used in the different optimization phases to
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influence the heuristics. The higher the level, the more the compiler focusses on code size optimization.
To choose a trade-off value read the description below about which optimizations are affected and the
impact of the different trade-off values.

Note that the trade-off settings are directions and there is no guarantee that these are followed. The

compiler may decide to generate different code if it assessed that this would improve the result.

Optimization hint: Optimizing for size has a speed penalty and vice versa. The advice is to
optimize for size by default and only optimize those areas for speed that are critical for the
application with respect to speed. Using the tradeoff options -t0, -t1 and -t2 globally for the
application is not recommended.

To specify the size/speed trade-off optimization level:
1. From the Project menu, select Properties for
The Properties dialog appears.
2. Inthe left pane, expand C/C++ Build and select Settings.
In the right pane the Settings appear.
3. On the Tool Settings tab, select C Compiler » Optimization.
4. Select a trade-off level in the Trade-off between speed and size box.

See also C compiler option --tradeoff (-t)

Instruction Selection

Trade-off levels 0, 1 and 2: the compiler selects the instructions with the smallest number of cycles.
Trade-off levels 3 and 4: the compiler selects the instructions with the smallest number of bytes.

Loop Optimization

For a top-loop, the loop is entered at the top of the loop. A bottom-loop is entered at the bottom. Every
loop has a test and a jump at the bottom of the loop, otherwise it is not possible to create a loop. Some
top-loops also have a conditional jump before the loop. This is only necessary when the number of loop
iterations is unknown. The number of iterations might be zero, in this case the conditional jump jumps

over the loop.

Bottom loops always have an unconditional jump to the loop test at the bottom of the loop.

Trade-off value Try to rewrite top-loops to [Optimize loops for
bottom-loops size/speed

0 no speed
yes speed

2 yes speed
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Trade-off value Try to rewrite top-loops to [Optimize loops for
bottom-loops size/speed
yes size
yes size

Example:

unsi gned int a[ 100];

void i( unsigned int |, unsigned int m)
{

unsi gned int i;

for (i =m i <1; i +=4)

{

ali] = 0;
}
return;

}

Coded as a bottom loop (compiled with --tradeoff=4) is:

nmovl b5, #a
nov r4,r3

shl ra, #2

add r5,ré

nmovl r4,#0

jmp .L2 ;; unconditional junp to |loop test at bottom
.L3:

mwi ré4,r5

addl r5, #16

addl r3,#4
.L2: ;; loop entry point

atu r3,r2

j bs sta, #4, . L3

ret

Coded as a top loop (compiled with --tradeoff=0) is:

nmovl b5, #a
nov r4,r3

shl ra, #2

add r5,ré

atu r3,r2 ;; test for at least one loop iteration

j bc sta,#4,.L2 ;; can be omtted when nunber of iterations is known
sub r2,r3

addl r2, #3

shr r2, #2

movl r4,#0

. L3: ;; loop entry point

mwi ré4,r5
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addl r5, #16

subl r2, #1

j bc sta, #5,.L3
.L2:

ret

Automatic Function Inlining

You can enable automatic function inlining with the option --optimize=+inline (-Oi) or by using #pr agna
optim ze +inline.This option is also part of the -O3 predefined option set.

When automatic inlining is enabled, you can use the options --inline-max-incr and --inline-max-size (or
their corresponding pragmas i nl i ne_max_i ncr / inline_max_si ze) to control automatic inlining.
By default their values are set to -1. This means that the compiler will select a value depending upon the
selected trade-off level. The defaults are:

Trade-off value inline-max-incr inline-max-size
0 100 50

1 50 25

2 20 20

3 10 10

4 0 0

For example with trade-off value 1, the compiler inlines all functions that are smaller or equal to 25 internal
compiler units. After that the compiler tries to inline even more functions as long as the function will not
grow more than 50%.

When these options/pragmas are set to a value >= 0, the specified value is used instead of the values
from the table above.

Static functions that are called only once, are always inlined, independent of the values chosen for
inline-max-incr and inline-max-size.

3.6. Static Code Analysis

Static code analysis (SCA) is a relatively new feature in compilers. Various approaches and algorithms
exist to perform SCA, each having specific pros and cons.

SCA Implementation Design Philosophy
SCA is implemented in the TASKING compiler based on the following design criteria:

* An SCA phase does not take up an excessive amount of execution time. Therefore, the SCA can be
performed during a normal edit-compile-debug cycle.

» SCA is implemented in the compiler front-end. Therefore, no new makefiles or work procedures have
to be developed to perform SCA.
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» The number of emitted false positives is kept to a minimum. A false positive is a message that indicates

that a correct code fragment contains a violation of a rule/recommendation. A number of warnings is
issued in two variants, one variant when it is guaranteed that the rule is violated when the code is
executed, and the other variant when the rules is potentially violated, as indicated by a preceding
warning message.

For example see the following code fragment:

extern int some_condition(int);
void f(void)

{
char buf[10];

int i;
for (i = 0; i <= 10; i++)
{

if (some_condition(i))

{
}

buf[i] = 0; /* subscript may be out of bounds */

}

As you can see in this example, if i =10 the array buf [ ] might be accessed beyond its upper boundary,
depending on the result of sone_condi ti on(i).If the compiler cannot determine the result of this
function at run-time, the compiler issues the warning "subscript is possibly out of bounds" preceding
the CERT warning "ARR35: do not allow loops to iterate beyond the end of an array". If the compiler
can determine the result, or ifthe i f statement is omitted, the compiler can guarantee that the "subscript
is out of bounds".

The SCA implementation has real practical value in embedded system development. There are no real
objective criteria to measure this claim. Therefore, the TASKING compilers support well known standards
for safety critical software development such as the MISRA guidelines for creating software for safety
critical automotive systems and secure "CERT C Secure Coding Standard" released by CERT. CERT
is founded by the US government and studies internet and networked systems security vulnerabilities,
and develops information to improve security.

Effect of optimization level on SCA results

The SCA implementation in the TASKING compilers has the following limitations:

Some violations of rules will only be detected when a particular optimization is enabled, because they
rely on the analysis done for that optimization, or on the transformations performed by that optimization.
In particular, the constant propagation and the CSE/PRE optimizations are required for some checks.
It is preferred that you enable these optimizations. These optimizations are enabled with the default
setting of the optimization level (-02).

Some checks require cross-module inspections and violations will only be detected when multiple
source files are compiled and linked together by the compiler in a single invocation.
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3.6.1. C Code Checking: CERT C

The CERT C Secure Coding Standard provides rules and recommendations for secure coding in the C
programming language. The goal of these rules and recommendations is to eliminate insecure coding
practices and undefined behaviors that can lead to exploitable vulnerabilities. The application of the secure
coding standard will lead to higher-quality systems that are robust and more resistant to attack.

For details about the standard, see the CERT C Secure Coding Standard web site. For general information
about CERT secure coding, see www.cert.org/secure-coding.

Versions of the CERT C standard

Version 1.0 of the CERT C Secure Coding Standard is available as a book by Robert C. Seacord
[Addison-Wesley]. Whereas the web site is a wiki and reflects the latest information, the book serves as
a fixed point of reference for the development of compliant applications and source code analysis tools.

The rules and recommendations supported by the TASKING compiler reflect the version of the CERT
web site as of June 1 2009.

The following rules/recommendations implemented by the TASKING compiler, are not part of the book:
PRE11-C, FLP35-C, FLP36-C, MSC32-C

For a complete overview of the supported CERT C recommendations/rules by the TASKING compiler,
see Chapter 15, CERT C Secure Coding Standard.

Priority and Levels of CERT C

Each CERT C rule and recommendation has an assigned priority. Three values are assigned for each
rule on a scale of 1 to 3 for

* severity - how serious are the consequences of the rule being ignored
1. low (denial-of-service attack, abnormal termination)
2. medium (data integrity violation, unintentional information disclosure)
3. high (run arbitrary code)

« likelihood - how likely is it that a flaw introduced by ignoring the rule could lead to an exploitable
vulnerability

1. unlikely
2. probable
3. likely
» remediation cost - how expensive is it to comply with the rule
1. high (manual detection and correction)

2. medium (automatic detection and manual correction)
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3. low (automatic detection and correction)

The three values are then multiplied together for each rule. This product provides a measure that can be
used in prioritizing the application of the rules. These products range from 1 to 27. Rules and
recommendations with a priority in the range of 1-4 are level 3 rules (low severity, unlikely, expensive to
repair flaws), 6-9 are level 2 (medium severity, probable, medium cost to repair flaws), and 12-27 are
level 1 (high severity, likely, inexpensive to repair flaws).

The TASKING compiler checks most of the level 1 and some of the level 2 CERT C recommendations/rules.

For a complete overview of the supported CERT C recommendations/rules by the TASKING compiler,
see Chapter 15, CERT C Secure Coding Standard.

To apply CERT C code checking to your application
1. From the Project menu, select Properties for
The Properties dialog appears.
2. Inthe left pane, expand C/C++ Build and select Settings.
In the right pane the Settings appear.
3. On the Tool Settings tab, select C Compiler » CERT C Secure Coding.
4. Make a selection from the CERT C secure code checking list.

5. If you selected Custom, expand the Custom CERT C entry and enable one or more individual
recommendations/rules.

On the command line you can use the option --cert.
cncs --cert={all | nane [-nane],...]

With --diag=cert you can see a list of the available checks, or you can use a three-letter mnemonic to
list only the checks in a particular category. For example, --diag=pre lists all supported checks in the
preprocessor category.

3.6.2. C Code Checking: MISRA C

The C programming language is a standard for high level language programming in embedded systems,
yet it is considered somewhat unsuitable for programming safety-related applications. Through enhanced
code checking and strict enforcement of best practice programming rules, TASKING MISRA C code
checking helps you to produce more robust code.

MISRA C specifies a subset of the C programming language which is intended to be suitable for embedded
automotive systems. It consists of a set of rules, defined in MISRA-C:2004, Guidelines for the Use of the
C Language in Critical Systems (Motor Industry Research Association (MIRA), 2004).

The compiler also supports MISRA C:1998, the first version of MISRA C and MISRA C: 2012, the latest
version of MISRA C. You can select the version with the following C compiler option:
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--m srac-versi on=1998
--m srac-versi on=2004
--m srac-version=2012

In your C source files you can check against the MISRA C version used. For example:

#if _ M SRAC VERSION__ == 1998
#elif _ M SRAC_VERSION__ == 2004
#elif _ M SRAC_VERSION__ == 2012
#endi f

For a complete overview of all MISRA C rules, see Chapter 16, MISRA C Rules.

Implementation issues

The MISRA C implementation in the compiler supports nearly all rules. Only a few rules are not supported
because they address documentation, run-time behavior, or other issues that cannot be checked by static
source code inspection, or because they require an application-wide overview.

During compilation of the code, violations of the enabled MISRA C rules are indicated with error messages
and the build process is halted.

MISRA C rules are divided in mandatory rules, required rules and advisory rules. If rules are violated,
errors are generated causing the compiler to stop. With the following options warnings, instead of errors,
are generated:

--m srac- nandat or y- war ni ngs
--m srac-required-warni ngs
--m srac-advi sory-war ni ngs

Note that not all MISRA C violations will be reported when other errors are detected in the input
source. For instance, when there is a syntax error, all semantic checks will be skipped, including
some of the MISRA C checks. Also note that some checks cannot be performed when the
optimizations are switched off.

Quality Assurance report

To ensure compliance to the MISRA C rules throughout the entire project, the TASKING linker can
generate a MISRA C Quality Assurance report. This report lists the various modules in the project with
the respective MISRA C settings at the time of compilation. You can use this in your company's quality

assurance system to provide proof that company rules for best practice programming have been applied
in the particular project.

To apply MISRA C code checking to your application

1. From the Project menu, select Properties for
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The Properties dialog appears.
2. Inthe left pane, expand C/C++ Build and select Settings.
In the right pane the Settings appear.
3. On the Tool Settings tab, select C Compiler » MISRA C.
4. Select the MISRA C version (1998, 2004 or 2012).

5. Inthe MISRA C checking box select a MISRA C configuration. Select a predefined configuration
for conformance with the required rules in the MISRA C guidelines.

6. (Optional) In the Custom 1998, Custom 2004 or Custom 2012 entry, specify the individual rules.
On the command line you can use the option --misrac.

cncs --msrac={all | nunber [-nunber],...]

3.7. C Compiler Error Messages

The C compiler reports the following types of error messages in the Problems view of Eclipse.

F ( Fatal errors)

After a fatal error the compiler immediately aborts compilation.

E (Errors)

Errors are reported, but the compiler continues compilation. No output files are produced unless you have
set the C compiler option --keep-output-files (the resulting output file may be incomplete).

W (Warnings)
Warning messages do not result into an erroneous assembly output file. They are meant to draw your
attention to assumptions of the compiler for a situation which may not be correct. You can control warnings

in the C/C++ Build » Settings » Tool Settings » C Compiler » Diagnostics page of the Project »
Properties for menu (C compiler option --no-warnings).

| (Information)

Information messages are always preceded by an error message. Information messages give extra
information about the error.

S (System errors)

System errors occur when internal consistency checks fail and should never occur. When you still receive
the system error message

SO##: internal consistency check failed - please report
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please report the error number and as many details as possible about the context in which the error
occurred.

Display detailed information on diagnostics

1. From the Window menu, select Show View » Other » TASKING » Problems.
The Problems view is added to the current perspective.

2. In the Problems view right-click on a message.
A popup menu appears.

3. Select Detailed Diagnostics Info.
A dialog box appears with additional information.

On the command line you can use the C compiler option --diag to see an explanation of a diagnostic
message:

cncs --diag=[format:]{all | nunber,...]
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Chapter 4. Using the Assembler

This chapter describes the assembly process and explains how to call the assembler.

The assembler converts hand-written or compiler-generated assembly language programs into machine
language, resulting in object files in the ELF/DWARF object format.

The assembler takes the following files for input and output:

assembly file
. 8¥C

assembler

relocatable object file
.0

assembly file (hand coded)

. asm

list file . 1st

————% error messages .ers

The following information is described:
» The assembly process.

» How to call the assembler and how to use its options. An extensive list of all options and their descriptions
is included in Section 8.2, Assembler Options.

» How to generate a list file.

» Types of assembler messages.

4.1. Assembly Process

The assembler generates relocatable output files with the extension . 0. These files serve as input for
the linker.

Phases of the assembly process

 Parsing of the source file: preprocessing of assembler directives and checking of the syntax of
instructions

* Instruction grouping and reordering
» Generation of the relocatable object file and optionally a list file

The assembler integrates file inclusion and macro facilities. See Section 2.10, Macro Operations for more
information.
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4.2. Calling the Assembler

The TASKING VX-toolset for MCS under Eclipse uses the TASKING makefile generator and make utility
to build your entire project. After you have built your project, the output files are available in a subdirectory
of your project directory, depending on the active configuration you have set in the C/C++ Build » Settings
page of the Project » Properties for dialog.

Building a project under Eclipse

You have several ways of building your project:

Build Selected File(s) (). This compiles and assembles the selected file(s) without calling the linker.
1. In the C/C++ Projects view, select the files you want to compile.

2. Right-click in the C/C++ Projects view and select Build Selected File(s).

Build Individual Project (1),

To build individual projects incrementally, select Project » Build project.

Rebuild Project (“), This builds every file in the project whether or not a file has been modified since
the last build. A rebuild is a clean followed by a build.

1. Select Project » Clean...
2. Enable the option Start a build immediately and click OK.

Build Automatically. This performs a build of all projects whenever any project file is saved, such as
your makefile.

This way of building is not recommended, but to enable this feature select Project » Build Automatically
and ensure there is a check mark beside the Build Automatically menu item. In order for this option
to work, you must also enable option Build on resource save (Auto build) on the Behavior tab of
the C/C++ Build page of the Project » Properties for dialog.

Select a target processor (core)

Processor options affect the invocation of all tools in the toolset. In Eclipse you need to set them for each
configuration.

1.

From the Project menu, select Properties for

The Properties dialog appears.

In the left pane, expand C/C++ Build and select Processor.
In the right pane the Processor page appears.

From the Configuration list, select a configuration or select[ All configurations ].
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4. From the Processor selection list, select a processor.

To access the assembler options
1. From the Project menu, select Properties for
The Properties dialog appears.
2. Inthe left pane, expand C/C++ Build and select Settings.
In the right pane the Settings appear.
3. From the Configuration list, select a configuration or select[ All configurations ].
4. On the Tool Settings tab, select Assembler.
5. Select the sub-entries and set the options in the various pages.

Note that the options you enter in the Assembler page are not only used for hand-coded assembly
files, but also for the assembly files generated by the compiler.

Note that when you click Restore Defaults to restore the default tool options, as a side effect the
processor is also reset to its default value on the Processor page (C/C++ Build » Processor).

You can find a detailed description of all assembler options in Section 8.2, Assembler Options.

Invocation syntax on the command line:
asncs [ [option]... [file]... ]...

The input file must be an assembly source file (. asm . nts or . src).

4.3. How the Assembler Searches Include Files

When you use include files (with the . | NCLUDE directive), you can specify their location in several ways.
The assembler searches the specified locations in the following order:

1. If the . | NCLUDE directive contains an absolute path name, the assembler looks for this file. If no path
or a relative path is specified, the assembler looks in the same directory as the source file.

2. When the assembler did not find the include file, it looks in the directories that are specified in the
Assembler » Include Paths page in the C/C++ Build » Settings » Tool Settings tab of the Project
Properties dialog (equivalent to option --include-directory (-I)).

3. When the assembler did not find the include file (because it is not in the specified include directory or
because no directory is specified), it looks in the path(s) specified in the environment variable ASMCSI NC.
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4. When the assembiler still did not find the include file, it finally tries the default include directory relative
to the installation directory.

Example

Suppose that the assembly source file t est . asmcontains the following lines:
. I NCLUDE ' nyi nc. i nc'

You can call the assembler as follows:

asnts -1l nyinclude test.asm

First the assembler looks for the file myi nc. asm in the directory where t est . asmis located. If the file
is not there the assembler searches in the directory nyi ncl ude. If it was still not found, the assembler
searches in the environment variable ASMCSI NC and then in the default i ncl ude directory.

4.4. Generating a List File

The list file is an additional output file that contains information about the generated code. You can
customize the amount and form of information.

If the assembler generates errors or warnings, these are reported in the list file just below the source line
that caused the error or warning.

To generate alist file

1. From the Project menu, select Properties for
The Properties dialog appears.

2. Inthe left pane, expand C/C++ Build and select Settings.
In the right pane the Settings appear.

3. On the Tool Settings tab, select Assembler » List File.

4. Enable the option Generate list file.

5. (Optional) Enable the options to include that information in the list file.

Example on the command line
The following command generates the listfile t est . | st :
asncts -1 test.asm

See Section 11.1, Assembler List File Format, for an explanation of the format of the list file.
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4.5. Assembler Error Messages

The assembler reports the following types of error messages in the Problems view of Eclipse.

F ( Fatal errors)

After a fatal error the assembler immediately aborts the assembly process.

E (Errors)

Errors are reported, but the assembler continues assembling. No output files are produced unless you
have set the assembler option --keep-output-files (the resulting output file may be incomplete).

W (Warnings)

Warning messages do not result into an erroneous assembly output file. They are meant to draw your
attention to assumptions of the assembler for a situation which may not be correct. You can control
warnings in the C/C++ Build » Settings » Tool Settings » Assembler » Diagnostics page of the Project
» Properties for menu (assembler option --no-warnings).

Display detailed information on diagnostics

1. From the Window menu, select Show View » Other » TASKING » Problems.
The Problems view is added to the current perspective.

2. In the Problems view right-click on a message.
A popup menu appears.

3. Select Detailed Diagnostics Info.
A dialog box appears with additional information.

On the command line you can use the assembler option --diag to see an explanation of a diagnostic
message:

asncs --diag=[format:]{all | nunber,...]
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Chapter 5. Using the Linker

This chapter describes the linking process, how to call the linker and how to control the linker with a script
file.

The TASKING linker is a combined linker/locator. The linker phase combines relocatable object files (. 0
files, generated by the assembler), and libraries into a single relocatable linker object file (. out ). The

locator phase assigns absolute addresses to the linker object file and creates an absolute object file which
you can load into a target processor. From this point the term linker is used for the combined linker/locator.

The linker can simultaneously link and locate all programs for all cores available on a target board. The

target board may be of arbitrary complexity. A simple target board may contain one standard processor

with some external memory that executes one task. A complex target board may contain multiple standard
processors and DSPs combined with configurable IP-cores loaded in an FPGA. Each core may execute
a different program, and external memory may be shared by multiple cores.

The linker takes the following files for input and output:

relocatable object files
el

relocatable linker object file
.out

relocatable object library
.a

linker script file

sl linker map file .map

linker
———-» error messages .elk

relocatable linker object file
.out

memory definition file . mdf

v v '

Intel Hex ELF/DWARF Motorola S-record
absolute object file  absolute object file  absolute object file
.hex .elf .sre

This chapter first describes the linking process. Then it describes how to call the linker and how to use
its options. An extensive list of all options and their descriptions is included in Section 8.3, Linker Options.

To control the link process, you can write a script for the linker. This chapter shortly describes the purpose
and basic principles of the Linker Script Language (LSL) on the basis of an example. A complete description
of the LSL is included in Linker Script Language.

5.1. Linking Process

The linker combines and transforms relocatable object files (. 0) into a single absolute object file. This
process consists of two phases: the linking phase and the locating phase.

In the first phase the linker combines the supplied relocatable object files and libraries into a single
relocatable object file. In the second phase, the linker assigns absolute addresses to the object file so it
can actually be loaded into a target.
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Terms used in the linking process

Term

Definition

Absolute object file

Address
Address space

Architecture

Copy table

Core
Derivative

Library

Logical address

LSL file
MAU

Object code
Physical address
Processor

Relocatable object
file

Relocation
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Object code in which addresses have fixed absolute values, ready to load into a
target.

A specification of a location in an address space.

The set of possible addresses. A core can support multiple spaces, for example in
a Harvard architecture the addresses that identify the location of an instruction
refer to code space, whereas addresses that identify the location of a data object
refer to a data space.

A description of the characteristics of a core that are of interest for the linker. This
encompasses the address space(s) and the internal bus structure. Given this
information the linker can convert logical addresses into physical addresses.

A section created by the linker. This section contains data that specifies how the
startup code initializes the data and BSS sections. For each section the copy table
contains the following fields:

« action: defines whether a section is copied or zeroed
» destination: defines the section's address in RAM
* source: defines the sections address in ROM, zero for BSS sections

« length: defines the size of the section in MAUs of the destination space

An instance of an architecture.

The design of a processor. A description of one or more cores including internal
memory and any number of buses.

Collection of relocatable object files. Usually each object file in a library contains
one symbol definition (for example, a function).

An address as encoded in an instruction word, an address generated by a core
(CPU).

The set of linker script files that are passed to the linker.

Minimum Addressable Unit. For a given processor the number of bits between an
address and the next address. This is not necessarily a byte or a word.

The binary machine language representation of the C/assembly source.
An address generated by the memory system.

An instance of a derivative. Usually implemented as a (custom) chip, but can also
be implemented in an FPGA, in which case the derivative can be designed by the
developer.

Object code in which addresses are represented by symbols and thus relocatable.

The process of assigning absolute addresses.
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Term Definition

Relocation Information about how the linker must modify the machine code instructions when

information it relocates addresses.

Section A group of instructions and/or data objects that occupy a contiguous range of
addresses.

Section attributes  Attributes that define how the section should be linked or located.

Target The hardware board on which an application is executing. A board contains at least
one processor. However, a complex target may contain multiple processors and
external memory and may be shared between processors.

Unresolved A reference to a symbol for which the linker did not find a definition yet.

reference

5.1.1. Phase 1: Linking

The linker takes one or more relocatable object files and/or libraries as input. A relocatable object file, as
generated by the assembler, contains the following information:

» Header information: Overall information about the file, such as the code size, name of the source file
it was assembled from, and creation date.

» Object code: Binary code and data, divided into various named sections. Sections are contiguous
chunks of code that have to be placed in specific parts of the memory. The program addresses start
at zero for each section in the object file.

» Symbols: Some symbols are exported - defined within the file for use in other files. Other symbols are
imported - used in the file but not defined (external symbols). Generally these symbols are names of
routines or names of data objects.

» Relocation information: A list of places with symbolic references that the linker has to replace with
actual addresses. When in the code an external symbol (a symbol defined in another file or in a library)
is referenced, the assembler does not know the symbol's size and address. Instead, the assembler
generates a call to a preliminary relocatable address (usually 0000), while stating the symbol name.

» Debug information: Other information about the object code that is used by a debugger. The assembler
optionally generates this information and can consist of line numbers, C source code, local symbols
and descriptions of data structures.

The linker resolves the external references between the supplied relocatable object files and/or libraries
and combines the files into a single relocatable linker object file.

The linker starts its task by scanning all specified relocatable object files and libraries. If the linker
encounters an unresolved symbol, it remembers its name and continues scanning. The symbol may be
defined elsewhere in the same file, or in one of the other files or libraries that you specified to the linker.
If the symbol is defined in a library, the linker extracts the object file with the symbol definition from the
library. This way the linker collects all definitions and references of all of the symbols.

Next, the linker combines sections with the same section name and attributes into single sections. The
linker also substitutes (external) symbol references by (relocatable) numerical addresses where possible.
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At the end of the linking phase, the linker either writes the results to a file (a single relocatable object file)
or keeps the results in memory for further processing during the locating phase.

The resulting file of the linking phase is a single relocatable object file (. out ). If this file contains unresolved
references, you can link this file with other relocatable object files (. 0) or libraries (. a) to resolve the
remaining unresolved references.

With the linker command line option --link-only, you can tell the linker to only perform this linking phase
and skip the locating phase. The linker complains if any unresolved references are left.

5.1.2. Phase 2: Locating

In the locating phase, the linker assigns absolute addresses to the object code, placing each section in
a specific part of the target memory. The linker also replaces references to symbols by the actual address
of those symbols. The resulting file is an absolute object file which you can actually load into a target
memory. Optionally, when the resulting file should be loaded into a ROM device the linker creates a
so-called copy table section which is used by the startup code to initialize the data and BSS sections.

Code modification

When the linker assigns absolute addresses to the object code, it needs to modify this code according
to certain rules or relocation expressions to reflect the new addresses. These relocation expressions are
stored in the relocatable object file. Consider the following snippet of x86 code that moves the contents
of variable a to variable b via the eax register:

Al 3412 0000 nov a, %eax (a defined at 0x1234, byte reversed)
A3 0000 0000 rmov %ax, b (b is inported so the instruction refers to
0x0000 since its |location is unknown)

Now assume that the linker links this code so that the section in which a is located is relocated by 0x10000
bytes, and b turns out to be at 0x9A12. The linker modifies the code to be:

Al 3412 0100 nov a, %eax (0x10000 added to the address)
A3 129A 0000 nov %ax, b (0x9A12 patched in for b)

These adjustments affect instructions, but keep in mind that any pointers in the data part of a relocatable
object file have to be modified as well.

Output formats

The linker can produce its output in different file formats. The default ELF/DWARF format (. el f ) contains
an image of the executable code and data, and can contain additional debug information. The Intel-Hex
format (. hex) and Motorola S-record format (. sr €) only contain an image of the executable code and
data. You can specify a format with the options --output (-0) and --chip-output (-c).

Controlling the linker

Via a so-called linker script file you can gain complete control over the linker. The script language is called
the Linker Script Language (LSL). Using LSL you can define:

» The memory installed in the embedded target system:
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To assign locations to code and data sections, the linker must know what memory devices are actually
installed in the embedded target system. For each physical memory device the linker must know its
start-address, its size, and whether the memory is read-write accessible (RAM) or read-only accessible
(ROM).

» How and where code and data should be placed in the physical memory:

Embedded systems can have complex memory systems. If for example on-chip and off-chip memory
devices are available, the code and data located in internal memory is typically accessed faster and
with dissipating less power. To improve the performance of an application, specific code and data
sections should be located in on-chip memory. By writing your own LSL file, you gain full control over
the locating process.

» The underlying hardware architecture of the target processor.

To perform its task the linker must have a model of the underlying hardware architecture of the processor
you are using. For example the linker must know how to translate an address used within the object
file (a logical address) into an offset in a particular memory device (a physical address). In most linkers
this model is hard coded in the executable and can not be modified. For the TASKING linker this
hardware model is described in the linker script file. This solution is chosen to support configurable
cores that are used in system-on-chip designs.

When you want to write your own linker script file, you can use the standard linker script files with
architecture descriptions delivered with the product.

See also Section 5.7, Controlling the Linker with a Script.

5.2. Calling the Linker

In Eclipse you can set options specific for the linker. After you have built your project, the output files are
available in a subdirectory of your project directory, depending on the active configuration you have set
in the C/C++ Build » Settings page of the Project » Properties for dialog.

Building a project under Eclipse

You have several ways of building your project:

* Build Individual Project (&T),

To build individual projects incrementally, select Project » Build project.

Rebuild Project (“). This builds every file in the project whether or not a file has been modified since
the last build. A rebuild is a clean followed by a build.

1. Select Project » Clean...

2. Enable the option Start a build immediately and click OK.
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 Build Automatically. This performs a build of all projects whenever any project file is saved, such as
your makefile.

This way of building is not recommended, but to enable this feature select Project » Build Automatically
and ensure there is a check mark beside the Build Automatically menu item. In order for this option
to work, you must also enable option Build on resource save (Auto build) on the Behavior tab of
the C/C++ Build page of the Project » Properties for dialog.

To access the linker options
1. From the Project menu, select Properties for
The Properties dialog appears.
2. Inthe left pane, expand C/C++ Build and select Settings.
In the right pane the Settings appear.
3. From the Configuration list, select a configuration or select[ Al configurations ].
4. On the Tool Settings tab, select Linker.
5. Select the sub-entries and set the options in the various pages.

Note that when you click Restore Defaults to restore the default tool options, as a side effect the
processor is also reset to its default value on the Processor page (C/C++ Build » Processor).

You can find a detailed description of all linker options in Section 8.3, Linker Options.

Invocation syntax on the command line:
Imcs [ [option]... [file]l... 1...

When you are linking multiple files, either relocatable object files (. 0) or libraries (. a), it is important to
specify the files in the right order. This is explained in Section 5.3, Linking with Libraries.

You can find a detailed description of all linker options in Section 8.3, Linker Options.
Example:
Incs -dgtnB1_08.1sl test.o

This links and locates the file t est . 0 and generates the filet est . el f.

5.3. Linking with Libraries

There are two kinds of libraries: system libraries and user libraries.
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System library
System libraries are stored in the directory:

<installation path>\1ib\ncs30\[be|le][\nnd] (MCS v3.0 libraries)
<installation path>\Iib\ncs31\[be|le][\nmd] (MCS v3.1 libraries)
<installation path>\Iib\ncs40\[be|le][\nnd] (MCS v4.0 libraries)

The libraries are available in big-endian (be) or little-endian (le) variants. For MCS cores without multiply
and/or divide support, the libraries are present in the nnd directory.

An overview of the system libraries is given in the table in Chapter 10, Libraries.

Sources for the libraries are present in the directories | i b\ src, | i b\ src. * in the form of an executable.
If you run the executable it will extract the sources in the corresponding directory.

To link the default C (system) libraries

1. From the Project menu, select Properties for
The Properties dialog appears.

2. Inthe left pane, expand C/C++ Build and select Settings.
In the right pane the Settings appear.

3. On the Tool Settings tab, select Linker » Libraries.

4. Enable the option Link default libraries.

When you want to link system libraries from the command line, you must specify this with the option
--library (-1). For example, to specify the system library | i bc. a, type:

Incs --library=c test.o

User library

You can create your own libraries. Section 6.3, Archiver describes how you can use the archiver to create
your own library with object modules.

To link user libraries

1. From the Project menu, select Properties for
The Properties dialog appears.

2. Inthe left pane, expand C/C++ Build and select Settings.
In the right pane the Settings appear.

3. On the Tool Settings tab, select Linker » Libraries.
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4. Add your libraries to the Libraries box.

When you want to link user libraries from the command line, you must specify their filenames on the
command line:

Incs start.o nylib.a
If the library resides in a sub-directory, specify that directory with the library name:
Incs start.o nylibs\nylib.a

If you do not specify a directory, the linker searches the library in the current directory only.

Library order

The order in which libraries appear on the command line is important. By default the linker processes
object files and libraries in the order in which they appear at the command line. Therefore, when you use
a weak symbol construction, like pri nt f , in an object file or your own library, you must position this
object/library before the C library.

With the option --first-library-first you can tell the linker to scan the libraries from left to right, and extract
symbols from the first library where the linker finds it. This can be useful when you want to use newer
versions of a library routine:

Incs --first-library-first a.a test.o b.a

If the file t est . o calls a function which is both presentin a. a and b. a, normally the functionin b. a
would be extracted. With this option the linker first tries to extract the symbol from the first library a. a.

Note that routines in b. a that call other routines that are present in both a. a and b. a are now also
resolved from a. a.

5.3.1. How the Linker Searches Libraries

System libraries

You can specify the location of system libraries in several ways. The linker searches the specified locations
in the following order:

1. The linker first looks in the Library search path that are specified in the Linker » Libraries page in
the C/C++ Build » Settings » Tool Settings tab of the Project Properties dialog (equivalent to the
option --library-directory (-L)). If you specify the -L option without a pathname, the linker stops
searching after this step.

2. When the linker did not find the library (because it is not in the specified library directory or because
no directory is specified), it looks in the path(s) specified in the environment variables LI BMCS /
LIBMCS2_ 0 / LIBMCS3_0 / LIBMCS3_1 / LIBMCS4_0.

3. When the linker did not find the library, it tries the default | i b directory relative to the installation
directory (or a processor specific sub-directory).
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User library

If you use your own library, the linker searches the library in the current directory only.

5.3.2. How the Linker Extracts Objects from Libraries

A library built with the TASKING archiver armcs always contains an index part at the beginning of the
library. The linker scans this index while searching for unresolved externals. However, to keep the index
as small as possible, only the defined symbols of the library members are recorded in this area.

When the linker finds a symbol that matches an unresolved external, the corresponding object file is
extracted from the library and is processed. After processing the object file, the remaining library index
is searched. If after a complete search of the library unresolved externals are introduced, the library index
will be scanned again. After all files and libraries are processed, and there are still unresolved externals
and you did not specify the linker option --no-rescan, all libraries are rescanned again. This way you do
not have to worry about the library order on the command line and the order of the object files in the
libraries. However, this rescanning does not work for ‘weak symbols'. If you use a weak symbol construction,
like pri nt f,in an object file or your own library, you must position this object/library before the C library.

The option --verbose (-v) shows how libraries have been searched and which objects have been extracted.

Resolving symbols

If you are linking from libraries, only the objects that contain symbols to which you refer, are extracted
from the library. This implies that if you invoke the linker like:

Incs nylib.a

nothing is linked and no output file will be produced, because there are no unresolved symbols when the
linker searches through nyl i b. a.

It is possible to force a symbol as external (unresolved symbol) with the option --extern (-e):
Incs --extern=nain nylib.a

In this case the linker searches for the symbol mai n in the library and (if found) extracts the object that
contains mai n.

If this module contains new unresolved symbols, the linker looks again in nyl i b. a. This process repeats
until no new unresolved symbols are found.

5.4. Incremental Linking

With the TASKING linker it is possible to link incrementally. Incremental linking means that you link some,
but not all . 0 modules to a relocatable object file . out . In this case the linker does not perform the locating

phase. With the second invocation, you specify both new . o files as the . out file you had created with
the first invocation.

Incremental linking is only possible on the command line.
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Inmcs --increnental testl.o -otest. out
I ncs test2.0 test. out

This links the file t est 1. o and generates the file t est . out . This file is used again and linked together
with t est 2. o to create the file t est . el f (the default name if no output filename is given in the default
ELF/DWARF format).

With incremental linking it is normal to have unresolved references in the output file until all . o files are
linked and the final . out or . el f file has been reached. The option --incremental (-r) for incremental
linking also suppresses warnings and errors because of unresolved symbols.

5.5. Importing Binary Files

With the TASKING linker it is possible to add a binary file to your absolute output file. In an embedded
application you usually do not have a file system where you can get your data from.

Add a data object in Eclipse
1. SelectLinker » Data Objects.
The Data objects box shows the list of object files that are imported.
2. To add a data object, click on the Add button in the Data objects box.
3. Type or select a binary file (including its path).
On the command line you can add raw data to your application with the linker option --import-object.

This makes it possible for example to display images on a device or play audio. The linker puts the raw
data from the binary file in a section. The section is aligned on a 4-byte boundary. The section name is
derived from the filename, in which dots are replaced by an underscore. So, when importing a file called
ny. np3, a section with the name nmy_np3 is created. In your application you can refer to the created
section by using linker labels.

For example:
.extern __lc_ub_ny_nmp3; /* linker |abels */
.extern __lc_ue_ny_np3;

If you want to use the export functionality of Eclipse, the binary file has to be part of your project.

5.6. Linker Optimizations

During the linking and locating phase, the linker looks for opportunities to optimize the object code. Both
code size and execution speed can be optimized.
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To enable or disable optimizations

1. From the Project menu, select Properties for
The Properties dialog appears.

2. Inthe left pane, expand C/C++ Build and select Settings.
In the right pane the Settings appear.

3. On the Tool Settings tab, select Linker » Optimization.

4. Enable one or more optimizations.

You can enable or disable the optimizations described below. The command line option for each
optimization is given in brackets.

Delete unreferenced sections (option -Oc/-OC)
This optimization removes unreferenced sections from the resulting object file.
This optimization considers a section referenced if either of the following two conditions is true:
1. The section is protected from unreferenced section removal, which can be one of:
« the section is assigned an absolute address, either in the object file or in LSL
* the section is selected by exact name in LSL (no wildcard pattern) .
» asymbol defined in the section is referenced in LSL
« the section has the 'protected' section flag set, either in the object file or in LSL
2. The section is referenced via a relocation by another section that is considered referenced.

"I multiple sections of a specific name are created by using section renaming, all of these sections are
protected against unreferenced section removal. With a selection using wildcards, matching sections are
selected, but matching sections that are unreferenced may be removed. See Selecting sections for a
group in Section 13.8.2, Creating and Locating Groups of Sections.

First fit decreasing (option -OI/-OL)

When the physical memory is fragmented or when address spaces are nested it may be possible that a
given application cannot be located although the size of the available physical memory is larger than the
sum of the section sizes. Enable the first-fit-decreasing optimization when this occurs and re-link your
application.

The linker's default behavior is to place sections in the order that is specified in the LSL file (that is, working
from low to high memory addresses or vice versa). This also applies to sections within an unrestricted
group. If a memory range is partially filled and a section must be located that is larger than the remainder
of this range, then the section and all subsequent sections are placed in a next memory range. As a result
of this gaps occur at the end of a memory range.
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When the first-fit-decreasing optimization is enabled the linker will first place the largest sections in the
smallest memory ranges that can contain the section. Small sections are located last and can likely fit in
the remaining gaps.

Compress copy table (option -Ot/-OT)

The startup code initializes the application's data areas. The information about which memory addresses
should be zeroed and which memory ranges should be copied from ROM to RAM is stored in the copy
table.

When this optimization is enabled the linker will try to locate sections in such a way that the copy table
is as small as possible thereby reducing the application's ROM image.

Note that this optimization only affects unrestricted sections that require an initialization action in
the copy table. The affected sections get a clustered restriction. Unrestricted sections are sections
that do not have their absolute location or their relative location to other sections restricted. See
also Define the mutual order of sections in an LSL group in Section 13.8.2, Creating and Locating
Groups of Sections.

Delete duplicate code (option -Ox/-OX)

Delete duplicate constant data (option -Oy/-QY)

These two optimizations remove code and constant data that is defined more than once, from the resulting
object file.

5.7. Controlling the Linker with a Script

With the options on the command line you can control the linker's behavior to a certain degree. From
Eclipse itis also possible to determine where your sections will be located, how much memory is available,
which sorts of memory are available, and so on. Eclipse passes these locating directions to the linker via
a script file. If you want even more control over the locating process you can supply your own script.

The language for the script is called the Linker Script Language, or shortly LSL. You can specify the script
file to the linker, which reads it and locates your application exactly as defined in the script. If you do not
specify your own script file, the linker always reads a standard script file which is supplied with the toolset.

5.7.1. Purpose of the Linker Script Language
The Linker Script Language (LSL) serves three purposes:

1. It provides the linker with a definition of the target's core architecture. This definition is supplied with
the toolset.

2. It provides the linker with a specification of the memory attached to the target processor.

3. It provides the linker with information on how your application should be located in memory. This gives
you, for example, the possibility to create overlaying sections.
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The linker accepts multiple LSL files. You can use the specifications of the core architectures that Altium
has supplied in the i ncl ude. | sl directory. Do not change these files.

If you use a different memory layout than described in the LSL file supplied for the target core, you must
specify this in a separate LSL file and pass both the LSL file that describes the core architecture and your
LSL file that contains the memory specification to the linker. Next you may want to specify how sections
should be located and overlaid. You can do this in the same file or in another LSL file.

LSL has its own syntax. In addition, you can use the standard C preprocessor keywords, such as #i ncl ude
and #def i ne, because the linker sends the script file first to the C preprocessor before it starts interpreting
the script.

The complete LSL syntax is described in Chapter 13, Linker Script Language (LSL).

5.7.2. Eclipse and LSL

In Eclipse you can specify the size of the stack and heap; the physical memory attached to the processor;
identify that particular address ranges are reserved; and specify which sections are located where in
memory. Eclipse translates your input into an LSL file that is stored in the project directory under the
name project_name. | sl and passes this file to the linker. If you want to learn more about LSL you can
inspect the generated file project_name. | sl .

To add a generated Linker Script File to your project
1. From the File menu, select File » New » TASKING MCS C Project.
The New C Project wizard appears.

2. Fillin the project settings in each dialog and click Next > until the following dialog appears.
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{2} New Assembly/C Project = @

MCS Project Settings =

€3 Select a processor te continue

Processor selection

» [ Bosch GTM basic definitions Expand Al
Expand Selected
Collapse All

Multi-core configuration

Actions
[#] Add linker script file to the project

3. Enable the option Add linker script file to the project and click Finish.
Eclipse creates your project and the file "project_name. | sl " in the project directory.

If you do not add the linker script file here, you can always add it later with File » New » Linker Script
File (LSL)

To change the Linker Script File in Eclipse
There are two ways of changing the LSL file in Eclipse.
* You can change the LSL file directly in an editor.

1. Double-click on the file project_name. | sl .

The project LSL file opens in the editor area.
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bl myproject.lsl 52 = O

'/ TASKING VX-toolset for MCS -
Eclipse project linker script file

#if defined(_ PROC_GTM31_@2_ )
#define GTM_REDEFINE_ON_CHIP_ITEMS
#include "gtm31_e2.1s1"

processor gtm31 82

{ E
derivative = my_gtm31_@2;
}
derivative my_gtm31l_82 extends gtm31_82
{
memory mcs@@ (tag="ocn-chip")
mau = 3;
write_unit = 4;
type = ram;
size = Bk+8k>>1;
map ram@(dest=bus:aei, src_offset=8, dest_offset=0x33008, siz
map raml(dest=bus:aei, src_offset=8k, dest_offset=0x35008+3k,
map mcs_ram@(dest=bus:mcs@@:mcs_bus, src_offset=8, dest_offse
map mcs_raml(dest=bus:mcs@@:mcs_bus, src_offset=8k, dest_offs
} -
] 1 3

2. You can edit the LSL file directly in the project_name. | sl editor.

A * appears in front of the name of the LSL file to indicate that the file has changes.

3. click [=] or select File » Save to save the changes.

» You can also make changes to the property pages Memory (Memory/Reserved/MCS Macros) and
Stack/Heap.

1. From the Project menu, select Properties for
The Properties dialog appears.

2. Inthe left pane, expand C/C++ Build and select Memory or Stack/Heap.
In the right pane the corresponding property page appears.

3. Make changes to memory and/or stack/heap and click OK.

The project LSL file is updated automatically according to the changes you make in the pages.

You can quickly navigate through the LSL file by using the Outline view (Window » Show View » Outline).

161



TASKING VX-toolset for MCS User Guide

5.7.3. Preprocessor Macros in the Linker Script Files

The linker script files contain several predefined preprocessor macros. If for some reason you need to
change a default value, you can use Eclipse or the linker option --define to define a new value, or add
this option via the control program to the linker.

For example, to set the stack size for channel 0 of MCS core 00 from the command line to 48, enter:

ccnts - W--defi ne=GTM_MCS00_STACK 0=48 test.o

With option -WI the control program passes the macro definition to the linker.

The following macros are available in the linker script files.

Macro

Description

GTM_CPU_ENDIANNESS

Identifies the endianness (big or little) of the main processing cores
of the CPU based on the option --endianness.

GTM_MCFG_CTRL

Identifies the value of the MCFG_CTRL register that determines
the GTM memory configuration. The default is 0x00000000, which
is no swap and no borrow.

GTM_MCS_COPYTABLE_SPACE

Identifies the LSL address space (on the CPU) that holds the copy
table used to initialize GTM MCS memory.

GTM_MCScore_HEAP

Identifies the size of the heap for the specified MCS core. The
default is 256 octets.

GTM_MCScore_MAIN_CHANNEL

Itis possible to execute the mai n() function on an arbitrary channel
for a specified MCS core. You can set this macro to the channel
number in the range [0 .. 7]. If this macro is not defined, the mai n()
function will be executed on channel 0.

GTM_MCS_NO_START ADDRESS

If defined, no start address (__ START) will specified in the LSL file.
The C mai n() function is disabled for all MCS cores, allowing a
custom channel function to be defined for each core's main channel.
If this macro is not defined, mai n() is executed using the channel
function __START. This macro also influences
GTM_MCScore_STACK_channel_ENTRY_POINTS.

GTM_MCS_NO_VECTOR_TABLE

If defined, no vector table will specified in the LSL file.

GTM_MCS_RAMO_SIZE

Identifies the size of a large MCS memory block in octets (default:
0x1000).

GTM_MCS_STACKS_BALLOONING

By default all MCS stacks have a fixed size. When this macro is
defined, stacks will be "ballooning”. This means that after locating
all sections, the largest remaining gap in the space is used
completely for the stack.

GTM_MCScore_STACK_channel

Identifies the size of the stack for the specified channel of the MCS
core. channel is a number in the range [0 .. 7]. By default, all MCS
stacks are 32 octets.
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Macro Description
GTM_MCScore_STACK_channel |Specifies the entry points for stack estimation of the stack for the
_ENTRY_POINTS specified channel of the MCS core. By default the macro for the

main channel is setto " __ START". If macro
GTM_MCS_NO_START_ADDRESS is defined, this macro is set
to".vector.channel ".

MCS_RAM1_EN_ADDR_MSB If defined as 1, the second memory block of each MCS is half the
size of the first memory block. If this macro is undefined, the second
memory block of each MCS is the same size as the first memory

block.

MCS00_ORAM .. MCS07_ORAM Identifies the offset of the memory for core MCSO00 .. MCSO07 from
the GTM base address.

GTM_REDEFINE_ON_CHIP_ITEMS |If defined as 1, no memories are defined in the GTM.

5.7.4. Structure of a Linker Script File

A script file consists of several definitions. The definitions can appear in any order.

The architecture definition (required)

In essence an architecture definition describes how the linker should convert logical addresses into
physical addresses for a given type of core. If the core supports multiple address spaces, then for each
space the linker must know how to perform this conversion. In this context a physical address is an offset
on a given internal or external bus. Additionally the architecture definition contains information about items
such as the stack.

This specification is normally written by Altium. Altium supplies LSL files in the i ncl ude. | s| directory.

The architecture definition of the LSL file should not be changed by you unless you also modify the core's
hardware architecture. If the LSL file describes a multi-core system an architecture definition must be
available for each different type of core.

The linker uses the architecture name in the LSL file to identify the target. For example, the default library
search path can be different for each core architecture.

The derivative definition

The derivative definition describes the configuration of the internal (on-chip) bus and memory system.
Basically it tells the linker how to convert offsets on the buses specified in the architecture definition into
offsets in internal memory. Microcontrollers and DSPs often have internal memory and I/O sub-systems
apart from one or more cores. The design of such a chip is called a derivative.

When you want to use multiple cores of the same type, you must instantiate the cores in a derivative
definition, since the linker automatically instantiates only a single core for an unused architecture.

Altium supplies LSL files for each derivative (deri vati ve. | sl ). When you use a derivative that is not
(yet) supported by the TASKING tools, you may have to write a derivative definition.
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The processor definition

The processor definition describes an instance of a derivative. A processor definition is only needed in a
multi-processor embedded system. It allows you to define multiple processors of the same type.

If for a derivative 'A' no processor is defined in the LSL file, the linker automatically creates a processor
named 'A' of derivative 'A'. This is why for single-processor applications it is enough to specify the derivative
in the LSL file.

The memory and bus definitions (optional)

Memory and bus definitions are used within the context of a derivative definition to specify internal memory
and on-chip buses. In the context of a board specification the memory and bus definitions are used to
define external (off-chip) memory and buses. Given the above definitions the linker can convert a logical
address into an offset into an on-chip or off-chip memory device.

The board specification

The processor definition and memory and bus definitions together form a board specification. LSL provides
language constructs to easily describe single-core and heterogeneous or homogeneous multi-core
systems. The board specification describes all characteristics of your target board's system buses, memory
devices, 1/0 sub-systems, and cores that are of interest to the linker. Based on the information provided
in the board specification the linker can for each core:

» convert a logical address to an offset within a memory device
* locate sections in physical memory

* maintain an overall view of the used and free physical memory within the whole system while locating

The section layout definition (optional)

The optional section layout definition enables you to exactly control where input sections are located.
Features are provided such as: the ability to place sections at a given address, to place sections in a
given order, and to overlay code and/or data sections.

Example: Skeleton of a Linker Script File

A linker script file that defines a derivative "X" based on the MCS architecture with two cores, its external
memory and how sections are located in memory, may have the following skeleton:

architecture MCS

/1 Specification of the MCS core architecture.
/1l Witten by Altium

}

architecture MCS2.0 extends MCS

{
}
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architecture MCS3.0 extends MCS2.0

{
}

architecture MCS3.1 extends MCS3.0

{
}

architecture MCS4. 0 extends MCS3.1

{
}

derivative X [// derivative nane is arbitrary

{

/1 Specification of the derivative.
/1 Witten by Altium

core nts00 /1 always specify the core(s)
{
architecture = MCSS. 1;
I
}
core ntsOl /1 always specify the core(s)
{
architecture = MCSS. 1;
I
}
bus aei /1 internal bus
{
mau = 8§;
wi dth = 32;
}
/'l internal menory
}
menory name
{
/1l external nmenory definition
}
section_l ayout :nts00:nts /1 section |ayout
{
/'l section placenent statenments
/'l sections are located in address space nts
/'l of core 'ncs00'
}

Using the Linker
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section_l ayout :ntsOl:nts /1 section |ayout

{

/1 section placenent statenents

/'l sections are located in address space nts
/'l of core 'ncsOl'

}

See for example the files nts_ar ch. | sl and gt nB1_02. | sl in the directory i ncl ude. | sl for an
actual implementation.

Overview of LSL files delivered by Altium

Altium supplies the following LSL files in the directory i ncl ude. | sl .

LSL file Description

ncs_arch. | sl Defines the base architectures (MCS, MCS2.0, MCS3.0, MCS3.1, MCS4.0)
for all MCS cores.

derivative. sl Defines the derivative. Contains a memory definition and section layout. It is
included in the file nts_ar ch. | sl . The selection of the derivative is based
on your CPU selection (control program option --cpu). The filename specifies
the MCS version and the number of cores (gt nver si on_cores. | sl ). For
example, gt nB1_02. | sI for MCS v3.1 with two cores.

cpu. | sl Includes the file deri vati ve. | sl based on your CPU selection. The CPU
is specified by the _ CPU__ macro. This file is used by Eclipse as part of
tenplate.|lsl.

tenpl ate. | sl This file is used by Eclipse as a template for the project LSL file. It includes

the file cpu. | sl .

defaul t. sl Contains a default memory definition and section layout based on the gtm31_01
derivative. This file is used on a command line invocation of the tools, when
no CPU is selected (no option --cpu).

When you select to add a linker script file when you create a project in Eclipse, Eclipse makes a copy of
the file t enpl at e. | sI and names it “project_name. | sl ". On the command line, the linker uses the file
def aul t. | sl , unless you specify another file with the linker option --Isl-file (-d).

5.7.5.The Architecture Definition

Although you will probably not need to write an architecture definition (unless you are building your own
processor core) it helps to understand the Linker Script Language and how the definitions are interrelated.

Within an architecture definition the characteristics of a target processor core that are important for the
linking process are defined. These include:

» space definitions: the logical address spaces and their properties

» bus definitions: the 1/0 buses of the core architecture
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* mappings: the address translations between logical address spaces, the connections between logical
address spaces and buses and the address translations between buses

Address spaces

A logical address space is a memory range for which the core has a separate way to encode an address
into instructions. Most microcontrollers and DSPs support multiple address spaces. For example, separate
spaces for code and data. Normally, the size of an address space is 2N, with N the number of bits used
to encode the addresses.

The relation of an address space with another address space can be one of the following:
* one space is a subset of the other. These are often used for "small" absolute or relative addressing.

« the addresses in the two address spaces represent different locations so they do not overlap. This
means the core must have separate sets of address lines for the address spaces. For example, in
Harvard architectures we can identify at least a code and a data memory space.

Address spaces (even nested) can have different minimal addressable units (MAU), alignment restrictions,
and page sizes. All address spaces have a number that identifies the logical space (id).

The MCS has one address space for architecture MCS as defined in ncs_ar ch. | sl

Space|ld [MAU |Description ELF sections

mcs |1 |8 MCS address space |.mcstext, .mcsdata

The MCS architecture in LSL notation

The best way to write the architecture definition, is to start with a drawing. The following figure shows a
part of the architecture MCS as defined in nts_arch. | sl :

SHECE PGS bus trcs_kus
0

id =1 man = 8

ral = 8 width = 8
1EM — — —

The figure shows one address space called nts. The address space has attributes like a number that
identifies the logical space (id), a MAU and an alignment. In LSL notation the definition of this address
space looks as follows:

space nts

id=1;
mau = 8;

map (src_of fset=0, dest_offset=0, size=0x1000000,
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dest =bus: nts_bus);

}

The keyword map corresponds with the arrows in the drawing. You can map:
 address space => address space

» address space => bus

* memory => bus (not shown in the drawing)

* bus => bus (not shown in the drawing)

Next the internal bus, named nts_bus must be defined in LSL:

bus nts_bus

{
8, // there are 8 data lines on the bus

This completes the LSL code in the architecture definition. Note that all code above goes into the
architecture definition, thus between:

architecture MCS
{

}

/1 Al code above goes here.

5.7.6. The Derivative Definition

Although you will probably not need to write a derivative definition (unless you are using multiple cores
that both access the same memory device) it helps to understand the Linker Script Language and how
the definitions are interrelated.

A derivative is the design of a processor, as implemented on a chip (or FPGA). It comprises one or more
cores and on-chip memory. The derivative definition includes:

» core definition: an instance of a core architecture
* bus definition: the 1/0O buses of the core architecture

* memory definitions: internal (or on-chip) memory

Core

Each derivative must have at least one core and each core must have a specification of its core architecture.
This core architecture must be defined somewhere in the LSL file(s).

core nts00

{
architecture = MCS3. 1;
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copyt abl e_space = nts00: nts;

}
Bus

Each derivative can contain a bus definition for connecting external memory. In this example, the bus
aei is used:

bus aei

{

mau

= 8;
width =

32; // there are 32 data lines on the bus

}
Memory

External memory is usually described in a separate memory definition, but you can specify on-chip memory
for a derivative. For example:

menory ncs00

{
mau = 8;
wite unit = 4;
si ze GITM_MCS_RAMD_SI ZE + __MCS_RAML_SI ZE;
type ram

map ranD (dest=bus:aei, src_offset=0, dest_offset=MCS00_ORAM
si ze=GTM_MCS_RAMD_SI ZE) ;

map ranl (dest=bus:aei, src_offset=GITM MCS_RAM)_SI ZE,
dest _of f set =MCS00_ORAM+GTM_MCS_RAMD_SI ZE,
size=__MCS_RAML_SI ZE) ;

map ncs_ranD (dest=bus:__MCSO00_MAPO_CORE: nts_bus, src_of f set =0,
dest _of f set =__MCSO00_MAPO_ADDR, size=GIM MCS_RAMD_SI ZE) ;
map ncs_ranl (dest=bus:__MCS00_MAP1_CORE: nts_bus,
src_of fset =GTM_MCS_RAMD_SlI ZE,
dest _of fset=__MCSO0_MAP1_ADDR, size=__MCS RAML_SI ZE);
}

This completes the LSL code in the derivative definition. Note that all code above goes into the derivative
definition, thus between:

derivative X /1 name of derivative

/1 Al code above goes here
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5.7.7.The Processor Definition

The processor definition is only needed when you write an LSL file for a multi-processor embedded
system. The processor definition explicitly instantiates a derivative, allowing multiple processors of the
same type.

processor nane

{
}

If no processor definition is available that instantiates a derivative, a processor is created with the same
name as the derivative.

derivative = derivative_nang;

5.7.8.The Memory Definition

Once the core architecture is defined in LSL, you may want to extend the processor with external (or
off-chip) memory. You need to specify the location and size of the physical external memory devices in
the target system.

The principle is the same as defining the core's architecture but now you need to fill the memory definition:

menory name

{
}

If you use a different memory layout than described in the LSL file supplied for the target core, you can
specify this in Eclipse or you can specify this in a separate LSL file and pass both the LSL file that describes
the core architecture and your LSL file that contains the memory specification to the linker.

/1 menory definitions

To add memory using Eclipse

1. From the Project menu, select Properties for
The Properties dialog appears.

2. Inthe left pane, expand C/C++ Build and select Memory.
In the right pane the Memory page appears.

3. Open the Memory tab and click on the Add... button.
The Add new memory dialog appears.

4. Enter the memory name, type and size.

5. Click on the Add... button.

The Add new mapping dialog appears.
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6. You have to specify at least one mapping. Enter the mapping name (optional), address, size and

destination and click OK.

The new mapping is added to the list of mappings.
7. Click OK.

The new memory is added to the list of memories (user memory).
8. Click OK to close the Properties dialog.

The updated settings are stored in the project LSL file.

If you make changes to the on-chip memory as defined in the architecture LSL file, the memory is copied
to your project LSL file and the line #def i ne GTM_REDEFI NE_ON_CHI P_I| TEMS is added. If you remove
all the on-chip memory from your project LSL file, also make sure you remove this define.

5.7.9.The Section Layout Definition: Locating Sections

Once you have defined the internal core architecture and optional memory, you can actually define where
your application must be located in the physical memory.

Sections have a name, an indication (section type) in which address space it should be located and
attributes like writable or read-only.

In the section layout definition you can exactly define how input sections are placed in address spaces,
relative to each other, and what their absolute run-time and load-time addresses will be.

Section placement

To control the locating of sections, you need to write one or more section definitions in the LSL file. At
least one for each address space where you want to change the default behavior of the linker. In our
example, we need to locate sections in the address space nts:

section_l ayout :nts00:nts

{
}

To locate sections, you must create a group in which you select sections from your program. For our
example, we need to define one group, which contains the section . ncsdat a. mydat a. All other sections
are located using the defaults specified in the architecture definition.

/'l Section placenent statenents

group ( run_addr = nem ncts00 )

{
}

This completes the LSL file for the sample architecture and sample program. You can now invoke the
linker with this file and the sample program to obtain an application that works for this architecture.

sel ect ".ntsdata. nydata";
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For a complete description of the Linker Script Language, refer to Chapter 13, Linker Script Language
(LSL).

5.7.9.1. Locating Code and Data Sections in Separate Pages

When code and data are in the same memory page, this will have a negative effect on the run-time speed.
To have the best performance, code must end up in np0 and data in np1.

The following example shows how to do this in LSL. Note that for "code in mp0, data in mpQ", the directions
need to be reversed. Only a sect i on_| ayout with hi gh_t o_| owis needed since | ow_t o_hi gh is
the default.

section_layout :nts00:nts (direction=high_to_Iow)

{
group (contiguous)
{
select ".ntstext";
select ".nrstext.*";
}
}
section_l ayout :nts00:nts (direction=low_to_high)
{
group (contiguous)
{
sel ect ".ntsdata";
select ".ntsdata.*";
}
}

5.8. Linker Labels

The linker creates labels that you can use to refer to from within the application software. Some of these
labels are real labels at the beginning or the end of a section. Other labels have a second function, these
labels are used to address generated data in the locating phase. The data is only generated if the label
is used.

Linker labels are labels starting with _| c¢_. The linker assigns addresses to the following labels when
they are referenced:

Label Description

_lc_ub_nane Begin of section name. Also used to mark the begin of the stack or heap or
copy table.

_lc_b_nane

_lc_ue_nane End of section name. Also used to mark the end of the stack or heap.

_lc_e_nane

172



Using the Linker

Label Description

_lc_gb_name Begin of group name. This label appears in the output file even if no reference
to the label exists in the input file.

_lc_ge_nane End of group name. This label appears in the output file even if no reference
to the label exists in the input file.

The linker only allocates space for the stack and/or heap when a reference to either of the section labels
exists in one of the input object files.

If there is no LSL file in your project, select File » New » Linker Script File (LSL), add the lines that
define the symbol. Add the LSL file to the linker options (Tool Options » Linker » Script File » Linker
script file (.Isl)).

5.9. Generating a Map File

The map file is an additional output file that contains information about the location of sections and symbols.
You can customize the type of information that should be included in the map file.

To generate a map file
1. From the Project menu, select Properties for
The Properties dialog appears.
2. Inthe left pane, expand C/C++ Build and select Settings.
In the right pane the Settings appear.
3. On the Tool Settings tab, select Linker » Map File.
4. Enable the option Generate XML map file format (.mapxml) for map file viewer.
5. (Optional) Enable the option Generate map file (.map).
6. (Optional) Enable the options to include that information in the map file.
Example on the command line
The following command generates the map file t est . map:
Incs --map-file test.o
With this command the map file t est . nap is created.

See Section 11.2, Linker Map File Format, for an explanation of the format of the map file.
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5.10. Linker Error Messages

The linker reports the following types of error messages in the Problems view of Eclipse.

F ( Fatal errors)

After a fatal error the linker immediately aborts the link/locate process.

E (Errors)

Errors are reported, but the linker continues linking and locating. No output files are produced unless you
have set the linker option --keep-output-files.

W (Warnings)

Warning messages do not result into an erroneous output file. They are meant to draw your attention to
assumptions of the linker for a situation which may not be correct. You can control warnings in the C/C++
Build » Settings » Tool Settings » Linker » Diagnostics page of the Project » Properties for menu
(linker option --no-warnings).

| (Information)

Verbose information messages do not indicate an error but tell something about a process or the state
of the linker. To see verbose information, use the linker option --verbose.

S (System errors)

System errors occur when internal consistency checks fail and should never occur. When you still receive
the system error message

S6##: nmessage

please report the error number and as many details as possible about the context in which the error
occurred.

Display detailed information on diagnostics

1. From the Window menu, select Show View » Other » TASKING » Problems.
The Problems view is added to the current perspective.

2. Inthe Problems view right-click on a message.
A popup menu appears.

3. Select Detailed Diagnostics Info.
A dialog box appears with additional information.

On the command line you can use the linker option --diag to see an explanation of a diagnostic message:
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Imcs --diag=[format:]{all | nunber,...]
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Chapter 6. Using the Utilities

The TASKING VX-toolset for MCS comes with a number of utilities:

ccmces A control program. The control program invokes all tools in the toolset and lets you quickly
generate an absolute object file from assembly source input files. Eclipse uses the control
program to call the assembler and linker.

amk A make utility to maintain, update, and reconstruct groups of programs. The make utility
looks whether files are out of date, rebuilds them and determines which other files as a
consequence also need to be rebuilt. It supports parallelism which utilizes the multiple
cores found on modern host hardware.

armcs An archiver. With this utility you create and maintain library files with relocatable object
modules (. 0) generated by the assembler.

hidumpmcs A high level language (HLL) object dumper. With this utility you can dump information about
an absolute object file (. el f). Key features are a disassembler with HLL source intermixing
and HLL symbol display and a HLL symbol listing of static and global symbols.

cnvba2ta.pl A Perl script to convert Bosch MCS assembly to TASKING assembly for MCS.

6.1. Control Program

The control program is a tool that invokes all tools in the toolset for you. It provides a quick and easy way
to generate the final absolute object file out of your C sources without the need to invoke the compiler,
assembler and linker manually.

Eclipse uses the control program to call the C compiler, assembler and linker, but you can call the control
program from the command line. The invocation syntax is:

ccnes [ [option]... [file]l... ]...

Recognized input files
* Files with a . ¢ suffix are interpreted as C source programs and are passed to the compiler.

 Files with a . asmsuffix are interpreted as hand-written assembly source files which have to be passed
to the assembler.

» Files with a . sr ¢ suffix are interpreted as compiled assembly source files. They are directly passed to
the assembler.

» Files with a . a suffix are interpreted as library files and are passed to the linker.
 Files with a . o suffix are interpreted as object files and are passed to the linker.

» Files with a . out suffix are interpreted as linked object files and are passed to the locating phase of
the linker. The linker accepts only one . out file in the invocation.

» Files with a . | sl suffix are interpreted as linker script files and are passed to the linker.

177



TASKING VX-toolset for MCS User Guide

Options

The control program accepts several command line options. If you specify an unknown option to the
control program, the control program looks if it is an option for a specific tool. If so, it passes the option
directly to the tool. However, it is recommended to use the control program options --pass-* (-Wc, -Wa,
-WI) to pass arguments directly to tools.

For a complete list and description of all control program options, see Section 8.4, Control Program
Options.

Example with verbose output
ccnts --verbose --cpu=gtnB1_02 test.c

The control program calls all tools in the toolset and generates the absolute object file t est . el f . With
option --verbose (-v) you can see how the control program calls the tools:

+ "path\cnes" -D__CPU__=gtnB81 02 -D__CPU GTM31_02__
--core=ncts3.1 --fp-nmodel =cFlnrTz -0 cc5966a.src test.c

+ "path\asncs" -D__CPU__=gtnB81_02 -D_ _CPU GIM31_02_
--core=ncts3.1 --endi anness=little -0 cc5966b. 0 cc5966a. src

+ "path\lIncs” -o test.elf -dgtnB1_02.1sl --non-romable
--user-provided-initialization-code -D__CPU__=gtnB81_02
-D__PROC GTM31_02__ --map-file cc5966b. o

"-Lpath\lib\ncs31\le" -lc -Ifp -1Irt

The control program produces unique filenames for intermediate steps in the build process (such as
cc5966a. src and cc5966b. o in the example above) which are removed afterwards, unless you specify
command line option --keep-temporary-files (-t).

Example with argument passing to a tool
ccncs --pass-c=-Cc test.c

The option -Oc is directly passed to the compiler.
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6.2. Make Utility amk

amk is a make utility that you can use to maintain, update, and reconstruct groups of programs. amk
features parallelism which utilizes the multiple cores found on modern host hardware, hardening for path
names with embedded white space and it has an (internal) interface to provide progress information for
updating a progress bar. It does not use an external command shell (/ bi n/ sh, cnd. exe) but executes
commands directly.

The primary purpose of any make utility is to speed up the edit-build-test cycle. To avoid having to build
everything from scratch even when only one source file changes, it is necessary to describe dependencies
between source files and output files and the commands needed for updating the output files. This is
done in a so called "makefile”.

6.2.1. Makefile Rules

A makefile dependency rule is a single line of the form:
[target ...] : [prerequisite ...]

where target and prerequisite are path names to files. Example:
test.o : test.c

This states that target t est . o depends on prerequisite t est . ¢. So, whenever the latter is modified the
first must be updated. Dependencies accumulate: prerequisites and targets can be mentioned in multiple
dependency rules (circular dependencies are not allowed however). The command(s) for updating a
target when any of its prerequisites have been modified must be specified with leading white space after
any of the dependency rule(s) for the target in question. Example:

test.o :
ccnts test.c # | eadi ng white space

Command rules may contain dependencies too. Combining the above for example yields:

test.o : test.c
ccnes test.c

White space around the colon is not required. When a path name contains special characters such as
"', '#' (start of comment), '=" (macro assignment) or any white space, then the path name must be enclosed
in single or double quotes. Quoted strings can contain anything except the quote character itself and a
newline. Two strings without white space in between are interpreted as one, so it is possible to embed
single and double quotes themselves by switching the quote character.

When a target does not exist, its modification time is assumed to be very old. So, amk will try to make it.
When a prerequisite does not exist possibly after having tried to make it, it is assumed to be very new.
So, the update commands for the current target will be executed in that case. amk will only try to make
targets which are specified on the command line. The default target is the first target in the makefile which
does not start with a dot.
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Static pattern rules

Static pattern rules are rules which specify multiple targets and construct the prerequisite names for each
target based on the target name.

[target ...] : target-pattern : [prerequisite-patterns ...]

The target specifies the targets the rules applies to. The target-pattern and prerequisite-patterns specify
how to compute the prerequisites of each target. Each target is matched against the target-pattern to
extract a part of the target name, called the stem. This stem is substituted into each of the
prerequisite-patterns to make the prerequisite names (one from each prerequisite-pattern).

Each pattern normally contains the character '%' just once. When the target-pattern matches a target,
the '%' can match any part of the target name; this part is called the stem. The rest of the pattern must
match exactly. For example, the target f 00. 0 matches the pattern '% o', with 'f 00" as the stem. The
targets f 00. ¢ and f 0o. el f do not match that pattern.

The prerequisite names for each target are made by substituting the stem for the '%' in each prerequisite
pattern.

Example:

objects =test.o filter.o

all: $(objects)

$(objects): %o %c
ccnes -¢ $< -0 $@

echo the stemis $*

Here '$<' is the automatic variable that holds the name of the prerequisite, '$@is the automatic variable
that holds the name of the target and '$*' is the stem that matches the pattern. Internally this translates
to the following two rules:

test.o: test.c
cecncs -c test.c -o test.o
echo the stemis test

filter.o: filter.c
ccncs -c¢ filter.c -o filter.o
echo the stemis filter

Each target specified must match the target pattern; a warning is issued for each target that does not.

Special targets

There are a number of special targets. Their names begin with a period.

Target Description

. DONE When the make utility has finished building the specified targets, it continues with
the rules following this target.
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Target Description
ANT The rules following this target are executed before any other targets are built.
. PHONY The prerequisites of this target are considered to be phony targets. A phony target

is a target that is not really the name of a file. The rules following a phony target are
executed unconditionally, regardless of whether a file with that name exists or what
its last-modification time is.

For example:

. PHONY: cl ean

cl ean:
rm*.o

With ank cl ean, the command is executed regardless of whether there is a file
named cl ean.

6.2.2. Makefile Directives

Directives inside makefiles are executed while reading the makefile. When a line starts with the word

"i ncl ude" or "-i ncl ude" then the remaining arguments on that line are considered filenames whose
contents are to be inserted at the current line. "- i ncl ude" will silently skip files which are not present.
You can include several files. Include files may be nested.

Example:
i ncl ude nakefil e2 nakefile3

White spaces (tabs or spaces) in front of the directive are allowed.

6.2.3. Macro Definitions

A macro is a symbol hame that is replaced with its definition before the makefile is executed. Although
the macro name can consist of lowercase or uppercase characters, uppercase is an accepted convention.
When a line does not start with white space and contains the assignment operator '=', ":=' or '+=' then the
line is interpreted as a macro definition. White space around the assignment operator and white space
at the end of the line is discarded. Single character macro evaluation happens by prefixing the name with
'$". To evaluate macros with names longer than one character put the name between parentheses '()' or
curly braces '{}'. Macro names may contain anything, even white space or other macro evaluations.
Example:

DI NNER = $(FOOD) and $( BEVERAGE)
FOOD = pi zza

BEVERAGE = sparkling water

FOOD += with cheese

With the += operator you can add a string to an existing macro. An extra space is inserted before the
added string automatically.
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Macros are evaluated recursively. Whenever $( DI NNER) or ${ DI NNER} is mentioned after the above,

it will be replaced by the text "pi zza wi th cheese and sparkling wat er". The left hand side in

a macro definition is evaluated before the definition takes place. Right hand side evaluation depends on
the assignment operator:

= Evaluate the macro at the moment it is used.
1= Evaluate the replacement text before defining the macro.

Subsequent '+=' assignments will inherit the evaluation behavior from the previous assignment. If there
is none, then '+='is the same as '=". The default value for any macro is taken from the environment. Macro
definitions inside the makefile overrule environment variables. Macro definitions on the amk command
line will be evaluated first and overrule definitions inside the makefile.

Predefined macros

Macro Description

$ This macro translates to a dollar sign. Thus you can use "$$" in the makefile to represent
a single "$".

@ The name of the current target. When a rule has multiple targets, then it is the name

of the target that caused the rule commands to be run.

* The basename (or stem) of the current target. The stem is either provided via a static
pattern rule or is calculated by removing all characters found after and including the
last dot in the current target name. If the target name is 't est . ¢' then the stem is

't est ' (if the target was not created via a static pattern rule).

< The name of the first prerequisite.

MAKE The amk path name (quoted if necessary). Optionally followed by the options -n and
-S.

ORIG N The name of the directory where amk is installed (quoted if necessary).

SUBDI R The argument of option -G. If you have nested makes with -G options, the paths are

combined. This macro is defined in the environment (i.e. default macro value).

The @, * and < macros may be suffixed by 'D' to specify the directory component or by 'F' to specify the
filename component. $( @) evaluates to the directory name holding the file$( @) . $( @) / $( @) is
equivalent to $@ Note that on MS-Windows most programs accept forward slashes, even for UNC path
names.

The result of the predefined macros @, * and < and 'D' and 'F' variants is not quoted, so it may be necessary
to put quotes around it.

Note that stem calculation can cause unexpected values. For example:

$@ $*

/hone/ . wi ne/test / hone/

/ hone/test/. project [ hone/ test/
/.. lfile /.
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Macro string substitution
When the macro name in an evaluation is followed by a colon and equal sign as in
$(MACRQO stringl=string2)

then amk will replace stringl at the end of every word in $( MACRO) by string2 during evaluation. When
$( MACRO) contains quoted path names, the quote character must be mentioned in both the original string
and the replacement stringl. For example:

$(MACRO. . 0" =. d")

6.2.4. Makefile Functions
A function not only expands but also performs a certain operation. The following functions are available:

$(filter pattern ...,item ...)

Thefil t er function filters a list of items using a pattern. It returns items that do match any of the pattern
words, removing any items that do not match. The patterns are written using '%,

${filter %c %h, test.c test.h test.o readne.txt .project output.c}
results in:

test.c test.h output.c

$(filter-out pattern ...,item ...)

The fil ter-out function returns all items that do not match any of the pattern words, removing the
items that do match one or more. This is the exact opposite of the fi | t er function.

${filter-out %c %h, test.c test.h test.o readne.txt .project output.c}
results in:

test.o readne.txt .project

$(foreach var-name, item ..., action)

The f or each function runs through a list of items and performs the same action for each item. The
var-name is the name of the macro which gets dynamically filled with an item while iterating through the
item list. In the action you can refer to this macro. For example:

${foreach T, test filter output, ${T}.c ${T}.h}
results in:

test.c test.h filter.c filter.h output.c output.h

1Intemally, amk tokenizes the evaluated text, but performs substitution on the original input text to preserve compatibility here with
existing make implementations and POSIX.
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6.2.5. Conditional Processing

Lines containing i f def , i f ndef, el se or endi f are used for conditional processing of the makefile.
They are used in the following way:

i fdef macro-nane

if-l1ines
el se

el se-1ines
endi f

The if-lines and else-lines may contain any number of lines or text of any kind, even otheri f def ,i f ndef,
el se and endi f lines, or no lines at all. The el se line may be omitted, along with the else-lines following
it. White spaces (tabs or spaces) in front of preprocessing directives are allowed.

First the macro-name after the i f def command is checked for definition. If the macro is defined then
the if-lines are interpreted and the else-lines are discarded (if present). Otherwise the if-lines are discarded;
and if there is an el se line, the else-lines are interpreted; but if there is no else line, then no lines are
interpreted.

When you use the i f ndef line instead of i f def , the macro is tested for not being defined. These
conditional lines can be nested to any level.

You can also add tests based on strings. With i f eq the result is true if the two strings match, with i f neq
the result is true if the two strings do not match. They are used in the following way:

i feq(stringl, string2)

if-l1ines
el se

el se-1ines
endi f

6.2.6. Makefile Parsing

amk reads and interprets a makefile in the following order:

1. When the last character on a line is a backslash (\) (i.e. without trailing white space) then that line and
the next line will be concatenated, removing the backslash and newline.

2. The unquoted '#' character indicates start of comment and may be placed anywhere on a line. It will
be removed in this phase.

# this conment line is continued\
on the next line
3. Trailing white space is removed.

4. When a line starts with white space and it is not followed by a directive or preprocessing directive, then
it is interpreted as a command for updating a target.
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5. Otherwise, when a line contains the unquoted text '=', '+=' or ":=' operator, then it will be interpreted as
a macro definition.
6. Otherwise, all macros on the line are evaluated before considering the next steps.
7. When the resulting line contains an unquoted ":' the line is interpreted as a dependency rule.

8. When the first token on the line is "i ncl ude" or "-i ncl ude" (which by now must start on the first
column of the line), amk will execute the directive.

9. Otherwise, the line must be empty.

Macros in commands for updating a target are evaluated right before the actual execution takes place
(or would take place when you use the -n option).

6.2.7. Makefile Command Processing

A line with leading white space (tabs or spaces) without a (preprocessing) directive is considered as a
command for updating a target. When you use the option -j or -J, amk will execute the commands for
updating different targets in parallel. In that case standard input will not be available and standard output
and error output will be merged and displayed on standard output only after the commands have finished
for a target.

You can precede a command by one or more of the following characters:

@ Do not show the command. By default, commands are shown prior to their output.
- Continue upon error. This means that amk ignores a non-zero exit code of the command.
+ Execute the command, even when you use option -n (dry run).

Execute the command on the foreground with standard input, standard output and error
output available.

Built-in commands

Command Description

true This command does nothing. Arguments are ignored.

fal se This command does nothing, except failing with exit code 1. Arguments are
ignored.

echo arg... Display a line of text.

exit code Exit with defined code. Depending on the program arguments and/or the extra

rule options '-' this will cause amk to exit with the provided code. Please note
that 'exi t 0" has currently no result.

argfil e file arg... Create an argument file suitable for the --option-file (-f) option of all the other
tools. The first ar gf i | e argument is the name of the file to be created.
Subsequent arguments specify the contents. An existing argument file is not
modified unless necessary. So, the argument file itself can be used to create
a dependency to options of the command for updating a target.
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Command Description
r m[option]... file... Remove the specified file(s). The following options are available:
-r, --recursive Remove directories and their contents recursively.
-f, --force Force deletion. Ignore non-existent files, never prompt.
-i, --interactive Interactive. Prompt before every removal.
-v, --verbose Verbose mode. Explain what is being done.
-m file Read options from file..
-?, --help Show usage.

6.2.8. Calling the amk Make Utility

The invocation syntax of amk is:

ank [option]... [target]... [macro=def]...
For example:

ank test.elf

target You can specify any target that is defined in the makefile. A target can also be one
of the intermediate files specified in the makefile.

macro=def Macro definition. This definition remains fixed for the amk invocation. It overrides any
regular definitions for the specified macro within the makefiles and from the
environment. It is not inherited by subordinate amk's

option For a complete list and description of all amk make utility options, see Section 8.5,
Parallel Make Utility Options.

Exit status

The make utility returns an exit status of 1 when it halts as a result of an error. Otherwise it returns an
exit status of 0.
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6.3. Archiver

The archiver armcs is a program to build and maintain your own library files. A library file is a file with
extension . a and contains one or more object files (. 0) that may be used by the linker.

The archiver has five main functions:

Deleting an object module from the library

Moving an object module to another position in the library file

» Replacing an object module in the library or add a new object module
» Showing a table of contents of the library file

» Extracting an object module from the library

The archiver takes the following files for input and output:

relocatable object library
.a

relocatable object file N

[s]
linker

The linker optionally includes object modules from a library if that module resolves an external symbol
definition in one of the modules that are read before.

archiver

relocatable object library
.a

6.3.1. Calling the Archiver

You can create a library in Eclipse, which calls the archiver or you can call the archiver on the command
line.

To create a library in Eclipse

Instead of creating an MCS absolute ELF file, you can choose to create a library. You do this when you
create a new project with the New C Project wizard.

1. From the File menu, select New » TASKING MCS C Project.
The New C Project wizard appears.
2. Enter a project name.
3. Inthe Project type box, select TASKING MCS Library and click Next >.

4. Follow the rest of the wizard and click Finish.
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5. Add the files to your project.

6.

Build the project as usual. For example, select Project » Build Project (1),

Eclipse builds the library. Instead of calling the linker, Eclipse now calls the archiver.

Command line invocation

You can call the archiver from the command line. The invocation syntax is:

arncs key option [sub _option...] library [object _file]

key_option With a key option you specify the main task which the archiver should perform. You
must always specify a key option.

sub_option Sub-options specify into more detail how the archiver should perform the task that is
specified with the key option. It is not obligatory to specify sub-options.

library The name of the library file on which the archiver performs the specified action. You

must always specify a library name, except for the options -? and -V. When the library
is not in the current directory, specify the complete path (either absolute or relative) to

the library.

object_file The name of an object file. You must always specify an object file name when you

add, extract, replace or remove an object file from the library.

Options of the archiver utility

The following archiver options are available:

Description Option Sub-option
Main functions (key options)

Replace or add an object module -r -a-b-c-n-u-v
Extract an object module from the library -X -0 -v
Delete object module from library -d -v

Move object module to another position -m -a-b-v
Print a table of contents of the library -t -s0-s1
Print object module to standard output -p

Sub-options

Append or move new modules after existing module name -a name

Append or move new modules before existing module name -b name

Suppress the message that is displayed when a new library is -C

created

Create a new library from scratch -n

Preserve last-modified date from the library -0

Print symbols in library modules -s{0|1}
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Description Option Sub-option
Replace only newer modules -u
Verbose -v

Miscellaneous

Display options -?
Display description of one or more diagnostic messages --diag
Display version header -V
Read options from file -f file
Suppress warnings above level n -wn

For a complete list and description of all archiver options, see Section 8.6, Archiver Options.
6.3.2. Archiver Examples

Create a new library

If you add modules to a library that does not yet exist, the library is created. To create a new library with
the name nyl i b. a and add the object modules cstart. o and cal c. o toit:

arncts -r nylib.a cstart.o calc.o

Add a new module to an existing library

If you add a new module to an existing library, the module is added at the end of the module. (If the
module already exists in the library, it is replaced.)

arncs -r nylib.a nod3.0

Print a list of object modules in the library
To inspect the contents of the library:

arncs -t nylib.a

The library has the following contents:

cstart.o

calc.o
nod3. o

Move an object module to another position
To move nod3. o to the beginning of the library, position it just before cstart . o:

arncs -nmb cstart.o nylib.a nbd3.o0
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Delete an object module from the library

To delete the object module cst ar t . o from the library nyl i b. a:
arncs -d nylib.a cstart.o

Extract all modules from the library

Extract all modules from the library nmyl i b. a:

arncs -x nylib.a
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6.4. HLL Object Dumper

The high level language (HLL) dumper hidumpmcs is a program to dump information about an absolute
object file (. el f). Key features are a disassembler with HLL source intermixing and HLL symbol display
and a HLL symbol listing of static and global symbols.

6.4.1. Invocation

Command line invocation

You can call the HLL dumper from the command line. The invocation syntax is:
hl dumpnts [option]... file...

The input file must be an ELF file with or without DWARF debug info (. el f).

The HLL dumper can process multiple input files. Files and options can be intermixed on the command
line. Options apply to all supplied files. If multiple files are supplied, the disassembly of each file is preceded
by a header to indicate which file is dumped. For example:

========== fj|le.elf ==========

For a complete list and description of all options, see Section 8.7, HLL Object Dumper Options. With
hl dunmpnts - - hel p you will see the options on st dout .

6.4.2. HLL Dump Output Format

The HLL dumper produces output in text format by default, but you can also specify the XML output format
with option --output-type=xml. The XML output is mainly for use in the Eclipse editor. Alternatively, you
can use option --adx-format to produce output in the ADX address list format. For more information about
this format, see ADX Specification - Address List Format for A2L Address Calculation - Compiler vendors,
Version 1.10, 2015-04-27.

The output is printed on st dout , unless you specify an output file with --output=filename.
The parts of the output are dumped in the following order:

1. Module list

2. Section list

3. Call graph using the DWARF debug info

4. Section dump (disassembly)

5. HLL symbol table

6. Assembly level symbol table

7. Note sections

8. Debug control flow section
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With the option --dump-format=flag you can control which parts are shown. By default, all parts are
shown, except for parts 3 and 8.

Example

Suppose we have a simple "Hello World" program in a file called hel | 0. c. We call the control program
as follows:

ccnes -g -t --control-flowinfo hello.c

Option -g tells to include DWARF debug information. Option -t tells to keep the intermediate files. Option
--control-flow-info adds control flow information to the output file. This command results (among other
files) in the file hel | 0. el f (the absolute object file).

We can dump information about the ELF file with the following command:

hl dumpnts -F3 hello. el f

Option -F3 enables all parts. A possible output could be (just a fraction of the actual output is shown):

---------- Module list ----------

Narme Full path
hello.c hello.c

---------- Section list ----------

Address Si ze Al'ign Type Narme

000003f 4 28 4 text .ncstext. hello. main

000002b8 24 4 data .ncsdat a. hel | 0. $1$str
00000300 4 4 data .ncsdata. hello.world
000002d0 48 4 data . ncsdat a. hel | 0. $2$str

---------- Call graph using the DWARF debug info ----------

+-- 0x000003f4 nmin

L-- 0x0000092c printf

L-- 0x00000474 _doprint
L-- 0x00000840 _io_putc

: L-- 0x00000900 f putc
: L-- 0x0000067c _f I sbuf
: L-- 0x00000820 _host_write
i : L-- 0x00000430 _dbg_trap
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Section dunp

0x00000840

00000000 1c 04 00 eO

. sde
. sect

.word 00000077, 0000006f, 00000072, 00000060

cl

' . ncsdat a. hel | 0. $1$str’

0x00000548

_fflush

+-- 0x00000820 _host_wite *

+-- 0x000007e8 _host _Is

eek

+-- 0x00000430 _dbg_trap

0x00000820 _host_write *

_io_putc *

. sdecl
. sect

j m

.ncsdata. hell o. $1$str'

.word 00000064, 00000000

. sde

. sect

cl

' . ncsdat a. hel | 0. $2%str'
' . ncsdat a. hel | 0. $2$str"’
.word 00000048, 00000065, 0000006¢c, 0000006¢c; H..
.word 0000006f, 0000002c, 00000020, 00000025; o..

, DATA AT 0x2b8

, DATA AT 0x2d0

.word 00000073, 00000021, 0000000a, 00000000; s

. sde

. sect

wor | d

000003f 4
000003f 8
000003f ¢
00000400
00000404
00000408
0000040c

. sdecl
. sect

04
00
00
do
2c
04
00

cl

00
03
00
02
09
00
00

_lc_ub_stack_0
. Space 128

HLL synbo

00
01
74
00
03
00
04

27
a5
a5
12
el
37
el

mai n:

tabl e

. sdecl
. sect
addl
nrd
mar i
nmovl
cal l
subl
ret

"stack_0', DATA AT 0x964
"stack_0'

'.ntsdata. hel l o.worl d', DATA AT 0x300
".ncsdata. hello.world
.word 000002b8

r7,0x00000004
r5, 0x00000300
r5r7,0

r2, 0x000002d0
printf
r7,0x00000004

'.vector.0Q0', CODE AT
".vector.0'
__START

W...0...

".nctstext. hello.min'
".nctstext. hello.min'

0x0

, CODE AT 0x3f4
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Addr ess Size HLL Type

00000020 24 struct

00000038 320 static char

00000178 320 static char

00000300 4 char *
00000304 240 struct _iobuf
000003f 4 28 void

---------- Assenbly | evel synbol tab
Address Si ze Type Nane

00000000

00000000 stack_0
00000020 24 data _dbg_request
00000300 4 data world

00000304 240 data _iob

000003f 4 28 code main

00000410 12 code _Exit

0000041c 20 code __START
---------- .note sections ----------
Section .note, section 35:

00000000 type: TASKI NG ASSEMBLER NAMVE
0000000c nane: Altium
00000014 desc: asnts

Debug control flow section

start of fset 0

start address: 0x000003f 4
code size 0

#entries 1

dest. offset 10

Module list

This part lists all modules (C files) found in the object file(s). It lists the flename and the complete path

name at the time the module was built.

Section list

This part lists all sections found in the object file(s)

Address

Size The size (length) of the secti
Align The alignment of the section
Type The section type.

Name The name of the section.

With option --sections=name[,name]... you can sp
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_i ob[ 10]

Name

dbg_request [dbg.c]
stdin_buf[80] [_iob.c]
stdout _buf[80] [_iob.c]
world [hello.c]

[ _iob.c]

mai n()

e

The start address of the section. Hexadecimal, 8 digits, 32-bit.
on in bytes. Decimal, filled up with spaces.
in number of bytes. Decimal, filled up with spaces.

ecify a list of sections that should be dumped.
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Call graph

The linker can generate a call graph in the linker map file. However, if you only have an ELF file and you
need to test it, you can use the option --dump-format=+callgraph.You can then step through the call
graph to identify the flow for debugging purposes. Some notes about the call graph:

The call graph starts with the default entry point of the application.
Recursive calls are marked with 'R'.
Inline functions are marked with 'I'.

A function is analyzed only once. When a function is called again, it is not analyzed again and this is
marked with "',

By default the DWARF debug information is used to generate the call graph. When no DWARF
information is available the ELF information is used. Inline functions can only be detected and dumped
when DWARF information is available.

With option --call-graph-elf-mode you can force the call graph to use ELF symbols even when DWARF
information is available. This can be useful when you want to dump information from an assembly
function.

With option --call-graph-root=function you can specify the address or function name where to start
the call graph (default: mai n() ).

Section dump

This part contains the disassembly. It consists of the following columns:

address column Contains the address of the instruction or directive that is shown in the disassembly.

If the section is relocatable the section start address is assumed to be 0. The
address is represented in hexadecimal and has a fixed width. The address is
padded with zeros. No Ox prefix is displayed. For example, on a 32-bit architecture,
the address 0x32 is displayed as 00000032.

encoding column Shows the hexadecimal encoding of the instruction (code sections) or it shows the

hexadecimal representation of data (data sections). The encoding column has a
maximum width of eight digits, i.e. it can represent a 32-bit hexadecimal value.
The encoding is padded to the size of the data or instruction. For example, a 16-bit
instruction only shows four hexadecimal digits. The encoding is aligned left and
padded with spaces to fill the eight digits.

label column Displays the label depending on the option --symbols=[hlljasm|none]. The default

is asm, meaning that the low level (ELF) symbols are used. With hll, HLL (DWARF)
symbols are used. With none, no symbols will be included in the disassembly.
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disassembly column For code sections the instructions are disassembled. Operands are replaced with
labels, depending on the option --symbols=[hlllasm|none].

The contents of data sections are represented by directives. A new directive will
be generated for each symbol. ELF labels in the section are used to determine
the start of a directive. ROM sections are represented with . wor d directives. RAM
sections are represented with . space directives. This can be either the size
specified in the ELF symbol, or the size up to the next label.

With option --hex, no directives will be generated for ROM data sections and no disassembly dump will
be done for code sections. Instead a hex dump is done with the following format:

AAAAAAAA HO HL H2 H3 H4 H5 H6 H7 H8 H9 HA HB HC HD HE HF RRRRRRRRRRRRRRRR
where,

A = Address (8 digits, 32-bit)

Hx = Hex contents, one byte (16 bytes max)

R = ASCII representation (16 characters max)

For example:

section 7 (.ntsdata.hello. $2%str):
000002d0 48 00 00 00 65 00 00 00 6¢c 00 00 00 6¢c 00 00 OO H...e...l...1...
000002e0 6f 00 00 00 2c 00 00 00 20 00 00 00 25 00O OO OO O...,... ...%..
000002f0 73 00 00 00 21 00 00 00O Oa 00 00 00 00 00 00 OO s...!...........

With option --hex, RAM sections will be represented with only a start address and a size indicator:
AAAAAAAA Space: 24 bytes

With option --disassembly-intermix you can intermix the disassembly with HLL source code.

HLL symbol table

This part contains a symbol listing based on the HLL (DWARF) symbols found in the object file(s). The
symbols are sorted on address.

Address The start address of the symbol. Hexadecimal, 8 digits, 32-bit.
Size The size of the symbol from the DWARF info in bytes.

HLL Type The HLL symbol type.

Name The name of the HLL symbol.

HLL arrays are indicated by adding the size in square brackets to the symbol name. For example:

00000038 320 static char stdin_buf[80] [_iob.c]
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With option --expand-symbols=+basic-types HLL struct and union symbols are listed including all fields.
Array members are expanded in one array member per line regardless of the HLL type. For example:

00000038 320 static char stdi n_buf[80] [_iob.c]
00000038 4  char
0000003c 4 char
00000040 4  char
00000174 4  char

HLL struct and union symbols are listed by default without fields. For example:
00000020 24 struct _dbg_request [dbg.c]

With option --expand-symbols all struct, union and array fields are included as well. For the fields the
types and names are indented with two spaces. For example:

00000020 24 struct _dbg_request [dbg.c]
00000020 4 i nt _errno

00000024 4 enum nr

00000028 16 uni on u

00000028 4 struct exit

00000028 4 i nt st at us
00000028 8 struct open

00000028 4 const char * pat hnane
0000002c 4 unsi gned int flags

Functions are displayed with the full function prototype. Size is the size of the function. HLL Type is the
return type of the function. For example:

0000092c 56 int printf(const char * restrict format,

The local and static symbols get an identification between square brackets. The filename is printed and
if a function scope is known the function name is printed between the square brackets as well. If multiple
files with the same name exist, the unique part of the path is added. For example:

00000200 4 int count [file.c, somefunc()]
00000204 4 int count [x\a.c]
00000208 4 int count [y\a.c, foo()]

Global symbols do not get information in square brackets.

Assembly level symbol table

This part contains a symbol listing based on the assembly level (ELF) symbols found in the object file(s).
The symbols are sorted on address.

Address The start address of the symbol. Hexadecimal, 8 digits, 32-bit.
Size The size of the symbol from the ELF info in bytes. If this field is empty, the size is
zero.
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Type Code or Data, depending on the section the symbol belongs to. If this field is empty,
the symbol does not belong to a section.

Name The name of the ELF symbol.

Debug control flow section

When control flow information is present in the ELF file (control program option --control-flow-info), this
part shows information about the basic blocks and their relation.

start offset The start seek offset in bytes from the beginning of the section.

start address The start address of the basic block.

code size The code size of the basic block.

#entries The number of successor basic blocks. This value can be 0 if there are no
SUCCESSOrSs.

dest. offset The destination offset in bytes to the first, second, ... successor from the beginning

of the section.

6.5. Bosch MCS Assembly to TASKING Assembly Converter

The Perl script cnvba2ta.pl is a converter to convert Bosch MCS assembly files to TASKING VX-toolset
for MCS assembily files. You need to have Perl installed on your system.

Command line invocation

You can call the converter from the command line by using Perl. The invocation syntax is:

perl cnvba2ta.pl input _file > output _file

Without output redirection the output is sent to st dout . The converted file includes ncs_defi nes. i nc.
For example:

perl cnvba2ta.pl bosch_nts.nts > tsk_nts.asm
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This chapter describes the debugger and how you can run and debug a C application. This chapter only
describes the TASKING specific parts.

7.1. Reading the Eclipse Documentation

Before you start with this chapter, it is recommended to read the Eclipse documentation first. It provides
general information about the debugging process. This chapter guides you through a number of examples
using the TASKING debugger with simulation as target.

You can find the Eclipse documentation as follows:
1. Start Eclipse.
2. From the Help menu, select Help Contents.
The help screen overlays the Eclipse Workbench.
3. Inthe left pane, select C/C++ Development User Guide.
4. Open the Getting Started entry and select Debugging projects.

This Eclipse tutorial provides an overview of the debugging process. Be aware that the Eclipse
example does not use the TASKING tools and TASKING debugger.

7.2. Creating a Customized Debug Configuration

Before you can debug a project, you need a Debug launch configuration. Such a configuration, identified
by a name, contains all information about the debug project: which debugger is used, which project is
used, which binary debug file is used, which perspective is used, ... and so forth.

If you want to debug on a target board, you have to create a custom debug configuration for your target
board, otherwise you have to create a debug launch configuration for the TASKING simulator.

To debug a project, you need at least one opened and active project in your workbench. In this
chapter, it is assumed that the mypr oj ect is opened and active in your workbench.

Create or customize your debug configuration
To create or change a debug configuration follow the steps below.
1. From the Debug menu, select Debug Configurations...

The Debug Configurations dialog appears.

2. Select TASKING C/C++ Debugger and click the New launch configuration button (L7
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) to add a new configuration.
Or: In the left pane, select the configuration you want to change, for example, TASKING C/C++
Debugger » myproject.

3. Inthe Name field enter the name of the configuration. By default, this is the name of the project, but
you can give your configuration any name you want to distinguish it from the project name. For
example enter mypr oj ect . si mul at or to identify the simulator debug configuration.

4. Onthe Target tab, select the MCS Simulator or any of the target boards.

The dialog shows several tabs.

Target tab

On the Target tab you can select on which target the application should be debugged. An application
can run on an external evaluation board, or on a simulator using your own PC. On this tab you can also
select the connection settings. The information in this tab is based on the Debug Target Configuration
(DTC) files as explained in Chapter 14, Debug Target Configuration Files.

{2} Debug Configurations ==
Create, manage, and run configurations F
TASKING C/C++ Debugger E
eI Name: | myproject
type filter text Target . := Initialization| 5] Project| 69= Arguments| B Source| £ Miscellaneous
4 5 TASKING C/C++ Debugger Teeiesits -
5 myproject
) Show all targets (©) Show targets for GTM31_02
Target: IMCS Simulator
Configuration:
Connection settings
Connection: | Simulatar -
e Field Value
Filter matched 2 of 2 items =
= N
@ Debug Close

Initialization tab

On the Initialization tab enable one or more of the following options:
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{23 Debug Configurations (===
Create, manage, and run configurations - 4
TASKING C/C++ Debugger E
B
EIEER Neme: | myproject
type filter text Target | = Initialization . [5] Project| (- Arguments| & Source. [ Miscellaneous

a ¥ TASKING C/C++ Debugger

V|Initial download of pregram
#5 myproject L

] Verify download of program
V] Reset target
] Goto main
] Break on exit
Reduce target state polling
5
Initialize target board

Filter matched 2 of 2 items

@ e

Initial download of program

If enabled, the target application is downloaded onto the target. If disabled, only the debug information
in the file is loaded, which may be useful when the application has already been downloaded (or flashed)
earlier. If downloading fails, the debugger will shut down.

Verify download of program

If enabled, the debugger verifies whether the code and data has been downloaded successfully. This
takes some extra time but may be useful if the connection to the target is unreliable.

Reset target

If enabled, the target is immediately reset after downloading has completed. Registers that have the
i nit resource setinthe . dt c file, are reset to their default value. Execution stops at the reset vector
__START().

Goto main

If enabled, only the C startup code is processed when the debugger is launched. The application stops
executing when it reaches the first C instruction in the function mai n()) . Usually you enable this option
in combination with the option Reset Target.

Break on exit
If enabled, the target halts automatically when the exi t () function is called.
Reduce target state polling

If you have set a breakpoint, the debugger checks the status of the target every number of seconds to
find out if the breakpoint is hit. In this field you can change the polling frequency.
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* Initialize Target Board
Some target boards contain a power supply chip which needs to be initialized every time after power-on,
before hardware debugging is started. If enabled, the target board is initialized automatically before
the start of a debug session.

This option is not supported for the MCS.
Project tab

On the Project tab, you can set the properties for the debug configuration such as a name for the project
and the application binary file(s) which are used when you choose this configuration.

(2} Debug Cenfigurations ==
Create, manage, and run configurations K <
TASKING C/C++ Debugger J
5 X|[E - Name: | myproject
type filter texdt Target | i= Initialization | [£] Project . = Arguments| %> Source | (] Miscellaneous
4 5 TASKING C/C++ Debugger
5 myproject Lieg==3
myproject Browse...
Binary files
File Offeet Add,
S{build_confighmyproject.cif
The start address wil be taken from the first ile that defines one
Filter matched 2 of 2 items
@ e

* In the Project field, you can choose the project for which you want to make a debug configuration.
Because the project nypr oj ect is the active project, this project is filled in automatically. Click the
Browse... button to select a different project. Only the opened projects in your workbench are listed.

* Inthe Binary files group box, you can choose one or more binary files to debug. The file
mypr oj ect . el f is automatically selected from the active project.

The order of the binary files matters. Use the Up and Down buttons to change the order. If there are
multiple files, the application start address is taken from the first file that defines one. An ELF file always
defines one, whereas Hex files may not.

Note that conflicts between symbols could arise, for example when you download two ELF files that
both contain the function mai n() . When you download multiple files, we recommend that the first
binary file is an ELF file that contains the startup code and mai n() and that the other files are auxiliary

Hex files.

To add a binary file

1. Click Add... to add a binary file.
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.} Add Binary File

(i) Specify a binary file and optionally an offset

File:

Y build_cenfigi\myproject.elf
Offcet:

Affects only code and data, not debug information

(=]
Search... | | Browse...

@ [ ok

] | Cancel |

2. Specify the binary file, use the Search... button to select one from the active project, or use the

Browse... button to search the file system.

3. Optionally, specify an address offset. The value will be added to all target addresses in the binary

file.

Note that the address offset will be applied only to code, data and the start address, not to debug
information. Specifying a non-zero offset is not recommended for an ELF/DWARF file. If the offset
causes an address to underflow or overflow an error occurs.

Arguments tab

If your application's mai n() function takes arguments, you can pass them in this tab. Arguments are
conventionally passed in the ar gv[] array. Because this array is allocated in target memory, make sure

you have allocated sufficient memory space for it.

(.} Debug Configurations

Create, manage, and run configurations 5 <
TASKING C/C++ Debugger J
< B Y
RIEER Name:  myproject
type filter text Target | := Initialization | || Project [ £9: Arguments . %/ Source| ] Miscellaneous
# Crr
4 % TASKING C/C++ Debugger C/C++ program arguments
#5 myproject
argl arg2
arg3 argd )|
Variables.
Working directory
¥ Use default working directory
S{workspace_loc:myproject}
Filter matched 2 of 2 items
= E—
@
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Source tab

On the Source tab, you can add additional source code locations in which the debugger should search
for debug data.

(£ Debug Configurations ==
Create, manage, and run configurations F
TASKING C/C++ Debugger
SEX| B3~ Name: myproject
type filter texdt Target | i= Initialization [ [5] Project [60= Arguments %/ Source . =] Miscellaneous
4 7 TASKING C/C++ Debugger ||| Source Lookup Path:
s myproject , 1= Default Add..
Edit..
up
Down

Restore Default

7] Search for duplicate source files on the path

Apply Revert
Filter matched 2 of 2 items

®

 Usually, the default source code location is correct.

Miscellaneous tab

On the Miscellaneous tab you can specify several file locations.
{} Debug Configurations (55|

Create, manage, and run configurations

qu\

TASKING C/C++ Debugger

B =
EIEEN Name: | myproject

type filter tedt Target | = Initialization | [£] Project | (- Arguments | 1 Source [ (] Miscellaneous
2 #5 TASKING C/C++ Debugger

% mypraisct Debugger location:  C:\Program Files\TASKING\GTM wcyrz\cmcs\eclipselpl | Erovse..

FSS root directory:  ${project_lochS{build_config] Browse...
ORTIHile Browse..
KSM module: Browse...

GOl log file: Browse..
Debug instrument log file (if applicable):

Browse...

(7| Cache target access
[ Launch in background
[7] Use linker/locator memory map file (.mdf) for memory map

Appl Revert
Filter matched 2 of 2 items

®

» Debugger location
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The location of the debugger itself. This should not be changed.
* FSSroot directory

The initial directory used by file system simulation (FSS) calls. See the description of the FSS view.
* ORTI file and KSM module

If you wish to use the debugger's special facilities for kernel-aware debugging, specify the name of a
Kernel Debug Interface (KDI) compatible KSM module (shared library) in the appropriate edit box. See
also the description of the RTOS view.

* GDlI log file and Debug instrument log file

You can use the options GDI log file and Debug instrument log file (if applicable) to control the generation
of internal log files. These are primarily intended for use by or at the request of Altium support personnel.

« Cache target access

Except when using a simulator, the debugger's performance is generally strongly dependent on the
throughput and latency of the connection to the target. Depending on the situation, enabling this option
may result in a noticeable improvement, as the debugger will then avoid re-reading registers and
memory while the target remains halted. However, be aware that this may cause the debugger to show
the wrong data if tasks with a higher priority or external sources can influence the halted target's state.

e Launch in background

When this option is disabled you will see a progress bar when the debugger starts. If you do not want
to see the progress bar and want that the debugger launches in the background you can enable this
option.

» Use linker/locator memory map file (.mdf) for memory map

You can use this option to find errors in your application that cause access to non-existent memory or
cause an attempt to write to read-only memory. When building your project, the linker/locator creates
a memory description file (. mdf ) file which describes the memory regions of the target you selected
in your project properties. The debugger uses this file to initialize the debugging target.

This option is only useful in combination with a simulator as debug target. The debugger may fail to
start if you use this option in combination with other debugging targets than a simulator.

7.3. Troubleshooting
If the debugger does not launch properly, this is likely due to mistakes in the settings of the execution

environment or to an improper connection between the host computer and the execution environment.
Always read the notes for your particular execution environment.

Some common problems you may check for, are:
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Problem

Solution

Wrong device name in the launch
configuration

Make sure the specified device name is correct.

Invalid baud rate

Specify baud rate that matches the baud rate the execution
environment is configured to expect.

No power to the execution
environment.

Make sure the execution environment or attached probe is powered.

Cable connected to the wrong port
on the execution environment or host.

Some target machines and hosts have several ports. Make sure
you connect the cable to the correct port.

Conflict between communication
ports.

A device driver or background application may use the same
communications port on the host system as the debugger. Disable
any service that uses the same port-number or choose a different
port-number if possible.

Port already in use by another user.

The port may already be in use by another user on some UNIX
hosts, or being allocated by a login process. Some target machines
and hosts have several ports. Make sure you connect the cable to
the correct port.

7.4. TASKING Debug Perspective

After you have launched the debugger, you are either asked if the TASKING Debug perspective should
be opened or it is opened automatically. The Debug perspective consists of several views.

To open views in the Debug perspective:

1. Make sure the Debug perspective is opened

2. From the Window menu, select Show View »

3. Select a view from the menu or choose Other... for more views.

By default, the Debug perspective is opened with the following views:
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£} TASKING Debug - myproject/myproject.c - GTM Eclipse IDE vxyrz = e |
File Edit Source Refactor Mavigate Search Project Debug Window Help
[mild R A S L A T RS ~H oo
Quick Access | [ | [7F] TASKING C/C++ (%5 TASKING Debug
Debug &2 = = O |[#= Varisbles 22 99 Breakpoints = B || Registers 2 & W= 4
9 P 2]
4 ¥5 myproject [TASKING C/C++ Debugger] - = | & ‘ i Group:
a {2 MCS Simulator - GTM31_02 (6/6/19 11:41 AM)
MName Value
4 f® Thread [MCS Channel 0] (Suspended) : = p— Name Value Usage
= 1 main) myproject.c3 600001514] ||| ! apetizacianebicnnsizl | o 00 =
. 4@ Thread [MCS Channel 1] (Suspended) B 00
. @ Thread [MCS Channel 2] (Suspended) 2 0
+ o Thread [MCS Channel 3] (Suspended) a o0
> o Thread [MCS Channel 4] (Suspended) N o
. Thread [MCS Channel 5] (Suspended) hs ks -
4 " » < » 4 »
myproject.c } Disassem = Outline
¢ myproject.c & = 8 |/ oi bly 52 3= outl B =0
#include <stdio.h>
Address:
Lat main( vold } 881473 60 88 88 74 atul r4,8x80000000 -
int i @@l4fc fe 14 52 e8 jbc  sta,5,@xlafe
for (;ﬂ‘ em3; it4) 881500 62 88 88 14 movl  r4,8x20800062
i ’ ’ @81564 86 88 51 c2 sub r2,rs
printf( "Ed\n",i ); B 881508 @@ 88 45 d2 asrs  r2,rd
H @@156c @1 88 88 32 subl  r2,8x20800861
printf( "Helle world, " ); @88151@ BB 8@ 84 e@ ret
printf( "this is \n" ); int main( void )
printf( "a small %dst\n",i-3 ); 91514 68 8@ @8 27 addl r7,8x80000008
printf( "debugging example.\n" ); 881518 fc ff 74 a6 mwri  r6,r7,-4
- or (i=1; i<=3; i++ i
¥ for (i i i
Kl » &l *
& Console 52 & Tasks % Bl E| B~ 80 Memory 2 Ja| |‘ | v e .
Debug [myproject] Monitors .,
Communication: Simulator a
Debug Instrument Module: disimmcs
Starting Debugger...
Launching configuratien: myproject
“ [ r

7.4.1. Debug View

The Debug view shows the target information in a tree hierarchy shown below with a sample of the

possible icons:

Icon Session item Description

5 Launch instance |Launch configuration name and launch type

Debugger instance | Debugger name and state

o® @ g2 | Thread instance |Thread number and state

E = Stack frame Stack frame number, function, file name, and file line number
instance

Stack display

During debugging (running)

the actual stack is displayed as it increases or decreases during program

execution. By default, all views present information that is related to the current stack item (variables,
memory, source code etc.). To obtain the information from other stack items, click on the item you want.
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The Debug view displays stack frames as child elements. It displays the reason for the suspension beside
the thread, (such as end of stepping range, breakpoint hit, and signal received). When a program exits,

the exit code is displayed.

The Debug view contains numerous functions for controlling the individual stepping of your programs and
controlling the debug session. You can perform actions such as terminating the session and stopping the
program. All functions are available from the right-click menu, though commonly used functions are also

available from the toolbar.

Controlling debug sessions

Icon Action Description
) Remove all Removes all terminated launches.
Reset target Resets the target system. Registers that have the i ni t resource set in the
[ svstem 9 . dt c file, are reset to their default value. Execution stops at the reset vector
Y __START().

. Restart Resets the target system and restarts the application. The application stops
© executing when it reaches the first C instruction in the function mai n() .
b Resume Resumes the application after it was suspended (manually, breakpoint,

signal).
oo Suspend Suspends the application (pause). Use the Resume button to continue.

i Right-click menu. Restarts the selected debug session when it was
@, Relaunch terminated. If the debug session is still running, a new debug session is

launched.

4 Reload current Reloads the current application without restarting the debug session. The
. application application does restart of course.

. Ends the selected debug session and/or process. Use Relaunch to restart
L] Terminate . ) ;
this debug session, or start another debug session.
[ | Terminate all Right-click menu. As terminate. Ends all debug sessions.
@_ | Terminate and Right-click menu. Ends the debug session and removes it from the Debug
®lremove view.
@ |Terminate and Right-click menu. Ends the debug session and relaunches it. This is the
*|Relaunch same as choosing Terminate and then Relaunch.
v Disconnect Detaches the debugger from the selected process (useful for debugging

attached processes).

Stepping through the application

Icon Action Description

3 Step into Steps to the next source line or instruction.

_ Steps over a called function. The function is executed and the application
iy Step over

suspends at the next instruction after the call.
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Icon Action Description
Executes the current function. The application suspends at the next
- Step return . ; X
instruction after the return of the function.
i Instruction Toggle. If enabled, the stepping functions are performed on instruction level
stepping instead of on C source line level.
Toggle. If an interrupt source continues generating interrupts while the
target is stopped (either manually or by hitting a breakpoint), a following
e Interrupt aware  |single step will always enter the Interrupt Service Routine (ISR). This can

stepping

lead to some problems during single stepping. With interrupt aware stepping
enabled, interrupts are temporarily disabled after the target has stopped.
When execution resumes the interrupts are restored.

Miscellaneous

Icon Action Description
. Right-click menu. Copies the stack as text to the windows clipboard. You
Copy Stack ) ) . .
can paste the copied selection as text in, for example, a text editor.
45 Edit project... Right-click menu. O.pens.the debug configuration dialog to let you edit the
current debug configuration.
5 Edit Source Right-click menu. Opens the Edit Source Lookup Path window to let you
Lookup... edit the search path for locating source files.

7.4.2. Breakpoints View

You can add, disable and remove breakpoints by clicking in the marker bar (left margin) of the Editor
view. This is explained in the Getting Started manual.

Description

The Breakpoints view shows a list of breakpoints that are currently set. The button bar in the Breakpoints
view gives access to several common functions. The right-most button — opens the Breakpoints menu.

Types of breakpoints

To access the breakpoints dialog, add a breakpoint as follows:

1. Click the Add TASKING Breakpoint button (&).

The Breakpoints dialog appears.

Each tab lets you set a breakpoint of a specific type. You can set the following types of breakpoints:
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» File breakpoint

t:] Breakpoints @

Select breakpoint type
(1) Create file breakpoint

File |Function | Code Address | Data | Data Addressl Stack |Instruction | Cycle ITimer |

File: queens.c - Browse...

Line: 58

Method

_) Hardware breakpoint
_) Software breakpoint

@ Mo preference

Condition:

Ignore count:

@ o [

If a debug session is active, the File drop-down box is filled with all source files as present in the debug
information in the ELF file. This can include files not present in the Eclipse project (for example from
libraries). If a file could be matched to a file in the active Eclipse project it will show as an Eclipse project
relative filename.

The target halts when it reaches the specified line of the specified source file. Note that it is possible
that a source line corresponds to multiple addresses, for example when a header file has been included
into two different source files or when inlining has occurred. If so, the breakpoint will be associated with
all those addresses. It is also possible that on some files no line breakpoints can be set because the
debugger lacks line information.
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* Function

t:] Breakpoints @
Select breakpoint type
(1) Create function breakpoint

| File | Function |CodeAddress| Data | Data Addressl Stack |Instruction | Cycle |Timer |

Function: ’main VI
File: ’queens.c v]
Method

() Hardware breakpoint
(0) Software breakpoint

@ Mo preference

Condition:

Ignore count:

® .

The Function drop-down box is filled with all functions from the debug information and the symbol
table (if not already in the debug information). You can use the File drop-down box to filter the list of
functions. If you select <all> you will see the filenames (between parentheses) behind each entry in
the Function drop-down box. Functions marked with function_name [section] originate from the symbol
table. These functions are normally not associated with a filename and will therefore be included if
<unknown> is selected in the File drop-down box. Functions marked ‘filename'::function_name are
static functions.

The target halts when it reaches the first line of the specified function. Note that function breakpoints
generally will not work on inlined instances of a function.
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» Code Address

{ﬁ Breakpoints @
Select breakpoint type
€ Mo address specified.

File | Function | Code Address |Data | Data Addressl Stack |In§truction | Cycle ITimer |
Address:
Method

() Hardware breakpoint

() Software breakpoint

@ Mo preference

Condition:

Ignore count:

®

The target halts when it reaches the specified instruction address.

» Data

{ﬁ Breakpoints @
Select breakpoint type
(1) Create data breakpoint

| File | Function | CodeAddress| Data |Data Addressl Stack |Instruction | Cycle ITimer |

Variable: 'queens.c':chess_board -
File: ’queens.c v]
Type

() Break on read access
() Break on write access

(@ Break on read or write access

Condition:

Ignore count:

(?3' [ oK ] ’ Cancel ]

The Variable drop-down box is filled with all variables from the debug information and the symbol table
(if not already in the debug information), but you can also enter text yourself. If a label is filled in, the
size will be 1 MAU. You can use the File drop-down box to filter the list of variables. If you select <all>
you will see the filenames (between parentheses) behind each entry in the Variables drop-down box.
Variables marked with variable_name [section] originate from the symbol table. These variables are
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normally not associated with a flename and will therefore be included if <unknown> is selected in the
File drop-down box. Variables marked ‘filename'::variable_name are static.

The target halts when the given variable is read or written to, as specified.

» Data Address

t:] Breakpoints IEI
Select breakpoint type
3 Mo address specified.

| File | Function | CodeAddressl Data | Data Address | Stack |Instruction | Cycle |Timer |

Address:

Length: 1
Type
(") Break on read access
() Break on write access

(@ Break on read or write access

Condition:

Ignore count:

The target halts when the given memory range (specified in terms of an absolute Address and a Length
in MAUSs) is read or written to, as specified.

» Stack

f:] Breakpoints @
Select breakpoint type
3 Mo stack frame selected.

| File | Function | CodeAddressl Data | Data Address| Stack |Instruction | Cycle |Timer |
Level: ’ v]
Method

() Hardware breakpoint

(0) Software breakpoint

@ Mo preference

Condition:

Ignore count:

®
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The target halts when it reaches the specified stack level.

e Instruction

ﬁj Breakpoints @
Select breakpoint type
3 No count specified.

| File | Function | Code Address | Data | Data Addressl Stack | Instruction | Cycle ITimer

Count:

Condition:

Ignore count:

The target halts when the given number of instructions (Count) has been executed.

* Cycle

ﬁj Breakpoints @
Select breakpoint type
3 Mo count specified.

| File | Function | Code Address | Data | Data Addressl Stack |Instruction| Cycle |Timer |

Count:

Condition:

Ignore count:

The target halts when the given number of clock cycles (Count) has elapsed.
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e Timer

t:] Breakpoints @

Select breakpoint type
3 Mo time specified.

| File | Function | CodeAddressl Data | Data Addressl Stack |Instruction | Cycle | Timer L

Time:

Condition:

Ignore count:

'/?3' OK Cancel

The target halts when the given amount of Time elapsed. The value entered is interpreted by the debug
instrument.

In addition to the type of the breakpoint, you can specify the condition that must be met to halt the program.

In the Condition field, type a condition. The condition is an expression which evaluates to 'true' (non-zero)
or ‘false' (zero). The program only halts on the breakpoint if the condition evaluates to 'true’.

In the Ignore count field, you can specify the number of times the breakpoint is ignored before the program
halts. For example, if you want the program to halt only in the fifth iteration of a while-loop, type '4": the
first four iterations are ignored.

7.4.3. File System Simulation (FSS) View

The File System Simulation (FSS) view is automatically opened when the target requests FSS input or
generates FSS output. The virtual terminal that the FSS view represents, follows the VT100 standard. If
you right-click in the view area of the FSS view, a menu is presented which gives access to some
self-explanatory functions.

Per debugging session, you can have more than one FSS view, each of which is associated with a positive
integer. By default, the view "FSS #1" is associated with the standard streams st di n, st dout , st derr
and st daux. Other views can be accessed by opening a file named "terminal window <number>", as
shown in the example below.

FILE * f3 = fopen("term nal w ndow 3", "rw');
fprintf(f3, "Hello, w ndow 3.\n");
fclose(f3);

You can set the initial working directory of the target application in the Debug configuration dialog (see
also Section 7.2, Creating a Customized Debug Configuration):
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1. On the Debugger tab, select the Miscellaneous sub-tab.
2. In the FSS root directory field, specify the FSS root directory.

The FSS implementation is designed to work without user intervention. Nevertheless, there are some
aspects that you need to be aware of.

First, the interaction between the C library code (in the files dbg*. ¢ and dbg*. h; see Section 10.1.4,
dbg.h) and the debugger takes place via a breakpoint, which incidentally is not shown in the Breakpoints
view. Depending on the situation this may be a hardware breakpoint, which may be in short supply.

Secondly, proper operation requires certain code in the C library to have debug information. This debug
information should normally be present but might get lost when this information is stripped later in the
development process.

7.4.4. Disassembly View

The Disassembly view shows target memory disassembled into instructions and / or data. If possible, the
associated C / C++ source code is shown as well. If you are debugging a multi-channel project, each
thread has its own Disassembly view.

To open a thread specific Disassembly view, select a stack frame in a thread in the Debug view and click
the Open thread specific Disassembly View button ().

The Address field shows the address of the current selected line of code.

To view the contents of a specific memory location, type the address in the Address field. If the address
is invalid, the field turns red.

7.4.5. Expressions View

The Expressions view allows you to evaluate and watch regular C expressions.

To add an expression:

Click OK to add the expression.

1. Right-click in the Expressions View and select Add Watch Expression.
The Add Watch Expression dialog appears.

2. Enter an expression you want to watch during debugging, for example, the variable name "i

If you have added one or more expressions to watch, the right-click menu provides options to Remove
and Edit or Enable and Disable added expressions.

» You can access target registers directly using #NAME. For example "ar r [ #R0 << 3] " or "#T| MER3
= m++". If a register is memory-mapped, you can also take its address, for example, "&#ADCI N'.

» Expressions may contain target function calls like for example "g1 + i nvert (&g2)". Be aware that
this will not work if the compiler has optimized the code in such a way that the original function code
does not actually exist anymore. This may be the case, for example, as a result of inlining. Also, be
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aware that the function and its callees use the same stack(s) as your application, which may cause
problems if there is too little stack space. Finally, any breakpoints present affect the invoked code in
the normal way.

7.4.6. Memory View

Use the Memory view to inspect and change process memory. The Memory view supports the same
addressing as the C language. You can address memory using expressions such as:

» 0x0847d3c

. (&) +1024

* *ptr

Monitors

To monitor process memory, you need to add a monitor:

1. Inthe Debug view, select a debug session. Selecting a thread or stack frame automatically selects
the associated session.

2. Click the Add Memory Monitor button in the Memory Monitors pane.
The Monitor Memory dialog appears.
3. Type the address or expression that specifies the memory section you want to monitor and click OK.

The monitor appears in the monitor list and the Memory Renderings pane displays the contents of
memory locations beginning at the specified address.

To remove a monitor:
1. Inthe Monitors pane, right-click on a monitor.

2. From the popup menu, select Remove Memory Monitor.

Renderings

You can inspect the memory in so-called renderings. A rendering specifies how the output is displayed:
hexadecimal, ASCII, signed integer, unsigned integer or traditional. You can add or remove renderings
per monitor. Though you cannot change a rendering, you can add or remove them:

1. Click the New Renderings... tab in the Memory Renderings pane.
The Add Memory Rendering dialog appears.

2. Select the rendering you want (Traditional, Hex, ASCII, Signed Integer, Unsigned Integer or Hex
Integer) and click Add Rendering(s).

To remove a rendering:

1. Right-click on a memory address in the rendering.
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2. From the popup menu, select Remove Rendering.

Changing memory contents

In a rendering you can change the memory contents. Simply type a new value.

Warning: Changing process memory can cause a program to crash.

The right-click popup menu gives some more options for changing the memory contents or to change the
layout of the memory representation.

7.4.7. Compare Application View

You can use the Compare Application view to check if the downloaded application matches the application
in memory. Differences may occur, for example, if you changed memory addresses in the Memory view.

» To check for differences, click the Compare button.

7.4.8. Heap View

With the Heap view you can inspect the status of the heap memory. This can be illustrated with the
following example:

string = (char *) malloc(100);
strcpy ( string, "abcdefgh" );
free (string);

If you step through these lines during debugging, the Heap view shows the situation after each line has
been executed. Before any of these lines has been executed, there is no memory allocated and the Heap
view is empty.

« After the first line the Heap view shows that memory is occupied, the description tells where the block
starts, how large it is (100 MAUs) and what its content is (0x0, 0x0, ...).

 After the second line, "abcdef gh" has been copied to the allocated block of memory. The description
field of the Heap view again shows the actual contents of the memory block (0x61, 0x62,...).

» The third line frees the memory. The Heap view is empty again because after this line no memory is
allocated anymore.

7.4.9. Logging View

Use the Logging view to control the generation of internal log files. This view is intended mainly for use
by or at the request of Altium support personnel.

7.4.10. RTOS View

The debugger has special support for debugging real-time operating systems (RTOSs). This support is
implemented in an RTOS-specific shared library called a kernel support module (KSM) or RTOS-aware
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debugging module (RADM). You have to create your own Run Time Interface (ORTI) and specify this file
on the Miscellaneous tab while configuring a customized debug configuration (see also Section 7.2,
Creating a Customized Debug Configuration):

1. From the Debug menu, select Debug Configurations...
The Debug Configurations dialog appears.

2. Inthe left pane, select the configuration you want to change, for example, TASKING C/C++ Debugger
» myproject.

Or: click the New launch configuration button (L) to add a new configuration.
3. Open the Miscellaneous tab
4. Inthe ORTI file field, specify the name of your own ORTI file.
5. Inthe KSM module field, specify the name of a KSM shared library file suitable for RTOS kernels.

The debugger supports ORTI specifications v2.0 and v2.1.

7.4.11. Registers View

In the Registers view you can examine the value of registers while stepping through your application. If
you are debugging a multi-channel project, each thread has its own Registers view. The registers are
organized in a number of register groups, which together contain all known registers. You can select a
group to see which registers it contains. This view has a number of features:

* While you step through the application, the registers involved in the step turn yellow. If you scroll in the
view or switch groups, some registers may appear on a lighter yellow background, indicating that the
debugger does not know whether the registers have changed because the debugger did not read the
registers before the step began.

il Registers &7 v W = 0
Group: | Core -

MName Value Usage

il (0] -
rl 0 =
r2 016

r3 00

rd 03

] 0x2ff0

6 Osdl

7 MlBec il

4 ;
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Thread specific Registers view:

S [MCS Channel 0]-Registers 52 o W8 = O ||} [MCS Channel 1])-Registers &3 o W = O || [MCS Channel 2])-Registers 3 ¢ W= O
Group: | Core b Group: | Core b Group: | Core b

Name Value Usage Name Value Usage Name Value Usage

0 00 Ao 0:0 - || 00 -
i 00 =l 2 0:0 =|[ 2 00 E
2 00 12 0:0 r2 00

3 00 3 0:0 3 00

1! 00 0! 0:0 r 00

5 00 5 02 5 Ot

6 00 6 0:0 6 00

7 0:3bcd -7 0:3ebc - |7 0:3fdc -

» To open a thread specific Registers view, select a thread in the Debug view and click the Open thread
specific Registers View button (¢#).

» You can change each register's value.

» You can search for a specific register: right-click on a register and from the popup menu select Find
Register.... Enter a group or register name filter, click the register you want to see and click OK. The
register of your interest will be shown in the view.

7.4.12.Trace View

If tracing is enabled, the Trace view shows the code was most recently executed. For example, while you
step through the application, the Trace view shows the executed code of each step. To enable tracing:

 Right-click in the Trace view and select Trace.
A check mark appears when tracing is enabled.

The view has three tabs, Source, Instruction and Raw, each of which represents the trace in a different
way. However, not all target environments will support all three of these. The view is updated automatically
each time the target halts.

220



Using the Debugger

7.5. Multi-channel Debug Support

The TASKING debugger supports multi-channel debugging. For every MCS channel a separate thread
is visible in the Debug view.

The following picture shows the 8 MCS channel threads for a project.

%5 Debug &2 = = 0
4 ¥ myproject [TASKING C/C++ Debugger]
4 {“3,3 MCS Simulator - GTM31_02 (6/6/19 5:59 PM) (Suspended)
a4 f® Thread [MCS Channel 0] (Suspended)
= 1 main() myproject.c:3 000001514
a4 f® Thread [MCS Channel 1] (Suspended)
= 10:4() 0:00000004
a f® Thread [MCS Channel 2] (Suspended)
= 1A 0:00000008
a4 f® Thread [MCS Channel 3] (Suspended)
= 1 0xc() 0:0000000¢
a4 f® Thread [MCS Channel 4] (Suspended)
= 1000 0:00000010
a4 f® Thread [MCS Channel 5] (Suspended)
= 10:4() 0:00000014
a4 f® Thread [MCS Channel 6] (Suspended)
= 10x8() 0:00000018
a4 f® Thread [MCS Channel 7] (Suspended)
= 10} 0:0000001c

Stepping/Breakpoints

The channels do not run separately from each other. When you do a single step in a channel the other
channels are also stepped through until you are back in the channel where you initiated the step.

Breakpoints hit by code that is run on a channel different than channel O are also honored.
Suspend or resume

Suspend () and resume (IF) work on all channels simultaneously. You cannot suspend or resume a
single channel thread. So, it does not matter which thread is selected or if you select the MCS Si nul at or .

Update views
When you select a function in a thread, the Source view, the Register view and the Disassembly view

are updated to the contents of the thread (either running or suspended - with the latter situation up-to-date
information is shown).
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Chapter 8. Tool Options

This chapter provides a detailed description of the options for the C compiler, assembler, linker, control
program, make utility, archiver and the HLL object dumper.

Tool options in Eclipse (Menu entry)

For each tool option that you can set from within Eclipse, a Menu entry description is available. In Eclipse
you can customize the tools and tool options in the following dialog:

1. From the Project menu, select Properties
The Properties dialog appears.

2. Inthe left pane, expand C/C++ Build and select Settings.
In the right pane the Settings appear.

3. Open the Tool Settings tab.
You can set all tool options here.

Unless stated otherwise, all Menu entry descriptions expect that you have this Tool Settings tab
open.

The following tables give an overview of all tool options on the Tool Settings tab in Eclipse with hyperlinks
to the corresponding command line options (if available).

Global Options

Eclipse option Description or option

Use global 'product directory' preference Directory where the TASKING toolset is
installed

Treat warnings as errors Control program option --warnings-as-errors

Keep temporary files Control program option
--keep-temporary-files (-t)

Verbose mode of control program Control program option --verbose (-v)

Endianness Control program option --endianness

Initialization mode Control program option --meminit

C Compiler

Eclipse option Description or option

Preprocessing
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Eclipse option

Description or option

Automatic inclusion of '.sfr' file

C compiler option --include-file

Store preprocessor output in <file>.pre

Control program option --preprocess (-E) /
--no-preprocessing-only

Keep comments in preprocessor output

Control program option
--preprocess=+comments

Keep #line info in preprocessor output

Control program option
--preprocess=-noline

Defined symbols

C compiler option --define

Pre-include files

C compiler option --include-file

Include Paths

Include paths

C compiler option --include-directory

Language

Comply to C standard

C compiler option --iso

Allow GNU C extensions

C compiler option --language=+gcc

Allow // comments in ISO C90 mode

C compiler option --language=+comments

Check assignment of string literal to non-const string pointer

C compiler option --language=-strings

Treat ‘char' variables as unsigned

C compiler option --uchar

Treat 'int' bit-fields as signed

C compiler option --signed-bitfields

Allow optimization across volatile access

C compiler option --language=-volatile

Allow Shift JIS Kanji in strings

C compiler option --language=+kanji

Floating-Point

Floating-point model

Control program option --fp-model

Code Generation

Use extended register set

C compiler option --extended-registers

Allow the use of divide/modulo instructions

C compiler option --instruction-set=+divide

Allow the use of multiply instructions

C compiler option
--instruction-set=+multiply

Allocation

Rename sections

C compiler option --rename-sections

Optimization

Optimization level

C compiler option --optimize

Trade-off between speed and size

C compiler option --tradeoff

Always inline function calls

C compiler option --inline

Maximum size increment when inlining (in %)

C compiler option --inline-max-incr

Maximum size for functions to always inline

C compiler option --inline-max-size

Custom Optimization

C compiler option --optimize
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Eclipse option

Description or option

Debugging

Generate symbolic debug information

C compiler option --debug-info

Generate control flow information

C compiler option --control-flow-info

MISRA C

MISRA C checking

C compiler option --misrac

MISRA C version

C compiler option --misrac-version

Warnings instead of errors for mandatory rules

C compiler option
--misrac-mandatory-warnings

Warnings instead of errors for required rules

C compiler option
--misrac-required-warnings

Warnings instead of errors for advisory rules

C compiler option
--misrac-advisory-warnings

Custom 1998 / Custom 2004 / Custom 2012

C compiler option --misrac

CERT C Secure Coding

CERT C secure code checking

C compiler option --cert

Warnings instead of errors

C compiler option --warnings-as-errors

Custom CERT C

C compiler option --cert

Diagnostics

Suppress C compiler warnings

C compiler option --no-warnings=num

Suppress all warnings

C compiler option --no-warnings

Perform global type checking on C code

C compiler option --global-type-checking

Maximum number of emitted errors

C compiler option --error-limit

Miscellaneous

Merge C source code with generated assembly

C compiler option --source

Additional options

C compiler options, Control program options

Assembler

Eclipse option

Description or option

Preprocessing

Use TASKING preprocessor

Assembler option --preprocessor-type

Automatic inclusion of ".def' file

Assembler option --include-file

Defined symbols

Assembler option --define

Pre-include files

Assembler option --include-file

Include Paths

Include paths

Assembler option --include-directory
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Eclipse option

Description or option

Symbols

Generate symbolic debug

Assembler option --debug-info

Case insensitive identifiers

Assembler option --case-insensitive

Emit local EQU symbols

Assembler option --emit-locals=+equ

Emit local non-EQU symbols

Assembler option --emit-locals=+symbols

Set default symbol scope to global

Assembler option --symbol-scope

List File

Generate list file

Control program option --list-files

List ...

Assembler option --list-format

List section summary

Assembler option --section-info=+list

Diagnostics

Suppress warnings

Assembler option --no-warnings=num

Suppress all warnings

Assembler option --no-warnings

Display section summary

Assembler option --section-info=+console

Maximum number of emitted errors

Assembler option --error-limit

Miscellaneous

Merge sections with the same name

Assembler option --concatenate-sections

Allow Shift JIS Kanji in strings

Assembler option --kanji

Additional options

Assembler options

Linker

Eclipse option

Description or option

Output Format

Generate Intel Hex format file

Linker option --output=file:IHEX

Generate S-records file

Linker option --output=file:SREC

Generate C-array file

Linker option
--chip-output=basename: CARR:32

Create file for each memory chip

Linker option --chip-output

Size of addresses (in bytes) for Intel Hex records

Linker option --output=file:IHEX:size

Size of addresses (in bytes) for Motorola S records

Linker option --output=file:SREC:size

Emit start address record

Linker option --hex-format=s

Emit list of exported symbols

Linker option --hex-format=y

Libraries

Rescan libraries to solve unresolved externals

Linker option --no-rescan
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Eclipse option

Description or option

Libraries

The libraries are added as files on the
command line.

Library search path

Linker option --library-directory

Data Objects

Data objects

Linker option --import-object

Script File

Defined symbols

Linker option --define

Linker script file (.Isl)

Linker option --Isl-file

Optimization

Delete unreferenced sections

Linker option --optimize=c

Use a 'first-fit decreasing' algorithm

Linker option --optimize=|

Compress copy table

Linker option --optimize=t

Delete duplicate code

Linker option --optimize=x

Delete duplicate data

Linker option --optimize=y

Map File

Generate map file (.map)

Control program option --no-map-file

Generate XML map file format (.mapxml) for map file viewer

Linker option --map-file=file.mapxml: XML

Include ...

Linker option --map-file-format

Diagnostics

Suppress warnings

Linker option --no-warnings=num

Suppress all warnings

Linker option --no-warnings

Maximum number of emitted errors

Linker option --error-limit

Miscellaneous

Strip symbolic debug information

Linker option --strip-debug

Link case insensitive

Linker option --case-insensitive

Do not use standard copy table for initialization

Linker option
--user-provided-initialization-code

Additional options

Linker options
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8.1. C Compiler Options

This section lists all C compiler options.

Options in Eclipse versus options on the command line

Most command line options have an equivalent option in Eclipse but some options are only available on
the command line. Eclipse invokes the compiler via the control program. Therefore, it uses the syntax of
the control program to pass options and files to the C compiler. If there is no equivalent option in Eclipse,
you can specify a command line option in Eclipse as follows:

1. From the Project menu, select Properties for
The Properties dialog appears.
2. Inthe left pane, expand C/C++ Build and select Settings.
In the right pane the Settings appear.
3. On the Tool Settings tab, select C Compiler » Miscellaneous.
4. Inthe Additional options field, enter one or more command line options.

Because Eclipse uses the control program, you have to precede the option with -Wc to pass the
option via the control program directly to the C compiler.

Be aware that some command line options are not useful in Eclipse or just do not have any effect. For
example, the option -n sends output to stdout instead of a file and has no effect in Eclipse.

Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (-)
character, long option names always begin with two minus (--) characters. You can abbreviate long option
names as long as it forms a unique name. You can mix short and long option names on the command
line.

Options can have flags or suboptions. To switch a flag 'on’, use a lowercase letter or a +longflag. To
switch a flag off, use an uppercase letter or a -longflag. Separate longflags with commas. The following
two invocations are equivalent:

cncs -Oac test.c
cnts --optimnm ze=+coal esce, +cse test.c

When you do not specify an option, a default value may become active.
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C compiler option: --cert

Menu entry
1. Select C Compiler » CERT C Secure Coding.
2. Make a selection from the CERT C secure code checking list.

3. If you selected Custom, expand the Custom CERT C entry and enable one or more individual
recommendations/rules.

Command line syntax
--cert={all | nane[-nane],...}
Default format: all

Description

With this option you can enable one or more checks for CERT C Secure Coding Standard
recommendations/rules. When you omit the argument, all checks are enabled. name is the name of a
CERT recommendation/rule, consisting of three letters and two digits. Specify only the three-letter
mnemonic to select a whole category. For the list of names you can use, see Chapter 15, CERT C Secure
Coding Standard.

On the command line you can use --diag=cert to see a list of the available checks, or you can use a

three-letter mnemonic to list only the checks in a particular category. For example, --diag=pre lists all
supported preprocessor checks.

Example

To enable the check for CERT rule STR30-C, enter:
cncs --cert=str30 test.c

Related information

Chapter 15, CERT C Secure Coding Standard

C compiler option --diag (Explanation of diagnostic messages)
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C compiler option: --check

Menu entry

Command line syntax

--check

Description

With this option you can check the source code for syntax errors, without generating code. This saves
time in developing your application because the code will not actually be compiled.

The compiler reports any warnings and/or errors.
This option is available on the command line only.
Related information

Assembler option --check (Check syntax)
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C compiler option: --control-flow-info

Menu entry

1. Select C Compiler » Debugging.

2. Enable the option Generate control flow information.

Command line syntax

--control -flowinfo

Description

With this option the compiler adds control flow information to the output file. The compiler generates a

. debug_control _f | owsection which describes the basic blocks and their relations. This information
can be used for code coverage analysis on optimized code.

Example

cncs --control-flowinfo test.c
Related information

Section 6.4.2, HLL Dump Output Format

C compiler option --debug-info (Debug information)
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C compiler option: --core

Menu entry
1. Expand C/C++ Build and select Processor.

2. From the Processor Selection list, select a processor or select User defined ....

Command line syntax
--core=core

You can specify the following core arguments:

mcs3.0 MCS v3.0 core
mcs3.1 MCS v3.1 core
mcs4.0 MCS v4.0 core

Default: mcs3.1

Description

With this option you specify the core architecture for a target processor for which you create your
application. If you use Eclipse or the control program, the MCS toolset derives the core from the processor
you selected. When the default core (mcs3.1) is used, the macro __ CORE_MCS31__ is defined in the C
source file.

With --core=mcs3.0, the compiler can generate MCS v3.0 instructions in the assembly file. The macro
__CORE_MCS30__ is defined in the C source file.

With --core=mcs3.1, the compiler can generate MCS v3.1 instructions in the assembly file. The macro
__CORE_MCS31__ is defined in the C source file.

With --core=mcs4.0, the compiler can generate MCS v4.0 instructions in the assembly file. The macro
__CORE_MCsS40__ is defined in the C source file.

Example

Select an MCS v3.0 core:

cncs --core=nts3.0 test.c
Related information

Control program option --cpu (Select processor)
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C compiler option: --debug-info (-g)
Menu entry

1. Select C Compiler » Debugging.

2. Togenerate symbolic debug information, select Default, Small set or Full.
To disable the generation of debug information, select None.

Command line syntax
- -debug-i nf o[ =subopt i on]
- g[ subopti on]

You can set the following suboptions:

small 1l/c Emit small set of debug information.
default 2/d Emit default symbolic debug information.
all 3/a Emit full symbolic debug information.

Default: - - debug- i nf o (same as - - debug- i nf o=def aul t)

Description

With this option you tell the compiler to add directives to the output file for including symbolic information.
This facilitates high level debugging but increases the size of the resulting assembler file (and thus the
size of the object file). For the final application, compile your C files without debug information.

The DWARF debug format allows for a flexible approach as to how much symbolic information is included,
as long as the structure is valid. Adding all possible DWARF data for a program is not practical. The
amount of DWARF information per compilation unit can be huge. And for large projects, with many object
modules the link time can grow unacceptably long. That is why the compiler has several debug information
levels. In general terms one can say, the higher the level the more DWARF information is produced.

The DWARF data in an object module is not only used for debugging. The toolset can also do "type
checking" of the whole application. In that case the linker will use the DWARF information of all object
modules to determine if every use of a symbol is done with the same type. In other words, if the application
is built with type checking enabled then the compiler will add DWARF information too.

Small set of debug information

With this suboption only DWARF call frame information and type information are generated. This enables
you to inspect parameters of nested functions. The type information improves debugging. You can perform
a stack trace, but stepping is not possible because debug information on function bodies is not generated.
You can use this suboption, for example, to compact libraries.
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Default debug information

This provides all debug information you need to debug your application. It meets the debugging
requirements in most cases without resulting in oversized assembler/object files.

Full debug information

With this suboption extra debug information is generated about unused typedefs and DWARF "lookup
table sections". Under normal circumstances this extra debug information is not needed to debug the
program. Information about unused typedefs concerns all typedefs, even the ones that are not used for
any variable in the program. (Possibly, these unused typedefs are listed in the standard include files.)
With this suboption, the resulting assembler/object file will increase significantly.

In the following table you see in more detail what DWARF information is included for the debug option

levels.

Feature -g1 |[-g2 |[-g3 |[type check Remarks

basic info + + + + info such as symbol name and type

call frame + + + + this is information for a debugger to compute
a stack trace when a program has stopped
at a breakpoint

symbol lifetime + + this is information about where symbols live
(e.g. on stack at offset so and so, when the
program counter is in this range)

line number info + + + file name, line number, column number

"lookup tables" + DWAREF sections ... this is an optimization
for the DWARF data, it is not essential

unused typedefs + in the C code of the program there can be
(many) typedefs that are not used for any
variable. Sometimes this can cause
enormous expansion of the DWARF data and
thus it is only included in -g3.

Related information
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C compiler option: --define (-D)
Menu entry
1. Select C Compiler » Preprocessing.
The Defined symbols box shows the symbols that are currently defined.
2. To define a new symbol, click on the Add button in the Defined symbols box.

3. Type the symbol definition (for example, denp=1)
Use the Edit and Delete button to change a macro definition or to remove a macro from the list.

Command line syntax
- -defi ne=macr o_name[ =macr o_defi ni tion]

- Dmacr o_name[ =nacr o_defini tion]

Description

With this option you can define a macro and specify it to the preprocessor. If you only specify a macro
name (no macro definition), the macro expands as '1".

You can specify as many macros as you like. Simply use the Add button to add new macro definitions.

On the command line, you can use the option --define (-D) multiple times. If the command line exceeds
the limit of the operating system, you can define the macros in an option file which you then must specify
to the compiler with the option --option-file (-f) file.

Defining macros with this option (instead of in the C source) is, for example, useful to compile conditional
C source as shown in the example below.

Make sure you do not use a reserved keyword as a macro name, as this can lead to unexpected
results.

Example

Consider the following C program with conditional code to compile a demo program and a real program:

void main( void)

{
#i f DEMO

deno_func(); /* conpile for the demo program */
#el se

real _func(); /* conpile for the real program*/
#endi f
}
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You can now use a macro definition to set the DEMO flag:

cnts --define=DEMO test.c
cntcs --define=DEMO=1 test.c

Note that both invocations have the same effect.

The next example shows how to define a macro with arguments. Note that the macro name and definition
are placed between double quotes because otherwise the spaces would indicate a new option.

cnts --define="MAX(A B)=((A) > (B) ? (A : (B))" test.c
Related information
C compiler option --undefine (Remove preprocessor macro)

C compiler option --option-file (Specify an option file)
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C compiler option: --dep-file

Menu entry

Eclipse uses this option in the background to create a file with extension . d (one for every input file).
Command line syntax

--dep-file[=file]

Description

With this option you tell the compiler to generate dependency lines that can be used in a Makefile. In
contrast to the option --preprocess=+make, the dependency information will be generated in addition to
the normal output file.

By default, the information is written to a file with extension . d (one for every input file). When you specify
a filename, all dependencies will be combined in the specified file.

Example
cnts --dep-file=test.dep test.c

The compiler compiles the file t est . ¢, which results in the output file t est . sr ¢, and generates
dependency lines in the file t est . dep.

Related information

C compiler option --preprocess=+make (Generate dependencies for make)
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C compiler option: --diag

Menu entry

1. From the Window menu, select Show View » Other » TASKING » Problems.
The Problems view is added to the current perspective.

2. In the Problems view right-click on a message.
A popup menu appears.

3. Select Detailed Diagnostics Info.

A dialog box appears with additional information.
Command line syntax
--diag=[format:]{all | nmsg[-nBQg],...}

You can set the following output formats:

html HTML output.
rtf Rich Text Format.
text ASCII text.

Default format: text

Description

With this option you can ask for an extended description of error messages in the format you choose.
The output is directed to stdout (normally your screen) and in the format you specify. The compiler does
not compile any files. You can specify the following formats: html, rtf or text (default). To create a file
with the descriptions, you must redirect the output.

With the suboption all, the descriptions of all error messages are given (except for the CERT checks). If
you want the description of one or more selected error messages, you can specify the error message
numbers, separated by commas, or you can specify a range.

With --diag=cert you can see a list of the available CERT checks, or you can use a three-letter mnemonic
to list only the checks in a particular category. For example, --diag=pre lists all supported preprocessor
checks.

Example
To display an explanation of message number 282, enter:
cnts --di ag=282

This results in the following message and explanation:
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E282: unterm nated conment

Make sure that every comment starting with /* has a matching */.
Nest ed coments are not possible.

To write an explanation of all errors and warnings in HTML format to file cer r or s. ht m , use redirection
and enter:

cnts --diag=htm:all > cerrors.htm

Related information
Section 3.7, C Compiler Error Messages

C compiler option --cert (Enable individual CERT checks)
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C compiler option: --error-file

Menu entry
Command line syntax
--error-file[=file]
Description

With this option the compiler redirects diagnostic messages to a file. If you do not specify a filename, the
error file will be named after the output file with extension . err .

Example
To write diagnostic messages to error s. err instead of st der r, enter:

cncs --error-file=errors.err test.c

Related information
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C compiler option: --error-limit
Menu entry

1. Select C/C++ Compiler » Diagnostics.

2. Enter avalue in the Maximum number of emitted errors field.

Command line syntax

--error-1limt=nunber

Default: 42

Description

With this option you limit the number of error messages in one compiler run to the specified number.
When the limit is exceeded, the compiler aborts with fatal error message F105. Warnings and informational

messages are not included in the count. When 0 (zero) or a negative number is specified, the compiler
emits all errors. Without this option the maximum number of errors is 42.

Related information

Section 3.7, C Compiler Error Messages
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C compiler option: --extended-registers

Menu entry

1. Select C Compiler » Code Generation.

2. Enable the option Use extended register set.

Command line syntax

--extended-registers

Description

The extended register set extends the registers of the current MCS channel with the registers of the next

MCS channel. By default the extended register set is disabled. You can use this option to enable the
registers RS0..RS7.

Related information
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C compiler option: --fp-model

Menu entry

1. Select C Compiler » Floating-Point.

2. Make a selection from the Floating-point model list.

3. If you selected Custom, enable one or more individual options.

Command line syntax
--f p-nodel =f | ags

You can set the following flags:

+/-contract c/C
+/-float fIF
+/-fastlib I/L
+/-nonan n/N
+/-rewrite r’R
+/-trap tT
+/-negzero z/lZ

0

1

2

3

Default: - - f p- nodel =cFI nr Tz

Description

allow expression contraction

treat 'double’ as 'float'

allow less precise library functions
allow optimizations to ignore NaN/Inf
allow expression rewriting

support trapping on exceptions
ignore sign of -0.0

alias for --fp-model=CFLNRtZ (strict)
alias for --fp-model=cFLNRTZ (precise)
alias for --fp-model=cFInrTz (fast double)
alias for --fp-model=cfinrTz (fast single)

With this option you select the floating-point execution model.

With --fp-model=+contract you allow the compiler to contract multiple float operations into a single
operation, with different rounding results. A possible example is fused multiply-add. With
--fp-model=-contract, the fused multiply-and-accumulate (FMA) operations are not generated. FMA
operations are not supported by the IEEE-754 standard. The result of FMA operations is only rounded

once at the end of the FMA.

With --fp-model=+float you tell the compiler to treat variables and constants of type doubl e as f | oat .
Because the f | oat type takes less space, execution speed increases and code size decreases, both at
the cost of less precision. Make sure you specify the corresponding libraries to the linker.
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With --fp-model=+fastlib you allow the compiler to select faster but less accurate library functions for
certain floating-point operations. With --fp-model=-fastlib more precise library functions are used and
the compiler defines the macro __PRECI SE_LI B_FP__, which is used in mat h. h.

With --fp-model=+nonan you allow the compiler to ignore NaN or Inf input values. An example is to
replace multiply by zero with zero.

With --fp-model=+rewrite you allow the compiler to rewrite expressions by reassociating. This might
result in rounding differences and possibly different exceptions. An example is to rewrite (a*c)+(b*c) as
(at+b)*c.

With --fp-model=+trap operations trap on floating-point exceptions. The floating-point instructions, as
implemented in the FPU, need to be handled in a special way if floating-point trapping behavior is expected
from the generated code. Make sure you specify the corresponding trapping floating-point library to the
linker.

With --fp-model=+negzero you allow the compiler to ignore the sign of -0.0 values. An example is to
replace (a-a) by zero.

Related information

Pragmas STDC FP_CONTRACT, f p_negzero,fp_nonanandfp_rewi tein Section 1.7, Pragmas to
Control the Compiler.
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C compiler option: --global-type-checking
Menu entry

1. Select C Compiler » Diagnostics.

2. Enable the option Perform global type checking on C code.

Command line syntax

--gl obal -t ype-checki ng

Description

The C compiler already performs type checking within each module. Use this option when you want the
linker to perform type checking between modules.

Related information

245



TASKING VX-toolset for MCS User Guide

C compiler option: --help (-?)
Menu entry
Command line syntax

--help[=item

-?

You can specify the following arguments:

intrinsics i Show the list of intrinsic functions

options o] Show extended option descriptions

pragmas p Show the list of supported pragmas

typedefs t Show the list of predefined typedefs
Description

Displays an overview of all command line options. With an argument you can specify which extended
information is shown.

Example

The following invocations all display a list of the available command line options:
cncs -?

cntcs --help

cnts

The following invocation displays a list of the available pragmas:

cnts - - hel p=pr agnas

Related information
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C compiler option: --include-directory (-I)

Menu entry
1. Select C Compiler » Include Paths.

The Include paths box shows the directories that are added to the search path for include files.
2. To define a new directory for the search path, click on the Add button in the Include paths box.

3. Type or select a path.

Use the Edit and Delete button to change a path or to remove a path from the list.

Command line syntax
--include-directory=path,...

-lpath, ...

Description

With this option you can specify the path where your include files are located. A relative path will be
relative to the current directory,

The order in which the compiler searches for include files is:

1. The pathname in the C source file and the directory of the C source (only for #include files that are
enclosed in ")

2. The path that is specified with this option.
3. The path that is specified in the environment variable CMCSI NC when the product was installed.

4. The default directory $( PRODDI R) \ i ncl ude (unless you specified option --no-stdinc).

Example
Suppose that the C source file t est . ¢ contains the following lines:

#i ncl ude <stdio. h>
#i ncl ude "nyinc. h"

You can call the compiler as follows:
cnts --include-directory=nyinclude test.c

First the compiler looks for the file st di 0. h in the directory nyi ncl ude relative to the current directory.
If it was not found, the compiler searches in the environment variable and then in the default include
directory.

247



TASKING VX-toolset for MCS User Guide

The compiler now looks for the file myi nc. h in the directory where t est . ¢ is located. If the file is not
there the compiler searches in the directory myi ncl ude. If it was still not found, the compiler searches
in the environment variable and then in the default include directory.

Related information

C compiler option --include-file (Include file at the start of a compilation)

C compiler option --no-stdinc (Skip standard include files directory)
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C compiler option: --include-file (-H)
Menu entry
1. Select C Compiler » Preprocessing.
The Pre-include files box shows the files that are currently included before the compilation starts.
2. To define a new file, click on the Add button in the Pre-include files box.

3. Type the full path and file name or select a file.

Use the Edit and Delete button to change a file name or to remove a file from the list.

Command line syntax
--include-file=file,...
-Hile,...

Description

With this option you include one or more extra files at the beginning of each C source file, before other
includes. This is the same as specifying #i ncl ude "fil e" atthe beginning of each of your C sources.

Example

cncs --include-file=stdio.h testl.c test2.c

The file st di 0. h is included at the beginning of both t est 1. ¢ and t est 2. c.
Related information

C compiler option --include-directory (Add directory to include file search path)
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C compiler option: --inline

Menu entry

1. Select C Compiler » Optimization.

2. Enable the option Always inline function calls.

Command line syntax

--inline

Description

With this option you instruct the compiler to inline calls to functions without the __noi nl i ne function

qualifier whenever possible. This option has the same effect as a #pr agrma i nl i ne at the start of the
source file.

Example
To always inline function calls:

cncs --inline test.c

Related information

Section 1.9.5, Inlining Functions: inline
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C compiler option: --inline-max-incr / --inline-max-size
Menu entry

1. Select C Compiler » Optimization.

2. Inthe Maximum size increment when inlining field, enter a value (default -1).

3. Inthe Maximum size for functions to always inline field, enter a value (default -1).

Command line syntax

--inline-max-incr=percentage (default: -1)
--inline-nmax-si ze=threshol d (default: -1)

Description

With these options you can control the automatic function inlining optimization process of the compiler.
These options only have effect when you have enabled the inlining optimization (option --optimize=+inline
or Optimize most).

Regardless of the optimization process, the compiler always inlines all functions that have the
function qualifier i nl i ne.

With the option --inline-max-size you can specify the maximum size of functions that the compiler inlines
as part of the optimization process. The compiler always inlines all functions that are smaller than the
specified threshold. The threshold is measured in compiler internal units and the compiler uses this
measure to decide which functions are small enough to inline. The default threshold is -1, which means
that the threshold depends on the option --tradeoff.

After the compiler has inlined all functions that have the function qualifier i nl i ne and all functions that
are smaller than the specified threshold, the compiler looks whether it can inline more functions without
increasing the code size too much. With the option --inline-max-incr you can specify how much the code
size is allowed to increase. The default value is -1, which means that the value depends on the option
--tradeoff.

Example
cncs --optimze=+inline --inline-max-incr=40 --inline-max-size=15 test.c

The compiler first inlines all functions with the function qualifier i nl i ne and all functions that are smaller
than the specified threshold of 15. If the code size has still not increased with 40%, the compiler decides
which other functions it can inline.

Related information
C compiler option --optimize=+inline (Optimization: automatic function inlining)

Section 1.9.5, Inlining Functions: inline
Section 3.5.3, Optimize for Code Size or Execution Speed
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C compiler option: --instruction-set

Menu entry
1. Select C Compiler » Code Generation.
2. Enable or disable the option Allow the use of divide/modulo instructions.

3. Enable or disable the option Allow the use of multiply instructions.
Command line syntax
--instruction-set=fl ags

You can set the following flags:

+/-divide d/D  allow the use of divide/modulo instructions
+/-multiply m/M  allow the use of multiply instructions
Default: - -i nstructi on- set =dm
Description

With this option you can select which instructions the compiler can use for code generation. When the
compiler is not allowed to use an instruction a run-time library call is used instead. When the selected
core forbids the use of an instruction it will never be used, even when enabled by this option.

With --instruction-set=+divide you allow the compiler to use the DIVU and DIVS instructions. These
instruction are used to generate code for the divide (/ ) and modulo (%) operations.

With --instruction-set=+multiply you allow the compiler to use the MULU and MULS instructions.

Related information
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C compiler option: --iso (-c)
Menu entry

1. Select C Compiler » Language.

2. From the Comply to C standard list, select ISO C99, ISO C11, or ISO C90.

Command line syntax

--is0={90]| 99| 11}

-c{90]| 99| 11}

Default: - -i so=11

Description

With this option you select the ISO C standard. C90 is also referred to as the "ANSI C standard". C99

refers to the ISO/IEC 9899:1999 (E) standard. C11 refers to the ISO/IEC 9899:2011 (E) standard. C11
is the default.

Example

To select the ISO C99 standard on the command line:
cncs --is0=99 test.c

Related information

C compiler option --language (Language extensions)
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C compiler option: --keep-output-files (-k)

Menu entry

Eclipse always removes the . sr ¢ file when errors occur during compilation.

Command line syntax
--keep-output-files
-k

Description

If an error occurs during compilation, the resulting . sr ¢ file may be incomplete or incorrect. With this
option you keep the generated output file (. sr ¢) when an error occurs.

By default the compiler removes the generated output file (. sr ¢c) when an error occurs. This is useful
when you use the make utility. If the erroneous files are not removed, the make utility may process corrupt
files on a subsequent invocation.

Use this option when you still want to inspect the generated assembly source. Even if it is incomplete or
incorrect.

Example

cnts --keep-output-files test.c

When an error occurs during compilation, the generated output file t est . sr ¢ will not be removed.
Related information

C compiler option --warnings-as-errors (Treat warnings as errors)
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C compiler option: --language (-A)
Menu entry
1. Select C Compiler » Language.
2. Enable or disable one or more of the following options:
» Allow GNU C extensions
* Allow // comments in ISO C90 mode
» Check assignment of string literal to non-'const’ string pointer
* Allow optimization across volatile access

 Allow Shift JIS Kanji in strings

Command line syntax
- -l anguage=[f I ags]
- Al fl ags]

You can set the following flags:

+/-gcc g/G  enable a number of gcc extensions
+/-kanji k/K support for Shift JIS Kanji in strings
+/-comments p/P /I comments in ISO C90 mode
+/-volatile viV don't optimize across volatile access
+/-strings xIX relaxed const check for string literals

Default: - AGKpVx

Default (without flags): - AGKPVX

Description

With this option you control the language extensions the compiler can accept. By default the MCS compiler
allows all language extensions, except for gcc extensions.

The option --language (-A) without flags disables all language extensions.

GNU C extensions

The --language=+gcc (-Ag) option enables the following gcc language extensions:
» The identifier __ FUNCTION__ expands to the current function name.

 Alternative syntax for variadic macros.
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 Alternative syntax for designated initializers.

 Allow zero sized arrays.

 Allow empty struct/union.

 Allow unnamed struct/union fields.

* Allow empty initializer list.

« Allow initialization of static objects by compound literals.

» The middle operand of a ? : operator may be omitted.

» Allow a compound statement inside braces as expression.

« Allow arithmetic on void pointers and function pointers.

» Allow a range of values after a single case label.

» Additional preprocessor directive #war ni ng.

» Allow comma operator, conditional operator and cast as Ivalue.
 An inline function without "st at i c" or "ext er n" will be global.
e An"extern inline"function will not be compiled on its own.

For a more complete description of these extensions, you can refer to the UNIX gcc info pages (info
gce).

Shift JIS Kanji support

With --language=+kanji (-Ak) you tell the compiler to support Shift JIS encoded Kanji multi-byte characters
in strings, (wide) character constants and / / comments. Without this option, encodings with Ox5c as the
second byte conflict with the use of the backslash as an escape character. Shift JISin/ *. . . */ comments
is supported regardless of this option. Note that Shift JIS also includes Katakana and Hiragana.

Comments in ISO C90 mode

With --language=+comments (-Ap) you tell the compiler to allow C++ style comments (//) in ISO C90
mode (option --is0=90). In ISO C99 mode this style of comments is always accepted.

Check assignment of string literal to non-const string pointer

With --language=+strings (-Ax) you disable warnings about discarded const qualifiers when a string
literal is assigned to a non-const pointer.

char *p;
int main( void)
{
p="hello"; // with -AX the conpiler issues warning W25
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}

Optimization across volatile access

Tool Options

With the --language=+volatile (-Av) option, the compiler will block optimizations when reading or writing
a volatile object, by executing all memory and register accesses before the access of the volatile object.
The volatile access acts as a memory barrier. With this option you can prevent for example that code

below the volatile object is optimized away to somewhere above the volatile object.

Example:

extern unsigned int variable;

extern volatile unsigned int access;

voi d Test Func( unsigned int flag )

{

access =
vari abl e
if( vari

{
}

vari abl e
access =

vari

}

0;
| = flag;
able == 3)

able = 0;

| = 0x8000;
1;

Result with --language=-volatile (default):

Test Func:
nmov|
mw
nrd
or
at ul
j bc
nmov|

.L2:
orl
nmov|
mw
mw
ret

Result with --language=+volatile:

Test Func:
nmov|
mw
nrd
or

.type func
r5, #0

r5, access
r5,vari abl e
r5r2

r5, #3

sta, #5, . L2
r5, #0

r5, #32768
ra, #1

r4, access

r5,vari abl e

.type func
r5, #0

r5, access
r5,vari abl e
r5r2

<== Vol atil e access

<== Vol atil e access
<== Mboved across vol atile access

<== Vol atil e access
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at ul r5, #3
j bc sta, #5,.L2
novl r5, #0
.L2:
orl r5, #32768
mw r5,variabl e ;. <== Not npved
novl r5, #1
mw r5, access ; <== Vol atil e access

ret

Note that the volatile behavior of the compiler with option --language=-volatile or --language=+volatile
is ISO C compliant in both cases.

Related information
C compiler option --iso (ISO C standard)

Section 1.4, Shift JIS Kanji Support
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C compiler option: --make-target

Menu entry

Command line syntax

- -make-t ar get =nane

Description

With this option you can overrule the default target name in the make dependencies generated by the

options --preprocess=+make (-Em) and --dep-file. The default target name is the basename of the input
file, with extension . o.

Example

cnts --preprocess=+make --neke-target=nytarget.o test.c

The compiler generates dependency lines with the default target name nyt ar get . o instead of t est . 0.
Related information

C compiler option --preprocess=+make (Generate dependencies for make)

C compiler option --dep-file (Generate dependencies in a file)
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C compiler option: --misrac

Menu entry
1. Select C Compiler » MISRA C.
2. Make a selection from the MISRA C checking list.

3. Ifyou selected Custom, expand the Custom 1998, Custom 2004 or Custom 2012 entry and enable
one or more individual rules.

Command line syntax
--misrac={all | nr[-nr]},...
Description

With this option you specify to the compiler which MISRA C rules must be checked. With the option
--misrac=all the compiler checks for all supported MISRA C rules.

Example
cnts --misrac=9-13 test.c

The compiler generates an error for each MISRA C rule 9, 10, 11, 12 or 13 violation in file t est . c.

Related information

Section 3.6.2, C Code Checking: MISRA C

C compiler option --misrac-mandatory-warnings
C compiler option --misrac-advisory-warnings
C compiler option --misrac-required-warnings

Linker option --misrac-report
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C compiler option: --misrac-advisory-warnings / --misrac-required-warnings
/ --misrac-mandatory-warnings

Menu entry

1. Select C Compiler » MISRA C.

2. Make a selection from the MISRA C checking list.

3. Enable one or more of the options:
Warnings instead of errors for mandatory rules
Warnings instead of errors for required rules
Warnings instead of errors for advisory rules.

Command line syntax
--m srac-advi sory-war ni ngs

--m srac-required-warni ngs
--m srac- mandat or y- war ni ngs

Description

Normally, if an advisory rule or required rule is violated, the compiler generates an error. As a consequence,
no output file is generated. With this option, the compiler generates a warning instead of an error.

Related information
Section 3.6.2, C Code Checking: MISRA C
C compiler option --misrac

Linker option --misrac-report
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C compiler option: --misrac-version

Menu entry
1. Select C Compiler » MISRA C.

2. Select the MISRA C version: 1998, 2004 or 2012.

Command line syntax
--m srac-version={1998| 2004| 2012}

Default: 2004
Description
MISRA C rules exist in three versions: MISRA C:1998, MISRA C:2004 and MISRA C:2012. By default,

the C source is checked against the MISRA C:2004 rules. With this option you can select which version
to use.

Related information
Section 3.6.2, C Code Checking: MISRA C

C compiler option --misrac

262



Tool Options

C compiler option: --no-stdinc

Menu entry

1. Select C Compiler » Miscellaneous.

2. Add the option --no-stdinc to the Additional options field.

Command line syntax

--no-stdinc

Description

With this option you tell the compiler not to look in the defaulti ncl ude directory relative to the installation

directory, when searching for include files. This way the compiler only searches in the include file search
paths you specified.

Related information
C compiler option --include-directory (Add directory to include file search path)

Section 3.3, How the Compiler Searches Include Files
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C compiler option: --no-warnings (-w)
Menu entry
1. Select C Compiler » Diagnostics.
The Suppress C compiler warnings box shows the warnings that are currently suppressed.
2. To suppress a warning, click on the Add button in the Suppress C compiler warnings box.

3. Enter the numbers, separated by commas or as a range, of the warnings you want to suppress (for
example 537, 538). Or you can use the Add button multiple times.

4. To suppress all warnings, enable the option Suppress all warnings.
Use the Edit and Delete button to change a warning number or to remove a number from the list.

Command line syntax

- - no- war ni ngs[ =nunber [ - nunber], ...]

-w nunber [ - nunber],...]

Description

With this option you can suppresses all warning messages or specific warning messages.
On the command line this option works as follows:

* If you do not specify this option, all warnings are reported.

« If you specify this option but without numbers, all warnings are suppressed.

* If you specify this option with a number or a range, only the specified warnings are suppressed. You
can specify the option --no-warnings=number multiple times.

Example

To suppress warnings 537 and 538, enter:

cnts test.c --no-warni ngs=537, 538

Related information

C compiler option --warnings-as-errors (Treat warnings as errors)

Pragma war ni ng
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C compiler option: --optimize (-O)

Menu entry

1. Select C Compiler » Optimization.

2. Select an optimization level in the Optimization level box.
Command line syntax

--optimze[ =fl ags]

-Ofl ags

You can set the following flags:

+/-coalesce a/lA Coalescer: remove unnecessary moves
+/-ipro b/B Interprocedural register optimizations
+/-cse c/C Common subexpression elimination
+/-expression e/lE Expression simplification

+/-flow fIF Control flow simplification

+/-glo g/G  Generic assembly code optimizations
+/-wrap h/H Shrink wrapping

+/-inline il Automatic function inlining

+/-loop I/L Loop transformations

+/-forward 0/0  Forward store

+/-propagate p/P Constant propagation

+/-subscript SIS Subscript strength reduction
+/-unroll u/U Unroll small loops

+/-peephole ylIY Peephole optimizations

Use the following options for predefined sets of flags:

--optimize=0 -O0  No optimization
Alias for -OaBCEFGHILOPSUY

No optimizations are performed except for the coalescer (to allow better debug information). The compiler
tries to achieve an optimal resemblance between source code and produced code. Expressions are
evaluated in the same order as written in the source code, associative and commutative properties are
not used.

--optimize=1 -O1  Optimize
Alias for -OabcefghILOPSUy

Enables optimizations that do not affect the debug ability of the source code. Use this level when you
encounter problems during debugging your source code with optimization level 2.
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--optimize=2 -02  Optimize more (default)
Alias for -OabcefghllopsUy

Enables more optimizations to reduce code size and/or execution time. This is the default optimization
level.

--optimize=3 -O3  Optimize most
Alias for -Oabcefghilopsuy

This is the highest optimization level. Use this level to decrease execution time to meet your real-time
requirements.

Default: - - opti m ze=2
Description

With this option you can control the level of optimization. If you do not use this option, the default
optimization level is Optimize more (option --optimize=2 or --optimize).

When you use this option to specify a set of optimizations, you can overrule these settings in your C
source file with #pragma optim ze flag/#pragnma endoptini ze.

In addition to the option --optimize, you can specify the option --tradeoff (-t). With this option you specify

whether the used optimizations should optimize for more speed (regardless of code size) or for smaller
code size (regardless of speed).

Example
The following invocations are equivalent and result all in the default optimization set:

cnts test.c

cnts --optimize=2 test.c
cncs -Q2 test.c

cnts --optimze test.c
cncs -Otest.c

cnts -Cabcefgllopsy test.c
cnts --optim ze=+coal esce, +i pro, +cse, +texpressi on, +f | ow,

+gl o, +wr ap, -i nl i ne, +l oop, +f or war d, +pr opagat e,
+subscri pt, -unrol |, +peephol e test.c

Related information
C compiler option --tradeoff (Trade off between speed and size)
Pragma opti m ze/ endopti m ze

Section 3.5, Compiler Optimizations
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C compiler option: --option-file (-f)

Menu entry
1. Select C Compiler » Miscellaneous.
2. Add the option --option-file to the Additional options field.

Be aware that the options in the option file are added to the C compiler options you have set in the
other pages. Only in extraordinary cases you may want to use them in combination.

Command line syntax
--option-file=file,...

-f file,...

Description

This option is primarily intended for command line use. Instead of typing all options on the command line,
you can create an option file which contains all options and flags you want to specify. With this option
you specify the option file to the compiler.

Use an option file when the command line would exceed the limits of the operating system, or just to store
options and save typing.

You can specify the option --option-file multiple times.

Format of an option file
* Multiple arguments on one line in the option file are allowed.
» To include whitespace in an argument, surround the argument with single or double quotes.

« If you want to use single quotes as part of the argument, surround the argument by double quotes and
vise versa:

"This has a single quote ' enbedded"
"This has a double quote " enbedded'
'"This has a double quote " and a single quote '"' enbedded"
» When a text line reaches its length limit, use a \ to continue the line. Whitespace between quotes is
preserved.

"This is a continuation \
li ne"

-> "This is a continuation |ine"
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* Itis possible to nest command line files up to 25 levels.

Example

Suppose the file myopt i ons contains the following lines:

--debug-info
- - def i ne=DEMO=1
test.c

Specify the option file to the compiler:
cnts --option-fil e=myoptions
This is equivalent to the following command line:

cnts --debug-info --define=DEMO=1 test.c

Related information
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C compiler option: --output (-0)

Menu entry

Eclipse names the output file always after the C source file.
Command line syntax

--output=file

-o file

Description

With this option you can specify another filename for the output file of the compiler. Without this option
the basename of the C source file is used with extension . src.

Example
To create the file out put . src instead of t est . src, enter:

cnts --output=output.src test.c

Related information
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C compiler option: --preprocess (-E)

Menu entry

1. Select C Compiler » Preprocessing.

2. Enable the option Store preprocessor output in <file>.pre.

3. (Optional) Enable the option Keep comments in preprocessor output.
4. (Optional) Enable the option Keep #line info in preprocessor output.
Command line syntax

- - preprocess[ =fl ags]

-E[ fl ags]

You can set the following flags:

+/-comments c/C keep comments

+/-includes i/l generate a list of included source files
+/-list I/L generate a list of macro definitions
+/-make m/M  generate dependencies for make
+/-noline p/P strip #line source position information

Default: - ECI LIMP

Description

With this option you tell the compiler to preprocess the C source. Under Eclipse the compiler sends the
preprocessed output to the file nane. pr e (where name is the name of the C source file to compile).
Eclipse also compiles the C source.

On the command line, the compiler sends the preprocessed file to stdout. To capture the information in
a file, specify an output file with the option --output.

With --preprocess=+comments you tell the preprocessor to keep the comments from the C source file
in the preprocessed output.

With --preprocess=+includes the compiler will generate a list of all included source files. The preprocessor
output is discarded.

With --preprocess=+list the compiler will generate a list of all macro definitions. The preprocessor output
is discarded.

With --preprocess=+make the compiler will generate dependency lines that can be used in a Makefile.
The preprocessor output is discarded. The default target name is the basename of the input file, with the
extension . 0. With the option --make-target you can specify a target name which overrules the default

target name.
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With --preprocess=+noline you tell the preprocessor to strip the #line source position information (lines
starting with #l i ne). These lines are normally processed by the assembler and not needed in the
preprocessed output. When you leave these lines out, the output is easier to read.

Example
cnts --preprocess=+coments, +i ncl udes, -1ist, -nake,-noline test.c --output=test.pre

The compiler preprocesses the file t est . ¢ and sends the output to the file t est . pr e. Comments and
a list of all included source files are included but no list of macro definitions and no dependencies are
generated and the line source position information is not stripped from the output file.

Related information
C compiler option --dep-file (Generate dependencies in a file)

C compiler option --make-target (Specify target name for -Em output)
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C compiler option: --rename-sections (-R)

Menu entry
1. Select C Compiler » Allocation

The Rename sections box shows the sections that are currently renamed.
2. Torename a section, click on the Add button in the Rename sections box.
3. Type the rename rule in the format type=format or format (for example,

ncsdat a={nmodul e} . {attri b})

Use the Edit and Delete button to change a section renaming or to remove an entry from the list.

Command line syntax

--renane-sections[=[type=][format_string]],...

-R[[type=][format _string]],...

Default section name: .type.{module}.{name}

Description

By default the compiler extends the standard ELF section names with the module name and the name
of the symbol that is allocated in the section. You can use this option to create your own unique section

names to ease selection in linker script files for locating.

With the type argument you select which sections are renamed. When the type of a section matches, the
section name will get the specified format_string as suffix.

You can specify the following section types:

Section type Description

mcstext program code

mcsdata initialized data

mcsbss uninitialized data (cleared)
all all sections

When you omit the type or use type "all", all sections will be renamed.

With the format_string you specify the string that extends the ELF section name. The format string can
contain characters and may contain the following format specifiers:

{attrib} Expands to the section attributes, separated by underscores. The cluster attribute,
used when debug information is enabled, is not included.

{odul e} Expands to the basename of the module name.
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{nane} Expands to the object name, name of variable or function.

In format specifier expansions (for example, a module name with an extra dot), dots ('.") are replaced by
dollars ($).

When you omit the format_string, only the section type will be used as the section name.

Example
To rename sections of type ntsdat a to . ntsdat a. nydat a. variable_name:
cnts --renane-sections=ntsdat a=nydat a. { nane} test.c

To generate the section name .type. NEWinstead of the default section name
.type.module_name.symbol_name, enter:

cncs -RNEWtest.c

To generate the section name section_type_prefix instead of the default section name
section_type_prefix.module_name.symbol_name, enter:

cncs -Rtest.c

Related information

Section 1.10, Section Naming
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C compiler option: --signed-bitfields

Menu entry

1. Select C Compiler » Language.

2. Enable the option Treat 'int' bit-fields as signed.

Command line syntax

--signed-bitfields

Description

For bit-fields it depends on the implementation whether a plaini nt is treated as si gned i nt orunsi gned
i nt.By default ani nt bit-field is treated as unsi gned i nt . This offers the best performance. With this

option you tell the compiler to treat i nt bit-fields as si gned i nt . In this case, you can still add the
keyword unsi gned to treat a particular i nt bit-field as unsi gned.

Related information

Section 1.1, Data Types
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C compiler option: --source (-s)

Menu entry

1. Select C Compiler » Miscellaneous.

2. Enable the option Merge C source code with generated assembly.
Command line syntax

--source

-s

Description

With this option you tell the compiler to merge C source code with generated assembly code in the output
file. The C source lines are included as comments.

Related information

Pragmas sour ce/ nosour ce

275



TASKING VX-toolset for MCS User Guide

C compiler option: --stdout (-n)

Menu entry

Command line syntax
- - stdout

-n

Description

With this option you tell the compiler to send the output to st dout (usually your screen). No files are
created. This option is for example useful to quickly inspect the output or to redirect the output to other
tools.

Related information
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C compiler option: --tradeoff (-t)

Menu entry
1. Select C Compiler » Optimization.

2. Select a trade-off level in the Trade-off between speed and size box.

Command line syntax
--tradeof f ={ 0] 1| 2| 3| 4}
-t{0] 1| 2] 3| 4}

Default: - - t r adeof f =4
Description

If the compiler uses certain optimizations (option --optimize), you can use this option to specify whether
the used optimizations should optimize for more speed (regardless of code size) or for smaller code size
(regardless of speed).

By default the compiler optimizes for code size (--tradeoff=4).
If you have not specified the option --optimize, the compiler uses the default Optimize more
optimization. In this case it is still useful to specify a trade-off level.

With option --tradeoff=3 or --tradeoff=4 the loop alignment optimization is switched off.

Example
To set the trade-off level for the used optimizations:
cnts --tradeoff=2 test.c

The compiler uses the default Optimize more optimization level and balances speed and size while
optimizing.

Related information
C compiler option --optimize (Specify optimization level)

Section 3.5.3, Optimize for Code Size or Execution Speed
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C compiler option: --uchar (-u)

Menu entry

1. Select C Compiler » Language.

2. Enable the option Treat 'char’ variables as unsigned.
Command line syntax

- -uchar

-u

Description

By default char is the same as specifying si gned char . With this option char is the same as unsi gned
char.

Related information

Section 1.1, Data Types
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C compiler option: --undefine (-U)

Menu entry
1. Select C Compiler » Preprocessing
The Defined symbols box shows the symbols that are currently defined.

2. Toremove a defined symbol, select the symbol in the Defined symbols box and click on the Delete
button.

Command line syntax
--undefi ne=nmacr o_nane

- Uracr o_nane

Description

With this option you can undefine an earlier defined macro as with #undef . This option is for example
useful to undefine predefined macros.

The following predefined ISO C standard macros cannot be undefined:

__FILE__ current source filename

__LINE__ current source line number (int type)
_TIME__ hh:mm:ss

__DATE__ Mmm dd yyyy

__STDC__ level of ANSI standard

Example

To undefine the predefined macro __ TASKI NG__:

cnts --undefine=_ TASKING test.c

Related information
C compiler option --define (Define preprocessor macro)

Section 1.8, Predefined Preprocessor Macros
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C compiler option: --unroll-factor

Menu entry

Command line syntax
--unroll-factor=val ue

Default: - -unrol | -factor=-1

Description

With the loop unrolling optimization, short loops are eliminated by replacing them with a number of copies
to reduce the number of branches. With this option you specify how many times eligible loops should be
unrolled. When the unroll factor is -1 (default), small loops are unrolled automatically if the loop unrolling
optimization (--optimize=+unroll / -Ou) is enabled and the optimization trade-off is set for speed
(--tradeoff=0/ -t0)).

Instead of this option you can use the following pragmas:
#pragma unrol | _factor val ue

#pragma endunrol | _factor

Example

To allow an unroll factor of four, enter:

cnts --optimze=+unroll --unroll-factor=4 --tradeoff=0 test.c
Related information

Pragma unrol | _factor

C compiler option --optimize (Specify optimization level)

C compiler option --tradeoff (Trade off between speed and size)

Section 3.5, Compiler Optimizations
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C compiler option: --verbose (-v)

Menu entry
Command line syntax
--verbose

-V

Description

With this option you put the C compiler in verbose mode. The C compiler performs its tasks while it prints
the steps it performs to st dout .

Related information
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C compiler option: --version (-V)

Menu entry

Command line syntax

--version
-V
Description

Display version information. The compiler ignores all other options or input files.

Related information
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C compiler option: --warnings-as-errors

Menu entry
1. Select Global Options.

2. Enable the option Treat warnings as errors.

Command line syntax

- -war ni ngs-as-errors[=nunber[-nunber],...]

Description

If the compiler encounters an error, it stops compiling. When you use this option without arguments, you
tell the compiler to treat all warnings not suppressed by option --no-warnings (or #pr agna war ni ng)
as errors. This means that the exit status of the compiler will be non-zero after one or more compiler
warnings. As a consequence, the compiler now also stops after encountering a warning.

You can limit this option to specific warnings by specifying a comma-separated list of warning numbers
or ranges. In this case, this option takes precedence over option --no-warnings (and #pr agna war ni ng).

Related information
C compiler option --no-warnings (Suppress some or all warnings)

Pragma war ni ng
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8.2. Assembler Options

This section lists all assembler options.

Options in Eclipse versus options on the command line

Most command line options have an equivalent option in Eclipse but some options are only available on
the command line. Eclipse invokes the assembler via the control program. Therefore, it uses the syntax

of the control program to pass options and files to the assembiler. If there is no equivalent option in Eclipse,
you can specify a command line option in Eclipse as follows:

1. From the Project menu, select Properties for
The Properties dialog appears.
2. Inthe left pane, expand C/C++ Build and select Settings.
In the right pane the Settings appear.
3. On the Tool Settings tab, select Assembler » Miscellaneous.
4. Inthe Additional options field, enter one or more command line options.

Because Eclipse uses the control program, Eclipse automatically precedes the option with -Wa to
pass the option via the control program directly to the assembler.

Be aware that some command line options are not useful in Eclipse or just do not have any effect. For
example, the option -V displays version header information and has no effect in Eclipse.

Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (-)
character, long option names always begin with two minus (--) characters. You can abbreviate long option
names as long as it forms a unique name. You can mix short and long option names on the command
line.

Options can have flags or suboptions. To switch a flag 'on’, use a lowercase letter or a +longflag. To
switch a flag off, use an uppercase letter or a -longflag. Separate longflags with commas. The following
two invocations are equivalent:

asncts -1 -LeMtest.src
asnts --list-file --list-format=+synbol,-macro test.src

When you do not specify an option, a default value may become active.
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Assembler option: --case-insensitive (-¢)

Menu entry

1. Select Assembler » Symbols.

2. Enable the option Case insensitive identifiers.
Command line syntax

--case-insensitive

-C

Default: case sensitive

Description

Tool Options

With this option you tell the assembler not to distinguish between uppercase and lowercase characters.
By default the assembler considers uppercase and lowercase characters as different characters.

Example

When assembling case insensitive, the label Label Nane is the same label as | abel nane.

asnts --case-insensitive test.asm

Related information

Assembler control $CASE
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Assembler option: --check

Menu entry

Command line syntax

--check

Description

With this option you can check the source code for syntax errors, without generating code. This saves
time in developing your application.

The assembler reports any warnings and/or errors.

This option is available on the command line only.

Related information
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Assembler option: --concatenate-sections

Menu entry
1. Select Assembler » Miscellaneous.

2. Enable the option Merge sections with the same name.

Command line syntax

--concat enat e- secti ons

Description

By default the linker does not merge sections with the same name into one section. With this option the
assembler uses the section attribute concat , instructing the linker to merge sections with the same name.

The advantage of section concatenation is faster locating, because there are less sections to locate.

The disadvantage of section concatenation is less efficient memory use, because of alignment gaps
between (sequentially concatenated) sections.

Related information
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Assembler option: --core

Menu entry

1. Expand C/C++ Build and select Processor.

2. From the Processor Selection list, select a processor.
Command line syntax

--core=core

You can specify the following core arguments:

mcs1.0 MCS v1.0
mcs2.0 MCS v2.0
mcs3.0 MCS v3.0
mcs3.1 MCS v3.1
mcs4.0 MCS v4.0

Default: mcs1.0

Description
With this option you specify the core architecture for a target processor for which you create your
application. If you use Eclipse or the control program, the MCS toolset derives the core from the processor

you selected. The define __CORE__ expands to the core argument without the dot. When the default
core (mcs1.0) is used, the define __CORE_MCS10__ is set to 1.

With --core=mcs2.0, you can use MCS v2.0 instructions in the assembly code. The define
__CORE_MCS20___issetto 1.

With --core=mcs3.0, you can use MCS v3.0 instructions in the assembly code. The define
__CORE_MCS30__issetto 1.

With --core=mcs3.1, you can use MCS v3.1 instructions in the assembly code. The define
__CORE_MCS31___issetto 1.

With --core=mcs4.0, you can use MCS v4.0 instructions in the assembly code. The define
__CORE_MCS40__ issetto 1.

Example

To allow the use of MCS v3.1 instructions in the assembly code, enter:
asnts --core=nts3.1 test.src

Related information

Control program option --cpu (Select processor)
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Assembler option: --debug-info (-g)

Menu entry
1. Select Assembler » Symbols.

2. Select an option from the Generate symbolic debug list.
Command line syntax

- -debug-i nf o[ =f | ags]

-g[flags]

You can set the following flags:

+/-asm a/lA Assembly source line information

+/-hll h/H Pass high level language debug information (HLL)
+/-local I/L Assembler local symbols debug information
+/-smart s/S Smart debug information

Default: - - debug- i nf o=+hl |

Default (without flags): - - debug- i nf o=+smart

Description
With this option you tell the assembler which kind of debug information to emit in the object file.

You cannot specify --debug-info=+asm,+hll. Either the assembler generates assembly source line
information, or it passes HLL debug information.

When you specify --debug-info=+smart, the assembler selects which flags to use. If high level language
information is available in the source file, the assembler passes this information (same as
--debug-info=-asm,+hll,-local). If not, the assembler generates assembly source line information (same
as --debug-info=+asm,-hll,+local).

With --debug-info=AHLS the assembler does not generate any debug information.

Related information

Assembler control $DEBUG
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Assembler option: --define (-D)

Menu entry
1. Select Assembler » Preprocessing.

The Defined symbols box right-below shows the symbols that are currently defined.
2. To define a new symbol, click on the Add button in the Defined symbols box.

3. Type the symbol definition (for example, denp=1)
Use the Edit and Delete button to change a macro definition or to remove a macro from the list.

Command line syntax

- -defi ne=macr o_nane[ =macr o_defi ni ti on]
- Dmacr o_name[ =nacr o_defini tion]
Description

With this option you can define a macro and specify it to the assembler preprocessor. If you only specify
a macro name (no macro definition), the macro expands as '1'".

You can specify as many macros as you like. Simply use the Add button to add new macro definitions.

On the command line, use the option --define (-D) multiple times. If the command line exceeds the limit
of the operating system, you can define the macros in an option file which you then must specify to the
assembler with the option --option-file (-f) file.

Defining macros with this option (instead of in the assembly source) is, for example, useful in combination
with conditional assembly as shown in the example below.

This option has the same effect as defining symbols via the . DEFI NE, . SET, and . EQU directives
(similar to #def i ne in the C language). With the . MACROdirective you can define more complex
macros.

Make sure you do not use a reserved keyword as a macro name, as this can lead to unexpected
results.

Example

Consider the following assembly program with conditional code to assemble a demo program and a real
program:
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.1 F DEMO ==

; instructions for deno application

. ELSE

; instructions for the real application
. ENDI F

You can now use a macro definition to set the DEMO flag:

asnts --define=DEMO t est.asm
asnts --defi ne=DEMO=1 test.asm

Note that both invocations have the same effect.
Related information

Assembler option --option-file (Specify an option file)
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Assembler option: --dep-file

Menu entry
Command line syntax
--dep-file[=file]
Description

With this option you tell the assembler to generate dependency lines that can be used in a Makefile. The
dependency information will be generated in addition to the normal output file.

By default, the information is written to a file with extension . d. When you specify a filename, all
dependencies will be combined in the specified file.

Example
asnts --dep-file=test.dep test.asm

The assembler assembles the file t est . asm which results in the output file t est . 0, and generates
dependency lines in the file t est . dep.

Related information

Assembler option --make-target (Specify target name for --dep-file output)
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Assembler option: --diag

Menu entry

1. From the Window menu, select Show View » Other » TASKING » Problems.
The Problems view is added to the current perspective.

2. In the Problems view right-click on a message.
A popup menu appears.

3. Select Detailed Diagnostics Info.

A dialog box appears with additional information.
Command line syntax
--diag=[format:]{all | nr,...}

You can set the following output formats:

html HTML output.
rtf Rich Text Format.
text ASCII text.

Default format: text

Description

With this option you can ask for an extended description of error messages in the format you choose.
The output is directed to stdout (normally your screen) and in the format you specify. You can specify the
following formats: html, rtf or text (default). To create a file with the descriptions, you must redirect the
output.

With the suboption all, the descriptions of all error messages are given. If you want the description of one
or more selected error messages, you can specify the error message numbers, separated by commas.

Example

To display an explanation of message number 244, enter:
asnts --di ag=244

This results in the following message and explanation:

W244: additional input files will be ignored

The assenbl er supports only a single input file. Al other input files are ignored.
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To write an explanation of all errors and warnings in HTML format to file aser r or s. ht m , use redirection
and enter:

asnts --diag=htm:all > aserrors.htni

Related information

Section 4.5, Assembler Error Messages
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Assembler option: --emit-locals

Menu entry

1. Select Assembler » Symbols.

2. Enable or disable one or both of the following options:
* Emit local EQU symbols

» Emit local non-EQU symbols

Command line syntax
--emt-locals[=flag,...]
You can set the following flags:

+/-equs e/lE emit local EQU symbols
+/-symbols s/S emit local non-EQU symbols

Default: - - eni t -1 ocal s=ES
Default (without flags): - - eni t - | ocal s=+synbol s

Description

With the option --emit-locals=+equs the assembler also emits local EQU symbols to the object file.
Normally, only global symbols and non-EQU local symbols are emitted. Having local symbols in the object
file can be useful for debugging.

Related information

Assembler directive .EQU
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Assembler option: --endianness

Menu entry
1. Select Global Options.

2. Specify the Endianness:Little-endian mode or Big-endian mode.

Command line syntax
- -endi anness=endi anness

-B
- - bi g-endi an

You can specify the following endianness:

big b Big endian
little | Little endian (default)
Description

By default, the assembler generates object files with instructions and data in little-endian format (least
significant byte of a word at lowest byte address). With --endianness=big the assembler generates object
files in big-endian format (most significant byte of a word at lowest byte address). -B is an alias for option

--endianness=big.

The endianness is reflected in the list file.

Assembly code can check the setting of this option by means of the built-in assembly function

@3l GENDI AN() .

Related information

Assembly function @3l GENDI AN( )
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Assembler option: --error-file

Menu entry
Command line syntax
--error-file[=file]
Description

With this option the assembler redirects diagnostic messages to a file. If you do not specify a filename,
the error file will be named after the output file with extension . er s.

Example
To write diagnostic messages to err or s. er s instead of st der r, enter:

asnts --error-file=errors.ers test.asm

Related information

Section 4.5, Assembler Error Messages
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Assembler option: --error-limit

Menu entry

1. Select Assembler » Diagnostics.

2. Enter avalue in the Maximum number of emitted errors field.

Command line syntax

--error-1limt=nunber

Default: 42

Description

With this option you tell the assembler to only emit the specified maximum number of errors. When 0

(null) is specified, the assembler emits all errors. Without this option the maximum number of errors is
42.

Related information

Section 4.5, Assembler Error Messages
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Assembler option: --extended-registers

Menu entry
1. Select C Compiler » Code Generation.

2. Enable the option Use extended register set.

Command line syntax

--extended-registers

Description
The extended register set extends the registers of the current MCS channel with the registers of the next

MCS channel. These registers are RS0..RS7, DSTAT, GMIO and GMI1. By default the extended register
set is disabled. You can use this option to enable the extended register set.

Related information
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Assembler option: --help (-?)

Menu entry

Command line syntax
--help[=item

-2

You can specify the following arguments:

options Show extended option descriptions

Description

Displays an overview of all command line options. When you specify the argument options you can list
detailed option descriptions.

Example
The following invocations all display a list of the available command line options:

asncs -?
asnts --help
asncs

To see a detailed description of the available options, enter:

asnts --hel p=options

Related information
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Assembler option: --include-directory (-)

Menu entry
1. Select Assembler » Include Paths.

The Include paths box shows the directories that are added to the search path for include files.
2. To define a new directory for the search path, click on the Add button in the Include paths box.

3. Type or select a path.

Use the Edit and Delete button to change a path or to remove a path from the list.

Command line syntax
--include-directory=path,...
-lpath, ...

Description

With this option you can specify the path where your include files are located. A relative path will be
relative to the current directory,

The order in which the assembler searches for include files is:

1. The pathname in the assembly file and the directory of the assembly source.

2. The path that is specified with this option.

3. The path that is specified in the environment variable ASMCSI NC when the product was installed.
4. The default directory $( PRODDI R) \ i ncl ude.

Example

Suppose that the assembly source file t est . asmcontains the following lines:

. I NCLUDE ' nyi nc. i nc'

You can call the assembler as follows:

asnts --include-directory=c:\proj\include test.asm

First the assembler looks for the file nyi nc. i nc in the directory where t est . asmis located. If it does
not find the file, it looks in the directory c: \ pr oj \ i ncl ude (this option). If the file is still not found, the
assembler searches in the environment variable and then in the default include directory.
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Related information

Assembler option --include-file (Include file at the start of the input file)
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Assembler option: --include-file (-H)

Menu entry
1. Select Assembler » Preprocessing.

The Pre-include files box shows the files that are currently included before the assembling starts.
2. To define a new file, click on the Add button in the Pre-include files box.

3. Type the full path and file name or select a file.
Use the Edit and Delete button to change a file name or to remove a file from the list.

Command line syntax
--include-file=file,...
-Hile,...

Description

With this option (set at project level) you include one extra file at the beginning of the assembly source
file. The specified include file is included before all other includes. This is the same as specifying . | NCLUDE
"file' atthe beginning of your assembly source.

Example
asncts --include-file=nyinc.inc test.asm

The file nyi nc. i nc is included at the beginning of t est . asmbefore it is assembled.

Related information

Assembler option --include-directory (Add directory to include file search path)
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Assembler option: --instruction-set

Menu entry
1. Select C Compiler » Code Generation.
2. Enable or disable the option Allow divide/modulo instructions.

3. Enable or disable the option Allow multiply instructions.
Command line syntax

--instruction-set=fl ags

You can set the following flags:

+/-divide d/D  allow the use of divide/modulo instructions
+/-multiply m/M  allow the use of multiply instructions
Default: - -i nstructi on- set =dm
Description

With this option you can select which instructions the assembler accepts. When the selected core forbids
the use of an instruction it will never be used, even when enabled by this option.

With --instruction-set=+divide you allow the assembler to use the DIVU and DIVS instructions.

With --instruction-set=+multiply you allow the assembler to use the MULU and MULS instructions.

Related information

304



Tool Options

Assembler option: --kaniji

Menu entry

1. Select Assembler » Miscellaneous.

2. Enable the option Allow Shift JIS Kanji in strings.

Command line syntax

--kanj i

Description

With this option you tell the assembler to support Shift JIS encoded Kanji multi-byte characters in strings.
Without this option, encodings with Ox5c¢ as the second byte conflict with the use of the backslash as an
escape character. Shift JIS in comments is supported regardless of this option.

Note that Shift JIS also includes Katakana and Hiragana.

Related information

305



TASKING VX-toolset for MCS User Guide

Assembler option: --keep-output-files (-k)

Menu entry

Eclipse always removes the object file when errors occur during assembling.
Command line syntax

--keep-output-files

-k

Description

If an error occurs during assembling, the resulting object file (. 0) may be incomplete or incorrect. With
this option you keep the generated object file when an error occurs.

By default the assembler removes the generated object file when an error occurs. This is useful when
you use the make utility. If the erroneous files are not removed, the make utility may process corrupt files
on a subsequent invocation.

Use this option when you still want to use the generated object. For example when you know that a
particular error does not result in a corrupt object file.

Related information

Assembler option --warnings-as-errors (Treat warnings as errors)

306



Tool Options

Assembler option: --list-file (-I)

Menu entry
1. Select Assembler » List File.
2. Enable the option Generate list file.

3. Enable or disable the types of information to be included.

Command line syntax
--list-file[=file]

-1 [file]

Default: no list file is generated
Description

With this option you tell the assembler to generate a list file. A list file shows the generated object code
and the relative addresses. Note that the assembler generates a relocatable object file with relative
addresses.

With the optional file you can specify an alternative name for the list file. By default, the name of the list
file is the basename of the output file with the extension . | st.

Related information

Assembler option --list-format (Format list file)
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Assembler option: --list-format (-L)

Menu entry
1. Select Assembler » List File.
2. Enable the option Generate list file.

3. Enable or disable the types of information to be included.

Command line syntax
--list-format=flag,...
-Lfl ags

You can set the following flags:

+/-section d/D  List section directives (. SDECL, . SECT)
+/-symbol e/E  List symbol definition directives

+/-macro m/M  List macro definitions

+/-empty-line n/N  List empty source lines and comment lines (hewline)
+/-conditional p/P  List conditional assembly

+/-equate q/Q List equate and set directives (. EQU, . SET)
+/-relocations r/R  List relocations characters ('r")
+/-equate-values v/V  List equate and set values

+/-wrap-lines w/W  Wrap source lines

+/-macro-expansion x/X  List macro expansions

+/-cycle-count y/Y  List cycle counts

+/-define-expansion z/Z  List define expansions

Use the following options for predefined sets of flags:

--list-format=0 -LO All options disabled
Alias for --list-format=DEMNPQRVWXYZ
--list-format=1 -L1 All options enabled

Alias for --list-format=demnpqrvwxyz
Default: - - | i st - f or mat =dEMhPqr Vnxy Z

Description
With this option you specify which information you want to include in the list file.

On the command line you must use this option in combination with the option --list-file (-1).
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Related information
Assembler option --list-file (Generate list file)

Assembler option --section-info=+list (Display section information in list file)
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Assembler option: --make-target

Menu entry
Command line syntax
- -make-t ar get =nane
Description

With this option you can overrule the default target name in the make dependencies generated by the
option --dep-file. The default target name is the basename of the input file, with extension . o.

Example
asnts --dep-file --make-target=../nytarget.o test.asm

The assembler generates dependency lines with the default target name . . / nyt ar get . o instead of
test.o.

Related information

Assembler option --dep-file (Generate dependencies in a file)

310



Tool Options

Assembler option: --no-notes

Menu entry
1. Select Assembler » Miscellaneous.

2. Add the option --no-notes to the Additional options field.

Command line syntax

--no-notes

Description
By default, the assembler generates a note section in the object file. The note section contains compiler
version and invocation information, if supplied in the input file, and version and invocation information of

the assembler. With this option you can suppress the generation of a note section in the output object
file.

Related information

Section 6.4.2, HLL Dump Output Format
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Assembler option: --no-warnings (-w)

Menu entry
1. Select Assembler » Diagnostics.

The Suppress warnings box shows the warnings that are currently suppressed.
2. To suppress a warning, click on the Add button in the Suppress warnings box.

3. Enter the numbers, separated by commas, of the warnings you want to suppress (for example
201, 202). Or you can use the Add button multiple times.

4. To suppress all warnings, enable the option Suppress all warnings.

Use the Edit and Delete button to change a warning number or to remove a number from the list.

Command line syntax

- - no-war ni ngs[ =nunber, .. .]
-w nunber, .. .]
Description

With this option you can suppresses all warning messages or specific warning messages.
On the command line this option works as follows:

* If you do not specify this option, all warnings are reported.

« If you specify this option but without numbers, all warnings are suppressed.

« If you specify this option with a number, only the specified warning is suppressed. You can specify the
option --no-warnings=number multiple times.

Example

To suppress warnings 201 and 202, enter:
asncts test.asm --no-warni ngs=201, 202
Related information

Assembler option --warnings-as-errors (Treat warnings as errors)
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Assembler option: --option-file (-f)

Menu entry
1. Select Assembler » Miscellaneous.
2. Add the option --option-file to the Additional options field.

Be aware that the options in the option file are added to the assembler options you have set in the
other pages. Only in extraordinary cases you may want to use them in combination.

Command line syntax
--option-file=file,...
-f file,...

Description

This option is primarily intended for command line use. Instead of typing all options on the command line,
you can create an option file which contains all options and flags you want to specify. With this option
you specify the option file to the assembler.

Use an option file when the command line would exceed the limits of the operating system, or just to store
options and save typing.

Option files can also be generated on the fly, for example by the make utility. You can specify the option
--option-file multiple times.

Format of an option file
* Multiple arguments on one line in the option file are allowed.
» To include whitespace in an argument, surround the argument with single or double quotes.

« If you want to use single quotes as part of the argument, surround the argument by double quotes and
vise versa:

"This has a single quote ' enbedded"
"This has a double quote " enbedded’
'"This has a double quote " and a single quote '"' enbedded"
* When a text line reaches its length limit, use a \ to continue the line. Whitespace between quotes is
preserved.

"This is a continuation \
l'i ne"

-> "This is a continuation |ine"
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* Itis possible to nest command line files up to 25 levels.

Example
Suppose the file myopt i ons contains the following lines:

- -debug-i nfo=+asm - | ocal
test.asm

Specify the option file to the assembler:
asnts --option-fil e=nyoptions
This is equivalent to the following command line:

asnts --debug-info=+tasm-1ocal test.asm

Related information
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Assembler option: --output (-0)

Menu entry

Eclipse names the output file always after the input file.
Command line syntax

--output=file

-o file

Description

With this option you can specify another filename for the output file of the assembler. Without this option,
the basename of the assembly source file is used with extension . o.

Example
To create the file r el obj . o instead of asm o, enter:

asnts --output=relobj.o asmasm

Related information
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Assembler option: --page-length

Menu entry

1. Select Assembler » Miscellaneous.

2. Add the option --page-length to the Additional options field.

Command line syntax

- - page- | engt h=nunber

Default: 72

Description

If you generate a list file with the assembler option --list-file, this option sets the number of lines in a page

in the list file. The default is 72, the minimum is 10. As a special case, a page length of 0 turns off page
breaks.

Related information
Assembler option --list-file (Generate list file)

Assembler control $PAGE
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Assembler option: --page-width

Menu entry

1. Select Assembler » Miscellaneous.

2. Add the option --page-width to the Additional options field.
Command line syntax

- - page-w dt h=nunber

Default: 132

Description

If you generate a list file with the assembler option --list-file, this option sets the number of columns per
line on a page in the list file. The default is 132, the minimum is 40.

Related information
Assembler option --list-file (Generate list file)

Assembler control $PAGE
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Assembler option: --preprocess (-E)

Menu entry
Command line syntax
- - preprocess

-E

Description

With this option the assembler will only preprocess the assembly source file. The assembler sends the
preprocessed file to stdout.

Related information
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Assembler option: --preprocessor-type (-m)

Menu entry

Command line syntax

- - preprocessor-type=type

-nt ype

You can set the following preprocessor types:

none n No preprocessor
tasking t TASKING preprocessor

Default: - - pr epr ocessor - t ype=t aski ng

Description

Tool Options

With this option you select the preprocessor that the assembler will use. By default, the assembler uses

the TASKING preprocessor.

When the assembly source file does not contain any preprocessor symbols, you can specify to the

assembler not to use a preprocessor.

Related information
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Assembler option: --section-info (-t)

Menu entry

1. Select Assembler » List File.

2. Enable the option Generate list file.

3. Enable the option List section summary.
and/or

1. Select Assembler » Diagnostics.

2. Enable the option Display section summary.
Command line syntax
--section-info[=flag,...]

-t[flags]

You can set the following flags:

+/-console c/C Display section summary on console
+/-list I/L List section summary in list file

Default: - - sect i on-i nf o=CL

Default (without flags): - - sect i on-i nf o=cl

Description

With this option you tell the assembler to display section information. For each section its memory space,

size, total cycle counts and name is listed on stdout and/or in the list file.

The cycle count consists of two parts: the total accumulated count for the section and the total accumulated
count for all repeated instructions. In the case of nested loops it is possible that the total supersedes the

section total.

Example

To writes the section information to the list file and also display the section information on stdout, enter:

asncs --list-file --section-info asmasm

Related information

Assembler option --list-file (Generate list file)
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Assembler option: --symbol-scope (-i)

Menu entry
1. Select Assembler » Symbols.

2. Enable or disable the option Set default symbol scope to global.

Command line syntax

- -synbol - scope=scope

-i scope

You can set the following scope:

global g Default symbol scope is global
local | Default symbol scope is local

Default: - - synbol - scope=I ocal

Description

With this option you tell the assembler how to treat symbols that you have not specified explicitly as global
or local. By default the assembler treats all symbols as local symbols unless you have defined them
explicitly as global.

Related information
Assembler directive .GLOBAL
Assembler directive .LOCAL

Assembler control $IDENT
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Assembler option: --version (-V)

Menu entry

Command line syntax

--version

-V

Description

Display version information. The assembler ignores all other options or input files.

Related information
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Assembler option: --warnings-as-errors

Menu entry
1. Select Global Options.

2. Enable the option Treat warnings as errors.

Command line syntax

- -war ni ngs- as-errors[=nunber, ...]

Description

If the assembler encounters an error, it stops assembling. When you use this option without arguments,
you tell the assembler to treat all warnings as errors. This means that the exit status of the assembler will
be non-zero after one or more assembler warnings. As a consequence, the assembler now also stops
after encountering a warning.

You can limit this option to specific warnings by specifying a comma-separated list of warning numbers.

Related information

Assembler option --no-warnings (Suppress some or all warnings)
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8.3. Linker Options

This section lists all linker options.

Options in Eclipse versus options on the command line

Most command line options have an equivalent option in Eclipse but some options are only available on
the command line. Eclipse invokes the linker via the control program. Therefore, it uses the syntax of the
control program to pass options and files to the linker. If there is no equivalent option in Eclipse, you can
specify a command line option in Eclipse as follows:

1. From the Project menu, select Properties for
The Properties dialog appears.
2. Inthe left pane, expand C/C++ Build and select Settings.
In the right pane the Settings appear.
3. On the Tool Settings tab, select Linker » Miscellaneous.
4. Inthe Additional options field, enter one or more command line options.

Because Eclipse uses the control program, Eclipse automatically precedes the option with -WI to
pass the option via the control program directly to the linker.

Be aware that some command line options are not useful in Eclipse or just do not have any effect. For
example, the option --keep-output-files keeps files after an error occurred. When you specify this option
in Eclipse, it will have no effect because Eclipse always removes the output file after an error had occurred.

Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (-)
character, long option names always begin with two minus (--) characters. You can abbreviate long option
names as long as it forms a unique name. You can mix short and long option names on the command
line.

Options can have flags or suboptions. To switch a flag 'on’, use a lowercase letter or a +longflag. To
switch a flag off, use an uppercase letter or a -longflag. Separate longflags with commas. The following
two invocations are equivalent:

Imcs -nfkl test.o
Imcs --map-file-format=+files, +link, +locate test.o

When you do not specify an option, a default value may become active.
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Linker option: --case-insensitive

Menu entry

1. Select Linker » Miscellaneous.

2. Enable the option Link case insensitive.
Command line syntax
--case-insensitive

Default: case sensitive

Description

Tool Options

With this option you tell the linker not to distinguish between uppercase and lowercase characters in
symbols. By default the linker considers uppercase and lowercase characters as different characters.

When you have written your own assembly code and specified to assemble it case insensitive, you must

also link the . o file case insensitive.

Related information

Assembler option --case-insensitive
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Linker option: --c-array-element-type

Menu entry

Command line syntax
--c-array-el enent-type=string
Default: unsi gned | ong
Description

With this option you can overrule the C data type to be used for all C array elements in a C array output
file. The type must be an integral type. Without this option the default data type is unsi gned | ong.

Related information
Section 12.4, C Array Format

Linker option --chip-output (Generate an output file for each chip)
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Linker option: --chip-output (-c)
Menu entry

1. Select Linker » Output Format.

2. Enable the option Generate Intel Hex format file and/or Generate S-records file and/or Generate
C array file.

3. Enable the option Create file for each memory chip.
4. Optionally, specify the Size of addresses.

Eclipse always uses the project name as the basename for the output file.

Command line syntax
--chi p- out put =[ basenane] : f or mat [ : addr _si ze], ...
-c[ basenane] : format [ : addr _si ze], . ..

You can specify the following formats:

IHEX Intel Hex

SREC Motorola S-records
BIN Binary

CARR C array

For Intel Hex and Motorola S-records the addr_size specifies the size of the addresses in bytes (record
length). For Intel Hex you can use the values 1, 2 or 4 bytes (default). For Motorola S you can specify: 2
(S1 records), 3 (S2 records) or 4 bytes (S3 records, default). For C array files, the address size specifies
the number of bits stored in each array element.

Description

With this option the linker generates an output file for each memory chip in the specified format: Intel Hex,
Motorola S-records, binary or C array. You can use the Intel Hex or Motorola S-record output for loading
into a PROM-programmer, or you can use the binary or C array output for importing the application into
a host application. The C array format contains the generated machine code in the form of C code. For
more information see Section 12.4, C Array Format.

The linker generates a file for each ROM or RAM memory defined in the LSL file, where one or more
initialized sections are located. For example:

nenory nmemane
{ type=rom }

The name of the file is the name of the Eclipse project or, on the command line, the name of the memory
device that was emitted with extension . hex (Intel Hex), . sr e (Motorola S-records) or . bi n (binary
without metadata). For the C array format the output is a . c file for the array definition and a . h file for
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the accompanying header file. Optionally, you can specify a basename which prepends the generated
file name.

The linker also always generates a task-related absolute object file in ELF/DWARF format and a
memory definition file, unless you specify linker option --no-default-output.

Use linker option --output for the debugging file and/or for hex files at space level.

Example

To generate Intel Hex output files for each defined memory, enter the following on the command line:
I nrcs --chip-out put=myprog: | HEX testl.o0

In this case, this generates the file nypr og_memname. hex.

To generate C array output files for each defined memory, enter the following on the command line:
I nrcs --chi p-out put=myprog: CARR 32 testl.o0

In this case, this generates the files mypr og_memname. ¢ and nmypr og_memname. h.

Related information

Chapter 12, Object File Formats

Linker option --output (Output file)

Linker option --hex-format (Specify Hex file or C array format settings)

Linker option --no-default-output (No default task-related output files)
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Linker option: --core (-C)
Menu entry
1. Expand C/C++ Build and select Processor.

2. From the Processor Selection list, select a processor or select User defined ....
3. From the Multi-core configuration list, select an MCS core.

Command line syntax

--core=MCS-core

- CMCS- cor e

You can specify the following MCS cores (depending on the chosen processor):

mcs00 MCS core 0
mcs01 MCS core 1
mcs02 MCS core 2
mcs03 MCS core 3
mcs04 MCS core 4
mcs05 MCS core 5
mcs06 MCS core 6
mcs07 MCS core 7
mcs08 MCS core 8
mcs09 MCS core 9

Default: mcs00

Description
With this option you specify the core for the target processor for which you create your application.

In a multi-task setting, use this option to tell the linker to use a specific core for a specific task. Only one
task can be assigned to a certain core. Assigning multiple tasks to a single core requires some form of
kernel functionality.

Example

To link objects for the MCS core nts01, enter:

lcms -0 test.elf -dgtnB1_02.1sl --core=nts0l1 --endianness=little
--non-romabl e --user-provided-initialization-code --no-romcopy
-D_CPU_=gtnBl1 02 -D_PROC GIMB1_02__ --map-file test.o

"-Lpath\lib\ncs31\le" -lc -Ifp -1Irt
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Related information

Control program option --Isl-core (Specify LSL core)
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Linker option: --define (-D)
Menu entry
1. Select Linker » Script File.
The Defined symbols box shows the symbols that are currently defined.
2. To define a new symbol, click on the Add button in the Defined symbols box.

3. Type the symbol definition (for example, denp=1)
Use the Edit and Delete button to change a macro definition or to remove a macro from the list.

Command line syntax
- -defi ne=macr o_name[ =macr o_defi ni tion]

- Dmacr o_name[ =nacr o_defini tion]

Description

With this option you can define a macro and specify it to the linker LSL file preprocessor. If you only
specify a macro name (no macro definition), the macro expands as '1'".

You can specify as many macros as you like; just use the option --define (-D) multiple times. If the
command line exceeds the limit of the operating system, you can define the macros in an option file which
you then must specify to the linker with the option --option-file (-f) file.

The definition can be tested by the preprocessor with #i f , #i f def and #i f ndef , for conditional locating.

Make sure you do not use a reserved keyword as a macro name, as this can lead to unexpected
results.

Example
To define the GTM_MCS_RAMO_SIZE, which is used in the linker script file gt n81_02. | sl , enter:

Incs test.o -otest.elf --Isl-file=gtnm81_02.1sl --define=GTM MCS_RAM)_SI ZE=0x1000

Related information

Linker option --option-file (Specify an option file)
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Linker option: --diag

Menu entry

1. From the Window menu, select Show View » Other » TASKING » Problems.
The Problems view is added to the current perspective.

2. In the Problems view right-click on a message.
A popup menu appears.

3. Select Detailed Diagnostics Info.

A dialog box appears with additional information.
Command line syntax
--diag=[format:]{all | nr,...}

You can set the following output formats:

html HTML output.
rtf Rich Text Format.
text ASCII text.

Default format: text

Description

With this option you can ask for an extended description of error messages in the format you choose.
The output is directed to stdout (normally your screen) and in the format you specify. You can specify the
following formats: html, rtf or text (default). To create a file with the descriptions, you must redirect the
output.

With the suboption all, the descriptions of all error messages are given. If you want the description of one
or more selected error messages, you can specify the error message numbers, separated by commas.

With this option the linker does not link/locate any files.
Example

To display an explanation of message number 106, enter:
I rcs --di ag=106

This results in the following message and explanation:
E106: unresol ved external : <nessage>

The linker could not resolve all external synbols.
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This is an error when the increnental |inking option is disabled.
The <nessage> indicates the synbol that is unresol ved.

To write an explanation of all errors and warnings in HTML format to file | kerr or s. ht ml , use redirection
and enter:

Inmcs --diag=htm:all > I kerrors. htni

Related information

Section 5.10, Linker Error Messages
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Linker option: --endianness

Menu entry
1. Select Global Options.

2. Specify the Endianness:Little-endian mode or Big-endian mode.

Command line syntax
- -endi anness=endi anness

-B
- - bi g-endi an

You can specify the following endianness:

big b Big endian
little | Little endian (default)
Description

By default, the linker links objects in little-endian mode. With --endianness=big you tell the linker to link
the input files in big-endian mode. The endianness used must be valid for the architecture you are linking
for. Depending on the endianness used, the linker links different libraries. -B is an alias for option

--endianness=big.

Related information
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Linker option: --error-file

Menu entry
Command line syntax
--error-file[=file]
Description

With this option the linker redirects diagnostic messages to a file. If you do not specify a filename, the
error file is | nts. el k.

Example

To write diagnostic messages to err or s. el k instead of st der r, enter:
Ints --error-file=errors.elk test.o

Related information

Section 5.10, Linker Error Messages
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Linker option: --error-limit

Menu entry
1. Select Linker » Diagnostics.

2. Enter avalue in the Maximum number of emitted errors field.
Command line syntax

--error-1limt=nunber

Default: 42

Description

With this option you tell the linker to only emit the specified maximum number of errors. When 0 (null) is
specified, the linker emits all errors. Without this option the maximum number of errors is 42.

Related information

Section 5.10, Linker Error Messages
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Linker option: --extern (-e)

Menu entry

Command line syntax
--extern=synbol , ...

-esynbol , . ..

Description

With this option you force the linker to consider the given symbol as an undefined reference. The linker
tries to resolve this symbol, either the symbol is defined in an object file or the linker extracts the
corresponding symbol definition from a library.

This option is, for example, useful if the startup code is part of a library. Because your own application
does not refer to the startup code, you can force the startup code to be extracted by specifying the symbol
__START as an unresolved external.

Example
Consider the following invocation:
Inmcs nylib.a

Nothing is linked and no output file will be produced, because there are no unresolved symbols when the
linker searches through nyl i b. a.

I ncs --extern=_START nylib.a

In this case the linker searches for the symbol _START in the library and (if found) extracts the object that
contains _START, the startup code. If this module contains new unresolved symbols, the linker looks
again in nyl i b. a. This process repeats until no new unresolved symbols are found.

Related information
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Linker option: --first-library-first

Menu entry

Command line syntax
--first-library-first
Description

When the linker processes a library it searches for symbols that are referenced by the objects and libraries
processed so far. If the library contains a definition for an unresolved reference the linker extracts the
object that contains the definition from the library.

By default the linker processes object files and libraries in the order in which they appear on the command
line. If you specify the option --first-library-first the linker always tries to take the symbol definition from
the library that appears first on the command line before scanning subsequent libraries.

This is for example useful when you are working with a newer version of a library that partially overlaps
the older version. Because they do not contain exactly the same functions, you have to link them both.
However, when a function is present in both libraries, you may want the linker to extract the most recent
function.

Example

Consider the following example:

Inmcs --first-library-first a.a test.o b.a

If the file t est . o calls a function which is both present in a. a and b. a, normally the function in b. a

would be extracted. With this option the linker first tries to extract the symbol from the first library a. a.

Note that routines in b. a that call other routines that are present in both a. a and b. a are now
also resolved from a. a.

Related information

Linker option --no-rescan (Rescan libraries to solve unresolved externals)
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Linker option: --global-type-checking

Menu entry

Command line syntax

--gl obal -t ype-checki ng

Description

Tool Options

Use this option when you want the linker to check the types of variable and function references against

their definitions, using DWARF 3 debug information.

Related information
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Linker option: --help (-?)

Menu entry

Command line syntax
--help[=item

-2

You can specify the following arguments:

options Show extended option descriptions

Description

Displays an overview of all command line options. When you specify the argument options you can list
detailed option descriptions.

Example

The following invocations all display a list of the available command line options:
Incs -7

Imcs --help

I ncs

To see a detailed description of the available options, enter:

I nrcs - - hel p=options

Related information
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Linker option: --hex-format

Menu entry
1. Select Linker » Output Format.

2. Enable the option Generate Intel Hex format file and enable or disable the option Emit start address
record.

3. Enable the option Generate C array file and enable or disable the option Emit list of exported
symbols.

Command line syntax
--hex-format=flag,...
You can set the following flag:

+/-start-address s/S Emit start address record
+/-c-array-symbols y/Y  Emit list of exported symbols

Default: - - hex- f or mat =s

Description

With this option you can specify to emit or omit the start address record from the hex file or you can emit
a list of exported symbols for C array files.

Related information
Chapter 12, Object File Formats
Linker option --output (Output file)

Linker option --chip-output (Generate an output file for each chip)
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Linker option: --hex-record-size

Menu entry

1. Select Linker » Miscellaneous.

2. Add the option --hex-record-size to the Additional options field.
Command line syntax

--hex-record-si ze=si ze

Default: 32

Description

With this option you can set the size (width) of the Intel Hex data records.
Related information

Linker option --output (Output file)

342



Tool Options

Linker option: --import-object
Menu entry
1. SelectLinker » Data Objects.
The Data objects box shows the list of object files that are imported.
2. To add a data object, click on the Add button in the Data objects box.

3. Type or select a binary file (including its path).
Use the Edit and Delete button to change a filename or to remove a data object from the list.

Command line syntax

--inmport-object=file,...

Description

With this option the linker imports a binary file containing raw data and places it in a section. The section
name is derived from the filename, in which dots are replaced by an underscore. So, when importing a

file called nmy. j pg, a section with the name nmy_j pg is created. In your application you can refer to the
created section by using linker labels.

Related information

Section 5.5, Importing Binary Files
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Linker option: --include-directory (-I)

Menu entry

Command line syntax
--include-directory=path,...
-lpath, ...

Description

With this option you can specify the path where your LSL include files are located. A relative path will be
relative to the current directory.

The order in which the linker searches for LSL include files is:

1. The pathname in the LSL file and the directory where the LSL file is located (only for #include files that
are enclosed in ")

2. The path that is specified with this option.

3. The default directory $( PRODDI R) \'i ncl ude. | sl .

Example

Suppose that your linker script file nyl sl . | sl contains the following line:

#i ncl ude "nyinc.inc"

You can call the linker as follows:

I mcs --include-directory=c:\proj\include --Isl-file=nylsl.lsl test.o

First the linker looks for the file myi nc. i nc in the directory where nyl sl . | sl is located. If it does not
find the file, it looks in the directory c: \ pr oj \ i ncl ude (this option). Finally it looks in the directory
$( PRODDI R)\i ncl ude. | sl .

Related information

Linker option --Isl-file (Specify linker script file)
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Linker option: --incremental (-r)

Menu entry

Command line syntax
--incremental

-r

Description

Normally the linker links and locates the specified object files. With this option you tell the linker only to
link the specified files. The linker creates a linker output file . out . You then can link this file again with
other object files until you have reached the final linker output file that is ready for locating.

In the last pass, you call the linker without this option with the final linker output file . out . The linker will
now locate the file.

Example
In this example, the filest est 1. o, t est 2. 0 and t est 3. o are incrementally linked:
l.1ncs --increnental testl.o test2.0 --output=test.out
testl.o and test2.0 are linked
2.lncs --incremental test3.o0 test.out
test3.0 and test.out are linked, taskl.out is created
3. I nts taskl. out

taskl.out is located

Related information

Section 5.4, Incremental Linking
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Linker option: --keep-output-files (-k)
Menu entry

Eclipse always removes the output files when errors occurred.

Command line syntax
--keep-output-files
-k

Description

If an error occurs during linking, the resulting output file may be incomplete or incorrect. With this option
you keep the generated output files when an error occurs.

By default the linker removes the generated output file when an error occurs. This is useful when you use
the make utility. If the erroneous files are not removed, the make utility may process corrupt files on a
subsequent invocation.

Use this option when you still want to use the generated file. For example when you know that a particular
error does not result in a corrupt object file, or when you want to inspect the output file, or send it to Altium
support.

Related information

Linker option --warnings-as-errors (Treat warnings as errors)
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Linker option: --library (-1)
Menu entry
1. Select Linker » Libraries.
The Libraries box shows the list of libraries that are linked with the project.
2. To add a library, click on the Add button in the Libraries box.
3. Type or select a library (including its path).

4. Optionally, disable the option Link default libraries.
Use the Edit and Delete button to change a library name or to remove a library from the list.

Command line syntax

--library=nane

-l nane

Description

With this option you tell the linker to use system library | i bname. a, where name is a string. The linker
first searches for system libraries in any directories specified with --library-directory, then in the directories

specified with the environment variables LI BMCS / LI BMCS2_0 / LIBMCS3_0 / LIBMCS3_1 /
LI BMCS4_0, unless you used the option --ignore-default-library-path.

Example
To search in the system library | i bc. a:
Incs test.o nylib.a --library=c

The linker links the file t est . o and first looks in library nyl i b. a (in the current directory only), then in
the system library | i bc. a to resolve unresolved symbols.

Related information

Linker option --library-directory (Additional search path for system libraries)
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Linker option: --library-directory (-L) / --ignore-default-library-path

Menu entry
1. SelectLinker » Libraries.
The Library search path box shows the directories that are added to the search path for library files.

2. To define a new directory for the search path, click on the Add button in the Library search path
box.

3. Type or select a path.

Use the Edit and Delete button to change a path or to remove a path from the list.

Command line syntax

--library-directory=path, ...
-Lpath, ...

--ignore-default-library-path
-L

Description

With this option you can specify the path(s) where your system libraries, specified with the option --library
(-1), are located. If you want to specify multiple paths, use the option --library-directory for each separate
path.

The default path is $( PRODDI R)\ | i b\ { nts30| nts31| ncs40}\ {be|l e}.

If you specify only -L (without a pathname) or the long option --ignore-default-library-path, the linker
will not search the default path and also not in the paths specified in the environment variables LI BMCS
/ LIBMCS2_0 / LIBMCS3_0 / LIBMCS3_1 / LIBMCS4_0. So, the linker ignores steps 2 and 3 as
listed below.

The priority order in which the linker searches for system libraries specified with the option --library ()
is:

1. The path that is specified with the option --library-directory.

2. The path that is specified in the environment variables LI BMCS / LIBMCS2_0 / LIBMCS3_0 /
LI BMCS3_1 / LIBMCS4_0.

3. The default directory $( PRODDI R)\ | i b\ { nts30| nts31| ncs40}\{be| | e}.

Example

Suppose you call the linker as follows:
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Incs test.o --library-directory=c:\nylibs --library=c

First the linker looks in the directory c: \ nyl i bs for library | i bc. a (this option). If it does not find the
requested libraries, it looks in the directory that is set with the environment variables LI BMCS /
LIBMCS2_0 / LIBMCS3_0 / LIBMCS3_1 / LI BMCS4_0.Then the linker looks in the default directory
$(PRODDI R)\ 1i b\ {nts30| ncs31| ncs40}\{be| | e} for libraries.

Related information

Linker option --library (Link system library)
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Linker option: --link-only
Menu entry

Command line syntax
--link-only

Description

With this option you suppress the locating phase. The linker stops after linking and informs you about
unresolved references.

Related information

Control program option --create=relocatable (-cl) (Stop after linking)
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Linker option: --Isl-check

Menu entry

Command line syntax

--1sl-check

Description

With this option the linker just checks the syntax of the LSL file(s) and exits. No linking or locating is
performed. Use the option --Isl-file to specify the name of the Linker Script File you want to test.

Related information
Linker option --Isl-file (Linker script file)
Linker option --Isl-dump (Dump LSL info)

Section 5.7, Controlling the Linker with a Script
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Linker option: --Isl-dump

Menu entry

Command line syntax
--1'sl -dunp[=fil €]
Description

With this option you tell the linker to dump the LSL part of the map file in a separate file, independent of
the option --map-file (generate map file). If you do not specify a filename, the file | nts. | df is used.

Related information

Linker option --map-file-format (Map file formatting)
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Linker option: --Isl-file (-d)

Menu entry
An LSL file can be generated when you create your project in Eclipse:
1. From the File menu, select File » New » TASKING MCS C Project.
The New C Project wizard appears.
2. Fillin the project settings in each dialog and click Next > until the MCS Project Settings appear.
3. Enable the option Add linker script file to the project and click Finish.
Eclipse creates your project and the file project. | sl in the project directory.
The LSL file can be specified in the Properties dialog:
1. Select Linker » Script File.

2. Specify a LSL file in the Linker script file (.Isl) field.

Command line syntax
--Isl-file=file
-dfile

Description

A linker script file contains vital information about the core for the locating phase of the linker. A linker
script file is coded in LSL and contains the following types of information:

« the architecture definition describes the core's hardware architecture.
» the memory definition describes the physical memory available in the system.
« the section layout definition describes how to locate sections in memory.

With this option you specify a linker script file to the linker. If you do not specify this option, the linker uses
a default script file. You can specify the existing file target. | sl or the name of a manually written linker
script file. You can use this option multiple times. The linker processes the LSL files in the order in which
they appear on the command line.

Related information
Linker option --Isl-check (Check LSL file(s) and exit)

Section 5.7, Controlling the Linker with a Script
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Linker option: --map-file (-M)

Menu entry

1. Select Linker » Map File.

2. Enable the option Generate XML map file format (.mapxml) for map file viewer.
3. (Optional) Enable the option Generate map file.

4. Enable or disable the types of information to be included.

Command line syntax
--map-file[=file][:XM]
-Mfile]l[:XM]

Default (Eclipse): XML map file is generated

Default (linker): no map file is generated

Description

With this option you tell the linker to generate a linker map file. If you do not specify a filename and you
specified the option --output, the linker uses the same basename as the output file with the extension
. map. If you did not specify the option --output, the linker uses the file t ask1. map. Eclipse names the
. map file after the project.

A linker map file is a text file that shows how the linker has mapped the sections and symbols from the
various object files (. 0) to the linked object file. A locate part shows the absolute position of each section.
External symbols are listed per space with their absolute address, both sorted on symbol and sorted on
address.

Related information
Linker option --map-file-format (Format map file)

Section 11.2, Linker Map File Format
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Linker option: --map-file-format (-m)

Menu entry

1. Select Linker » Map File.

2. Enable the option Generate XML map file format (.mapxml) for map file viewer.
3. (Optional) Enable the option Generate map file.

4. Enable or disable the types of information to be included.

Command line syntax
--map-file-format=flag,. ..
-nfl ags

You can set the following flags:

+/-callgraph c/C Include call graph information

+/-removed d/D  Include information on removed sections
+/-files fIF Include processed files information
+/-invocation i/l Include information on invocation and tools
+/-link k/IK Include link result information

+/-locate IlL Include locate result information
+/-memory m/M  Include memory usage information
+/-nonalloc n/N  Include information of non-alloc sections
+/-overlay 0/0 Include overlay information

+/-statics g/Q Include module local symbols information
+/-crossref r'R Include cross references information

+/-Isl s/S  Include processor and memory information
+/-rules u/U  Include locate rules

Use the following options for predefined sets of flags:

--map-file-format=0 -mO0  Link information

Alias for -mcDfikLMNoQrSuU
--map-file-format=1 -m1 Locate information

Alias for -mCDfiKIMNoQRSU
--map-file-format=2 -m2  Most information

Alias for -mcdfikimNoQrSu

Default: - - map-fi |l e- f or mat =2
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Description

With this option you specify which information you want to include in the map file.

On the command line you must use this option in combination with the option --map-file (-M).
Related information

Linker option --map-file (Generate map file)

Section 11.2, Linker Map File Format

356



Tool Options

Linker option: --misra-c-report
Menu entry

Command line syntax

--msra-c-report[=file]

Description

With this option you tell the linker to create a MISRA C Quality Assurance report. This report lists the

various modules in the project with the respective MISRA C settings at the time of compilation. If you do
not specify a filename, the file basename. ntr is used.

Related information

C compiler option --misrac (MISRA C checking)
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Linker option: --new-task

Menu entry

Command line syntax

--newt ask

Description

With this option the linker creates an additional task. Any options that follow only apply to the new task.
The linker processes options on the command line from left to right. To know whether a certain option
belongs to a different task it uses this option. This implies that all options for a given task must be fully

specified before moving on to the next.

Related information
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Linker option: --non-romable

Menu entry

Command line syntax

--non-ronabl e

Description

With this option you tell the linker that the application must not be located in ROM. The linker will locate
all ROM sections, including a copy table if present, in RAM. When the application is started, the data
sections are re-initialized and the BSS sections are cleared as usual.

This option is, for example, useful when you want to test the application in RAM before you put the final
application in ROM. This saves you the time of flashing the application in ROM over and over again.

If you want to locate your application in RAM only, without using ROM/flash resources of the chip, for
example when you run the debugger in RAM only, also specify the options --no-rom-copy and
--user-provided-initialization-code or use the control program option --meminit=none.

Related information
Control program option --meminit (Initialize memory)
Linker option --no-rom-copy (Do not generate ROM copy)

Linker option --user-provided-initialization-code (Own initialization code, no standard copy table)
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Linker option: --no-default-output

Menu entry

Command line syntax

--no-def aul t - out put

Description

By default the linker generates an absolute object file and a memory definition file for each task. With this
option you specify to the linker not to generate these files, unless explicitly specified.

This option is also automatically recognized by the control program as an option for the linker.

Example

Invocation to create a C array output only (using the control program):

ccnes --format=carr --output=nyprog test.c --no-nmap-file --no-default-output -v

This generates the files mypr og_gt n81_01_nts00. ¢ and mypr og_gt nB1_01_nts00. h. Without
--no-default-output also the files t ask1. el f and t askl. ndf are generated.

Related information
Linker option --chip-output (Generate an output file for each chip)

Control program option --no-map-file (Do not generate map file)
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Linker option: --no-rescan

Menu entry
1. SelectLinker » Libraries.

2. Disable the option Rescan libraries to solve unresolved externals.

Command line syntax

--Nno-rescan

Description

When the linker processes a library it searches for symbol definitions that are referenced by the objects
and libraries processed so far. If the library contains a definition for an unresolved reference the linker
extracts the object that contains the definition from the library. The linker processes object files and
libraries in the order in which they appear on the command line.

When all objects and libraries are processed the linker checks if there are unresolved symbols left. If so,
the default behavior of the linker is to rescan all libraries in the order given at the command line. The
linker stops rescanning the libraries when all symbols are resolved, or when the linker could not resolve
any symbol(s) during the rescan of all libraries. Notice that resolving one symbol may introduce new
unresolved symbols.

With this option, you tell the linker to scan the object files and libraries only once. When the linker has
not resolved all symbols after the first scan, it reports which symbols are still unresolved. This option is
useful if you are building your own libraries. The libraries are most efficiently organized if the linker needs
only one pass to resolve all symbols.

Related information

Linker option --first-library-first (Scan libraries in given order)
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Linker option: --no-rom-copy (-N)

Menu entry

Command line syntax

--no-rom copy

-N

Description

With this option the linker will not generate a ROM copy for data sections. A copy table is generated and
contains entries to clear BSS sections. However, no entries to copy data sections from ROM to RAM are

placed in the copy table.

The data sections are initialized when the application is downloaded. The data sections are not re-initialized
when the application is restarted.

Related information
Linker option --non-romable (Application is not romable)

Linker option --user-provided-initialization-code (Own initialization code, no standard copy table)
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Linker option: --no-warnings (-w)
Menu entry
1. Select Linker » Diagnostics.
The Suppress warnings box shows the warnings that are currently suppressed.
2. To suppress a warning, click on the Add button in the Suppress warnings box.

3. Enter the numbers, separated by commas, of the warnings you want to suppress (for example
135, 136). Or you can use the Add button multiple times.

4. To suppress all warnings, enable the option Suppress all warnings.
Use the Edit and Delete button to change a warning number or to remove a number from the list.

Command line syntax

- - no-war ni ngs[ =nunber, .. .]
-w nunber, ...]
Description

With this option you can suppresses all warning messages or specific warning messages.
On the command line this option works as follows:

« If you do not specify this option, all warnings are reported.

« If you specify this option but without numbers, all warnings are suppressed.

« If you specify this option with a number, only the specified warning is suppressed. You can specify the
option --no-warnings=number multiple times.

Example

To suppress warnings 135 and 136, enter:

I nrcs --no-warni ngs=135, 136 test.o
Related information

Linker option --warnings-as-errors (Treat warnings as errors)
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Linker option: --optimize (-O)

Menu entry

1.

2.

Select Linker » Optimization.

Select one or more of the following options:

» Delete unreferenced sections

» Use a 'first-fit decreasing' algorithm

» Compress copy table

Delete duplicate code

* Delete duplicate data

Command line syntax

--optinm ze=flag, ...

-Of I ags

You can set the following flags:

+/-delete-unreferenced-sections c/C

+/-first-fit-decreasing

+/-copytable-compression

+/-delete-duplicate-code

+/-delete-duplicate-data

I/L

tT
XIX

yIY

Use the following options for predefined sets of flags:

--optimize=0

--optimize=1

--optimize=2

Default: - - opti m ze=1
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No optimization
Alias for -OCLTXY

Delete unreferenced sections from the output
file

Use a 'first-fit decreasing' algorithm to locate
unrestricted sections in memory

Emit smart restrictions to reduce copy table size
Delete duplicate code sections from the output
file

Delete duplicate constant data from the output
file

Default optimization

Alias for -OcLtxy

All optimizations
Alias for -Ocltxy
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Description
With this option you can control the level of optimization.
Note that when you use the flag +copytable-compression, sections affected by the copy table
are located as if they were in a clustered LSL group, if they do not have a locate restriction yet.
Related information

For details about each optimization see Section 5.6, Linker Optimizations.

Define the mutual order of sections in an LSL group in Section 13.8.2, Creating and Locating Groups of
Sections.
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Linker option: --option-file (-f)

Menu entry

1. Select Linker » Miscellaneous.

2. Add the option --option-file to the Additional options field.

Be aware that the options in the option file are added to the linker options you have set in the other
pages. Only in extraordinary cases you may want to use them in combination.

Command line syntax
--option-file=file,...
-f file,...

Description

This option is primarily intended for command line use. Instead of typing all options on the command line,
you can create an option file which contains all options and flags you want to specify. With this option
you specify the option file to the linker.

Use an option file when the command line would exceed the limits of the operating system, or just to store
options and save typing.

Option files can also be generated on the fly, for example by the make utility. You can specify the option
--option-file multiple times.

Format of an option file
» Multiple arguments on one line in the option file are allowed.
» To include whitespace in an argument, surround the argument with single or double quotes.

« If you want to use single quotes as part of the argument, surround the argument by double quotes and
vise versa:

"This has a single quote ' enbedded"
"This has a doubl e quote " enbedded
"This has a double quote " and a single quote '"' enbedded"
» When a text line reaches its length limit, use a \ to continue the line. Whitespace between quotes is
preserved.

"This is a continuation \
i ne"

-> "This is a continuation |ine"
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* Itis possible to nest command line files up to 25 levels.

Example

Suppose the file myopt i ons contains the following lines:

--map-fil e=ny. map (generate a map file)

test.o (input file)

--library-directory=c:\nylibs (addi tional search path for systemlibraries)
Specify the option file to the linker:

I ncs --option-fil e=myoptions

This is equivalent to the following command line:

Inmcs --map-file=my.map test.o --library-directory=c:\nylibs

Related information
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Linker option: --output (-0)
Menu entry
1. Select Linker » Output Format.
2. Enable one or more output formats.
For some output formats you can specify a number of suboptions.

Eclipse always uses the project name as the basename for the output file.

Command line syntax
--output=[filenane][:format[:addr_size][, space_nane]]...
-o[filename][:format[:addr_size][, space_nane]]...

You can specify the following formats:

ELF ELF/DWARF

IHEX Intel Hex

SREC Motorola S-records
Description

By default, the linker generates an output file in ELF/DWARF format, with the name t ask1. el f .

With this option you can specify an alternative filename, and an alternative output format. The default
output format is the format of the first input file.

You can use the --output option multiple times. This is useful to generate multiple output formats. With
the first occurrence of the --output option you specify the basename (the filename without extension),
which is used for subsequent --output options with no filename specified. If you do not specify a filename,
or you do not specify the --output option at all, the linker uses the default basename t askn.

IHEX and SREC formats

If you specify the Intel Hex format or the Motorola S-records format, you can use the argument addr_size
to specify the size of addresses in bytes (record length). For Intel Hex you can use the values: 1, 2, and
4 (default). For Motorola S-records you can specify: 2 (S1 records), 3 (S2 records, default) or 4 bytes (S3
records). Note that if you make the addr_size too small, the linker might give a fatal object writer error
indicating an address overflow.

With the argument space_name you can specify the name of the address space. The name of the output
file will be filename with the extension . hex or . sr e and contains the code and data allocated in the
specified space. If they exist, any other address spaces are also emitted whereas their output files are
named filename_spacename with the extension . hex or. sre.

If you do not specify space_name, or you specify a non-existing space, the default address space is filled
in.
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Use option --chip-output (-c) to create Intel Hex or Motorola S-record output files for each chip defined
in the LSL file (suitable for loading into a PROM-programmer).

Example

To create the output file mypr og. hex of the address space named | i near , enter:

I ncs test.o --output=nyprog. hex: | HEX: 2, | i near

If they exist, any other address spaces are emitted as well and are named nypr og_spacename. hex.
Related information

Linker option --chip-output (Generate an output file for each chip)

Linker option --hex-format (Specify Hex file or C array format settings)
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Linker option: --strip-debug (-S)

Menu entry
1. Select Linker » Miscellaneous.

2. Enable the option Strip symbolic debug information.

Command line syntax
--strip-debug

-S

Description

With this option you specify not to include symbolic debug information in the resulting output file.

Related information
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Linker option: --user-provided-initialization-code (-i)
Menu entry

1. Select Linker » Miscellaneous.

2. Enable the option Do not use standard copy table for initialization.

Command line syntax
--user-provided-initialization-code
-i

Description

It is possible to use your own initialization code, for example, to save ROM space. With this option you
tell the linker not to generate a copy table for initialize/clear sections. Use linker labels in your source
code to access the positions of the sections when located.

If the linker detects references to the TASKING initialization code, an error is emitted: it is either the
TASKING initialization routine or your own, not both.

Note that the options --no-rom-copy and --non-romable, may vary independently. The
‘copytable-compression’ optimization (--optimize=t) is automatically disabled when you enable this option.

Related information
Linker option --no-rom-copy (Do not generate ROM copy)
Linker option --non-romable (Application is not romable)

Linker option --optimize (Specify optimization)
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Linker option: --verbose (-v)

Menu entry
1. Select Linker » Miscellaneous.
2. Enable the option Show link phases during processing.

The verbose output is displayed in the Problems view and the Console view.

Command line syntax
--verbose

-V

Description

With this option you put the linker in verbose mode. The linker prints the link phases while it processes
the files. The linker prints one entry for each action it executes for a task. When you use this option twice
(- vv) you put the linker in extra verbose mode. In this mode the linker also prints the filenames and it
shows which objects are extracted from libraries and it shows verbose information that would normally
be hidden when you use the normal verbose mode or when you run without verbose. With this option you
can monitor the current status of the linker.

Related information
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Linker option: --version (-V)

Menu entry

Command line syntax

--version
-V
Description

Display version information. The linker ignores all other options or input files.

Related information
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Linker option: --warnings-as-errors

Menu entry

1. Select Global Options.

2. Enable the option Treat warnings as errors.

Command line syntax

- -war ni ngs- as-errors[=nunber, ...]

Description

When the linker detects an error or warning, it tries to continue the link process and reports other errors
and warnings. When you use this option without arguments, you tell the linker to treat all warnings as
errors. This means that the exit status of the linker will be non-zero after the detection of one or more
linker warnings. As a consequence, the linker will not produce any output files.

You can also limit this option to specific warnings by specifying a comma-separated list of warning numbers.

Related information

Linker option --no-warnings (Suppress some or all warnings)
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Linker option: --whole-archive

Menu entry

1. Select Linker » Miscellaneous.

2. Add the option --whole-archive to the Additional options field.
Command line syntax

--whol e-archive=file

Description
This option tells the linker to directly load all object modules in a library, as if they were placed on the

command line. This is different from libraries specified as input files or with the -l option, which are only
used to resolve references in object files that were loaded earlier.

Example

Suppose the library myar chi ve. a contains the objects ny1. o, my2. o and ny3. o. Specifying
I ntcs --whol e-archi ve=nyarchi ve. a

is the same as specifying

Incs nmyl.o my2.0 ny3.0

Related information

Linker option --library (Link system library)
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8.4. Control Program Options

The control program ccmcs facilitates the invocation of the various components of the MCS toolset from
a single command line.

Options in Eclipse versus options on the command line

Eclipse invokes the compiler, assembler and linker via the control program. Therefore, it uses the syntax
of the control program to pass options and files to the tools. The control program processes command
line options either by itself, or, when the option is unknown to the control program, it looks whether it can
pass the option to one of the other tools. However, for directly passing an option to the C compiler,
assembler or linker, it is recommended to use the control program options --pass-c, --pass-assembler,
--pass-linker.

See the previous sections for details on the options of the tools.

Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (-)
character, long option names always begin with two minus (--) characters. You can abbreviate long option
names as long as it forms a unique name. You can mix short and long option names on the command
line.

Options can have flags or suboptions. To switch a flag 'on’, use a lowercase letter or a +longflag. To
switch a flag off, use an uppercase letter or a -longflag. Separate longflags with commas. The following
two invocations are equivalent:

ccnes -W-0ac test.c
ccnts --pass-c=--optim ze=+coal esce, +cse test.c

When you do not specify an option, a default value may become active.
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Control program option: --address-size

Menu entry

1. Select Linker » Output Format.

2. Enable the option Generate Intel Hex format file and/or Generate S-records file.
3. Specify the Size of addresses.

Eclipse always uses the project name as the basename for the output file.

Command line syntax

- - addr ess-si ze=addr _si ze

Description

If you specify IHEX or SREC with the control option --format, you can additionally specify the record
length to be emitted in the output files.

With this option you can specify the size of the addresses in bytes (record length). For Intel Hex you can
use the values 1, 2 or 4 bytes (default). For Motorola-S you can specify: 2 (S1 records), 3 (S2 records)
or 4 bytes (S3 records, default).

If you do not specify addr_size, the default address size is generated.
Example

To create the SREC file t est . sr e with S1 records, type:

ccncs --format =SREC - - addr ess-si ze=2 test.c

Related information

Control program option --format (Set linker output format)

Control program option --output (Output file)
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Control program option: --case-insensitive

Menu entry

1. Select Assembler » Symbols.

2. Enable the option Case insensitive identifiers.
Command line syntax

--case-insensitive

Default: case sensitive

Description

With this option you tell the assembler not to distinguish between uppercase and lowercase characters.
By default the assembler considers uppercase and lowercase characters as different characters.

Example

When assembling case insensitive, the label Label Nane is the same label as | abel nane.
ccnts --case-insensitive test.asm

Related information

Assembler option --case-insensitive

Assembler control $CASE
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Control program option: --check

Menu entry

Command line syntax

--check

Description

With this option you can check the source code for syntax errors, without generating code. This saves
time in developing your application because the code will not actually be compiled.

The compiler/assembler reports any warnings and/or errors.

This option is available on the command line only.

Related information
C compiler option --check (Check syntax)

Assembler option --check (Check syntax)
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Control program option: --control-flow-info

Menu entry

1. Select C Compiler » Debugging.

2. Enable the option Generate control flow information.
Command line syntax

--control-flowinfo
Description

Control flow information

With this option the compiler adds control flow information to the output file. The compiler generates a
. debug_control _f | owsection which describes the basic blocks and their relations. This information
can be used for code coverage analysis on optimized code.

Example

ccnts --control -flowinfo test.c
Related information

Section 6.4.2, HLL Dump Output Format

Control program option --debug-info (Debug information)
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Control program option: --core

Menu entry
1. Expand C/C++ Build and select Processor.

2. From the Processor Selection list, select a processor or select User defined ....

Command line syntax
--core=core

You can specify the following core arguments:

mcs1.0 MCS v1.0 core
mcs2.0 MCS v2.0 core
mcs3.0 MCS v3.0 core
mcs3.1 MCS v3.1 core
mcs4.0 MCS v4.0 core

Default: mcs3.1

Description

With this option you specify the core architecture for a target processor for which you create your
application. If you use Eclipse or the control program, the MCS toolset derives the core from the processor
you selected. When the default core (mcs3.1) is used, the macro __ CORE_MCS31__ is defined in the C
source file.

Note that the C compiler only supports cores mcs3.0 and mcs3.1. The assembler and linker support all
cores.

With --core=mcs1.0, you tell the assembler that the assembly file contains instructions for the MCS v1.0
core.

With --core=mcs2.0, you tell the assembler that the assembly file contains instructions for the MCS v2.0
core.

With --core=mcs3.0, the compiler can generate MCS v3.0 instructions in the assembly file. The macro
__CORE_MCS30__ is defined in the C source file.

With --core=mcs3.1, the compiler can generate MCS v3.1 instructions in the assembly file. The macro
__CORE_MCS31__ is defined in the C source file.

With --core=mcs4.0, the compiler can generate MCS v4.0 instructions in the assembly file. The macro
__CORE_MCsS40__ is defined in the C source file.

Example

Select an MCS v3.0 core:
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ccncs --core=nts3.0 test.c

Related information

Control program option --cpu (Select processor)
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Control program option: --cpu (-C)

Menu entry
1. Expand C/C++ Build and select Processor.

2. From the Processor selection list, select a processor or select User defined ....

Command line syntax
--cpu=id | nanme | cpu
-Cd | name | cpu
Description

With this option you define the target processor for which you create your application. You can specify a
full processor name, like GTM31_01, or a base CPU name, like gtm31_01 or its unique id, like gtm31_01.

The standard list of supported processors is defined in the file pr ocessor s. xmi . This file defines for
each processor its full name (for example, GTM31_01), its ID, the base CPU name (for example, gtm31_01)
and the core settings (for example, mcs3.1). To show a list of all supported processors you can use option
--cpu-list.

The control program reads the file pr ocessor s. xnl . The lookup sequence for names specified to this
option is as follows:

1. match with the i d' attribute in pr ocessor s. xm (case insensitive, for example gt n81_01)

2. if none matched, match with the 'nane’ attribute in pr ocessor s. xm (case insensitive, for example
GTMB1_01)

3. if still none matched, match any of the base CPU names (the 'cpu’ attribute in pr ocessor s. xni , for
example gt n81_01). If multiple processors exist with the same base CPU, a warning will be issued
and the first one is selected.

4. if still none matched, the control program issues a fatal error.

The preferred use of the option --cpu, is to specify an ID because that is always a unique name. For
example, --cpu=gtm31_01. The control program will lookup this processor name in the file
processors. xm . The control program passes the options to the underlaying tools. For example,
-D__CPU__=gtm31_01-D__CPU_GTM31_01__ --core=mcs3.1 to the C compiler and assembler, or
-dgtm31_01.Isl -D__CPU__=gtm31_01-D__ PROC_GTM31_01__ to the linker.

Example
To generate the filet est . el f for the GTM31_01 processor, enter:

ccntcs --cpu=gtnB1l_01 test.c

383



TASKING VX-toolset for MCS User Guide

Related information
Control program option --cpu-list (Show list of processors)
Control program option --Isl-core (Specify LSL core)

Control program option --processors (Read additional processor definitions)
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Menu entry

Command line syntax

--cpu-list[=pattern]

Description

Tool Options

With this option the control program shows a list of supported processors as defined in the file
processors. xml . This can be useful when you want to select a processor name or id for the --cpu

option.

The pattern works similar to the UNIX grep utility. You can use it to limit the output list.

Example

To show a list of all processors, enter:

ccnts --cpu-li st

To show all processors of the mcs3.1 core, enter:

ccnets --cpu-list=

--- ~/cnts/ etc/ processors. xm

id

gtn81_01
gtn81_02
gtm81_03
gtnB81_04
gtm81_05
gtm81_06
gt n81_07
gtm81_08
gtm81_09
gtnB81_10

ncs3. 1

nane

GTMB1_01
GTMB1_02
GTMB1_03
GTMB1_04
GTMB1_05
GTMB1_06
GTMB1_07
GTMB1_08
GTMB1_09
GTMB1_10

Related information

CPU

gtn81_01
gtn81_02
gtm81_03
gtnB81_04
gt m81_05
gtm81_06
gt n81_07
gtm31_08
gtm81_09
gtn81_10

Control program option --cpu (Select processor)

core

ncs3.
ncs3.
ncs3.
ncs3.
ncs3.
ncs3.
ncs3.
ncs3.
ncs3.
ncs3.

PRRPRPRRRRRERERE
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Control program option: --create (-c)

Menu entry

Command line syntax
--creat e[ =st age]
- c[ st age]

You can specify the following stages:

relocatable | Stop after the files are linked to a linker object file (. out )
mil m Stop after C files are compiled to MIL (. mi |)

object o] Stop after the files are assembled to objects (. 0)
assembly s Stop after C files are compiled to assembly (. src)

Default (without flags): - - cr eat e=obj ect

Description

Normally the control program generates an absolute object file of the specified output format from the file
you supplied as input. With this option you tell the control program to stop after a certain number of phases.

Example

To generate the object file t est . o:

ccnts --create test.c

The control program stops after the file is assembled. It does not link nor locate the generated output.
Related information

Linker option --link-only (Link only, no locating)

386



Tool Options

Control program option: --debug-info (-g)

Menu entry
1. Select C Compiler » Debugging.

2. Togenerate symbolic debug information, select Default, Small set or Full.
To disable the generation of debug information, select None.

Command line syntax
- -debug-i nf o[ =subopt i on]
- g[ subopti on]

You can set the following suboptions:

small l|c Emit small set of debug information.
default 2|d Emit default symbolic debug information.
all 3]a Emit full symbolic debug information.

Default: - - debug- i nf o (same as - - debug- i nf o=def aul t)

Description

With this option you tell the control program to include debug information in the generated object file.
The control program passes the option -gsuboption to the C compiler and calls the assembler with -gsl.
Related information

C compiler option --debug-info (Generate symbolic debug information)

Assembler option --debug-info (Generate symbolic debug information)
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Control program option: --define (-D)

Menu entry
1. Select Assembler » Preprocessing.

The Defined symbols box right-below shows the symbols that are currently defined.
2. To define a new symbol, click on the Add button in the Defined symbols box.

3. Type the symbol definition (for example, denp=1)
Use the Edit and Delete button to change a macro definition or to remove a macro from the list.

Command line syntax
- -defi ne=macr o_nane[ =macr o_defi ni ti on]

- Dmacr o_name[ =nacr o_defini tion]

Description

With this option you can define a macro and specify it to the preprocessor. If you only specify a macro
name (no macro definition), the macro expands as '1".

You can specify as many macros as you like. Simply use the Add button to add new macro definitions.

On the command line, use the option --define (-D) multiple times. If the command line exceeds the limit
of the operating system, you can define the macros in an option file which you then must specify to the
assembler with the option --option-file (-f) file.

Defining macros with this option (instead of in the assembly source) is, for example, useful to assembly
conditional assembly source as shown in the example below.

The control program passes the option --define (-D) to the assembler.
Make sure you do not use a reserved keyword as a macro name, as this can lead to unexpected
results.

Example

Consider the following C program with conditional code to compile a demo program and a real program:

void main( void )

{
#i f DEMO

dermo_func(); /* conpile for the deno program */
#el se

real _func(); /* conpile for the real program*/
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#endi f
}

You can now use a macro definition to set the DEMO flag:

ccnts --define=DEMO test.c
ccnts --define=DEMO=1 test.c

Note that both invocations have the same effect.

The next example shows how to define a macro with arguments. Note that the macro name and definition
are placed between double quotes because otherwise the spaces would indicate a new option.

ccnts --define="MAX(A B)=((A > (B) ? (A : (B))" test.c
Related information
Control program option --undefine (Remove preprocessor macro)

Control program option --option-file (Specify an option file)
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Control program option: --dep-file

Menu entry

Command line syntax
--dep-file[=file]
Description

With this option you tell the compiler to generate dependency lines that can be used in a Makefile. In
contrast to the option --preprocess=+make, the dependency information will be generated in addition to
the normal output file.

By default, the information is written to a file with extension . d (one for every input file). When you specify
a filename, all dependencies will be combined in the specified file.

Example
ccnes --dep-file=test.dep -t test.c

The compiler compiles the file t est . ¢, which results in the output file t est . sr ¢, and generates
dependency lines in the file t est . dep.

Related information

Control program option --preprocess=+make (Generate dependencies for make)
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Control program option: --diag

Menu entry

1. From the Window menu, select Show View » Other » TASKING » Problems.
The Problems view is added to the current perspective.

2. In the Problems view right-click on a message.
A popup menu appears.

3. Select Detailed Diagnostics Info.

A dialog box appears with additional information.
Command line syntax
--diag=[format:]{all | nr,...}

You can set the following output formats:

html HTML output.
rtf Rich Text Format.
text ASCII text.

Default format: text

Description

With this option you can ask for an extended description of error messages in the format you choose.
The output is directed to stdout (normally your screen) and in the format you specify. You can specify the
following formats: html, rtf or text (default). To create a file with the descriptions, you must redirect the
output.

With the suboption all, the descriptions of all error messages are given. If you want the description of one
or more selected error messages, you can specify the error message numbers, separated by commas.

Example

To display an explanation of message number 103, enter:
ccnts --di ag=103

This results in message 103 with explanation.

To write an explanation of all errors and warnings in HTML format to file ccer r or s. ht m , use redirection
and enter:

ccnts --diag=htm:all > ccerrors. htn
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Related information
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Control program option: --dry-run (-n)
Menu entry

Command line syntax

--dry-run

-n

Description

With this option you put the control program in verbose mode. The control program prints the invocations
of the tools it would use to process the files without actually performing the steps.

Related information

Control program option --verbose (Verbose output)
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Control program option: --endianness

Menu entry
1. Select Global Options.

2. Specify the Endianness:Little-endian mode or Big-endian mode.

Command line syntax
- -endi anness=endi anness

-B
- - bi g-endi an

You can specify the following endianness:

big b Big endian
little | Little endian (default)
Description

With this option the control program tells the assembler and linker what the endianness is of the host
CPU. By default, the assembler and linker generate code for a little-endian target (least significant byte
of a word at lowest byte address). With --endianness=big the assembler and linker generate code for a
big-endian target (most significant byte of a word at lowest byte address). -B is an alias for option

--endianness=big.

Related information
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Control program option: --error-file

Menu entry

Command line syntax

--error-file

Description

With this option the control program tells the compiler, assembler and linker to redirect diagnostic messages
to a file.

The error file will be named after the output file with extension . er r (for compiler) or . er s (for assembler).
For the linker, the error fileis | nts. el k.

Example

To write diagnostic messages to error files instead of st der r, enter:
ccnes --error-file -t test.c

Related information

Control Program option --warnings-as-errors (Treat warnings as errors)
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Control program option: --error-limit

Menu entry
1. Select C Compiler » Diagnostics.

2. Enter a value in the Maximum number of emitted errors field.

Command line syntax

--error-1limt=nunber

Default: 42

Description

With this option you limit the number of error messages in one invocation to the specified number. When
the limit is exceeded, the control program aborts with fatal error message F105. Warnings and informational
messages are not included in the count. When O (zero) or a negative number is specified, the control

program emits all errors. Without this option the maximum number of errors is 42. The control program
also passes this option to the C compiler, assembler and linker.

Related information

Section 3.7, C Compiler Error Messages
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Control program option: --extended-registers

Menu entry

1. Select C Compiler » Code Generation.

2. Enable the option Use extended register set.

Command line syntax

--extended-registers

Description

The extended register set extends the registers of the current MCS channel with the registers of the next
MCS channel. By default the extended register set is disabled. You can use this option to enable the

extended register set. The compiler enables RS0..RS7, whereas the assembler enables RS0..RS7,
DSTAT, GMIO and GMI1

Related information
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Control program option: --format

Menu entry
1. Select Linker » Output Format.

2. Enable the option Generate Intel Hex format file and/or Generate S-records file and/or Generate
C array file.

3. Optionally, specify the Size of addresses.

Eclipse always uses the project name as the basename for the output file.
Command line syntax
- - f or mat =f or mat

You can specify the following formats:

ELF ELF/DWARF

IHEX Intel Hex

SREC Motorola S-records

CARR C array
Description

With this option you specify the output format for the resulting (absolute) object file. The default output
format is ELF/DWARF, which can directly be used by the debugger.

If you choose IHEX or SREC, you can additionally specify the address size of the chosen format (option
--address-size).

If you choose CARR, the linker generates an output file for each memory chip in the C array format. The
C array format contains the generated machine code in the form of C code. For more information see
Section 12.4, C Array Format.

Example

To generate a Motorola S-record output file:

ccnes --format =SREC testl.c test2.c --output=test.sre
To generate C array output files (.c and .h):

ccnes --fornmat =CARR testl.c test2.c --output=test
Related information

Control program option --address-size (Set address size for linker IHEX/SREC files)
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Control program option --output (Output file)

Linker option --chip-output (Generate an output file for each chip)
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Control program option: --fp-model

Menu entry

1. Select C Compiler » Floating-Point.

2. Make a selection from the Floating-point model list.

3. If you selected Custom, enable one or more individual options.

Command line syntax
- -f p-nodel =f | ags

You can set the following flags:

+/-contract c/C
+/-float fIF
+/-fastlib I/L
+/-nonan n/N
+/-rewrite r’R
+/-trap t/T
+/-negzero z/lZ

0

1

2

3

Default: - - f p- nodel =cf | nr Tz

Description

allow expression contraction

treat 'double’ as 'float'

allow less precise library functions
allow optimizations to ignore NaN/Inf
allow expression rewriting

support trapping on exceptions
ignore sign of -0.0

alias for --fp-model=CFLNRtZ (strict)
alias for --fp-model=cFLNRTZ (precise)
alias for --fp-model=cFInrTz (fast double)
alias for --fp-model=cfinrTz (fast single)

With this option you select the floating-point execution model.

With --fp-model=+contract you allow the compiler to contract multiple float operations into a single
operation, with different rounding results. A possible example is fused multiply-add.

With --fp-model=+float you tell the compiler to treat variables and constants of type doubl e as f | oat .
Because the f | oat type takes less space, execution speed increases and code size decreases, both at
the cost of less precision. The control program automatically selects the correct libraries.

With --fp-model=+fastlib you allow the compiler to select faster but less accurate library functions for
certain floating-point operations. With --fp-model=-fastlib more precise library functions are used and
the compiler defines the macro __PRECI SE_LI B_FP__, which is used in mat h. h.
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With --fp-model=+nonan you allow the compiler to ignore NaN or Inf input values. An example is to
replace multiply by zero with zero.

With --fp-model=+rewrite you allow the compiler to rewrite expressions by reassociating. This might
result in rounding differences and possibly different exceptions. An example is to rewrite (a*c)+(b*c) as
(at+b)*c.

With --fp-model=+trap operations trap on floating-point exceptions. By default the control program uses
the non-trapping versions of the floating-point library (I i bf p. a). With this option you tell the control
program to use the trapping versions of the floating-point library (I i bf pt . a).

If you use the trapping floating-point library, exceptional floating-point cases are intercepted and can be
handled separately by an application defined exception handler. Using this library decreases the execution
speed of your application.

With --fp-model=+negzero you allow the compiler to ignore the sign of -0.0 values. An example is to
replace (a-a) by zero.

Related information

Pragmas STDC FP_CONTRACT, f p_negzer o, f p_nonan andf p_rew i t e in Section 1.7, Pragmas to
Control the Compiler.
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Control program option: --global-type-checking

Menu entry

1. Select C Compiler » Diagnostics.

2. Enable the option Perform global type checking on C code.

Command line syntax

--gl obal -t ype-checki ng

Description

The C compiler already performs type checking within each module. Use this option when you want the
linker to perform type checking between modules. The control program passes this option to both the C

compiler and the linker.

Related information
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Control program option: --help (-?)

Menu entry

Command line syntax
--help[=item

-2

You can specify the following argument:

options Show extended option descriptions

Description

Displays an overview of all command line options. When you specify the argument options you can list
detailed option descriptions.

Example
The following invocations all display a list of the available command line options:

ccnes - ?
ccnts --help
ccncs

To see a detailed description of the available options, enter:

ccnts --hel p=options

Related information
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Control program option: --include-directory (-I)

Menu entry
1. Select Assembler » Include Paths.

The Include paths box shows the directories that are added to the search path for include files.
2. To define a new directory for the search path, click on the Add button in the Include paths box.

3. Type or select a path.
Use the Edit and Delete button to change a path or to remove a path from the list.

Command line syntax
--include-directory=path,...

-lpath, ...

Description

With this option you can specify the path where your include files are located. A relative path will be
relative to the current directory.

The control program passes this option to the compiler and the assembler.

Example
Suppose that the C source file t est . ¢ contains the following lines:

#i ncl ude <stdio. h>
#i ncl ude "nyinc. h"

You can call the control program as follows:
cc87 --include-directory=nyinclude test.c

First the compiler looks for the file st di 0. h in the directory nyi ncl ude relative to the current directory.
If it was not found, the compiler searches in the environment variable and then in the default include
directory.

The compiler now looks for the file nyi nc. h in the directory where t est . c is located. If the file is not
there the compiler searches in the directory nyi ncl ude. If it was still not found, the compiler searches
in the environment variable and then in the default include directory.

Related information
C compiler option --include-directory (Add directory to include file search path)

C compiler option --include-file (Include file at the start of a compilation)
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Assembler option --include-directory (Add directory to include file search path)

Assembler option --include-file (Include file at the start of the input file)
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Control program option: --include-file (-H)

Menu entry
1. Select C/C++ Compiler » Preprocessing.

The Pre-include files box shows the files that are currently included before the compilation starts.
2. To define a new file, click on the Add button in the Pre-include files box.

3. Type the full path and file name or select a file.
Use the Edit and Delete button to change a file name or to remove a file from the list.

Command line syntax
--include-file=file,...
-Hile,...

Description

With this option you include one or more extra files at the beginning of each C source file, before other
includes. This is the same as specifying #i ncl ude "fil e" atthe beginning of each of your C sources.

Example

ccnts --include-file=stdio.h testl.c test2.c

The file st di 0. h is included at the beginning of bothtest 1. c and t est 2. c.
Related information

C compiler option --include-directory (Add directory to include file search path)

C compiler option --include-file (Include file at the start of a compilation)
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Control program option: --instruction-set

Menu entry
1. Select C Compiler » Code Generation.
2. Enable or disable the option Allow divide/modulo instructions.

3. Enable or disable the option Allow multiply instructions.

Command line syntax
--instruction-set=fl ags

You can set the following flags:

+/-divide d/D  allow the use of divide/modulo instructions
+/-multiply m/M  allow the use of multiply instructions
Default: - -i nstructi on- set =dm
Description

With this option you can select which instructions the compiler can use for code generation and as such
which instructions the assembler accepts. When the compiler is not allowed to use an instruction a run-time
library call is used instead. When the selected core forbids the use of an instruction it will never be used,
even when enabled by this option.

With --instruction-set=+divide you allow the compiler and assembler to use the DIVU and DIVS
instructions. These instruction are used to generate code for the divide (/ ) and modulo (%) operations.

With --instruction-set=+multiply you allow the compiler and assembler to use the MULU and MULS
instructions.

If one or both of the instructions are disabled, the control program specifies the libraries from the nnd
directory to the linker.

Related information
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Control program option: --iso

Menu entry
1. Select C Compiler » Language.

2. From the Comply to C standard list, select ISO C99, ISO C11, or ISO C90.

Command line syntax
--is0={90| 99| 11}
Default: - - i so=11
Description

With this option you select the ISO C standard. C90 is also referred to as the "ANSI C standard". C99
refers to the ISO/IEC 9899:1999 (E) standard. C11 refers to the ISO/IEC 9899:2011 (E) standard. C11
is the default.

Independent of the chosen ISO C standard, the control program always links libraries with C11 support.

Example

To select the ISO C99 standard on the command line:
ccncts --iso0=99 test.c

Related information

C compiler option --iso (ISO C standard)
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Control program option: --keep-output-files (-k)
Menu entry

Eclipse always removes generated output files when an error occurs.

Command line syntax
--keep-output-files
-k

Description

If an error occurs during the compilation, assembling or linking process, the resulting output file may be
incomplete or incorrect. With this option you keep the generated output files when an error occurs.

By default the control program removes generated output files when an error occurs. This is useful when
you use the make utility. If the erroneous files are not removed, the make utility may process corrupt files
on a subsequent invocation.

Use this option when you still want to use the generated files. For example when you know that a particular
error does not result in a corrupt file, or when you want to inspect the output file, or send it to Altium
support.

The control program passes this option to the compiler, assembler and linker.
Example
ccnts --keep-output-files test.c

When an error occurs during compiling, assembling or linking, the erroneous generated output files will
not be removed.

Related information
C compiler option --keep-output-files
Assembler option --keep-output-files

Linker option --keep-output-files
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Control program option: --keep-temporary-files (-t)
Menu entry

1. Select Global Options.

2. Enable the option Keep temporary files.

Command line syntax

--keep-tenporary-files

-t

Description

By default, the control program removes intermediate files like the . sr c file (result of the compiler phase)
and the . o file (result of the assembler phase).

With this option you tell the control program to keep temporary files it generates during the creation of
the absolute object file.

Example
ccnts --keep-tenporary-files test.c

The control program keeps all intermediate files it generates while creating the absolute object file
test.elf.

Related information
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Control program option: --library (-I)

Menu entry
1. Select Linker » Libraries.
The Libraries box shows the list of libraries that are linked with the project.
2. To add a library, click on the Add button in the Libraries box.
3. Type or select a library (including its path).

4. Optionally, disable the option Link default libraries.
Use the Edit and Delete button to change a library name or to remove a library from the list.

Command line syntax
--library=nane

-l nane

Description

With this option you tell the linker via the control program to use system library | i bname. a, where name
is a string. The linker first searches for system libraries in any directories specified with --library-directory,
then in the directories specified with the environment variables LI BMCS / LI BMCS2_0 / LI BMCS3_0
/ LIBMCS3_1 / LIBMCS4_0, unless you used the option --ignore-default-library-path.

Example
To search in the system library | i bc. a (C library):
ccnes test.o nylib.a --library=c

The linker links the file t est . o and first looks in library nyl i b. a (in the current directory only), then in
the system library | i bc. a to resolve unresolved symbols.

Related information

Control program option --no-default-libraries (Do not link default libraries)

Control program option --library-directory (Additional search path for system libraries)
Section 5.3, Linking with Libraries

Chapter 10, Libraries
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Control program option: --library-directory (-L) /
--ignore-default-library-path

Menu entry
1. Select Linker » Libraries.
The Library search path box shows the directories that are added to the search path for library files.

2. To define a new directory for the search path, click on the Add button in the Library search path
box.

3. Type or select a path.

Use the Edit and Delete button to change a path or to remove a path from the list.

Command line syntax

--library-directory=path, ...
-Lpath, ...

--ignore-default-library-path
-L

Description

With this option you can specify the path(s) where your system libraries, specified with the option --library
(-1), are located. If you want to specify multiple paths, use the option --library-directory for each separate
path.

The default path is $( PRODDI R)\ | i b\ { nts30| nts31| ncs40}\ {be|l e}.

If you specify only -L (without a pathname) or the long option --ignore-default-library-path, the linker
will not search the default path and also not in the paths specified in the environment variables LI BMCS
/ LIBMCS2_0 / LIBMCS3_0 / LIBMCS3_1 / LIBMCS4_0. So, the linker ignores steps 2 and 3 as
listed below.

The priority order in which the linker searches for system libraries specified with the option --library ()
is:

1. The path that is specified with the option --library-directory.

2. The path that is specified in the environment variables LI BMCS / LIBMCS2_0 / LIBMCS3_0 /
LI BMCS3_1 / LIBMCS4_0.

3. The default directory $( PRODDI R)\ | i b\ { nts30| nts31| ncs40}\{be| | e}.

Example

Suppose you call the control program as follows:
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ccnes test.c --library-directory=c:\nylibs --library=c

First the linker looks in the directory c: \ nyl i bs for library | i bc. a (this option). If it does not find the
requested libraries, it looks in the directory that is set with the environment variables LI BMCS /
LIBMCS2_0 / LIBMCS3_0 / LIBMCS3_1 / LI BMCS4_0.Then the linker looks in the default directory
$(PRODDI R)\ 1i b\ {nts30| ncs31| ncs40}\{be| | e} for libraries.

Related information
Control program option --library (Link system library)

Section 5.3.1, How the Linker Searches Libraries
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Control program option: --link-only

Menu entry
Command line syntax
--link-only
Description

With this option you suppress the locating phase. The linker stops after linking and informs you about
unresolved references.

Related information
Control program option --create=relocatable (-cl) (Stop after linking)

Linker option --link-only (Link only, no locating)
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Control program option: --list-files

Menu entry

Command line syntax

--list-files[=file]

Default: no list files are generated

Description

With this option you tell the assembler via the control program to generate a list file for each specified
input file. A list file shows the generated object code and the relative addresses. Note that the assembler

generates a relocatable object file with relative addresses.

With the optional file you can specify a name for the list file. This is only possible if you specify only one
input file to the control program. If you do not specify a file name, or you specify more than one input file,
the control program names the generated list file(s) after the specified input file(s) with extension . | st .

Note that object files and library files are not counted as input files.

Related information
Assembler option --list-file (Generate list file)

Assembler option --list-format (Format list file)
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Control program option: --Isl-core

Menu entry

1. Expand C/C++ Build and select Processor.

2. From the Select core list, select a processor core.
Command line syntax

--lsl-core=MCS-core

Depending on the used processor, you can specify the following MCS cores:

mcs00 MCS core 0
mcsO01 MCS core 1
mcs02 MCS core 2
mcs03 MCS core 3
mcs04 MCS core 4
mcs05 MCS core 5
mcs06 MCS core 6
mcs07 MCS core 7
mcs08 MCS core 8
mcs09 MCS core 9

Default: mcs00

Description

With this option you can specify the LSL core architecture the code is intended for. For example, the file
gtnB1_08. | sl inthei ncl ude. | sl directory, contains a description of derivative gt n81_08 and the
supported MCS cores. The _08 in the filename indicates this GTM configuration supports 8 cores.

Example
To link objects for the MCS core nts01, enter:
ccnts --cpu=gtnB81_08 --1lsl-core=ncs01 -t test.c

This results in the following invocation of the tools:

+ cncs -DCPU__=gtnB81 08 -D__CPU GTM31_08__ --core=nts3.1
--fp-nodel =cFInrTz -0 test.src test.c
+ asncs -D__CPU__=gtnB81_08 -D__CPU GTM31_08__ --core=nts3.1
--endianness=little -0 test.o test.src
+ lcms -0 test.elf -dgtnB1_08.1sl --core=nts0O1l

--endi anness=little --non-ronabl e
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--user-provided-initialization-code -D__LINKONLY___
-D_CPU_=gtnB1 08 -D__PROC GTM31_08__ --map-file test.o
"-Lpath\lib\ncs31\le" -lc -Ifp -1Irt

Related information

Linker option --core (Specify LSL core)
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Control program option: --Isl-file (-d)

Menu entry
An LSL file can be generated when you create your project in Eclipse:
1. From the File menu, select File » New » TASKING MCS C Project.
The New C Project wizard appears.
2. Fillin the project settings in each dialog and click Next > until the MCS Project Settings appear.
3. Enable the option Add linker script file to the project and click Finish.
Eclipse creates your project and the file project. | sl in the project directory.
The LSL file can be specified in the Properties dialog:
1. Select Linker » Script File.

2. Specify a LSL file in the Linker script file (.Isl) field.

Command line syntax
--Isl-file=file,...

-dfile,...

Description

A linker script file contains vital information about the core for the locating phase of the linker. A linker
script file is coded in LSL and contains the following types of information:

« the architecture definition describes the core's hardware architecture.
» the memory definition describes the physical memory available in the system.
« the section layout definition describes how to locate sections in memory.

With this option you specify a linker script file via the control program to the linker. If you do not specify
this option, the linker uses a default script file. You can specify the existing file target. | sl or the name
of a manually written linker script file. You can use this option multiple times. The linker processes the
LSL files in the order in which they appear on the command line.

Related information

Section 5.7, Controlling the Linker with a Script
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Control program option: --make-target

Menu entry

Command line syntax

- -make-t ar get =nane

Description

With this option you can overrule the default target name in the make dependencies generated by the

options --preprocess=+make (-Em) and --dep-file. The default target name is the basename of the input
file, with extension . o.

Example
ccnts --preprocess=+nake --nake-target=../mytarget.o test.c

The compiler generates dependency lines with the default target name . . / myt ar get . o instead of
test.o.

Related information
Control program option --preprocess=+make (Generate dependencies for make)

Control program option --dep-file (Generate dependencies in a file)
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Control program option: --meminit

Menu entry
1. Select Global Options.

2. Select the Initialization mode.
Command line syntax
--mem ni t =node

You can specify the following modes:

cpu Initialization is done by a CPU

mcs Self contained initialization from ROM

none The program is loaded directly into RAM
Description

With this option you can specify the initialization mode for the MCS memory. By default, the program is
loaded directly into RAM.

With --meminit=cpu, initialization of MCS memory is done by the CPU. The following applies:

« If the MCS is reset and the CPU is not reset at the same time, the MCS memory image is, or may be,
incorrect.

* The start-up code of the MCS does not initialize the MCS memory.
» The user provided initialization code is the CPU initialization code.
» The control program calls the linker with the options --link-only and -D__ LINKONLY__.

With --meminit=mcs, initialization is done by the MCS. This is the case for an MCS with its own ROM.
The MCS can be reset and its memory will be re-initialized correctly. The following applies:

» The start-up code of the MCS initializes the MCS memory by copying ROM to RAM and clearing BSS
sections.

With --meminit=none, the MCS does not initialize its memory. You can use this option when you want
to debug your program with the simulator. The following applies:

« If the MCS is soft reset, the MCS global data is not re-initialized.
» The start-up code of the MCS does not initialize the MCS memory.
» The user provided initialization code is empty.

 The control program calls the linker with the options --non-romable, --user-provided-initialization-code
and --no-rom-copy.
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» The simulator clears all memory, implicitly clearing all BSS sections.

* The simulator initializes RAM data sections, because initialization data is defined in RAM data sections
as a consequence of the linker option ---no-rom-copy.

Example

To initialize MCS memory from ROM:

ccnts --memnit=ncts test.c

Related information

Control program option --address-size (Set address size for linker IHEX/SREC files)
Control program option --output (Output file)

Linker option --chip-output (Generate an output file for each chip)
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Control program option: --no-default-libraries

Menu entry
1. SelectLinker » Libraries.

2. Disable the option Link default libraries.

Command line syntax

--no-default-libraries

Description

By default the control program specifies the standard C libraries (C99) and run-time library to the linker.
With this option you tell the control program not to specify the standard C libraries and run-time library to
the linker.

In this case you must specify the libraries you want to link to the linker with the option --library=library_name
or pass the libraries as files on the command line. The control program recognizes the option --library
(-1) as an option for the linker and passes it as such.

Example
ccntcs --no-default-libraries test.c

The control program does not specify any libraries to the linker. In normal cases this would result in
unresolved externals.

To specify your own libraries (I i bc. a) and avoid unresolved externals:

ccnts --no-default-libraries --library=c test.c

Related information
Control program option --library (Link system library)

Section 5.3.1, How the Linker Searches Libraries
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Control program option: --no-map-file

Menu entry
1. Select Linker » Map File.

2. Disable the option Generate map file.

Command line syntax

--no-map-file

Description

By default the control program tells the linker to generate a linker map file.

A linker map file is a text file that shows how the linker has mapped the sections and symbols from the
various object files (. 0) to the linked object file. A locate part shows the absolute position of each section.
External symbols are listed per space with their absolute address, both sorted on symbol and sorted on
address.

With this option you prevent the generation of a map file.

Related information
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Control program option: --no-warnings (-w)
Menu entry
1. Select C Compiler » Diagnostics.
The Suppress C compiler warnings box shows the warnings that are currently suppressed.
2. To suppress a warning, click on the Add button in the Suppress C compiler warnings box.

3. Enter the numbers, separated by commas or as a range, of the warnings you want to suppress (for
example 537, 538). Or you can use the Add button multiple times.

4. To suppress all warnings, enable the option Suppress all warnings.
Use the Edit and Delete button to change a warning number or to remove a number from the list.

Command line syntax

--no-war ni ngs[ =nunber [ - nunber], ...]
-w nunber [ - nunber],...]

Description

With this option you can suppresses all warning messages for the various tools or specific control program
warning messages.

On the command line this option works as follows:
* If you do not specify this option, all warnings are reported.
« If you specify this option but without numbers, all warnings of all tools are suppressed.

* If you specify this option with a number or a range, only the specified control program warnings are
suppressed. You can specify the option --no-warnings=number multiple times.

Example

To suppress all warnings for all tools, enter:
ccnts test.c --no-warni ngs
Related information

Control program option --warnings-as-errors (Treat warnings as errors)
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Control program option: --option-file (-f)

Menu entry

Command line syntax
--option-file=file,...
-f file,...

Description

This option is primarily intended for command line use. Instead of typing all options on the command line,
you can create an option file which contains all options and flags you want to specify. With this option
you specify the option file to the control program.

Use an option file when the command line would exceed the limits of the operating system, or just to store
options and save typing.

You can specify the option --option-file multiple times.

Format of an option file

* Multiple arguments on one line in the option file are allowed.

» To include whitespace in an argument, surround the argument with single or double quotes.

« If you want to use single quotes as part of the argument, surround the argument by double quotes and
vise versa:

"This has a single quote ' enbedded"
"This has a double quote " enbedded'
'"This has a double quote " and a single quote '"' enbedded"
* When a text line reaches its length limit, use a \ to continue the line. Whitespace between quotes is
preserved.

"This is a continuation \
li ne"

-> "This is a continuation |ine"

* Itis possible to nest command line files up to 25 levels.
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Example

Suppose the file myopt i ons contains the following lines:

--debug-info
- - def i ne=DEMO=1
test.c

Specify the option file to the control program:
ccnts --option-fil e=nyoptions
This is equivalent to the following command line:

ccnts —debug-info --defi ne=DEMO=1 test.c

Related information
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Control program option: --output (-0)

Menu entry

Eclipse always uses the project name as the basename for the output file.

Command line syntax
--output=file

-o file

Description

By default, the control program generates a file with the same basename as the first specified input file.
With this option you specify another name for the resulting absolute object file.

The default output format is ELF/DWARF, but you can specify another output format with option --format.
Example

ccnts test.c prog.c

The control program generates an ELF/DWARF object file (default) with the name t est . el f.

To generate the fileresul t . el f:

ccnts --output=result.elf test.c prog.c

Related information

Control program option --format (Set linker output format)

Linker option --output (Output file)

Linker option --chip-output (Generate an output file for each chip)
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Control program option: --pass (-W)

Menu entry
1. Select C Compiler » Miscellaneous or Assembler » Miscellaneous or Linker » Miscellaneous.
2. Add an option to the Additional options field.

Be aware that the options in the option file are added to the options you have set in the other pages.
Only in extraordinary cases you may want to use them in combination. The assembler options are
preceded by -Wa and the linker options are preceded by -WI. For the C options you have to do this
manually.

Command line syntax

--pass-assembler=option -Waoption Pass option directly to the assembler

--pass-c=option -Wcoption Pass option directly to the C compiler

--pass-linker=option -Wloption Pass option directly to the linker
Description

With this option you tell the control program to call a tool with the specified option. The control program
does not use or interpret the option itself, but specifies it directly to the tool which it calls.

Example
To pass the option --verbose directly to the linker, enter:

ccnts --pass-linker=--verbose test.c

Related information
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Control program option: --preprocess (-E) / --no-preprocessing-only
Menu entry

1. Select C Compiler » Preprocessing.

2. Enable the option Store preprocessor output in <file>.pre.

3. (Optional) Enable the option Keep comments in preprocessor output.

4. (Optional) Enable the option Keep #line info in preprocessor output.

Command line syntax

- - preprocess[ =fl ags]
-E[fl ags]

- - no- preprocessi ng-only

You can set the following flags:

+/-comments c/C keep comments

+/-includes il generate a list of included source files
+/-list I/L generate a list of macro definitions
+/-make m/M  generate dependencies for make
+/-noline p/P strip #line source position information

Default; - ECI LMP

Description

With this option you tell the compiler to preprocess the C source. The C compiler sends the preprocessed
output to the file name. pr e (where name is the name of the C source file to compile). Eclipse also
compiles the C source.

On the command line, the control program stops after preprocessing. If you also want to compile the C
source you can specify the option --no-preprocessing-only. In this case the control program calls the
compiler twice, once with option --preprocess and once for a regular compilation.

With --preprocess=+comments you tell the preprocessor to keep the comments from the C source file
in the preprocessed output.

With --preprocess=+includes the compiler will generate a list of all included source files. The preprocessor
output is discarded.

With --preprocess=+list the compiler will generate a list of all macro definitions. The preprocessor output
is discarded.
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With --preprocess=+make the compiler will generate dependency lines that can be used in a Makefile.
The information is written to a file with extension . d. The preprocessor output is discarded. The default
target name is the basename of the input file, with the extension . 0. With the option --make-target you
can specify a target name which overrules the default target name.

With --preprocess=+noline you tell the preprocessor to strip the #line source position information (lines

starting with #l i ne). These lines are normally processed by the assembler and not needed in the
preprocessed output. When you leave these lines out, the output is easier to read.

Example
ccnts --preprocess=+comments, - make, - noli ne --no-preprocessing-only test.c

The compiler preprocesses the file t est . ¢ and sends the output to the file t est . pr e. Comments are
included but no dependencies are generated and the line source position information is not stripped from
the output file. Next, the control program calls the compiler, assembler and linker to create the final object
fletest.elf

Related information
Control program option --dep-file (Generate dependencies in a file)

Control program option --make-target (Specify target name for -Em output)
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Control program option: --processors

Menu entry

1. From the Window menu, select Preferences.
The Preferences dialog appears.

2. Select TASKING » MCS.

3. Click the Add button to add additional processor definition files.

Command line syntax

--processors=file

Description
With this option you can specify an additional XML file with processor definitions.

The standard list of supported processors is defined in the file pr ocessor s. xml . This file defines for
each processor its full name (for example, GTM31_01), its ID, the base CPU name (for example, gtm31_01)
and the core settings (for example, mcs3.1).

The control program reads the specified file after the file pr ocessor s. xm in the product's et c directory.
Additional XML files can override processor definitions made in XML files that are read before.

Multiple --processors options are allowed.
Eclipse generates a --processors option in the makefiles for each specified XML file.
Example

Specify an additional processor definition file (suppose pr ocessor s- new. xni contains a new processor
MCSNEW:

CCNTS - - processors=processors-new. xm --cpu=MCSNEW t est. ¢

Related information

Control program option --cpu (Select processor)
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Control program option: --signed-bitfields

Menu entry

1. Select C Compiler » Language.

2. Enable the option Treat 'int' bit-fields as signed.

Command line syntax

--signed-bitfields

Description

For bit-fields it depends on the implementation whether a plaini nt is treated as si gned i nt orunsi gned
i nt.By default ani nt bit-field is treated as unsi gned i nt . This offers the best performance. With this

option you tell the compiler to treat i nt bit-fields as si gned i nt . In this case, you can still add the
keyword unsi gned to treat a particular i nt bit-field as unsi gned.

Related information
C compiler option --signed-bitfields

Section 1.1, Data Types
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Control program option: --undefine (-U)

Menu entry
1. Select C Compiler » Preprocessing
The Defined symbols box shows the symbols that are currently defined.

2. Toremove a defined symbol, select the symbol in the Defined symbols box and click on the Delete
button.

Command line syntax
--undefi ne=nmacr o_nane

- Uracr o_nane

Description

With this option you can undefine an earlier defined macro as with #undef . This option is for example
useful to undefine predefined macros.

The following predefined ISO C standard macros cannot be undefined:

__FILE__ current source filename

__LINE__ current source line number (int type)
_TIME__ hh:mm:ss

__DATE__ Mmm dd yyyy

__STDC level of ANSI standard

The control program passes the option --undefine (-U) to the compiler.

Example

To undefine the predefined macro __TASKI NG__:

ccnts --undefine=_ _TASKING _ test.c

Related information

Control program option --define (Define preprocessor macro)

Section 1.8, Predefined Preprocessor Macros
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Control program option: --verbose (-v)

Menu entry

1. Select Global Options.

2. Enable the option Verbose mode of control program.
Command line syntax

--verbose

-v

Description

With this option you put the control program in verbose mode. The control program performs its tasks
while it prints the steps it performs to st dout .

Related information

Control program option --dry-run (Verbose output and suppress execution)
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Control program option: --version (-V)

Menu entry

Command line syntax

--version
-V
Description

Display version information. The control program ignores all other options or input files.

Related information
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Control program option: --warnings-as-errors

Menu entry
1. Select Global Options.

2. Enable the option Treat warnings as errors.

Command line syntax

- -war ni ngs- as-errors[=nunber[-nunber],...]

Description

If one of the tools encounters an error, it stops processing the file(s). With this option you tell the tools to
treat warnings as errors or treat specific control program warning messages as errors:

* If you specify this option but without numbers, all warnings are treated as errors.

« If you specify this option with a number or a range, only the specified control program warnings are
treated as an error. You can specify the option --warnings-as-errors=number multiple times.

Use one of the --pass-tool options to pass this option directly to a tool when a specific warning for that
tool must be treated as an error. For example, use --pass-c=--warnings-as-errors=number to treat a
specific C compiler warning as an error.

Related information
Control program option --no-warnings (Suppress some or all warnings)

Control program option --pass (Pass option to tool)
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8.5. Parallel Make Utility Options

When you build a project in Eclipse, Eclipse generates a makefile and uses the make utility amk to build
all your files. However, you can also use the make utility directly from the command line to build your
project.

The invocation syntax is:
ank [option...] [target...] [macro=def]
This section describes all options for the parallel make utility.

For detailed information about the parallel make utility and using makefiles see Section 6.2, Make Utility
amk.

437



TASKING VX-toolset for MCS User Guide

Parallel make utility option: --always-rebuild (-a)

Command line syntax
--always-rebuild

-a

Description

Normally the make utility rebuilds only those files that are out of date. With this option you tell the make
utility to rebuild all files, without checking whether they are out of date.

Example
ank -a
Rebuilds all your files, regardless of whether they are out of date or not.

Related information
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Parallel make utility option: --change-dir (-G)

Command line syntax

--change-di r=path

-G path

Description

Normally you must call the make utility from the directory where your makefile and other files are stored.

With the option -G you can call the make utility from within another directory. The path is the path to the
directory where your makefile and other files are stored and can be absolute or relative to your current
directory.

The macro SUBDI Ris defined with the value of path.

Example

Suppose your makefile and other files are stored in the directory . . \ myfi | es.You can call the make
utility, for example, as follows:

ank -G ..\nyfiles

Related information
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Parallel make utility option: --diag
Command line syntax
--diag=[format:]{all | nmsg[-nBQg],...}

You can set the following output formats:

html HTML output.
rtf Rich Text Format.
text ASCII text.

Default format: text

Description

With this option you can ask for an extended description of error messages in the format you choose.
The output is directed to stdout (normally your screen) and in the format you specify. You can specify the
following formats: html, rtf or text (default). To create a file with the descriptions, you must redirect the
output.

With the suboption all, the descriptions of all error messages are given. If you want the description of one
or more selected error messages, you can specify the error message numbers, separated by commas,
or you can specify a range.

Example

To display an explanation of message number 169, enter:
ank --di ag=451

This results in the following message and explanation:

E451: nake st opped

An error has occured while executing one of the comands
of the target, and -k option is not specified.

To write an explanation of all errors and warnings in HTML format to file anker r or s. ht m , use redirection
and enter:

ank --diag=htm:all > ankerrors. htm

Related information
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Parallel make utility option: --dry-run (-n)

Command line syntax
--dry-run

-n

Description

With this option you tell the make utility to perform a dry run. The make utility shows what it would do but
does not actually perform these tasks.

This option is for example useful to quickly inspect what would happen if you call the make utility.

Example

ank -n

The make utility does not perform any tasks but displays what it would do if called without the option -n.
Related information

Parallel make utility option -s (Do not print commands before execution)
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Parallel make utility option: --help (-? / -h)

Command line syntax
--help[=item
-h[iteni

-?
You can specify the following arguments:
options o] Show extended option descriptions

Description

Displays an overview of all command line options. When you specify the argument options you can list
detailed option descriptions.

Example

The following invocations all display a list of the available command line options:

ank -?
ank -h
ank --help

To see a detailed description of the available options, enter:

ank --hel p=options

Related information
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Parallel make utility option: --jobs (-j) / --jobs-limit (-J)
Menu
1. From the Project menu, select Properties for
The Properties dialog appears.
2. Inthe left pane, select C/C++ Build.
In the right pane the C/C++ Build page appears.
3. On the Behavior tab, select Enable parallel build.

4. You can specify the number of parallel jobs, or you can use an optimal number of jobs. In the last
case, amk will fork as many jobs in parallel as cores are available.

Command line syntax

- -j obs[ =nunber]
-j [ nunber]

--jobs-1imt[=nunber]
- J[ nunber]

Description

When these options you can limit the number of parallel jobs. The default is 1. Zero means no limit. When
you omit the number, amk uses the number of cores detected.

Option -J is the same as -j, except that the number of parallel jobs is limited by the number of cores
detected.

Example
ank -j3
Limit the number of parallel jobs to 3.

Related information
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Parallel make utility option: --keep-going (-k)
Command line syntax

- - keep- goi ng

-k

Description

When during the make process the make utility encounters an error, it stops rebuilding your files.

With the option -k, the make utility only stops building the target that produced the error. All other targets
defined in the makefile are built.

Example
ank -k

If the make utility encounters an error, it stops building the current target but proceeds with the other
targets that are defined in the makefile.

Related information
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Parallel make utility option: --list-targets (-I)

Command line syntax

--list-targets

-1

Description

With this option, the make utility lists all "primary" targets that are out of date.
Example

ank -1
list of targets

Related information
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Parallel make utility option: --makefile (-f)

Command line syntax
--makefil e=nmy_makefile

-f nmy_nakefile
Description

By default the make utility uses the file makef i | e to build your files.

With this option you tell the make utility to use the specified file instead of the file makef i | e. Multiple -f
options act as if all the makefiles were concatenated in a left-to-right order.

If you use '-' instead of a makefile name it means that the information is read from st di n.

Example
ank -f mynake
The make utility uses the file mynake to build your files.

Related information
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Parallel make utility option: --no-warnings (-w)

Command line syntax

- - no-war ni ngs[ =nunber, .. .]
-w nunber, .. .]
Description

With this option you can suppresses all warning messages or specific warning messages.
On the command line this option works as follows:

« If you do not specify this option, all warnings are reported.

* If you specify this option but without numbers, all warnings are suppressed.

« If you specify this option with a number, only the specified warning is suppressed. You can specify the
option --no-warnings=number multiple times.

Example
To suppress warnings 751 and 756, enter:

ank --no-warni ngs=751, 756

Related information

Parallel make utility option --warnings-as-errors (Treat warnings as errors)
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Parallel make utility option: --silent (-s)

Command line syntax
--silent

-s

Description

With this option you tell the make utility to perform its tasks without printing the commands it executes.
Error messages are normally printed.

Example

ank -s

The make utility rebuilds your files but does not print the commands it executes during the make process.
Related information

Parallel make utility option -n (Perform a dry run)
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Parallel make utility option: --version (-V)

Command line syntax

--version
-V
Description

Display version information. The make utility ignores all other options or input files.

Related information
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Parallel make utility option: --warnings-as-errors

Command line syntax

- -war ni ngs- as-errors[=nunber, ...]

Description

If the make utility encounters an error, it stops. When you use this option without arguments, you tell the
make utility to treat all warnings as errors. This means that the exit status of the make utility will be non-zero
after one or more warnings. As a consequence, the make utility now also stops after encountering a
warning.

You can also limit this option to specific warnings by specifying a comma-separated list of warning numbers.

Related information

Parallel make utility option --no-warnings (Suppress some or all warnings)
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8.6. Archiver Options

The archiver and library maintainer armcs is a tool to build library files and it offers the possibility to
replace, extract and remove modules from an existing library.

The invocation syntax is:
arncs key_option [sub_option...] library [object_file]

This section describes all options for the archiver. Some suboptions can only be used in combination with
certain key options. They are described together. Suboptions that can always be used are described
separately.

For detailed information about the archiver, see Section 6.3, Archiver.

Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (-)
character, long option names always begin with two minus (--) characters. You can abbreviate long option

names as long as it forms a unique name. You can mix short and long option names on the command
line.

Overview of the options of the archiver utility

The following archiver options are available:

Description ‘Option Sub-option
Main functions (key options)

Replace or add an object module -r -a-b-c-n-u-v
Extract an object module from the library -X -0 -V
Delete object module from library -d -v

Move object module to another position -m -a-b-v
Print a table of contents of the library -t -s0-s1
Print object module to standard output -p

Sub-options

Append or move new modules after existing module name -a name

Append or move new modules before existing module name -b name

Suppress the message that is displayed when a new library is -C

created

Create a new library from scratch -n

Preserve last-modified date from the library -0

Print symbols in library modules -s{0|1}

Replace only newer modules -u

Verbose -v
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Description Option Sub-option
Miscellaneous

Display options -?

Display description of one or more diagnostic messages --diag

Display version header -V

Read options from file -f file

Suppress warnings above level n -wn
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Archiver option: --delete (-d)

Command line syntax
--delete [--verbose]
-d [-V]

Description

Delete the specified object modules from a library. With the suboption --verbose (-v) the archiver shows
which files are removed.

--verbose -v Verbose: the archiver shows which files are removed.
Example
arncs --delete nylib.a objl.0 obj2.0
The archiver deletes obj 1. o and obj 2. o from the library nyl i b. a.
arncs -d -v nylib.a obj1.0 obj2. 0

The archiver deletes obj 1. 0 and obj 2. o from the library nyl i b. a and displays which files are removed.

Related information
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Archiver option: --diag
Command line syntax
--diag=[format:]{all | nmsg[-nBQg],...}

You can set the following output formats:

html HTML output.
rtf Rich Text Format.
text ASCII text.

Default format: text

Description

With this option you can ask for an extended description of error messages in the format you choose.
The output is directed to stdout (normally your screen) and in the format you specify. The archiver does
not perform any actions. You can specify the following formats: html, rtf or text (default). To create a file
with the descriptions, you must redirect the output.

With the suboption all, the descriptions of all error messages are given. If you want the description of one
or more selected error messages, you can specify the error message numbers, separated by commas,
or you can specify a range.

Example

To display an explanation of message number 102, enter:
arncs --di ag=102

This results in the following message and explanation:

F102: cannot create "<file>"

The output file or a tenporary file could not be created. Check if you have
sufficient disk space and if you have wite permissions for the specified
file.

To write an explanation of all errors and warnings in HTML format to file ar er r or s. ht nl , use redirection
and enter:

arncs --diag=htm:all > arerrors.htnl

Related information
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Archiver option: --dump (-p)

Command line syntax

--dunp

-p

Description

Print the specified object module(s) in the library to standard output.

This option is only useful when you redirect or pipe the output to other files or tools that serve your own
purposes. Normally you do not need this option.

Example
arncs --dunmp nylib.a objl.o > file.o
The archiver prints the file obj 1. o to standard output where it is redirected to the file f i | e. 0. The effect

of this example is very similar to extracting a file from the library but in this case the 'extracted' file gets
another name.

Related information
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Archiver option: --extract (-x)

Command line syntax

--extract [--npdtinme] [--verbose]
-x [-0] [-V]

Description

Extract an existing module from the library.

--modtime -0 Give the extracted object module the same date as the last-modified
date that was recorded in the library. Without this suboption it
receives the last-modified date of the moment it is extracted.

--verbose -V Verbose: the archiver shows which files are extracted.

Example

To extract the file obj 1. o from the library nyl i b. a:

arncts --extract nylib.a objl.o

If you do not specify an object module, all object modules are extracted:

arncs -x nylib.a

Related information
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Archiver option: --help (-?)

Command line syntax
--help[=item

-?

You can specify the following argument:

options Show extended option descriptions

Description

Displays an overview of all command line options. When you specify the argument options you can list
detailed option descriptions.

Example
The following invocations all display a list of the available command line options:

arncs -?
arncs --help
arncs

To see a detailed description of the available options, enter:
arncts --hel p=options

Related information
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Archiver option: --move (-m)

Command line syntax

--nove [-a posnane] [-b posnhane]

-m[-a posnane] [-b posnane]

Description

Move the specified object modules to another position in the library.

The ordering of members in a library can make a difference in how programs are linked if a symbol is
defined in more than one member.

By default, the specified members are moved to the end of the archive. Use the suboptions -a or -b to
move them to a specified place instead.

--after=posname -a Move the specified object module(s) after the existing module
posname poshame.

--before=posname -b Move the specified object module(s) before the existing
posname module poshame.

Example

Suppose the library nmyl i b. a contains the following objects (see option --print):
obj1l.0

obj 2.0

obj 3.0

To move obj 1. o to the end of nyl i b. a:

arnts --nmove nylib.a objl.0

To move obj 3. o just before obj 2. o:

arnts -m-b obj3.0 nylib.a obj2.0

The library myl i b. a after these two invocations now looks like:
obj 3.0

obj 2.0
obj1l.0

Related information

Archiver option --print (-t) (Print library contents)
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Archiver option: --option-file (-f)
Command line syntax
--option-file=file

-f file

Description

Instead of typing all options on the command line, you can create an option file which contains all options
and flags you want to specify. With this option you specify the option file to the archiver.

Use an option file when the command line would exceed the limits of the operating system, or just to store
options and save typing.

You can specify the option --option-file (-f) multiple times.

If you use '-' instead of a filename it means that the options are read from st di n.

Format of an option file

» Multiple arguments on one line in the option file are allowed.

» To include whitespace in an argument, surround the argument with single or double quotes.

« If you want to use single quotes as part of the argument, surround the argument by double quotes and
vise versa:

"This has a single quote ' enbedded"
"This has a double quote " enbedded’

"This has a doubl e quote and a single quote '"' enbedded"

* When a text line reaches its length limit, use a \ to continue the line. Whitespace between quotes is
preserved.

"This is a continuation \
l'i ne"

-> "This is a continuation |line"

* Itis possible to nest command line files up to 25 levels.

Example
Suppose the file myopt i ons contains the following lines:

-x mylib.a objl.0
- w5
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Specify the option file to the archiver:

arncts --option-fil e=nyoptions

This is equivalent to the following command line:
arnts -x nylib.a objl.o -w5

Related information
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Archiver option: --print (-t)
Command line syntax

--print [--synbol s=0| 1]

-t [-s0]-s1]

Description

Print a table of contents of the library to standard output. With the suboption -s0 the archiver displays all
symbols per object file.

--symbols=0 -s0 Displays per object the name of the object itself and all symbols in
the object.
--symbols=1 -s1 Displays the symbols of all object files in the library in the form

library_name:object_name:symbol_name

Example

arncs --print nylib.a

The archiver prints a list of all object modules in the library nyl i b. a:
arncs -t -sO nylib.a

The archiver prints per object all symbols in the library.

Related information
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Archiver option: --replace (-r)

Command line syntax

--replace [--after=posnane] [--before=posnane]
[--create] [--new] [--newer-only] [--verbose]

-r [-a posnane] [-b posnane][-c] [-n] [-u] [-V]
Description

You can use the option --replace (-r) for several purposes:

» Adding new objects to the library

» Replacing objects in the library with the same object of a newer date
» Creating a new library

The option --replace (-r) normally adds a new module to the library. However, if the library already contains
a module with the specified name, the existing module is replaced. If you specify a library that does not
exist, the archiver creates a new library with the specified name.

If you add a module to the library without specifying the suboption -a or -b, the specified module is added
at the end of the archive. Use the suboptions -a or -b to insert them after/before a specified place instead.

--after=posname -aposhame Insert the specified object module(s) after the existing
module poshame.

--before=posname -b posname Insert the specified object module(s) before the existing
module posname.

--create -C Suppress the message that is displayed when a new library
is created.

--new -n Create a new library from scratch. If the library already

exists, it is overwritten.

--newer-only -u Insert the specified object module only if it is newer than
the module in the library.

--verbose -V Verbose: the archiver shows which files are replaced.
The suboptions -a or -b have no effect when an object is added to the library.
Example
Suppose the library nyl i b. a contains the following object (see option --print):
obj1l.0
To add obj 2. o to the end of nyl i b. a:

arnts --replace nylib.a obj2.0

462



Tool Options

To insert obj 3. o just before obj 2. o:

arncs -r -b obj2.0 nylib.a obj3.0

The library myl i b. a after these two invocations now looks like:

obj1.0

obj 3.0

obj 2.0

Creating a new library

To create a new library file, add an object file and specify a library that does not yet exist:
arnts --replace newib.a objl.0

The archiver creates the library new i b. a and adds the object obj 1. o to it.

To create a new library file and overwrite an existing library, add an object file and specify an existing
library with the supoption --new (-n):

arncs -r -n nylib.a objl.0

The archiver overwrites the library myl i b. a and adds the object obj 1. o to it. The new library nyl i b. a
only contains obj 1. o.

Related information

Archiver option --print (-t) (Print library contents)
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Archiver option: --version (-V)

Command line syntax

--version

-V

Description

Display version information. The archiver ignores all other options or input files.

Related information
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Archiver option: --warning (-w)

Command line syntax
- -war ni ng=l evel

-w evel

Description

With this suboption you tell the archiver to suppress all warnings above the specified level. The level is
a number between O - 9.

The level of a message is printed between parentheses after the warning number. If you do not use the
-w option, the default warning level is 8.

Example
To suppress warnings above level 5:

arnts --extract --warning=5 nylib.a obj1.0

Related information
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8.7. HLL Object Dumper Options

The high level language (HLL) dumper hidumpmcs is a program to dump information about an absolute
object file (. el f).

Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (-)
character, long option names always begin with two minus (--) characters. You can abbreviate long option
names as long as it forms a unique name. You can mix short and long option names on the command
line.

Options can have flags or suboptions. To switch a flag 'on’, use a lowercase letter or a +longflag. To
switch a flag off, use an uppercase letter or a -longflag. Separate longflags with commas. The following
two invocations are equivalent:

hl dumpnts - Fdhisy test.elf
hl dunpnts --dunp-f or mat =+dunp, +hl | synbol s, - nbdul es, +secti ons, +synbol s test.elf

When you do not specify an option, a default value may become active.
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HLL object dumper option: --adx-format (-A)

Command line syntax
--adx-format[=flag], ...
-Alflag]...

You can specify one of the following flags:

+/-force-elf-mode e/E  Force the use of ELF symbols instead of the DWARF debug
info
+/-reduced r'R Do not output tags CATEGORY, COMP-UNIT-NAME,

COMP-UNIT-DIR and CALLED-SYMBOLS.
Default (no flags): - - adx- f or mat =ER

Description

With this option you dump the application data in the ADX address list format. The address list format is
based on XML.

With --adx-format=+force-elf-mode, ELF symbols are used instead of the DWARF debug info, resulting
in reduced info.

With --adx-format=+reduced, the tags CATEGORY, COMP-UNIT-NAME, COMP-UNIT-DIR and
CALLED-SYMBOLS are not printed in the XML output.

Note that when you use this option all other output formatting options are ignored.

Example
hl dumpnts --adx-format hello.elf

<?xm version="1.0"7?>
<l-- Using DWARF debug info -->
<ADDRESS- CALCULATOR versi on="1.0.4" spec="1.10">
<GENERAL- | NFO>
<MACHI NE- TYPE>MCS</ MACHI NE- TYPE>
<ELF- TYPE>ET_EXEC</ ELF- TYPE>
</ GENERAL- | NFO>
<MEMORY- ELEMENT>
<LABEL- NAME>_dbg_r equest </ LABEL- NAVE>
<CATEGORY>STRUCTURE</ CATEGORY>
<ABSOLUTE- ADDRESS>0x00000020</ ABSOLUTE- ADDRESS>
<Sl| ZE>24</ SI ZE>
<DEMANGLED- NAME>_dbg_r equest </ DEMANGLED- NAME>
<SH | NDEX>24</ SH- | NDEX>
<COWP- UNI T- NAVE>. . /. ./ ../ dbg. c</ COVP- UNI T- NAMVE>
<COWP-UNI T- DI R>~/ | i bsrc/ ncs31/1 e/ libc/ </ COVP- UNI T- DI R>
</ MEMORY- ELEMENT>
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<SECTI ON- ELEMENT>
<SECTI ON- NAME>. ntst ext . hel | 0. mai n</ SECTI ON- NAVE>
<SECTI ON- START- ADDRESS>0x000003F4</ SECT!| ON- START- ADDRESS>
<SECTI ON- S| ZE>0x1C</ SECTI ON- S| ZE>
<SECTI ON- | NDEX>4</ SECTI ON- | NDEX>
<SECTI ON- TYPE>PROGBI TS</ SECTI ON- TYPE>
</ SECTI ON- ELEMENT>

hl dunpnts --adx-format =+reduced hell o. el f

<?xm version="1.0"?>
<!'-- Using DWARF debug info -->
<ADDRESS- CALCULATOR version="1.0.4" spec="1.10">
<GENERAL- | NFO>
<MACHI NE- TYPE>MCS</ MACHI NE- TYPE>
<ELF- TYPE>ET_EXEC</ ELF- TYPE>
</ GENERAL- | NFO>
<MEMORY- ELEMENT>
<LABEL- NAME>_dbg_r equest </ LABEL- NAMVE>
<ABSOLUTE- ADDRESS>0x00000020</ ABSOLUTE- ADDRESS>
<Sl| ZE>24</ SI ZE>
<DEMANGLED- NAME>_dbg_r equest </ DEMANGLED- NAMVE>
<SH | NDEX>24</ SH- | NDEX>
</ MEMORY- ELEMENT>
<SECT| ON- ELEMENT>
<SECTI ON- NAME>. ntst ext . hel | 0. mai n</ SECTI ON- NAMVE>
<SECTI ON- START- ADDRESS>0x000003F4</ SECTI ON- START- ADDRESS>
<SECTI ON- SI ZE>0x1C</ SECTI O\- SI ZE>
<SECTI ON- | NDEX>4</ SECTI ON- | NDEX>
<SECTI ON- TYPE>PROGBI TS</ SECTI ON- TYPE>
</ SECTI ON- ELEMENT>

hl dunpnts --adx-format =+force-el f-node hello.elf

<?xm version="1.0"7?>
<l-- Using ELF synbols -->
<ADDRESS- CALCULATOR version="1.0.4" spec="1.10">
<GENERAL- | NFO>
<MACHI NE- TYPE>MCS</ MACHI NE- TYPE>
<ELF- TYPE>ET_EXEC</ ELF- TYPE>
</ GENERAL- | NFO>
<MEMORY- ELEMENT>
<LABEL- NAME>_dbg_r equest </ LABEL- NAVE>
<CATEGORY>DATA</ CATEGCRY>
<ABSOLUTE- ADDRESS>0x00000020</ ABSOLUTE- ADDRESS>
<OFFSET>0x00000020</ OFFSET>
<S| ZE>24</ Sl ZE>
</ MEMORY- ELEMENT>
<SECTI| O\- ELEMENT>
<SECTI ON- NAME>. ntst ext . hel | 0. mai n</ SECTI ON- NAVE>
<SECTI O\- START- ADDRESS>0x000003F4</ SECTI ON- START- ADDRESS>
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<SECTI ON- S| ZE>0x1C</ SECTI ON- S| ZE>
<SECTI ON- | NDEX>4</ SECTI ON- | NDEX>
<SECTI ON- TYPE>PROGBI TS</ SECTI ON- TYPE>
</ SECTI ON- ELEMENT>
</ ADDRESS- CALCULATOR>

Related information

ADX Specification - Address List Format for A2L Address Calculation - Compiler vendors, Version 1.10,
2015-04-27

469



TASKING VX-toolset for MCS User Guide

HLL object dumper option: --blank-out (-b)

Command line syntax
- - bl ank- out [ =f | ag]
-b[fl ag]
You can specify the following format flags:
+/-labels I/L Black out hexadecimal address and labels.

Default: - - bl ank- out =L

Description

With this option you can blank out addresses and optionally labels in all dump phases. Instead of the
addresses and labels crosses (X's) are shown.

The +labels sub-option blanks out hexadecimal addresses and labels. With the -labels sub-option only
hexadecimal addresses are blanked out. This is the default.

This option is useful when you want to compare the output, but want to ignore the addresses and labels.
Example
hl dumpnts -F2 hello. el f

----------- Section dunmp ----------

.sdecl '.nctstext.hello.main', CODE AT 0x3f4
.sect '.nctstext.hello.min

000003f4 04 00 00 27 nmain: addl r 7, 0x00000004

000003f8 00 03 01 a5 nrd r5, 0x00000300

000003fc 00 00 74 a5 mar i r5r7,0

00000400 dO 02 00 12 novl r 2, 0x000002d0

00000404 2c 09 03 e0 call printf

00000408 04 00 00 37 subl r 7, 0x00000004

0000040c 00 00 04 eO ret

hl dumpnts -F2 --bl ank-out hello.elf

----------- Section dunmp ----------

.sdecl '.nctstext.hello.main', CODE AT XX

.sect '.nctstext.hello.min
XXXXXXXX 04 00 00 27 nain: addl r 7, 0x00000004
XXXXXXXX 00 03 01 a5 nrd r5, 0x00000300
XXXXXXXX 00 00 74 a5 mar i r5r7,0
XXXXXXXX dO0 02 00 12 novl r 2, 0x000002d0
XXXXXXXX 2¢ 09 03 e0 call printf
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XXXXXXXX 04 00 00 37 subl r 7, 0x00000004
XXXXXXXX 00 00 04 eO ret

hl dumpnts -F2 --bl ank-out =+l abel s hello. el f

----------- Section dunmp ----------
.sdecl '.ntstext.hello.main',
.sect '.ntstext.hello.min'
XXXXXXXX 04 00 00 27  XXXXXXXXXX:  addl r7, 0x00000004
XXXXXXXX 00 03 01 ab nmrd r5, 0x00000300
XXXXXXXX 00 00 74 ab mar i r5r7,0
XXXXXXXX d0 02 00 12 novl r2, 0x000002d0
XXXXXXXX 2¢ 09 03 €0 cal | ) 0,0.9,0,.0,:9.9,9,0:¢
XXXXXXXX 04 00 00 37 subl r7, 0x00000004
XXXXXXXX 00 00 04 eO ret

Related information

Tool Options

CODE AT XX
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HLL object dumper option: --call-graph-elf-mode
Command line syntax
--call -graph-el f-node

Description

With this option you can force the call graph to use the ELF symbols instead of the DWARF debug info,
for example when dumping from an assembly function.

Related information

Section 6.4.2, HLL Dump Output Format
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HLL object dumper option: --call-graph-root

Command line syntax

--cal |l -graph-root=function

Description

With this option you can specify the address or function name where to start the call graph. By default,
the call graph starts with nai n() .

Example

To start the call graph from pri nt f () instead of mai n(), enter:
hl dumpnts --call -graph-root=printf -F3 hello.elf
The call graph looks something like this:

+-- 0x0000092c printf

I
+-- 0x00000474 _doprint

I
+-- 0x00000840 _io_putc

I
+-- 0x00000900 fputc

I
+-- 0x0000067c _fI sbuf

I
+-- 0x00000820 _host_write

I
| +-- 0x00000430 _dbg_trap

I
+-- 0x00000820 _host_write *

I
I
I I

| +-- 0x000007e8 _host _I| seek
I

I

I

I

I

I

I

I

I

I

I

I I

| +-- 0x00000548 _fflush
I

I

I

I

I I

| +-- 0x00000430 _dbg_trap
I

| +-- 0x00000820 _host_wite *

I

+-- 0x00000840 _io_putc *

Related information

Section 6.4.2, HLL Dump Output Format
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HLL object dumper option: --class (-c)

Command line syntax
--cl ass[ =cl ass]
-c[cl ass]

You can specify one of the following classes:

all a Dump contents of all sections.
code c Dump contents of code sections.
data d Dump contents of data sections.

Default: - - cl ass=al |

Description

With this option you can restrict the output to code or data only. This option affects all parts of the output,
except the module list. The effect is listed in the following table.

Output part Effect of --class

Module list Not restricted

Section list Only lists sections of the specified class

Section dump Only dumps the contents of the sections of the specified class
HLL symbol table Only lists symbols of the specified class

Assembly level symbol |[Only lists symbols defined in sections of the specified class
table

Note sections Not restricted

By default all sections are included.

Related information

Section 6.4.2, HLL Dump Output Format

474



Tool Options

HLL object dumper option: --copy-table

Command line syntax

--copy-table

Description

With this option the HLL object dumper attempts to translate the specified code address to the destination
address of a copy table copy command during disassembly.

Related information
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HLL object dumper option: --diag
Command line syntax
--diag=[format:]{all | nmsg[-nBQg],...}

You can set the following output formats:

html HTML output.
rtf Rich Text Format.
text ASCII text.

Default format: text

Description

With this option you can ask for an extended description of error messages in the format you choose.
The output is directed to stdout (normally your screen) and in the format you specify. The HLL object
dumper does not process any files. You can specify the following formats: html, rtf or text (default). To
create a file with the descriptions, you must redirect the output.

With the suboption all, the descriptions of all error messages are given. If you want the description of one
or more selected error messages, you can specify the error message numbers, separated by commas,
or you can specify a range.

Example

To display an explanation of message number 101, enter:
hl dumpnts --di ag=101

This results in the following message and explanation:

F101: cannot create "<file>"

The output file or a tenporary file could not be created.
Check if you have sufficient disk space and if you have
wite permissions for the specified file.

To write an explanation of all errors and warnings in HTML format to file hl dunperrors. htnl , use
redirection and enter:

hl dumpnts --diag=htm :all > hldunperrors. htni

Related information
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HLL object dumper option: --disassembly-intermix (-i)

Command line syntax
--di sassenbl y-i nterm x[ =f1 ag]
-i[flag]
You can specify the following format flags:
+/-single-line sIS Force the insert to be limited to the first preceding source line.

Default: - - di sassenbl y-i nterm x=S

Description

With this option the disassembly is intermixed with HLL source code. The source is searched for as
described with option --source-lookup-path

The +single-line sub-option forces the insert to be limited to the first preceding source line. With the

-single-line sub-option all source lines that belong to the address are prefixed. For example comments
are thus also visible. This is the default.

Example

hl dumpnts --di sassenbly-interm x --source-|ookup-path=c:\nylib\src hello.elf

Related information

HLL object dumper option --source-lookup-path
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HLL object dumper option: --disassembly-without-encoding (-r)

Command line syntax

- -di sassenbl y-w t hout - encodi ng
-r

Description

With this option the address and encoding are not part of the disassembly of a code section. This is useful
when you only want the disassembly part.

Example
hl dumpnts -F2 hello. el f

----------- Section dunmp ----------

.sdecl '.ntstext.hello.min', CODE AT 0x3f4

.sect '.ntstext.hello.min
000003f4 04 00 00 27 nmmin: addl r7, 0x00000004
000003f8 00 03 01 a5 nrd r5, 0x00000300
000003fc 00 00 74 a5 mar i r5r7,0
00000400 dO 02 00 12 novl r2, 0x000002d0
00000404 2c 09 03 e0 call printf
00000408 04 00 00 37 subl r7, 0x00000004
0000040c 00 00 04 eO ret

hl dunpnts -F2 --di sassenbl y-wi t hout-encodi ng hello. el f

----------- Section dunmp ----------

.sdecl '.ntstext.hello.min', CODE AT 0x3f4

.sect '.ntstext.hello.min'
mai n:  addl r7, 0x00000004

nrd r5, 0x00000300

mm i r5r7,0

movl r2, 0x000002d0

call printf

add| r7, 0x00000004

ret

Related information
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HLL object dumper option: --dump-format (-F)

Command line syntax

--dunmp-format[=flag,...]

F[flag]...

You can specify the following format flags:

+/-callgraph c/C
+/-dump d/D
+/-debug-control-flow fIF
+/-hllsymbols h/H
+/-modules m/M
+/-note n/N
+/-sections s/S
+/-symbols yIY

0

1

2

3

Default: - - dunp- f or rat =CdFhmmsy

Description

Dump the call graph of the application.

Dump the contents of the sections in the object file. Code
sections can be disassembled, data sections are dumped.

Dump the debug control flow section.

List the high level language symbols, with address, size and
type.

Print a list of modules found in object file.

Dump all ELF . not e sections.

Print a list of sections with start address, length and type.
List the low level symbols, with address and length (if known).
Alias for CDFHMNSY (nothing)

Alias for CDFhMNSY (only HLL symbols)

Alias for CAFHMNSY (only section contents)

Alias for cdfhmnsy (everything)

With this option you can control which parts of the dump output you want to see. By default, all parts are

d

1

2.

umped, except for the call graph.
. Module list

Section list

. Call graph using the DWARF debug info

. Section dump (disassembly)
. HLL symbol table

. Assembly level symbol table
. Note sections

. Debug control flow section
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By default, all parts are dumped, except for parts 3 and 8.

You can limit the number of sections that will be dumped with the options --sections and --section-types.

Related information

Section 6.4.2, HLL Dump Output Format

480



Tool Options

HLL object dumper option: --expand-symbols (-e)

Command line syntax
--expand- symbol s[=fl ag], . ..
-e[flag]...

You can specify one of the following flags:

+/-basic-types b/B  Expand arrays with basic C types.

+/-fullpath fIF Include the full path to the field level.

+/-gap-info g/G Insert gap markers where data is not consecutive.
+/-nesting-indicator n/N  Print nesting bars.

Default (no flags): - - expand- synbol s=BFGN

Description

With this option you specify that all struct, union and array symbols are expanded with their fields in the
HLL symbol dump.

With --expand-symbols=+basic-types, HLL struct and union symbols are listed including all fields. Array
members are expanded in one array member per line regardless of the HLL type. For the fields the types
and names are indented with 2 spaces.

With --expand-symbols=+fullpath, all fields of structs and unions and all members of non-basic type
arrays are expanded and prefixed with their parent's names.

With --expand-symbols=+gap-info, unused memory in complex data types (structures and unions)
between data objects and between code objects is shown as { gap} parts. This option is useful to optimize
data memory usage. This option only works if debug information is available in the ELF file.

With --expand-symbols=+nesting-indicator, vertical bars (| ) are shown to make it easier to see the
expanded structs, unions and arrays.

Example
hl dumpnts -F1 hello. el f

---------- HLL synbol table ----------

Addr ess Size HLL Type Nare
00000020 24 struct _dbg_request [dbg.c]
00000038 320 static char stdin_buf[80] [_iob.c]

hl dumpnts -e -F1 hello.elf

---------- HLL synbol table ----------
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Addr ess Size HLL Type
00000020 24 struct

00000020 4 i nt

00000024 4 enum

00000028 16 uni on
00000028 4 struct
00000028 4 i nt
00000028 8 struct
00000028 4 const char
0000002c¢ 4 unsi gned int
00000038 320 static char

hl dumpnts -eb -F1 hello.elf

---------- HLL synmbol table --------
Addr ess Size HLL Type

00000020 24 struct

00000020 4 i nt

00000024 4 enum

00000028 16 uni on

00000028 4 struct
00000028 4 i nt

00000028 8 struct
00000028 4 const char
0000002c 4 unsi gned int
00000038 320 static char
00000038 4 char

0000003c 4 char

00000040 4 char

00000174 4 char

hl dumpnts -ef -F1 hello.elf

---------- HLL synmbol table --------
Addr ess Size HLL Type

00000020 24 struct

00000020 4 i nt

00000024 4 enum

00000028 16 uni on

00000028 4 struct
00000028 4 i nt

00000028 8 struct
00000028 4 const char
0000002c 4 unsi gned int
00000038 320 static char
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Name
_dbg_request [dbhg.c]
_errno
nr
u
exit
status
open
* pat hnane
flags

stdin_buf[80] [_iob.c]

Name
_dbg_request [dbg.c]
_errno
nr
u
exit
status
open
* pat hnane
flags

stdin_buf[80] [_iob.c]

Nane

_dbg_request [dbhg.c]

_dbg_request._errno
_dbg_request.nr
_dbg_request.u
_dbg_request.u.exit
_dbg_request.u.exit.status
_dbg_request. u. open
* _dbg_request. u. open. pat hnane
_dbg_request. u.open. fl ags

stdin_buf[80] [_iob.c]



hl dumpnts -eg -F1 hello.elf

---------- HLL symbol table --------

Addr ess Size HLL Type
00000020 24 struct

00000020 4 i nt

00000024 4 enum

00000028 16 uni on
00000028 4 struct
00000028 4 i nt
0000002c 12

00000028 8 struct
00000028 4 const char
0000002c 4 unsi gned int
00000030 8

00000038 320 static char

hl dumpnts -en -F1 hello.elf

---------- HLL symbol table --------

Addr ess Size HLL Type

00000020 24 struct

00000020 4 | int

00000024 4 | enum

00000028 16 | union

00000028 4 | | struct
00000028 4| | | int

00000028 8 | | struct
00000028 4 | | | const char
0000002c 4 | | | unsigned int

00000038 320 static char

Related information

Section 6.4.2, HLL Dump Output Format
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Nanme

_dbg_request [dbg.c]

_errno
nr
u
exit
status
{gap}
open
* pat hnane
flags
{gap}

stdin_buf[80] [_iob.c]

Nanme

_dbg_request [dbg.c]

_errno
nr
u
exit
status
open
* pat hnane
flags

stdin_buf[80] [_iob.c]
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HLL object dumper option: --help (-?)

Command line syntax

--help

-?

Description

Displays an overview of all command line options.

Example

The following invocations all display a list of the available command line options:
hl dumpnts -?

hl dunpnts --hel p
hl dunpnts

Related information
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HLL object dumper option: --hex (-x)

Command line syntax
- - hex

-X

Description

With this option you can control the way data sections and code sections are dumped. By default, the
contents of data sections are represented by directives. A new directive will be generated for each symbol.
ELF labels in the section are used to determine the start of a directive. ROM sections are represented
with . wor d directives, depending on the size of the data. RAM sections are represented with . space
directives, with a size operand depending on the data size. This can be either the size specified in the
ELF symbol, or the size up to the next label. Code sections are dumped as disassembly.

With option --hex, no directives will be generated for ROM data sections and no disassembly dump will
be done for code sections. Instead ROM data sections and code sections are dumped as hexadecimal
code with ASCII translation. RAM sections will be represented with only a start address and a size indicator.

Example

hl dunpnts -F2 --section=. ntsdata. hello.\$2\$str hello.elf

---------- Section dunp ----------
.sdecl '.ntsdata. hello.$2%str', DATA AT 0x2d0
.sect '.ntsdata.hello.$2%str’
.word 00000048, 00000065, 0000006¢c, 0000006¢c; H...e...l...l1...
.word 0000006f, 0000002c, 00000020, 00000025; o0...,... ...%..

.word 00000073, 00000021, 00000004, 00000000; s...!...........
hl dunpnts -F2 --section=. ntsdata. hello.\$2\$str --hex hello.elf
---------- Section dunp ----------
section 7 (.ntsdata. hello. $2$str):
000002d0 48 00 00 00 65 00 00 00 6¢c 00 00 00 6¢c 00 00 OO H...e...l...1...

000002e0 6f 00 00 00 2c 00 00 00 20 00 00 00 25 00 00 00 0...,... ...%..
000002f0 73 00 00 00 21 00 00 00 Oa 00 00 00 00 00 00 00 s...!'...........

Related information

Section 6.4.2, HLL Dump Output Format
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HLL object dumper option: --option-file (-f)

Command line syntax
--option-file=file,...

-f file,...

Description

This option is primarily intended for command line use. Instead of typing all options on the command line,
you can create an option file which contains all options and flags you want to specify. With this option
you specify the option file to the HLL object dumper.

Use an option file when the command line would exceed the limits of the operating system, or just to store
options and save typing.

You can specify the option --option-file multiple times.

Format of an option file
» Multiple arguments on one line in the option file are allowed.
» To include whitespace in an argument, surround the argument with single or double quotes.

« If you want to use single quotes as part of the argument, surround the argument by double quotes and
vise versa:

"This has a single quote ' enbedded"
"This has a double quote " enbedded

'This has a doubl e quote and a single quote '"' enbedded"

* When a text line reaches its length limit, use a \ to continue the line. Whitespace between quotes is
preserved.

"This is a continuation \
l'ine"

-> "This is a continuation line

* Itis possible to nest command line files up to 25 levels.

Example
Suppose the file myopt i ons contains the following lines:
- -synbol s=hl |

--cl ass=code
hello.elf

486



Tool Options

Specify the option file to the HLL object dumper:
hl dumpnts --option-file=nyoptions
This is equivalent to the following command line:

hl dumpnts --synbol s=hl| --cl ass=code hello.elf

Related information
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HLL object dumper option: --output (-0)
Command line syntax

--output=file

-o file

Description

By default, the HLL object dumper dumps the output on st dout . With this option you specify to dump
the information in the specified file.

The default output format is text, but you can specify another output format with option --output-type.

Example
hl dumpnts - - out put =dunp. txt hello. el f

The HLL object dumper dumps the output in file dunp. t xt .

Related information

HLL object dumper option --output-type
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HLL object dumper option: --output-type (-T)
Command line syntax
--out put -type[ =t ype]

- T[type]

You can specify one of the following types:

text t Output human readable text.
xml X Output XML.

Default: - - out put - t ype=t ext

Description

With this option you can specify whether the output is formatted as plain text or as XML.

Related information

HLL object dumper option --output
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HLL object dumper option: --sections (-S)

Command line syntax
--sections=nane,. ..

-Shane, ...

Description

With this option you can restrict the output to the specified sections only. This option affects the following
parts of the output:

Output part Effect of --sections

Module list Not restricted

Section list Only lists the specified sections

Section dump Only dumps the contents of the specified sections
HLL symbol table Not restricted

Assembly level symbol |Only lists symbols defined in the specified sections
table

Note sections Not restricted

By default all sections are included.

Related information

Section 6.4.2, HLL Dump Output Format
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HLL object dumper option: --source-lookup-path (-L)

Command line syntax
--sour ce- | ookup- pat h=pat h
-Lpath

Description

With this option you can specify an additional path where your source files are located. If you want to
specify multiple paths, use the option --source-lookup-path for each separate path.

The order in which the HLL object dumper will search for source files when intermixed disassembly is
used, is:

1. The path obtained from the HLL debug information.

2. The path that is specified with the option --source-lookup-path. If multiple paths are specified, the
paths will be searched for in the order in which they are given on the command line.

Example
Suppose you call the HLL object dumper as follows:
hl dumpnts --di sassenbly-interm x --source-|ookup-path=c:\nylib\src hello.elf

First the HLL object dumper looks in the directory found in the HLL debug information of file hel | o. el f
for the location of the source file(s). If it does not find the file(s), it looks in the directory c: \ nyl i b\ src.

Related information

HLL object dumper option --disassembly-intermix
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HLL object dumper option: --symbols (-S)

Command line syntax
- -synbol s[ =t ype]
- S[ type]

You can specify one of the following types:

asm a Display assembly symbols in code dump.
hll h Display HLL symbols in code dump.
none n Display plain addresses in code dump.

Default: - - synmbol s=asm

Description

With this option you can control symbolic information in the disassembly and data dump. For data sections
this only applies to symbols used as labels at the data addresses. Data within the data sections will never
be replaced with symbols.

Only symbols that are available in the ELF or DWARF information are used. If you build an application
without HLL debug information the --symbols=hll option will result in the same output as with
--symbols=none. The same applies to the --symbols=asm option when all symbols are stripped from
the ELF file.

Example
hl dumpnts -F2 hello. el f
----------- Section dunmp ----------

.sdecl '.nrstext.libc. START', CODE AT 0Ox4lc

.sect '.ntstext.libc. START'
0000041c 60 09 00 17 _ START: novl r7,0x00000960
00000420 00 00 00 12 novl r2, 0x00000000
00000424 00 00 00 13 novl r 3, 0x00000000
00000428 f4 03 03 €0 cal | .L12
0000042c 78 08 00 €0 jmp exit

hl dumpnts --synbol s=none -F2 hello.elf

----------- Section dunmp ----------
.sdecl '.nrstext.libc. START', CODE AT 0x414

sect '.nrstext.libc. START
0000041c 60 09 00 17 novl r7,0x00000960
00000420 00 00 00 12 novl r2, 0x00000000
00000424 00 00 00 13 novl r 3, 0x00000000
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00000428 f4 03 03 e0 cal | 0x000003f 4
0000042c 78 08 00 e0 jmp 0x00000878

Related information

Section 6.4.2, HLL Dump Output Format
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HLL object dumper option: --version (-V)

Command line syntax
--version

-V

Description

Display version information. The HLL object dumper ignores all other options or input files.

Related information
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HLL object dumper option: --xml-base-filename (-X)

Command line syntax
--xm - base-fil ename
-X

Description

With this option the <Fi | e nane> field in the XML output only contains the filename of the object file.
By default, any path name, if present, is printed as well.

Example

hl dumpnts --out put-type=xm --output=hello.xm ../hello.elf
The field <Fi | e name="../hello.el f">isusedinhel | 0. xm .

hl dumpnts --out put-type=xm --output=hello.xm -X ../hello.elf

The field <Fi | e name="hel | 0. el f">isused in hel | 0. xm . The path is stripped from the filename.

Related information

HLL object dumper option --output-type
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Chapter 9. Influencing the Build Time

In general many settings have influence on the build time of a project. Any change in the tool settings of
your project source will have more or less impact on the build time. The following sections describe several
issues that can have significant influence on the build time.

9.1. Optimization Options

In general any optimization may require more work to be done by the compiler. But this does not mean
that disabling all optimizations (level 0) gives the fastest compilation time. Disabling optimizations may
resultin more code being generated, resulting in more work for other parts of the compiler, like for example
the register allocator.

9.2. Automatic Inlining

Automatic inlining is an optimization which can result in significant longer build time. The overall functions
will get bigger, often making it possible to do more optimizations. But also often resulting in more registers
to be in use in a function, giving the register allocation a tougher job.

9.3. Header Files

Many applications include all header files in each module, often by including them all within a single
include file. Processing header files takes time. It is a good programming practice to only include the
header files that are really required in a module, because:

* itis clear what interfaces are used by a module
» an incremental build after modifying a header file results in less modules required to be rebuild

* it reduces compile time

9.4. Parallel Build

The make utility amk, which is used by Eclipse, has a feature to build jobs in parallel. This means that
multiple modules can be compiled in parallel. With today's multi-core processors this means that each
core can be fully utilized. In practice even on single core machines the compile time decreases when
using parallel jobs. On multi-core machines the build time even improves further when specifying more
parallel jobs than the number of cores.

In Eclipse you can control the parallel build behavior:
1. From the Project menu, select Properties for

The Properties dialog appears.
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2. Inthe left pane, select C/C++ Build.
In the right pane the C/C++ Build page appears.
3. On the Behavior tab, select Enable parallel build.

4. You can specify the number of parallel jobs, or you can use an optimal number of jobs. In the last
case, amk will fork as many jobs in parallel as cores are available.

9.5. Section Concatenation

By default the linker does not merge sections with the same name into one section. With the assembler
option --concatenate-sections the assembler uses the section attribute concat , instructing the linker
to merge sections with the same name.

The advantage of section concatenation is faster locating, because there are less sections to locate.

The disadvantage of section concatenation is less efficient memory use, because of alignment gaps
between (sequentially concatenated) sections.
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Chapter 10. Libraries

This chapter contains an overview of all library functions that you can call in your C source. This includes
all functions of the standard C library (ISO C99) and some functions of the floating-point library.

Section 10.1, Library Functions, gives an overview of all library functions you can use, grouped per header
file. A number of functions declared in wchar . h are parallel to functions in other header files. These are
discussed together.

Section 10.2, C Library Reentrancy, gives an overview of which functions are reentrant and which are
not.

C library / floating-point library / run-time library

The following libraries are included in the MCS toolset. Both Eclipse and the control program ccmcs
automatically select the appropriate libraries depending on the specified options.

Libraries Description

libc[s].a C libraries

Optional letter:

s = single precision floating-point (control program option
--fp-model=+float)

libfp.a Floating-point libraries (contains floating-point functions needed by the C
compiler)

librt.a Run-time library (contains other run-time functions needed by the C
compiler)

The libraries are stored in the directory:

<installation path>\1ib\ncs30\[be|le][\nnd] (MCS v3.0 libraries)
<installation path>\lib\ncs31\[be|le][\nnd] (MCS v3.1 libraries)
<installation path>\lib\ncs40\[be|le][\nnd] (MCS v4.0 libraries)

The libraries are available in big-endian (be) or little-endian (le) variants. For MCS cores without multiply
and/or divide support, the libraries are present in the nnd directory.

Sources for the libraries are present in the directories | i b\ src,| i b\ src. * in the form of an executable.
If you run the executable it will extract the sources in the corresponding directory.

10.1. Library Functions

The tables in the sections below list all library functions, grouped per header file in which they are declared.
Some functions are not completely implemented because their implementation depends on the context
where your application will run. These functions are for example all I/O related functions. Where possible,
these functions are implemented using file system simulation (FSS). This system can be used by the
debugger to simulate an 1/0 environment which enables you to debug your application.
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Wide character support

A number of wide character functions are available as C source code, but have not been compiled with
the C library. To use complete wide character functionality, you must recompile the libraries with the
macro WCHAR SUPPORT_ENABLED and keep this macro also defined when compiling your own sources.
See C compiler option --define (-D). The easiest way is to adapt the makefile for the library and change
the CCline to:

CC = $(PRODDI R)\ bi n\ cnts - DWCHAR SUPPORT_ENABLED
10.1.1. assert.h

assert (expr) Prints a diagnostic message if NDEBUG is not defined. (Implemented as macro)

For C11 only, the following macro is defined:

#define static_assert _Static_assert

10.1.2. complex.h

The complex number z is also written as x+yi where x (the real part) and y (the imaginary part) are real
numbers of types f | oat , doubl e orl ong doubl e.The real and imaginary part can be stored in structs
or in arrays. This implementation uses arrays because structs may have different alignments.

The header file conpl ex. h also defines the following macros for backward compatibility:

conpl ex _Conpl ex /[* C99 keyword */
i mginary _lmaginary /* C99 keyword */

Parallel sets of functions are defined for double, float and long double. They are respectively named
function, functionf , functionl . All long type functions, though declared in conpl ex. h, are implemented
as the doubl e type variant which nearly always meets the requirement in embedded applications.

This implementation uses the obvious implementation for complex multiplication; and a more sophisticated
implementation for division and absolute value calculations which handles underflow, overflow and infinities
with more care. The ISO C99 #pr agma CX_LI M TED_RANGE therefore has no effect.

Trigonometric functions

csin csi nf csinl Returns the complex sine of z.

ccos ccosf ccosl Returns the complex cosine of z.

ctan ct anf ctanl Returns the complex tangent of z.

casin casi nf casi nl Returns the complex arc sine sin'l(z).
cacos cacosf cacosl Returns the complex arc cosine cos'l(z).
cat an cat anf cat anl Returns the complex arc tangent tan'l(z).
csi nh csi nhf csi nhl Returns the complex hyperbolic sine of z.
ccosh ccoshf ccoshl Returns the complex hyperbolic cosine of z.
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ctanh ct anhf ct anhl

casi nh casi nhf casi nhl
cacosh cacoshf cacoshl
cat anh cat anhf catanhl

Libraries

Returns the complex hyperbolic tangent of z.
Returns the complex arc hyperbolic sinus of z.
Returns the complex arc hyperbolic cosine of z.

Returns the complex arc hyperbolic tangent of z.

Exponential and logarithmic functions

cexp cexpf cexpl
cl og cl ogf cl ogl

Returns the result of the complex exponential function e”.
Returns the complex natural logarithm.

Power and absolute-value functions

cabs cabsf cabsl
cpow cpowf cpowl
csqrt csqrtf csqrtl

Manipulation functions

carg car gf cargl
ci mag ci magf ci magl
conj conj f conj |
cproj cprojf cprojl
creal creal f creall

Returns the complex absolute value of z (also known as norm,
modulus or magnitude).

Returns the complex value of x raised to the power y (x’) where
both x and y are complex numbers.

Returns the complex square root of z.

Returns the argument of z (also known as phase angle).

Returns the imaginary part of z as a real (respectively as adoubl e,
fl oat,l ong doubl e)

Returns the complex conjugate value (the sign of its imaginary part
is reversed).

Returns the value of the projection of z onto the Riemann sphere.

Returns the real part of z as a real (respectively as a doubl e,
fl oat,l ong doubl e)

10.1.3. ctype.h and wctype.h

The header file ct ype. h declares the following functions which take a character ¢ as an integer type
argument. The header file wct ype. h declares parallel wide character functions which take a character

c of the wchar _t type as argument.

ctype.h wctype.h Description

i sal num i swal num Returns a non-zero value when c is an alphabetic character or a
number ([A-Z][a-z][0-9]).

i sal pha i swal pha Returns a non-zero value when c is an alphabetic character
([A-Z][a-z]).

i sbl ank i swbl ank Returns a non-zero value when c is a blank character (tab, space...)

iscntrl i swentrl Returns a non-zero value when c is a control character.

isdigit iswditit Returns a non-zero value when c is a numeric character ([0-9]).
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ctype.h wctype.h Description

i sgraph i swgr aph Returns a non-zero value when c is printable, but not a space.

i sl oner i sw ower Returns a non-zero value when c is a lowercase character ([a-z]).

i sprint i swprint Returns a non-zero value when c is printable, including spaces.

i spunct i swpunct Returns a non-zero value when c is a punctuation character (such
as '.I, |,|’ v!u).

i sspace i swspace Returns a non-zero value when c is a space type character (space,
tab, vertical tab, formfeed, linefeed, carriage return).

i supper i swupper Returns a non-zero value when c is an uppercase character ([A-Z]).

i sxdigit i swxdi git Returns a non-zero value when c is a hexadecimal digit
([0-9][A-F][a-f]).

t ol ower t oM ower Returns c converted to a lowercase character if it is an uppercase
character, otherwise c is returned.

t oupper t owupper Returns ¢ converted to an uppercase character if it is a lowercase
character, otherwise c is returned.

_tol ower - Converts c to a lowercase character, does not check if ¢ really is

an uppercase character. Implemented as macro. This macro
function is not defined in ISO C99.

_t oupper - Converts ¢ to an uppercase character, does not check if ¢ really
is a lowercase character. Implemented as macro. This macro
function is not defined in ISO C99.

i sasci i Returns a non-zero value when c is in the range of 0 and 127. This
function is not defined in ISO C99.
toascii Converts c to an ASCII value (strip highest bit). This function is

not defined in ISO C99.

10.1.4. dbg.h

The header file dbg. h contains the debugger call interface for file system simulation. It contains low level
functions. This header file is not defined in ISO C99.

_dbg_trap Low level function to trap debug events

_argcv(const char Low level function for command line argument passing
*buf, size_t size)

10.1.5. errno.h

int errno External variable that holds implementation defined error codes.

The following error codes are defined as macros in er r no. h:

EPERM 1 Operation not permitted
ENOCENT 2 No such file or directory
El NTR 3 Interrupted system call
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ElI O 4 I/O error

EBADF 5 Bad file number

EAGAI N 6 No more processes
ENOVEM 7 Not enough core
EACCES 8 Permission denied
EFAULT 9 Bad address

EEXI ST 10 File exists

ENOTDI R 11 Not a directory

El SDI R 12 Is a directory

El NVAL 13 Invalid argument

ENFI LE 14 File table overflow
EMFI LE 15 Too many open files
ETXTBSY 16 Text file busy

ENCSPC 17 No space left on device
ESPI PE 18 lllegal seek

EROFS 19 Read-only file system
EPI PE 20 Broken pipe

ELOCP 21 Too many levels of symbolic links
ENAMETOOLONG 22 File name too long

Floating-point errors

EDOM 23 Argument too large
ERANGE 24 Result too large

Errors returned by printf/scanf

ERR_FORMAT 25 lllegal format string for printf/scanf
ERR_NOFLOAT 26 Floating-point not supported
ERR_NCLONG 27 Long not supported

ERR_NOPO NT 28 Pointers not supported

Encoding errors set by functions like fgetwc, getwc, mbrtowc, etc ...

El LSEQ 29 Invalid or incomplete multibyte or wide character

Errors returned by RTOS

ECANCELED 30 Operation canceled
ENCDEV 31 No such device
10.1.6. fcntl.h

Libraries

The header file f cnt | . h contains the function open() , which calls the low level function _open(), and
definitions of flags used by the low level function _open() . This header file is not defined in ISO C99.

open Opens a file a file for reading or writing. Calls _open.
(FSS implementation)
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10.1.7. fenv.h

Contains mechanisms to control the floating-point environment.

feget env Stores the current floating-point environment.

f ehol dexept Saves the current floating-point environment and installs an environment
that ignores all floating-point exceptions.

fesetenv Restores a previously saved (f eget env or f ehol dexcept ) floating-point
environment.

f eupdat eenv Saves the currently raised floating-point exceptions, restores a previously
saved floating-point environment and finally raises the saved exceptions.

f ecl ear except Clears the current exception status flags corresponding to the flags specified
in the argument.

feget exceptfl ag Stores the current setting of the floating-point status flags.

f er ai seexcept Raises the exceptions represented in the argument. As a result, other
exceptions may be raised as well.

fesetexceptfl ag Sets the current floating-point status flags.

f et est except Returns the bitwise-OR of the exception macros corresponding to the

exception flags which are currently set and are specified in the argument.

For each supported exception, a macro is defined. The following exceptions are defined:

FE_DI VBYZERO FE_I NEXACT FE_I NVALI D
FE_OVERFLOW FE_UNDERFLOW FE_ALL_EXCEPT

f egetround Returns the current rounding direction, represented as one of the values of
the rounding direction macros.

fesetround Sets the current rounding directions.

For each supported rounding mode, a macro is defined. The following rounding mode macro is defined:

FE_TONEAREST

10.1.8. float.h

The header file f | oat . h defines the characteristics of the real floating-point types f | oat , doubl e and
| ong doubl e.

f | oat . h used to contain prototypes for the functions copysi gn(f ), i si nf (f), i sfi ni te(f),
i snan(f) and scal b(f ). These functions have accordingly to the ISO C99 standard been moved
to the header file mat h. h. See also Section 10.1.15, math.h and tgmath.h.

The following functions are only available for ISO C90:
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copysignf(float f,float s) Copies the sign of the second argument s to the value of the first
argument f and returns the result.

copysi gn(doubl e d, doubl e s) Copies the sign of the second argument s to the value of the first
argument d and returns the result.

isinff(float f) Test the variable f on being an infinite (IEEE-754) value.

i si nf(double d); Test the variable d on being an infinite (IEEE-754) value.
isfinitef(float f) Test the variable f on being a finite (IEEE-754) value.

i sfinite(double d) Test the variable d on being a finite (IEEE-754) value.

i snanf (float f) Test the variable f on being NaN (Not a Number, IEEE-754) .

i snan(doubl e d) Test the variable d on being NaN (Not a Number, IEEE-754) .
scal bf (float f,int p) Returns f * 27p for integral values without computing 2N.

scal b(doubl e d,int p) Returns d * 2"p for integral values without computing 2”N. (See

also scal bn in Section 10.1.15, math.h and tgmath.h)

10.1.9. inttypes.h and stdint.h

The header files st di nt . hand i ntt ypes. h provide additional declarations for integer types and have
various characteristics. The st di nt . h header file contains basic definitions of integer types of certain
sizes, and corresponding sets of macros. This header file clearly refers to the corresponding sections in
the ISO C99 standard.

Thei ntt ypes. h header file includes st di nt . h and adds portable formatting and conversion functions.
Below the conversion functions from i nt t ypes. h are listed.

i maxabs(intmax_t j) Returns the absolute value of j

i maxdi v(intmax_t nuner, Computes nuner / denomand nuner % denom The resultis stored
i ntmax_t denom in the quot and r emcomponents of the i maxdi v_t structure type.
strtoi max(const char * Convert string to maximum sized integer. (Compare strtol |)

restrict nptr, char **
restrict endptr, i nt base)

strtoumax(const char * Convert string to maximum sized unsigned integer. (Compare
restrict nptr, char ** strtoul )
restrict endptr, i nt base)

west oi max(const wechar _t *  Convert wide string to maximum sized integer. (Compare wcst ol | ')
restrict nptr, wchar _t **
restrict endptr, i nt base)

west oumax( const wehar _t * Convert wide string to maximum sized unsigned integer. (Compare
restrict nptr, wchar _t ** westoul I)
restrict endptr, i nt base)

10.1.10.i0.h

The header file i 0. h contains prototypes for low level I/O functions. This header file is not defined in ISO
C99.
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_cl ose(fd) Used by the functions cl ose and f cl ose. (FSS implementation)

_I seek(fd, of fset, whence) Used by all file positioning functions: f get pos, f seek, f set pos,
ftell,rew nd.(FSS implementation)

_open(fd,fl ags) Used by the functions f open and f r eopen. (FSS implementation)

_read(fd, *buff, cnt) Reads a sequence of characters from a file. (FSS implementation)

_unli nk(*nan®e) Used by the function remove. (FSS implementation)

_wite(fd, *buffer,cnt) Writes a sequence of characters to a file. (FSS implementation)

10.1.11.is0646.h
The header file i s0646. h adds tokens that can be used instead of regular operator tokens.

#define and &&
#define and_eq &=
#define bitand &
#define bitor
#defi ne conpl
#define not
#define not _eq
#define or
#define or_eq
#define xor
#define xor_eq *

S—— = - —
In—1

10.1.12. limits.h

Contains the sizes of integral types, defined as macros.

10.1.13. locale.h

To keep C code reasonable portable across different languages and cultures, a number of facilities are
provided in the header file | ocal e. h.

char *setlocale( int category, const char *locale )

The function above changes locale-specific features of the run-time library as specified by the category
to change and the name of the locale.

The following categories are defined and can be used as input for this function:

LC ALL 0 LC NUMERIC 3
LC COLLATE 1 LC TI ME 4
LC _CTYPE 2 LC_MONETARY 5

struct |conv *|ocal econv( void )
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Returns a pointer to type st ruct | conv with values appropriate for the formatting of numeric
guantities according to the rules of the current locale. The st r uct | conv in this header file is
conforming the ISO standard.

10.1.14. malloc.h

The header file mal | oc. h contains prototypes for memory allocation functions. This include file is not
defined in ISO C99, it is included for backwards compatibility with ISO C90. For ISO C99, the memory
allocation functions are part of st dl i b. h. See Section 10.1.24, stdlib.h and wchar.h.

mal | oc(si ze) Allocates space for an object with size size.
The allocated space is not initialized. Returns a pointer to the
allocated space.

al i gned_al | oc(al i gnnent, (C11 only) Allocates space for an object whose alignment is
si ze) specified by alignment and with size size.
The allocated space is not initialized. Returns a pointer to the
allocated space.

cal I oc(nobj, si ze) Allocates space for n objects with size size.
The allocated space is initialized with zeros. Returns a pointer to
the allocated space.

free(*ptr) Deallocates the memory space pointed to by ptr which should be
a pointer earlier returned by the mal | oc or cal | oc function.

real l oc(*ptr, si ze) Deallocates the old object pointed to by ptr and returns a pointer
to a new object with size size, while preserving its contents.
If the new size is smaller than the old size, some contents at the
end of the old region will be discarded. If the new size is larger than
the old size, all of the old contents are preserved and any bytes in
the new object beyond the size of the old object will have
indeterminate values.

10.1.15. math.h and tgmath.h

The header file mat h. h contains the prototypes for many mathematical functions. Before ISO C99, all
functions were computed using the double type (the float was automatically converted to double, prior to
calculation). In this ISO C99 version, parallel sets of functions are defined for doubl e, f | oat and | ong
doubl e. They are respectively named function, functionf , functionl . All | ong type functions, though
declared in mat h. h, are implemented as the doubl e type variant which nearly always meets the
requirement in embedded applications.

The header file t gmat h. h contains parallel type generic math macros whose expansion depends on the
used type. t gmat h. h includes mat h. h and the effect of expansion is that the correct mat h. h functions
are called. The type generic macro, if available, is listed in the second column of the tables below.

Trigonometric and hyperbolic functions

math.h tgmath.h Description

sin si nf sinl sin Returns the sine of x.
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math.h tgmath.h Description

cos cosf cosl cos Returns the cosine of x.

tan t anf t anl tan Returns the tangent of x.

asin asi nf asinl asin Returns the arc sine sin'l(x) of x.
acos acosf acosl acos Returns the arc cosine cos'l(x) of x.
at an at anf at anl at an Returns the arc tangent tan'l(x) of x.

atan2 atan2f atan2l at an2 Returns the result of: tan’l(y/ X).

si nh si nhf si nhl si nh Returns the hyperbolic sine of x.
cosh coshf coshl cosh Returns the hyperbolic cosine of x.
t anh t anhf t anhl t anh Returns the hyperbolic tangent of x.
asi nh asi nhf  asi nhl asi nh Returns the arc hyperbolic sine of x.

acosh acoshf  acoshl acosh Returns the non-negative arc hyperbolic cosine of x.
at anh atanhf  atanhl at anh Returns the arc hyperbolic tangent of x.

Exponential and logarithmic functions

All of these functions are new in ISO C99, except for exp, | og and | 0g10.

math.h tgmath.h Description
exp expf expl exp Returns the result of the exponential function e*.
exp2 exp2f exp2l exp2 Returns the result of the exponential function 2*.

expml expmif  expmil expml Returns the result of the exponential function e*-1.

| og | ogf | ogl | og Returns the natural logarithm I n(x), x>0.

| 0ogl0 | og10f 1 ogl0l | 0og10 Returns the base-10 logarithm of x, x>0.

| oglp I oglpf 1 oglpl | oglp Returns the base-e logarithm of (1+x) . x <> - 1.

| 0g2 | og2f | og2l | 0g2 Returns the base-2 logarithm of x. x>0.

il ogb il ogbf ilogbl il ogb Returns the signed exponent of x as an integer. x>0.

| ogb | ogbf | ogbl | ogb Returns the exponent of x as a signed integer in value in

floating-point notation. x > 0.

frexp, Idexp, modf, scalbn, scalbln

math.h tgmath.h Description

frexp frexpf frexpl frexp Splits a float x into fraction f and exponent n, so that:
f=0.00r0.5<|f|<1.0andf2" = x. Returns f, stores n.

| dexp | dexpf | dexpl | dexp Inverse of f r exp. Returns the result of x*2".
(x and n are both arguments).

nmodf nmodf f nodf | - Splits a float x into fraction f and integer n, so that:
| f| < 1.0 and f+n=x. Returns f, stores n.
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math.h tgmath.h Description

scal bn scal bnf scalbnl scalbn Computes the result of x* FLT_RADI X". efficiently, not
normally by computing FLT_RADI X" explicitly.

scal bl n scal bl nf scal bl nl scal bl n Same as scal bn but with argumentn as | ong i nt.

Rounding functions

math.h tgmath.h Description

ceil ceilf ceill ceil Returns the smallest integer not less than x, as a double.

floor floorf floorl floor Returns the largest integer not greater than x, as a double.

rint rintf rintl rint Returns the rounded integer value as an i nt according
to the current rounding direction. See f env. h.

I rint lrintf lrintl I rint Returns the rounded integer value as a |l ong i nt
according to the current rounding direction. See f env. h.

Ilrint Ilrintf Ilrintl Ilrint Returns the rounded integer value asal ong | ong i nt
according to the current rounding direction. See f env. h.

near byi nt nearbyi ntf nearbyi ntl nearbyi nt Returns the rounded integer value as a floating-point
according to the current rounding direction. See f env. h.

round roundf  roundl round Returns the nearest integer value of x as int.

Iround Iroundf Iroundl Iround Returnsthe nearestinteger value of x as long int.

I'lround Iroundf Ilroundl Ilround Returnsthe nearestinteger value of x as long long int.

trunc truncf  truncl trunc Returns the truncated integer value x.

Remainder after division

math.h tgmath.h Description

f nod f nodf f nodl f nod Returns the remainder r of x- ny. n is chosen as
trunc(xly).r has the same sign as x.

renai nder renai nderf renai nderl renai nder Returns the remainder r of x- ny. n is chosen as
trunc(xly) .r may not have the same sign as x.

renguo renguof renguol rengquo  Same as remainder. In addition, the argument * quo is

Power and absolute-value functions

given a specific value (see ISO).

math.h tgmath.h Description

cbrt cbrtf cbrtl chrt Returns the real cube root of x (=x*'3).

f abs f absf f absl f abs Returns the absolute value of x (] x| ). (abs, I abs, I | abs,
div,ldiv,|Idiv aredefinedinstdlib. h)

fma f maf f mal fma Floating-point multiply add. Returns x*y+z.

hypot hypotf hypotl  hypot Returns the square root of x2+y?.
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math.h tgmath.h Description
pow powf pow power Returns x raised to the power y (xY). 1
sqrt sqrtf sqrtl sqrt Returns the non-negative square root of x. x O.

Ywith compiler option --fp-model=-fastlib more precise versions of pow, powf and pow are used when
the arguments have no fractional part. The macro __PRECI SE_LI B_FP__ is defined. By default, less
precise versions are used.

Manipulation functions: copysign, nan, nextafter, nexttoward

math.h tgmath.h Description

copysi gn copysi gnf copysignl| copysi gn Returns the value of x with the sign of y.

nan nanf nanl - Returns a quiet NaN, if available, with content indicated
through t agp.

nextafter nextafterf nextafterl nextafter Returns the next representable value in the specified
format after x in the direction of y. Returns y is x=y.

nexttovard nexttovard nedttonard nexttoward Same as next af t er, except that the second argument
in all three variants is of type long double. Returns vy if

X=Y.

Positive difference, maximum, minimum

math.h tgmath.h Description

fdim fdi nf fdim fdim Returns the positive difference between: | x-y| .
f max f maxf f max| f max Returns the maximum value of their arguments.
fmn fm nf fmnl fmn Returns the minimum value of their arguments.

Error and gamma

math.h tgmath.h Description
erf erff erfl erf Computes the error function of x.
erfc erfcf erfcl erc Computes the complementary error function of x.

| ganma | ganmmaf | gammal | gamma Computes the * | oge| M(X) |
tgamma tgamaf tgammal tganma  Computes IMN(x)
Comparison macros

The next are implemented as macros. For any ordered pair of numeric values exactly one of the
relationships - less, greater, and equal - is true. These macros are type generic and therefore do not have
a parallel function in t gmat h. h. All arguments must be expressions of real-floating type.

math.h tgmath.h  Description

i sgreater - Returns the value of (x) > (y)
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math.h tgmath.h  Description

i sgreat erequal - Returns the value of (x) >= (vy)

i sl ess - Returns the value of (x) < (y)

i sl essequal - Returns the value of (x) <= (vy)

i sl essgreater - Returns the value of (x) < (y) || (x) > (y)

i sunor der ed - Returns 1 if its arguments are unordered, O otherwise.

Classification macros

The next are implemented as macros. These macros are type generic and therefore do not have a parallel
function in t gmat h. h. All arguments must be expressions of real-floating type.

math.h tgmath.h  Description

fpcl assify - Returns the class of its argument:
FP_I NFI NI TE, FP_NAN, FP_NORVAL, FP_SUBNORVAL or
FP_ZERO

isfinite - Returns a nonzero value if and only if its argument has a finite
value

i sinf - Returns a nonzero value if and only if its argument has an infinite
value

i snan - Returns a nonzero value if and only if its argument has NaN value.

i snor nal - Returns a nonzero value if an only if its argument has a normal
value.

signbit - Returns a nonzero value if and only if its argument value is
negative.

10.1.16. setjmp.h

The setj np and | ongj np in this header file implement a primitive form of non-local jumps, which may
be used to handle exceptional situations. This facility is traditionally considered more portable than
signal . h

int setjnp(jnp_buf Records its caller's environment in env and returns 0.
env)

voi d | ongj mp(j mp_buf Restores the environment previously saved with a call to set j np() .
env, int status)

10.1.17. signal.h

Signals are possible asynchronous events that may require special processing. Each signal is named by
a number. The following signals are defined:

SI A NT 1 Receipt of an interactive attention signal
SIGLL 2 Detection of an invalid function message
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S| GFPE 3 An erroneous arithmetic operation (for example, zero divide, over f | ow)
SIGSEGY 4 Aninvalid access to storage

SIGTERM 5 A termination request sent to the program

SIGABRT 6 Abnormal termination, such as is initiated by the abor t function

The next function sends the signal sig to the program:

int raise(int sig)

The next function determines how subsequent signals will be handled:
si gnal function *signal (int, signalfunction *);

The first argument specifies the signal, the second argument points to the signal-handler function or has
one of the following values:

S| G_DFL Default behavior is used
SIG I GN The signal is ignored

The function returns the previous value of si gnal f uncti on for the specific signal, or SI G_ERRIf an
error occurs.

10.1.18. stdalign.h

This C11 header file contains the following macro definitions about alignment:

#define alignas _Alignas
#define __alignas_is_defined 1

#define alignof _Alignof
#define __alignof_is_defined 1

10.1.19. stdarg.h

The facilities in this header file gives you a portable way to access variable arguments lists, such as
needed foras f pri ntf and vfpri ntf.va_copy is new in ISO C99. This header file contains the
following macros:

va_arg(va_list ap,type) Returnsthe value of the next argument in the variable argument list.
Its return type has the type of the given argument t ype. A next call to
this macro will return the value of the next argument.

va_copy(va_list dest, This macro duplicates the current state of sr ¢ in dest, creating a

va_list src) second pointer into the argument list. After this call, va_arg() may be
used on sr c and dest independently.

va_end(va_list ap) This macro must be called after the arguments have been processed.
It should be called before the function using the macro 'va_start' is
terminated.
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va_start(va_list ap, This macro initializes ap. After this call, each call to va_arg() will return

| ast ar g) the value of the next argument. In our implementation, va_| i st cannot
contain any bit type variables. Also the given argument | ast ar g must
be the last non-bit type argument in the list.

10.1.20. stdbool.h

This header file contains the following macro definitions. These names for boolean type and values are
consistent with C++. You are allowed to #undef i ne or redefine the macros below.

#define bool _Bool
#define true 1
#define fal se 0
#define __bool _true_fal se_are_defined 1

10.1.21. stddef.h
This header file defines the types for common use:

ptrdiff _t Signed integer type of the result of subtracting two pointers.
size_t Unsigned integral type of the result of the si zeof operator.
wchar _t Integer type to represent character codes in large character sets.

Besides these types, the following macros are defined:

NULL Expands to the null pointer constant (voi d *) 0 for C or O (zero) for C++.
of f set of (_t ype, Expands to an integer constant expression with type si ze_t that is the offset
_menber) in bytes of _nmenber within structure type _t ype.

10.1.22. stdint.h

See Section 10.1.9, inttypes.h and stdint.h
10.1.23. stdio.h and wchar.h

Types

The header file st di 0. h contains functions for performing input and output. A number of functions also
have a parallel wide character function or macro, defined in wehar . h. The header file wchar . h also
includes st di 0. h.

In the C language, many |I/O facilities are based on the concept of streams. The st di 0. h header file
defines the data type FI LE which holds the information about a stream. A FI LE object is created with
the function f open. The pointer to this object is used as an argument in many of the in this header file.
The FI LE object can contain the following information:

« the current position within the stream
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 pointers to any associated buffers

« indications of for read/write errors

» end of file indication

The header file 